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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Some application pages have help icons    to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Introduction to Financial Reporting

Overview of Using Financial Analytics and Reports  
Oracle Financials Cloud provides predefined analyses, dashboards, and reports that help you meet financial and
business intelligence requirements. With the many reporting tools, you can run, view, and build user-defined or real-
time analytics and reports.

The Oracle Financials Cloud: Using Analytics and Reports Guide covers using predefined analysis and reports for the
following Oracle Fusion Financial Applications:

• General Ledger

• Intercompany

• Budgetary Control

• Tax

• Subledger Accounting

• Payables

• Payments

• Cash Management

• Receivables

• Advanced Collections

• Revenue Management

• Assets

• Financial Localization Features for EMEA, Latin America, and Asia/Pacific

Financial Reporting Solutions  
Different reporting requirements exist in a finance organization. The Chief Financial Officer needs professional-quality
financial statements, financial analysts analyze ledger balances, and other users perform real-time transactional
queries.

Oracle Fusion Financials delivers a state-of-the-art reporting platform that's built on top of an analytic data model.
The reports work off the same data source and support drill-downs to real-time source transactions. The queries and
reports are accurate and up to the minute, providing multidimensional analysis without the need for a separate data
warehouse.

Reporting Tools
Oracle has many tools to meet these reporting needs. Some of your reporting needs and the tools used in the reporting
solution are listed in this table.
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Reporting Needs Solution

Boardroom ready financial statements
with drill-down to your source transactions
that are GAAP-compliant.
 

Oracle Financial Reporting Studio is used to create financial reports based on the GL balances cube
data. Then, use the Financial Reporting Center to view and drill into reports.
 

Exception-based account monitoring with
multidimensional analysis and drill-down
capability
 

Account Groups are created to monitor key accounts in General Ledger. From the account group, use
the Sunburst visualization tool to interact with your account balances across business dimensions to
view balances from different perspectives.
 

Spreadsheet financial reports with
multidimensional analysis, pivoting, real-
time analysis, and drill down capability.
 

Oracle Smart View enables you to interactively analyze your balances and define reports using a
familiar spreadsheet environment.
 

High volume operational reporting with
configurable templates for financial
applications.
 

Oracle Analytics Publisher reports are submitted to show the latest application transactional data
using the Enterprise Scheduler System (ESS) from either the Scheduled Processes page or from an
application-specific work area. BI Publisher has the ability to generate pixel perfect report output.
BI Publisher is the tool of choice to generate fixed form reports such as W-2 and tax forms, invoices,
purchase orders, or company checks,
 

Transactional reporting in real time to
support daily decision making.
 

Oracle Transactional BI Analyses are built off of transactional tables using Subject Areas. Use BI
Publisher if the need is for pixel perfect reporting.
 

Centralize location for performing
application functions and reviewing data.
 

Oracle Transactional BI Dashboards put all the information, functions, and actions that a business user
requires to do their job in one place. Dashboards are built with Oracle Transactional BI objects such as
analyses and reports.
 

Mobile access to timely reporting
information from financial applications.
 

BI Mobile Apps is a mobile application designer that enables you to create information-driven
applications with rich interaction, visualization, and media, for mobile devices such as iPhone, iPad,
Android phone, tablet, and more.
 

Related Topics
• Overview of Financial Reporting Center

Overview of Financial Reporting Center  
The Financial Reporting Center is intended to be the primary user interface for financials end users to access all seven
report types.

Financial Reporting Center
The Financial Reporting Center includes these report types: Financial Reporting Web Studio Reports, Account Groups
and Sunburst, Smart View Reports, Oracle Transactional Business Intelligence Analyses, Oracle Transactional Business
Intelligence Dashboards, Oracle Analytics Publisher Reports, and Business Intelligence Mobile Apps. Other reporting
tools are also available to run the same seven report types.

This figure illustrates the report types that are available in the Financial Reporting Center.
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Reports can be accessed through various methods. However, the Financial Reporting Center provides access to every
type of report, is intended to be the primary user interface for financials end users, and is tablet and smartphone
friendly. In addition to accessing reports, you can add favorites, define tags, and view report details, such as type and
last updated date.

Financial Reports are read from the Shared > Custom > Financials and My Folders directories. All other report types
can be saved anywhere in the BI Catalog however, any user-defined content should be in the Shared > Custom folder.
Subfolders can be created within the Shared > Custom folder.

Seven types of reports can be run from the Financial Reporting Center and from the other reporting tools.

• Financial Reports: These reports are built off of the Oracle Financial Reporting Web Studio using data in the
Oracle General Ledger balances cube. For example, company income statements and balance sheets. These
reports are mainly run by users in General Ledger.

• Account Groups and Sunburst: Account groups are used to monitor key accounts in General Ledger. When
a user creates an account group, it becomes visible in the Financial Reporting Center with the Sunburst
visualization tool. The Sunburst visualization tool lets you interact with your account balances across various
business dimensions to view balances from different perspectives. Account groups are used only in General
Ledger.

• Smart View Reports: Smart View is a multidimensional pivot analysis tool combined with full Excel functionality.
Smart View enables you to interactively analyze your balances and define reports using a familiar spreadsheet
environment. These queries are mainly for users in General Ledger. To share Smart View queries, users can
email them to other users, or they can upload the queries to the Financial Reporting Center where users can

3
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download them to a local drive for use. The Financial Reporting Center is only a place for users to upload and
download Smart View queries.

Note:  To upload a Smart View report to the Financial Reporting Center: select the Open Workspace for
Financial Reports task, navigate to the BI Catalog, and select Upload from the Tasks section. Be sure to
upload the Excel file to one of the folder locations mentioned previously.

• Oracle Transactional Business Intelligence Analyses: These analyses and reports are built off of transactional
tables using subject areas. These reports can be run by users in General Ledger, Payables, Receivables, Cash
Management, Intercompany, and so on.

• Oracle Transactional Business Intelligence Dashboards: Dashboards put all the information, functions,
and actions that a business user must have to do their job in one place. Dashboards are built off of Oracle
Transactional Business Intelligence objects like analyses and reports. These reports can be run by users in
General Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.

• Oracle Analytics Publisher Reports: Most of these reports are predefined and must first be submitted and
resubmitted to see the latest data by the Oracle Enterprise Scheduler through the Scheduled Processes
navigation. These reports can be run by users in General Ledger, Payables, Receivables, Cash Management,
Intercompany, and so on.

• BI Mobile Apps: Oracle Business Intelligence Mobile App Designer is an application that enables you to create
multitouch information-driven applications with rich interaction, rich visualization, and rich media, for mobile
devices such as iPhone, iPad, Android phone, tablet, and more. These reports can be run by users in General
Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.

Other Reporting Tools
Six other tools are available for reporting in Financials.

The following table lists the other reporting tools and the types of reports they support.

Other Reporting Tools Report Type

General Accounting Dashboard and
Account Inspector
 

Account Groups
 

Reports and Analytics
 

Oracle Transactional Business Intelligence Objects
 

BI Catalog
 

All Report Types, Except Oracle Analytics Publisher Reports
 

Enterprise Performance Management
Workspace
 

Reports, Books, Snapshot Reports, Snapshot Books, Financial Reporting Batches, and Batch Scheduler
 

Enterprise Scheduler System
 

Oracle Analytics Publisher Reports
 

Even though the Financial Reporting Center is designed to be the main user interface for a financial end user's reporting
needs, some users may choose to use any of the six other tools for reporting in financials, such as:

• General Accounting Dashboard, which provides access to Account Groups: Uses the Account Monitor to
efficiently monitor and track key account balances in real time.
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• Account Inspector: Perform ad hoc queries from account groups and financial reports through drill down to
underlying journals and subledger transactions.

• Reports and Analytics: This reporting tool has a panel that reflects the folder structure of the BI Catalog. Users
can access and run any Oracle Transactional Business Intelligence analysis, report or dashboard. Users can't
run predefined Financial Reports or Oracle Analytics Publisher reports from this interface. This interface can be
used by all financials users.

• BI Catalog: A component of the Enterprise Performance Management Workspace where you can run all report
types, except for predefined Oracle Analytics Publisher reports.

• Enterprise Performance Management Workspace: Create reports, books, snapshot reports, snapshot books,
Financial Reporting batches, and batch scheduler, and schedule batches to automatically run and burst to
email.

• Enterprise Scheduler System: Only Oracle Analytics Publisher reports can be submitted from this interface.
Users access this interface by navigating to Tools > Scheduled Processes. Most financial users have access to
this interface to run standard reports for General Ledger, Payables, Receivables, and so on.

Related Topics
• Set Up Financial Reporting Center and Smart View

• How to Access EPM Narrative Reporting Reports in Financial Reporting Center

Overview of Dashboards and Work Areas for Oracle
Fusion Financial Applications  
Oracle Fusion Financial Applications embraces the concept of dashboards to bring the work that needs to be done and
the information needed to do it to the front and center of each user's attention.

All Oracle Fusion Financials applications deploy dashboards. On a dashboard, work areas display tabulations of the
tasks that a given role needs to accomplish. These are updated by incoming work load in real time. In Payables, for
example, newly scanned invoices are tabulated for the Payables Specialist to process. In General Ledger, the accounts
monitored by the accountant are updated at each journal posting. In Receivables, new invoices and receipts pending
further actions are listed for the Billing Specialist and Receivables Specialist to process.

The tabulations are designed to be easily adjusted to suit your needs in several ways and can be modified, prioritized,
and even replaced. Portlets to other Oracle and non-Oracle sources can be added.

The work areas monitor processes and provide updates on status. Items awaiting approval, for example, are listed, as
are items with issues, such as incomplete invoices and unposted journals. Social tools are available, so that any person
who needs to act, such as an approver, can be contacted immediately. The tabulations support searching by example,
saved searches, export to spreadsheet, and other actions, so that the work can be moved along without using menus or
navigating away from the work area.

5

https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20033440
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=u30248431


Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 1
Introduction to Financial Reporting

6



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 2
Analytics and Reports

2  Analytics and Reports

Overview of Oracle Fusion General Accounting
Dashboard  
The Oracle Fusion General Accounting dashboard is the entry point to the General Ledger for both Oracle Fusion
Accounting Hub and Oracle Fusion Applications.

The objective of the dashboard is to present information that you can use and the actions you can take as you
move through the application. Changes, activities, and expectations can be immediately evaluated. Embedded data
tabulations provide you with the information that is used to make better decisions.

The General Accounting dashboard displays information about:

• Items that you or others want to approve

• Items that you want to complete

• Errors that have occurred and the actions that you want to take

• Counts of issues, which assist you in determining the volume of work

• Status of the self-monitoring processes

• Information to quickly resolve exceptions, expedite approvals, and focus on understanding the business results

The first level of reporting appears in the General Accounting dashboard. You can save the data in portlets on the
dashboard to a spreadsheet, analyze it using the spreadsheet functionality, and report on it separately.

Example of Viewing a Financial Report  
Your company creates financial reports with Financial Reporting Studio. You need to view your monthly results on the
most recent reports.

Review your financial report in HTML format for the current month.

Viewing a Financial Report
1. Navigator > General Accounting: Financial Reporting Center.
2. Select your Data Access Set.
3. Use the Live Reports and Books tab to review reports or groups of reports called books in various formats

including PDF, Excel, and HTML
4. Click the View as HTML button on the desired report.
5. Use the Respond to Prompts window to select the report criteria.
6. Click the Go to Member Selection icon next to the desired dimensions.
7. Click the Expand button for the desired dimension and continue to expand until the desired value is available to

be selected.
8. Click the Add to Selected icon.

7
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9. Click the OK button until the report opens. The report displays as an HTML web page
10. Click the Done button to return to the Financial Reporting Center.

FAQs  

View Analytics, Reports, and Dashboards  

Watch video
 

There are different ways to view and work with your analytics and reports. You can view analyses, dashboards, and
reports in the course of your work, on your usual pages and infolets. Or you can find them in the business intelligence
catalog with the Reports and Analytics work area and the Reports and Analytics panel tab.

View Analytics in Infolets
Use your favorite infolet pages to find analytics.

1. Use the page controls and Previous and Next icons to explore infolet pages in the home page, where they may
appear in infolets with summaries and aggregations or performance metrics. You may also find infolets in some
work areas.

2. Click an infolet to open a detailed analysis. So for example, if an infolet has transactions summed to a total, click
it to view details of the underlying transactions.

3. Click Done.

View Objects in Familiar Work Areas and Pages
Use analyses, dashboards, and reports available in your usual pages and work areas.

1. Explore your pages. Some may include analysis and report links or embedded objects, sometimes in tabs or
panel tabs.

2. Some work areas have a Reports and Analytics panel tab, where you explore catalog folders for relevant
analyses and reports for the work area. And if you have permission, you can map more objects to the work area
if they're appropriate.

a. Open the panel tab.
b. Expand the Shared Reports and Analytics folder and explore the available content.
c. Click the link for any object and see its type to determine whether it's an analysis, a report, or a

dashboard.
d. Click View to open the object.

View Objects in the Reports and Analytics Work Area
Use the Reports and Analytics work area to search or browse the catalog and view any analysis, dashboard, or report
you have access to. It opens at the highest level of the catalog's folder hierarchy with all objects you have marked as
favorites.

Here are some things you can do in the Reports and Analytics work area.

1. Click Navigator > Tools > Reports and Analytics.

8
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2. Filter and search for objects:

a. From the Filter list, select what you want to find.
b. To view objects you have marked as favorites, select Favorites in the list. Or select Recent Items to view

objects you recently worked with, or a recent search to run it again. Enter a name or part of a name and
click the Search icon.

c. In the search results, use the icons to identify what the objects are.
d. Click the name of an object to open it, or click More and select an action.

3. In the breadcrumbs, browse the catalog folders for analytics and reports. Click any Hierarchical Selector icon
to select a different node for the next level in the hierarchy.

4. Mark objects as favorites.

◦ Select Favorites in the Saved Searches to display your favorite objects.

◦ Click the Add Favorites icon for an object to mark it as a favorite.

◦ Click the Remove from Favorites icon to remove an object from your favorites.

5. Create and edit analyses and reports.

a. Click Create and select Report or Analysis.
b. Use wizards to create your analysis or report.

6. Click the Browse Catalog button (or click the More icon for a specific report, dashboard, or analysis) to use
more features.

Note:  If you don't see an analysis in the work area, browse the catalog for it. In the Catalog, select Show
Hidden Items to display any hidden analyses.

View Analyses
An analysis queries against your company's data and answers business questions with visualizations, such as charts
and tables. They may appear on your pages, or as parts of a dashboard.

1. From the catalog folders or search results, open an analysis to view.
2. Click Refresh to rerun the analysis and refresh its data.
3. Click Print and select either Printable PDF or Printable HTML to open a printable version.
4. Click Export to get analysis data in various formats, for example PDF, Excel, PowerPoint, comma-separated

value (CSV), and XML.

Note:  When you export data in a CSV format, dates are exported in raw format and converted to UTC time
zone.

View Grouped Analyses in Dashboards
Some analyses are grouped in dashboards to give you meaningful related information. A dashboard contains pages of
analyses, prompts that filter information, and other objects.

1. From the catalog folders or search results, open a dashboard to view.
2. Select values for any dashboard prompts to filter the dashboard.
3. Click Apply to refine the results of all of the analyses in the dashboard.

9
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View Reports
Reports show data in a predefined format that's optimized for printing.

1. From the catalog folders or search results, open a report.
2. Click the View Report icon if you want a different format.

◦ Choose HTML or PDF to display the report in a format for printing. Because it's optimized for printing,
PDF often provides the best results.

◦ You can also export the report as RTF for editing in a word processor, or as Excel or PowerPoint.

3. From the catalog folders or search results, you can also do these tasks:

◦ Click Edit to edit the report properties, layout, and data model.

◦ Click Report History to see details about past submissions of the report.

◦ Click Schedule to schedule the report to be run.

Why do I see amounts of zero in analyses?  
Currency exchange rates might not be set up correctly. For example, you set EUR as your preferred currency in general
preferences, and corporate currency is USD. Amounts are displayed in EUR after conversion from USD at the current
exchange rate.

10
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3  Other Analytics and Reports Tasks

Briefing Books  

Create Briefing Books  
Use briefing books to hold a collection of analytic snapshots. These snapshots give you a picture of what's going on
at the time the analytic is added, downloaded, or rerun. You can download briefing books as PDFs or MHTML to view,
print, or

Add Content to New Briefing Books

1. Open the Reports and Analytics work area.
2. Click Browse Catalog.
3. Select your analytic, then click More and select Add to Briefing Book.

Or, find your dashboard and click Open.

a. Go to the dashboard page you want to add.
b. Click the Page Options button and select Add to Briefing Book.

4. Select Updatable if you want the analytic results refreshed whenever the briefing book is downloaded or rerun,
or Snapshot to store it without updating.

5. Click Browse.
6. Name your briefing book and save it in My Folders.

Add Content to Existing Briefing Books

1. Open the Reports and Analytics work area.
2. Click Browse Catalog.
3. Select your analysis, then click More and select Add to Briefing Book.

Or, find your dashboard and click Open.

a. Go to the dashboard page you want to add.
b. Click the Page Options button and select Add to Briefing Book.

4. Select Updatable if you want the analytic results refreshed whenever the briefing book is downloaded or rerun,
or Snapshot to store it without updating.

Download and Edit Briefing Books

1. Open the Reports and Analytics work area.
2. Click Browse Catalog to locate your briefing book, and click PDF to download it.
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Schedule Analytics and Reports  

Schedule Analytics, Dashboard Pages, and Briefing Books  
You can schedule Analytics, dashboard pages, and briefing books to run when you need them. You can also schedule
other automated tasks, for example to deliver results to specific recipients, send notifications, or to generate a list of
changes implemented today using the

Create an Agent

1. Open the Reports and Analytics work area or the Reports and Analytics panel tab if available in other work
areas.

2. Click Browse Catalog.
3. Click the New icon and, from the Actionable Intelligence section, select Agent.
4. Make sure you enter information on the Delivery Content tab to specify the analysis, dashboard page, or

briefing book to run. Browse for the analysis, dashboard page, or briefing book, which must be specified to
generate an attachment.

5. Click the Save this Agent icon and save it in My Folders.

Related Topics
• Schedule Reports

Schedule Reports  
Reports can run based on a schedule that you define. You can set up other automated tasks, for example to deliver
results to specific recipients or send notifications. You submit a report with the schedule and criteria for other
automated tasks defined.

If a report is set up as a scheduled process, you submit the process as you would any scheduled process. You can
schedule them from:

• Any work area where there is a link to the report.

• The Scheduled Processes work area, where you can submit all processes that you have access to.

• The Reports and Analytics work area or panel tab, if the report is set up for submission from there.

Submitting a Report or Scheduled Process
Follow these steps:

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work
areas where you can find the report.

2. Click the name of your report.
3. Click Schedule if the option is there. The report is set up as a scheduled process.
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a. Enter any parameters to avoid unnecessarily large results.
b. Click Advanced to enter a schedule, deliver results to a specific destination (including e-mail or printer),

or define criteria for sending notifications.
4. If you don't see Schedule, then click View.

a. Click the Actions button for the report and select Schedule.
b. Enter information similar to step 3.

Related Topics
• What are scheduled processes?

• Schedule Analytics, Dashboard Pages, and Briefing Books

• Submit Scheduled Processes and Process Sets

• View Status and Other Details for Scheduled Processes

What are scheduled processes?  
Scheduled processes do tasks that are too complex or time-consuming to do manually, for example importing data or
updating many records. You can run scheduled processes on a recurring schedule and send notifications based on how
the process ends.

Some scheduled processes give you printable output. Those processes might have Report in their name.

Use the Scheduled Processes work area to run all the processes you've access to and to manage submissions. If you
need access to this work area, ask your security administrator to assign you a role that gives you access, for example
a custom role with the the Manage Scheduled Processes (FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege.
Other than the Scheduled Processes work area, you might be also able to run certain processes from other work areas.

Jobs and Job Definitions
Each scheduled process that you run is based on a job. The job is the executable that controls what the process does.
Each job needs a job definition, which, for example, identifies the parameters and other options you've set for the
process. You or your administrator can create job definitions for Oracle Analytics Publisher reports so that users can run
the reports as scheduled processes.

Process Sets
A process set is a scheduled process that contains multiple processes or even other process sets. So, when you submit a
process set, you're running more than process.

Note:  When you submit certain scheduled processes, the job logic causes other processes to automatically run. But
in this case, you're not submitting a process set that includes those other processes.

Submission
When you submit a scheduled process, you can use its parameters to control how, and which records are processed.
For example, a process includes only the transactions that were edited by the person you select for a Last Updated By
parameter. Some scheduled processes don't have parameters.
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As part of the submission, you can also set up a schedule for the process, for example to run once a week for two
months. Every time a process runs, there's a unique process ID.

Output
Some scheduled processes provide output in PDF, HTML, and other formats. For example, a process can import records
and also produce output with details about those records. There are many types of output, for example a tax document
or a list of transactions.

Submit Scheduled Processes and Process Sets  

Watch video
 

Use the Scheduled Processes work area to run all the scheduled processes that you've access to, including process sets.
You can also submit many processes from other work areas.

Some processes that give you output are also reports that you can view from the Reports and Analytics work area
or panel tab. You can find that panel tab in some work areas. It's quick to submit a scheduled process with the bare
minimum steps. But there are many additional options you can set, for example, if you want to run the process on a
schedule.

Select the Scheduled Process and Define Parameters
Here's what you do:

1. Click Navigator  > Tools > Scheduled Processes.
2. On the Scheduled Processes Overview page, click Schedule New Process.
3. Leave the type as Job, select the process that you want to submit, and click OK.
4. In the Process Details dialog box, enter at least the required parameters, if any.

◦ Some processes have no parameters at all.

◦ Some parameters depend on other parameters. For example, date range parameters might appear only
after you select By Date for another parameter.

5. Click the Advanced button if you want to define the schedule, notifications, or output. Continue to the next
steps. Or, just skip to the steps for finishing the submission, to run the process once as soon as possible with
the default output.

Define the Schedule
Set up a schedule to run the process on a recurring basis or at a specific time. Use the Process Details dialog box in
Advanced mode.

1. Open the Schedule tab and select Using a schedule for the Run option.
2. Select a frequency, for example Daily or Monthly.

◦ Select User-Defined if you want to enter the exact dates and times to run the process.

◦ You can select Use a Saved Schedule to use an existing schedule, if there are any.

3. Depending on the frequency you selected, define when the process should run.
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Some processes can't be run more often than a certain frequency, for example more than every 10 minutes. But there
are some situations where that validation doesn't apply, for example, when different users run that same process less
than 10 minutes apart. Or, if you use a saved schedule that has an individual run in addition to the regular frequency, for
example a schedule that runs every 10 minutes and once at five minutes after the first run.

Define the Output
You can choose the layout, format, and destination for your output. Use the Process Details dialog box in Advanced
mode.

1. Open the Output tab, if available.
2. Click Add Output Document.
3. Change the name if you want. The name identifies this output document when you go to view output later.
4. Select a layout if you've more than one to choose from.
5. Select a format, for example one of these options:

◦ PDF: Is the best option if you want to print the output.

◦ Excel: Supports embedded images, such as charts and logos, but can be opened only in Excel 2003 or
higher.

◦ Data: Gives you report data in an XML file, which is used mainly for editing the report layout.

6. Click Add Destination to send the output somewhere, for example to a printer or email address. You can add
many destinations and send the output to all of them at the same time.

Tip:  You can also print the output as part of the steps for finishing the submission, instead of adding a
printer destination here.

7. To add more output documents, repeat steps 2 to 6.

Set Up Notifications
You can have notifications sent out depending on how the process ends. Use the Process Details dialog box in Advanced
mode to set that up. These notifications are in English and they show times in UTC, no matter what language and time
zone the recipient has in their preferences.

1. Open the Notification tab.
2. Click Create Notification.
3. From the Address Type list, select whether you want to identify the recipient by their email address or user ID.
4. In the Recipient field, enter either the email address or user ID of the person you want to send the notification

to.
5. In the Condition list, select when to send the notification, for example when the process ends in error.
6. Click OK.
7. To send notifications to more people, repeat steps 2 to 6.

Finish the Submission
Follow these steps in the Process Details dialog box:

1. Click the Process Options button if you want to define settings that affect the data to be processed.
2. If the process gives you output and you want to print it, select the Print output check box and a printer.
3. Select the Notify me when this process ends check box if you want to get a notification. This notification is in

English and shows times in UTC, no matter what language and time zone you have in your preferences.
4. Enter submission notes to capture any information you want to associate with this submission. You can use

your notes to find this submission later.
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5. Click Submit.
6. Click OK to confirm.

Tip:  Note down the process ID for your submission if you might need to easily find it later. For example, let's
say you set the process to run once a week. If you later want to cancel all runs on this schedule, you need to
cancel this original submission with the process ID you see.

Submit Process Sets
To submit a process set from the Scheduled Processes Overview page:

1. Proceed with the steps that you would follow to submit any scheduled process, but select Job Set for the Type
option.

2. In the Process details dialog box, set parameters for individual processes in the set. A process set itself doesn't
have parameters.

a. Select a process on the Processes tab.
b. Enter parameters for that process, if any.
c. Repeat for other processes in the set.

3. Define the schedule, output, and notifications for the process set, as you would do for any scheduled process.
4. Set any other options and click Submit.

Whether you use the Notifications tab or the Notify me when this process ends check box, or both, notifications are
sent when the entire process set ends, not when each process within the set ends.

Related Topics
• Examples of Process Options

• View Analytics, Reports, and Dashboards

• View Status and Other Details for Scheduled Processes

• Example of Process Details for a Process Set

Examples of Process Options  
When you submit scheduled processes, click the Process Options button in the Process Details dialog box to set
options such as language and time zone.

Here are a few things to know:

• Your settings affect the data to be processed and what you get in the output.

• If the process is running on a schedule, your settings apply to every run.

• The settings override what's set in general preferences, which you can get to by clicking your user name in the
global header and selecting Set Preferences.

Let's take a look at some examples of process options that you can set.

Language
You set the language process option to Spanish, while the Current Session field is set to Japanese in your general
preferences. So, your output is in Spanish. If you don't set the language process option, the output is in Japanese.
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Currency
You set the currency process option to Euro, while your general currency preference is set to Yen. The scheduled process
makes calculations based on the Euro, and the output shows all monetary amounts in Euro.

Statuses of Scheduled Processes  
After you submit a scheduled process, it can go through many statuses until it reaches a final state.

This table explains the statuses you might see. The Action Required column tells you if something can be done for the
process:

• No (in progress): The process was submitted and hasn't reached a final state yet. But you or administrators
don't need to do anything to move the process along.

• Yes: You or administrators need to do something to get the process to another status.

• No (final): The process has reached a final state, and nothing else can be done.

Status Description Action Required?

Blocked
 

At least one other running process is
incompatible with and currently blocking your
process. The situation will be automatically
fixed.
 

No (in progress)
 

Canceled
 

The process was canceled, and you can't restart
it.
 

No (final)
 

Canceling
 

The process is currently moving to the
Canceled status.
 

No (in progress)
 

Completed
 

The main part of the process completed, and
postprocessing (such as sending notifications
and generating output) has started.
 

No (in progress)
 

Error
 

The process finished running and ended with
errors.
 

No (final)
 

Error Auto-Retry
 

The process ended with errors but will
automatically run again.
 

No (in progress)
 

Error Manual Recovery
 

The process ended with errors and requires an
administrator to move the process to a final
state.
 

Yes
 

Expired
 

The process didn't run and its schedule already
ended. You can't restart it, but you can resubmit
with the same parameters or submit a new
process.
 

No (final)
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Status Description Action Required?

Finished
 

The process ran based on a schedule, and it's
either a process set or a process that causes
other processes to automatically run. Either
way, all processes involved are done running.
 

No (final)
 

Hold
 

The process is put on hold and needs someone
to release it before it can continue running.
 

Yes
 

Paused
 

The process is paused so that another process
that was automatically kicked off can run first.
 

No (in progress)
 

Pending Validation
 

Some validations, for example related to
security, are performed on the process before it
runs.
 

No (in progress)
 

Ready
 

The process passed validation and is about to
start running.
 

No (in progress)
 

Retrying
 

The process resulted in an error but will try
again. It will automatically rerun at the time
you see in the Scheduled Time column on
the Scheduled Processes Overview page. The
number of retries depends on how the job is set
up. After all the retries, if the process still can't
run successfully, it will end with the Error status.
 

No (in progress)
 

Running
 

The main part of the process is currently
running.
 

No (in progress)
 

Schedule Ended
 

The last submission in a schedule has
happened for a process that's either a process
set or a process that causes other processes
to automatically run. Either way, all processes
involved have started running, but might not be
done yet.
 

No (in progress)
 

Succeeded
 

The process successfully completed.
 

No (final)
 

Validation Failed
 

The process failed validation.
 

No (final)
 

Wait
 

The process passed validation but isn't running
yet.
 

No (in progress)
 

Warning
 

The process finished running and ended with a
warning, for example, that a notification wasn't
sent.
 

No (final)
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Related Topics
• View Status and Other Details for Scheduled Processes

View Status and Other Details for Scheduled Processes  
After you submit a scheduled process, you can track its progress. Processes can finish running in seconds, or a few
minutes, or even longer.

If something interrupts a process while it's running, for example a server restarting, then the process automatically
picks up where it left off. If you need to see all processes, not just the ones you submitted, ask your security
administrator to assign you a custom role that has the ESS Monitor Role (ESSMonitor) or ESS Operator Role
(ESSOperator).

Here's where you can find processes that were submitted:

• Scheduled Processes work area
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• Other work areas with a section for scheduled processes, if available.

Check the Status in the Scheduled Processes Work Area
Here's how you find your scheduled process and see how it's doing.

1. Click Navigator > Tools > Scheduled Processes.

The Search Results table shows processes that were submitted in the last hour because the default saved
search is Last hour. The table might be blank if nothing was submitted in the last hour.

2. If you don't see the process, click the Refresh icon or run a search. For the search, enter your own criteria or
select another saved search. Here are a few examples of saved searches you can use:

◦ Last 24 hours

◦ Last 72 hours

◦ Cancelable Processes

Tip:  In the search results, select Hierarchy for the View option to see, for example, the structure of nested
processes or process sets within a process set. For processes running on a recurring schedule, the parent
node is the original submission, the child nodes each run in the schedule.If submission notes were entered
when submitting the process, you can use the Submission Notes column to help identify the process.

3. Refresh the search results at any time to see the latest status of the process in the Status column. You can also
check the Start Time column to see if the process has started running yet.

Note:  Times such as start time and scheduled time are shown in the time zone you set in your preferences.
If you change your preferences, you can see the change in the Scheduled Processes work area next time you
sign in.
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4. To get more details about the status, select your process in the Search Results table and open the Status Details
tab. Here’s some of the information you might find:

◦ Status description, which explains what the current status means.

◦ The position of the process with the Ready status, in the sequence of submitted processes. For example,
if your process is queued up for submission at position 5, there are four processes that need to start
running before your process starts.

◦ Duration of a process, based on its current status.
- How long process has been blocked: If a process is blocked, you can see how long it has been in

the blocked status. For blocked processes, you can also expand the Incompatibility section to get
information about which incompatible processes are preventing yours from running.

- How long process has been running: If a process is running or completed, you can see how long it
has been in the running status. If your process is in progress, and it’s blocking other processes, you
can also see IDs of those processes, which can’t run until yours is done.

- How long process took to complete: If a process is completed, you can see how long it took to
complete with Error, Finished, Warning, or Succeeded status.

◦ On the Status Details tab, you can also expand the Status of Items to Process section, if available.

Here are a few things to know about the Status of Items to Process section:
- This section isn't available for process sets. But, it's available for individual processes, including

those within process sets, that are in these statuses:

◦ Running

◦ Completed

◦ Succeeded

◦ Error

◦ Error Auto-Retry

◦ Error Manual Recovery

◦ Canceled

◦ Canceling

◦ Warning

◦ Hold

◦ Paused

- If a specific process is predefined to show progress information through graphs, you can see that
information in one or more graphs. For example, a process importing lines from a file might show
a graph called Lines. You hover over parts of the graph to see how many lines are successfully
imported, how many ended up in error, and how many are still pending. A process can have
multiple graphs, depending on what it’s working on.

5. With your process still selected in the Search Results table, optionally click the View Log button (if available),
especially if information isn’t available in the Status of Items to Process section. The type of information in the
log varies, depending on the process. You can open the log from here only if the process is currently running.
When the process is done, you might want to also take a look at the final log, if any, from the Process Details
tab.
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View Other Details in the Scheduled Processes Work Area
To get more information about a scheduled process, select it in the Search Results table and see the Process Details tab
that appears after the table. These are some of the details you might find:

• Completion text, which is automatically generated when the process reaches a final state. What you see
depends on the process. For example, it might say that the process finished 1792 records in less than a second.

• The log attachment, for example for details about why the process ended in error.

• Report output that the process generated, if any.

• Parameters for the scheduled process.

◦ Open the Parameter Names with Values subsection to see the parameters from the Process Details dialog
box and the values that were entered when the process was submitted.

◦ Use the All Parameter Values subsection for troubleshooting purposes, if you need to see the parameters
and values in their actual, technical format. This subsection might have more parameters. For example,
some processes run with additional parameter values that are derived from the parameter values you
entered when you submitted the process.

Monitor Scheduled Processes in Other Work Areas
Some work areas have a section where you can monitor the scheduled processes that were already submitted.

1. Go to the section if it's available, usually on the landing page of the work area.
2. Click the Refresh icon if you don't see any processes or need to see the latest status.

◦ If you still don't see the process you're looking for, try changing the filters. If that doesn't help, use the
Scheduled Processes work area instead.

◦ If submission notes were entered when submitting the process, you can use the Submission Notes
column to help identify the process.

3. Do either of these things to check on the progress of the process:

◦ For more details about the status, click the status link. For example, if a process is in the Ready status,
you can click the Ready link in the Status column to see where the process is in the submission queue.

◦ Check the Start Time column to see if the process has started running yet. If it has, you can click the link
in the View Log column to get information about how the process is running.

Related Topics
• Statuses of Scheduled Processes

• What do I get if I view scheduled processes in a hierarchy?

• View Output from Scheduled Processes

• Cancel or Make Changes to Scheduled Processes

• Resubmit Scheduled Processes and Process Sets

Cancel or Make Changes to Scheduled Processes  
Life is full of second chances! After a scheduled process is submitted, you can still cancel it or make other changes in
the Scheduled Processes work area.
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What you can do to the process depends on its status. Also, depending on what you've access to, you can even work on
processes that someone else submitted. If you need to cancel processes that someone else submitted, ask your security
administrator to assign you a custom role that has the ESS Administrator Role (ESSAdmin).

Make Changes to Processes
Select the scheduled process in the Search Results table. Here are some things you might be able to do.

Changes you can Make to Processes

Task Prerequisite Procedure

Edit Schedule
 
Change the submission schedule, for example,
 to submit it biweekly instead of weekly.
 

This option is there only if you select the
row with the process ID you got when you
submitted the process to run on a schedule.
The row should be the parent node when you
view the search results in a hierarchy, and the
status should be Wait.

From the Actions menu, select Edit Schedule.

Edit Output
 
Change output options of a process, for
example, from HTML format to PDF.
 

You can do this only if the process generates
output, and hasn’t started running yet.

From the Actions menu, select Edit Output.

Put On Hold
 
Pause the process.
 

Click the Put On Hold button.

Release Process
 
Resume a process that's on hold so that it
continues to run.
 

Click the Release Process button.

Change Process Priority
 
Change the priority of a process to affect
when it runs. When there are many submitted
processes, those with a lower number, for
example 2, would usually run before those with
a higher number, for example 7.
 

You can do this only if your implementor has
enabled priorities for scheduled processes,
and you've a custom role that has the ESS
Administrator Role (ESSAdmin).
 
You can change priorities only for processes
that have the Blocked, Hold, Ready, or Wait
status.
 

Click the Change Process Priority button.

Note:  Even if the process hasn't started, you can't change the parameter settings. You can cancel the process and
submit again with the parameter values you want.
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Cancel a Process
Select the scheduled process in the Search Results table, and click Cancel Process.

Cancel a Process Running on a Schedule

If you submitted a process to run on a schedule, for example once a day, you can cancel the scheduled runs even if
some of the runs already happened.

1. Find the original submission, the row with the process ID you got when you submitted the process. The row
should be the parent node when you view the search results in a hierarchy, and the status should be Wait.

2. Click Cancel Process.

When you cancel this original submission, you cancel any current and future runs based on the schedule you
had set.

What to Do If Processes Take a Long Time to Cancel

Sometimes it takes a while for a process to finish canceling. So, you can use the Actions menu to end it. The option you
get depends on the process.

Options and Descriptions

Option Description

Hard Cancel To end the process shortly after you canceled it, without waiting for the cancellation to finish by itself.

Force Cancel To end a process that has been canceling for over 30 minutes but isn't done yet.

Processes on Remote Servers

Some processes run on a remote server. Even if the status for the process that you hard or force canceled has changed
to Canceled, the process might still be running on the remote server. With the scheduled process still selected in the
Search Results table, you check the status of the remote process on the Process Details tab that appears after the table.

Option You Used to End Your
Process

Field that Shows the Status of the
Remote Process

Status of Process on Remote Server

Force Cancel Remote Process Status • Completed Successfully: The remote process was successfully
canceled within the 30 minute grace period.

• Running/Unknown: Your scheduled process is in a Canceled
state, but the remote process is still running.

• Terminated: Your scheduled process is in a Canceled state, and
the remote process is successfully canceled after the 30 minute
grace period.

Hard Cancel External Job Status • Completed Successfully: The remote process has successfully
canceled.

• Running/Unknown: Your scheduled process is in a Canceled
state, but the remote process is still running.
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Cancel Processes in Bulk
You can cancel up to 100 processes at once, as long as the processes haven't reached a final state.

1. Click Navigator > Tools > Scheduled Processes.
2. In the Search section, select Cancelable Processes from the Saved Search list.
3. Make sure that what you get in the Search Results table meets these requirements:

◦ No more than 100 processes

◦ Only processes with a cancelable status:

- Wait
- Ready
- Running
- Completed
- Blocked
- Hold
- Paused
- Pending Validation
- Schedule Ended
- Error Auto-Retry

4. Use the Search section to change your search results, if you need to.
5. Select Cancel Processes in Bulk from the Actions menu.

Related Topics
• View Status and Other Details for Scheduled Processes

• Allow Updates to Scheduled Process Priority

Resubmit Scheduled Processes and Process Sets  
You can easily resubmit scheduled process using the exact same parameter values, if the process has a Succeeded
status and wasn't part of a submission involving other processes.

For process sets, you can also resubmit after changing any of the parameters or other options.

Resubmit Processes
In the Scheduled Processes work area, here's how you resubmit processes using the same parameters:

1. Click Navigator > Tools > Scheduled Processes.
2. In the Search Results table, select your process and take a look at its details, including parameter values.
3. Click Resubmit.

Some other work areas have a section, usually on the landing page of the work area, where you can monitor the
processes that were already submitted. In the table there, you can also select your process, see its parameter values, and
click the Resubmit button.
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Resubmit Process Sets
Resubmit process sets from the Scheduled Processes work area, not other work areas.

1. Click Navigator > Tools > Scheduled Processes.
2. See process details, including parameter values, for the processes that ran as part of your process set.
3. In the Search Results table, select your process set.
4. Click Resubmit, and you're done. Or, click the Resubmit drop-down button and select Resubmit with

Changes.

a. In the Process Details dialog box, select a process on the Processes tab.
b. Change any of the parameters.
c. Repeat and change parameters for any of the other processes in the process set.
d. Define anything else as part of the submission, for example the schedule.
e. Click Submit.

Both options to resubmit are available for process sets in either of these situations:

• The process set has any of the statuses in a final state, for example Succeeded or Canceled.

• The process set ran on a schedule and has either the Wait or Schedule Ended status. The option applies only
to the original submission, the row with the process ID you got when you submitted the process to run on a
schedule. The row would be the parent node when you view the search results in a hierarchy.

Related Topics
• Submit Scheduled Processes and Process Sets

• View Status and Other Details for Scheduled Processes

View Output from Scheduled Processes  
Other than processing records, some scheduled processes also give you output. When you submit the process, you can
select the output layout and format, and set other output options.

In the Scheduled Processes work area, you can view the output and even republish it in a different format without
resubmitting the process. You might be able to see the output from other work areas too.

When You're In the Scheduled Processes Work Area
Here's what you do:

1. Click Navigator > Tools > Scheduled Processes.
2. Find your scheduled process and, if you need to, refresh the search results to see the latest status.
3. Select the scheduled process.
4. Go to the Output subsection on the Process Details tab.
5. Click the link in the Output Name column to view or download the output, which you can then print.
6. To view or export the output in a different format, follow these steps:

a. Click the Republish button.
b. Click the Actions icon.
c. Select Export, and then select a format.
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If you want the Data format, you can also just click the XML Data icon instead.

Note:  On the Process Details tab, if you don't see an Output subsection, look for a Log and Output subsection. The
output might be there instead as an attachment. This is likely if the Output tab isn't available when you submitted the
process in Advanced mode.

When You're In Other Work Areas
Some other work areas have a section, usually on the landing page of the work area, where you can monitor the
scheduled processes that were already submitted. In the table there, find your process and click the Output icon in the
View Output column.

Related Topics
• Submit Scheduled Processes and Process Sets

FAQs  

What do I get if I view scheduled processes in a hierarchy?  
When you select Hierarchy for the View option, you might see some search results in a hierarchical structure. Here are
some possibilities for what the hierarchy can represent.

Hierarchy View

Parent Node Child Nodes

A submitted process set. The nested processes or process sets within the submitted process set.

A process or process set submitted to run
on a schedule.

Each run in the schedule.

A process or process set that causes other
processes to run automatically.

The other processes that run.

Related Topics
• Process Sets
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4  Oracle Fusion General Ledger

Oracle Transactional Business Intelligence Reports for GL
 
This topic includes details about the Oracle Fusion General Ledger reports predefined using Oracle Transactional
Business Intelligence (BI).

Overview
These reports assist in reviewing journals, accounts, and balances. You can use these reports as part of your
reconciliation process.

The Oracle Business Intelligence reports for the General Ledger include:

Journal Reports Description

Account Analysis Report
 

Provides the beginning, periodic activity, and ending balances for the selected accounts and periods.
Drill down on the periodic activity balance provides journal details and transactions details including
journal source, category, transaction number, and event class.
 

General Journals Report
 

Provides the journals activity for the selected period. The content can be filtered by ledger set, ledger,
 entered currency, approval status, date range, account, source, category, journal batch, and batch
status.
 

Trial Balance Report
 

Provides the beginning, periodic activity, and ending balances summarized by balancing segment,
 natural account, and cost center for the selected ledger, accounting period, and currency.
 

Key Insights
Before running the journal reports, verify that all subledger transactions have been imported and all journal entries for
the period have been posted.
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Columns
Oracle Transactional Business Intelligence reporting tool provides embedded analytics and supports online inquiry
for most transactions. The selections you make are dependent on the columns that were chosen during the report
definition.

The output of data in a predefined format provides little or no interaction and simplifies your reporting.

Frequently Asked Questions
The following table lists frequently asked questions about these reports.

FAQ Answer

How do find these reports?
 

Edit, run, and view these reports from Navigator > Tools  > Reports and Analytics > Financials >
General Ledger.
 

Who uses these reports?
 

• Financial Managers

• Financial Accountants

• Financial Specialists

When do I use these reports?
 

• During monthly journal entry processing.

• During period close to verify all transactions have been imported and journals posted.

• In account balance reconciliations.

What type of reports are these?
 

Oracle Transactional Business Intelligence
 

Oracle General Ledger Predefined Reports  
Oracle General Ledger provides predefined reports that cover the following areas: account analysis, journals, trial
balance reports, reconciliation reports, charts of accounts.

You can schedule and run reports from the Scheduled Processes work area. In some cases, you can access and open
reports in the Reports and Analytics work area. Use the Browse Catalog icon on the Reports and Analytics work area to
open the business intelligence (BI) Catalog. You can run and edit reports in the BI Catalog.

The following table describes the predefined account analysis reports.
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Name Description

Account Analysis
 

• Prints balances by account segment and a secondary segment for each journal entry.

• Lists the subledger document number for transactions imported from subledgers.

General Ledger Account Details Report
 

• Provides journal information to trace each transaction back to its original source.

• Prints a separate page for each balancing segment value.

• For each journal line, prints:

◦ The account affected, the concatenated description, the journal line amount, and the beginning
and ending account balance.

◦ Journal details including source, category, journal name, and effective date.

• Lists accounts in ascending order by account segment value.

• Prints a CR next to credit amounts.

Account Analysis for Contra Account
Report
 

• Prints balances by account segment and a secondary segment.

• Lists the contra account for each journal entry and the subledger document number for
transactions imported from subledgers.

• Prints by date range, accounting flexfield range, contra account, and amount range.

Average Balance Audit Account Analysis
Report
 

• Displays the detail account activity that created the aggregate balances and related average
balances.

• Displays daily average balance information for the selected accounts for the specified range of
dates.

• Contains parameters such as the as-of reporting date, average balance type (period, quarter, or
year average-to-date), and account ranges.

Note:
Use to research how average balances are calculated for an account.
 

The following table describes the predefined journal reports.

Name Description

Journals Report
 

• Provides journal activity for a given period or range of periods, balancing segment value,
 currency, and range of account segment values.

• Prints the accounting date, category, journal name, reference, journal batch name, entered debit
or credit amounts, net balance, and account total for each journal.

• Includes a total for each balancing segment and a grand total for all the activity.

General Journals Report
 

Provides journal activity for a given period or range of periods, balancing segment value, currency, and
range of account segment values.
 

Journals Batch Summary Report
 

• Lists posted journal batches for a particular ledger, balancing segment value, currency, and date
range.
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Name Description

• Provides information about actual balances for your journal batches, source, batch, and posting
dates, total entered debits and credits. Sorts the information by journal batch within each journal
entry category.

• Includes totals for each journal category and a grand total for each ledger and balancing segment
value combination.

• Doesn't report on budget or encumbrance balances.

Journals Details Report
 

Provides information about manually entered journals prior to posting, including field by field, all data
entered into the applications or data imported from external sources.
 

Journals Day Book Report
 

• Provides posted journal entries and journal details chronologically by accounting date for a
specified range of dates, journal source, and journal category.

Note:
To run the report for all journal sources and categories, clear the Source and Category fields.
 

• Sorts journal entries for each accounting date by document number.

• Prints the accounting date, document number, journal entry name, journal source and category,
 subledger document name and number, currency, and conversion rate.

Note:  When you set the General Ledger Journal Entry Summarization option, as part of the Manage
Subledger Accounting Options task, to either Summarize by general ledger date or Summarize by
general ledger period, the SUBLEDGER_DOC_SEQUENCE_ID and SUBLEDGER_DOC_SEQUENCE_
VALUE columns will be empty in the GL_JE_LINES table, even though document sequencing is
enabled. All subledger entry lines are summarized into a single general ledger entry if the following
details are the same: accounting period or date, General Ledger journal category, account, entered
currency, side, balance type. As a result, the report won't display details in the Subledger Document
Sequence and Subledger Document Number columns.

• Prints for each journal line, the line number, account segment value and description, functional
debit and credit amounts, description, and cost center segment value.

Reconciled Transactions Report
 

Provides details of clearing account journal lines that have been successfully reconciled by both
automatic and manual reconciliation processes.
 

Unreconciled Transactions Report
 

Lists all unreconciled clearing account journal lines, specifically the unreconciled lines that weren't
subjected to reconciliation yet, those lines rejected by previous automatic or manual reconciliation
processes, and those lines that were marked as reviewed.
 

Journal and Transaction Details Report
 

Lists the general ledger journals and subledger transactions activity along with header, line, and
distribution-level details. Includes the account combinations on each line for the selected accounts.
 

Note:  You can run or schedule this report only from Oracle Analytics Publisher.

The following table describes the predefined trial balance reports.
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Name Description

Trial Balance Report
 

Provides summarized actual account balances and activity by ledger, balancing segment, and account
segment value.
 

Trial Balance - Average Balances
 

• Provides a listing of ending balances and average balances for selected accounts based on an
effective date specified.

• Prints the ledger currency or foreign-entered balances.

• Displays period, quarter, and year average-to-date balances.

Note:
Request additional information by specifying balancing segments and account ranges.
 

The following table describes the predefined reconciliation reports.

Name Description

Cash to General Ledger Reconciliation
Report
 

Extracts cash management and general ledger accounting and transactional data for reconciling cash
management to the general ledger.
 

Payables to Ledger Reconciliation Report
 

• Provides both summarized and detailed reconciling data for review.

• Shows payables and accounting beginning and ending balances, as well as summarized activity
for the period and how this activity was accounted.

Receivables to Ledger Reconciliation
Report
 

• Provides reconciliation of receivables data to the general ledger.

• Shows receivables and accounting beginning and ending balances, as well as summarized activity
for the period and how the activity was accounted.

The following table describes the predefined chart of account reports.

Name Description

Balancing Segment Value Assignments
Report
 

• Reports on the assignment of primary balancing segment values to legal entities and ledgers
across accounting setups.

• Allows quick identification of overlapping balancing segment value errors and reviews of any
unassigned values.

Note:
The application doesn't check for overlapping balancing segment values online.
 

Chart of Accounts Mapping Rules Report
 

• Provides both the segment and account rules defined for a specific chart of accounts mapping.

• For mappings with account rules, prints each subsidiary account range and the parent account
into which it maps.

• For mapping with segment rules, prints the rule name and the parent and subsidiary segments.
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Name Description

• For mappings with a rollup range rule, prints each subsidiary segment value range and its
corresponding parent segment value.

To run the predefined reports, navigate to the Scheduled Processes work area and follow these steps:

1. Click Schedule New Process.
2. Search for the process name.
3. Specify the parameters.
4. Enter the process options and schedule.
5. Click Submit.

General Ledger Account Analysis Reports  
This topic includes details about the Oracle General Ledger account analysis reports.

Overview
The account analysis reports assist in reviewing journals and related transactions. You can use these reports as part of
your reconciliation process and in preparation of your closing entries.
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The account analysis reports include:

Account Analysis Reports Description

Account Analysis
 

• Prints balances by account segment and a secondary segment for each journal entry.

• Lists the subledger document number for transactions imported from subledgers.

General Ledger Account Details Report
 

• Provides journal information to trace each transaction back to its original source.

• Prints a separate page for each balancing segment value.

• For each journal line, prints:

◦ The account affected, the concatenated description, the journal line amount, and the beginning
and ending account balance.

◦ Journal details including source, category, journal name, and effective date.
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Account Analysis Reports Description

• Lists accounts in ascending order by account segment value.

• Prints a CR next to credit amounts.

Account Analysis for Contra Account
Report
 

• Prints balances by account segment and a secondary segment.

• Lists the contra account for each journal entry and the subledger document number for
transactions imported from subledgers.

• Prints by date range, accounting flexfield range, contra account, and amount range.

Average Balance Audit Account Analysis
Report
 

• Displays the detail account activity which created the aggregate balances and related average
balances.

• Displays daily average balance information for the selected accounts for the specified range of
dates.

• Contains parameters such as the as-of reporting date, average balance type (period, quarter, or
year average-to-date), and account ranges.

Note:
Use to research how average balances are calculated for an account.
 

Key Insights
Before running the account analysis reports, verify that all subledger transactions have been imported and all journal
entries for the period have been posted.

Parameters
The following table describes selected process parameters for the account analysis reports.

Parameter Description Example

Data Access Set
 

Secures access to ledgers, ledger sets, and
portions of ledgers using primary balancing
segment values.
 

US Ledger Set
 

Encumbrance Type
 

When Balance Type of Encumbrance
is selected, gives the option to select
Commitments or Obligations.
 

Commitments
 

Account Type
 

Indicates whether the amounts represent Base,
 Period, Quarter, or Year to Date. For Average
Balancing, indicates Period Average, Quarter
Average, or Year Average to Date.
 

PATD Period Average to date balance used in
average balance processing.
 

Includes User Transaction Identifiers
 

List of identifiers linking the account generation
and the transaction, for example PO Number.
This helps in identifying the parent transaction.
 

No
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Parameter Description Example

Account, Account Range, or Contra Account
Filters and Conditions Defined
 

Restricts the data reported based on the
entered filter and condition.
 

Company equals 101
 

Additional Segment
 

To run the report by account and another
segment.
 

Cost Center
 

Document Sequence
 

Uniquely identifies each business document or
business event with a number if enabled.
 

Invoice
 

From and To Document Number
 

Assigned unique document sequence number.
 

101
 

Frequently Asked Questions
The following table lists frequently asked questions about the account analysis reports.

FAQ Answer

How do find these reports?
 

Schedule, run, and view these reports from Navigator > Tools  > Scheduled Processes.
 

Who uses these reports?
 

• Financial Accountants

• Financial Specialists

When do I use these reports?
 

• During monthly journal entry processing.

• During preparation of closing entries.

• In account balance reconciliations.

What type of reports are these?
 

Oracle Analytics Publisher
 

General Ledger Journal Reports  
This topic includes details about the Oracle General Ledger journal reports.

Overview
The journal reports assist in reviewing journals activity. You can use these reports as part of your reconciliation process
and in ensuring completion of posting of all entries before period close.

The following figure shows an example of the Journals Report. The report has columns for the line, account, transaction
date, description, entered and accounted amounts, and units.
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The following table describes each journal report.

Name Description

Journals Report
 

• Provides journal activity for a given period or range of periods, balancing segment value,
 currency, and range of account segment values.

• Prints the accounting date, category, journal name, reference, journal batch name, entered debit
or credit amounts, net balance, and account total for each journal.

• Includes a total for each balancing segment and a grand total for all the activity.

General Journals Report
 

Provides journal activity for a given period or range of periods, balancing segment value, currency, and
range of account segment values.
 

Journals Batch Summary Report
 

• Lists posted journal batches for a particular ledger, balancing segment value, currency, and date
range.

• Provides information about actual balances for your journal batches, source, batch, and posting
dates, total entered debits and credits. Sorts the information by journal batch within each journal
entry category.

• Includes totals for each journal category and a grand total for each ledger and balancing segment
value combination.

• Doesn't report on budget or encumbrance balances.

Journals Details Report
 

Provides information about manually entered journals prior to posting, including field by field, all data
entered into the application or data imported from external sources.
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Name Description

Journals Day Book Report
 

• Provides posted journal entries and journal details chronologically by accounting date for a
specified range of dates, journal source, and journal category.

Note:
To run the report for all journal sources and categories, clear the Source and Category fields.
 

• Sorts journal entries for each accounting date by document number.

• Prints the accounting date, document number, journal entry name, journal source and category,
 subledger document name and number, currency, and conversion rate.

Note:  When you set the General Ledger Journal Entry Summarization option, as part of the Manage
Subledger Accounting Options task, to either Summarize by general ledger date or Summarize by
general ledger period, the SUBLEDGER_DOC_SEQUENCE_ID and SUBLEDGER_DOC_SEQUENCE_
VALUE columns will be empty in the GL_JE_LINES table, even though document sequencing is
enabled. All subledger entry lines are summarized into a single general ledger entry if the following
details are the same: accounting period or date, General Ledger journal category, account, entered
currency, side, balance type. As a result, the report won't display details in the Subledger Document
Sequence and Subledger Document Number columns.

• Prints for each journal line, the line number, account segment value and description, functional
debit and credit amounts, description, and cost center value.

Reconciled Transactions Report
 

Provides details of clearing account journal lines that have been successfully reconciled by both
automatic and manual reconciliation,
 

Unreconciled Transactions Report
 

Lists all unreconciled clearing account journal lines, specifically the unreconciled lines that aren't
subjected to reconciliation yet, those lines rejected by previous automatic or manual reconciliation
processes, and those lines that were marked as reviewed.
 

Journal and Transaction Details Report
 

Lists the general ledger journals and subledger transactions activity along with header, line, and
distribution-level details. Includes the account combinations on each line for the selected accounts.
 

Note:  You can run or schedule this report only from Oracle Analytics Publisher.

Key Insights
Before running the journal reports, verify that all subledger transactions have been imported and all journal entries for
the period have been posted.

Parameters
The following table describes selected process parameters from the journal reports and provides examples.

Parameter Description Example

Data Access Set
 

Secures access to ledgers, ledger sets, and
portions of ledgers using primary balancing
segment values.

US Ledger Set
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Parameter Description Example

 

From and To Accounting Date
 

Determines the date on which the journal
is recorded. Must be in an open or future
enterable accounting period.
 

10-01-2014
 

Includes Adjustment Period
 

Includes journals posted in adjustment periods,
 if selected.
 

No
 

Frequently Asked Questions
The following table lists frequently asked questions about the journal reports.

FAQ Answer

How do I find these reports?
 

Schedule, run, and view these reports from Navigator > Tools  > Scheduled Processes.
 

Who uses these reports?
 

• Financial Accountants

• Financial Specialists

When do I use these reports?
 

• During monthly journal entry processing.

• During period close to verify all transactions have been imported and journals posted.

• In account balance reconciliations.

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• Journal and Transaction Details Report

General Ledger Trial Balance Reports  
This topic includes details about the Oracle General Ledger trial balance reports.

Overview
The trial balance reports assist in reviewing general ledger balances. You can use these reports as part of your
reconciliation process and in ensuring completion of the period close.

This figure shows an example of the Trial Balance Report. The report has columns for the account, description,
beginning balance, debits, credits, and ending balance.
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Here are descriptions of the trial balance reports.

Name Description

Trial Balance Report
 

Provides summarized actual account balances and activity by ledger, balancing segment, and account
segment value.
 

General Ledger Trial Balance Report
 

Lists detail or summary actual account balances and activity by ledger, balancing segment, and
account segment: the report prints the value, description, debit or credit balance for beginning and
period end, and debits and credits for period activity.
 

Average Balances Trial Balance Report
 

 
• Provides a listing of ending balances and average balances for selected accounts based on an

effective date specified.

• Prints the ledger currency or foreign-entered balances.

• Displays period, quarter, and year average-to-date balances.

Key Insights
Before running the trial balance reports, verify that all subledger transactions have been imported and all journal entries
for the period have been posted.
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Parameters
The following table describes selected process parameters from the trial balance reports and provides examples.

Parameter Description Example The Reports That Include It

Data Access Set
 

Secures access to ledgers, ledger
sets, and portions of ledgers using
primary balancing segment values.
 

US Ledger Set
 

Trial Balance Report, General
Ledger Trial Balance Report,
 Average Balances Trial Balance
Report
 

Balancing Segment Filter and
Condition
 

Restricts the data reported based
on the entered balancing segment
filter and condition.
 

Company equals 101
 

Trial Balance Report
 

Account Filter and Condition
 

Restricts the data reported based
on the account segment filters and
conditions.
 

Cost Center doesn't equal 100
 

General Ledger Trial Balance
Report, Average Balances Trial
Balance Report
 

Summarize By
 

Determines if the report is
summarized by Account, which
refers to account combination,
 Natural Account, or by Natural
Account plus another segment.
 

Natural Account
 

Trial Balance Report, Average
Balances Trial Balance Report
 

From and To Periods
 

Determines the accounting period
for which account balances are
reported.
 

Apr-21
 

General Ledger Trial Balance
Report
 

Frequently Asked Questions
The following table lists frequently asked questions about the trial balance reports.

FAQ Answer

How do I find these reports?
 

Schedule, run, and view these reports from Navigator > Tools  > Scheduled Processes.
 

Who uses these reports?
 

• Financial Managers

• Financial Accountants

• Financial Specialists

When do I use these reports?
 

• During month-end reconciliation.

• During period close to verify all transactions have been processed.

What type of reports are these?
 

Oracle Analytics Publisher
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General Ledger Reconciliation Reports  
This topic includes details about the Oracle General Ledger reconciliation reports.

Overview
The reconciliation reports assist in reconciling journals and related transactions. You can use these reports as part of
your reconciliation with your subledgers.

The following figure shows an example of the Receivables to Ledger Reconciliation Summary report. The report
includes columns for the accounting beginning balance, receivables amounts, accounting amounts, and the difference.

The following table describes the reconciliation reports.

Name Description

Cash to General Ledger Reconciliation
Report
 

Extracts cash management and general ledger accounting and transactional data for reconciling cash
management to the general ledger.
 

Payables to Ledger Reconciliation Report
 

• Provides both summarized and detailed reconciling data for review.

• Shows payables and accounting beginning and ending balances, as well as summarized activity
for the period and how this activity was accounted.

Receivables to Ledger Reconciliation
Report
 

• Provides reconciliation of receivables data to the general ledger.

• Shows receivables and accounting beginning and ending balances, as well as summarized activity
for the period and how the activity was accounted.

Key Insights
Before running the reconciliations reports, verify that all subledger transactions have been imported and all journal
entries for the period have been posted.
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Parameters
The following table describes some of the process parameters from the reports and provides examples.

Parameter Description Example

Bank Account
 

Account used for your cash transactions.
 

Bank of America
 

Include Intercompany Transactions
 

Include or exclude intercompany transactions
or run the report for intercompany transactions
only.
 

Yes
 

Include Bills Payable
 

Include the transactions, formerly known as
future dated payments, which instruct banks to
disburse funds to a supplier's bank on a specific
date. That date is known as the maturity date.
 

Yes
 

Include On-Account Items
 

Include items which are credits applied to a
customer's account.
 

Yes
 

Include Unapplied and Unidentified Receipts
 

Include receipts that haven't been applied to a
customer's account.
 

Yes
 

Account Filters and Conditions Defined
 

Restricts the data reported based on the
entered filter and condition.
 

Company equals 101
 

Frequently Asked Questions
The following table lists frequently asked questions about the reconciliation reports.

FAQ Answer

How do find these reports?
 

Schedule, run, and view these reports from Navigator > Tools  > Scheduled Processes.
 

Who uses these reports?
 

• Financial Accountants

• Financial Specialists

When do I use these reports?
 

• During monthly journal entry processing.

• During period close to verify all transactions have been imported and journals posted.

• In account balance reconciliations.

What type of reports are these?
 

Oracle Analytics Publisher
 

44



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 4
Oracle Fusion General Ledger

Related Topics
• Overview of Payables to Ledger Reconciliation Report

• Overview of the Receivables to General Ledger Reconciliation Report

• Cash to General Ledger Reconciliation Report

General Ledger Chart of Accounts Reports  
This topic includes details about the Oracle General Ledger chart of accounts reports.

Overview
The account analysis reports assist in reviewing journals and related transactions. You can use these reports as part of
your reconciliation process and in preparation of your closing entries.

The following figure shows an example of the Chart of Accounts Mapping Rules Report. The parameters for the report
include the chart of accounts mapping name and the tree version effective date. The report provides the account rules
and segment rules for the specified mapping.

The following table describes the chart of accounts reports.

Name Description

Balancing Segment Value Assignments
Report
 

• Reports on the assignment of primary balancing segment values to legal entities and ledgers
across accounting set ups.

• Lets you quickly identify overlapping balancing segment value errors and review for any
unassigned values.
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Name Description

Note:
The application does not check for overlapping balancing segment values online.
 

Chart of Accounts Mapping Rules Report
 

• Provides both the segment and account rules defined for a specific chart of accounts mapping.

• If the mapping has account rules, the report prints each subsidiary account range and the parent
account into which it maps.

• If the mapping has segment rules, the report prints the rule name and the parent and subsidiary
segments. If the mapping has a rollup range rule, the report prints each subsidiary segment value
range and its corresponding parent segment value.

Key Insights
Before running the chart of accounts reports, verify that all subledger transactions have been imported and all journal
entries for the period have been posted.

Parameters
The following table describes selected process parameters from the reports and provides examples.

Parameter Description Example

Value Set
 

Enter the value set that contains the balancing
segments you are reporting on.
 

Corporate Company
 

From and To Balancing Segments
 

Enter the description of the balancing segment
value to report from and to.
 

Canada
 

Assignment Status
 

Select one of the following options: All, Ledger
only, Legal Entity, only, or Unassigned to
 

Ledger only
 

Actuating Configuration
 

Select the ledger you want to report on.
 

US Primary Ledger
 

Show Only Balancing Segment Values with
Multiple Assignments
 

Show only those balancing segment values that
have more than one legal entity assigned to it.
 

No
 

Chart of Accounts Mapping
 

Select the mapping you have defined.
 

CN code to US Mapping
 

Tree Version Effective Date
 

Select the date that determines which tree
version to use as one of the report's criteria.
 

8/28/2016
 

Frequently Asked Questions
The following table lists frequently asked questions about the chart of accounts reports.
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FAQ Answer

How do find these reports?
 

Schedule, run, and view these reports from Navigator > Tools  > Scheduled Processes.
 

Who uses these reports?
 

• Financial Accountants

• Financial Specialists

When do I use these reports?
 

• During monthly journal entry processing.

• During preparation of closing entries.

• In account balance reconciliations.

What type of reports are these?
 

Oracle Analytics Publisher
 

Overview of Smart View  
Oracle Hyperion Smart View provides common Word, PowerPoint, and Excel interfaces designed specifically for Oracle
Hyperion Enterprise Performance Management, Oracle Transactional Business Intelligence, and Oracle General Ledger.

Using Smart View, you can view, import, manipulate, distribute, and share data in Excel, Word, and PowerPoint
interfaces. Smart View is a comprehensive tool for accessing and integrating Enterprise Performance Management,
Business Intelligence, and General Ledger content from Microsoft Office products.

Smart View provides the ability to create and refresh spreadsheets to use real-time account balances and activity. You
can use Smart View for:

• Analysis

• Predefined form interaction

• Report design

Analysis
Smart View uses the Excel environment to interactively investigate the data contained in the sources. You start with
templates that begin the process or a blank sheet where you begin shaping and altering the grids of data.

Predefined Form Interaction
Use Smart View to work in the Excel environment either for a consistent experience or to tie other spreadsheet-based
models into your process. For example, use Smart View with Oracle Hyperion Planning to incorporate data that is still
housed in spreadsheet and workbook-based models.

Report Design
Report design is another dimension of Smart View, which uses the capabilities of Oracle General Ledger data. Once
the data is available within Smart View you can create reports as needed based on a combination of data sources. For
example, planning and financial management data can be used to compare actual to budget. Reports can be made
more complex by providing the ability to compare multiple scenarios for different periods. The power of Smart View is
used to create reports and is refreshed periodically, as needed.
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Smart View provides the ability to create and refresh spreadsheets to use real-time account balance information. You
can use Smart View to:

• Perform ad hoc multidimensional pivot analysis with full spreadsheet functionality

• Drill down from any parent value to the next parent or child value

• Perform drill down from any child value to detail balances, journal lines, and subledger transactions

• Analyze actual, budget, and forecast information

• Increase visibility with charts and graphs

• Apply date effective hierarchies to past, present, or future hierarchies to change the financial data reported in
your financial reports. For example, to compare 2014 to 2015 results, realign the data in your 2014 reports by
applying the 2015 organization hierarchy.

Tip:  Best practice when using Smart View is to always turn on row suppression in the Smart View options. You can't
suppress columns in Smart View.  For more information about Smart View suppression, see the Smart View Options
chapter in the Oracle Smart View for Office User's Guide at http://docs.oracle.com/cloud/latest/epm-common/
SVPBC/opt_data.htm#SVPBC-options_202.

For more detailed information about Smart View, refer to the Using EPM with Oracle Fusion Cloud Financials link on the
Oracle Financials All Books page of the Oracle Help Center at https://docs.oracle.com.

Creating an Ad Hoc Analysis in Smart View  
This example shows how to create an ad hoc analysis in Smart View.

Creating an Ad Hoc Analysis
This example includes steps for configuring the Smart View connection, selecting dimension members, creating
separate reports, and formatting amounts.

1. Navigate to the Financial Reporting Center.
2. Open the Tasks panel and click the Open Workspace for Financial Reports task.
3. Remove /index.jsp from the end of the workspace URL and copy the rest of the URL. For example, copy 

https://example.com.
4. Open Excel.
5. Navigate to the Smart View ribbon and click Options.
6. In the Shared Connections URL field on the Advanced tab, replace everything before workspace with

the copied URL and append SmartViewProviders. For example, https://example.com/workspace/
SmartViewProviders.

7. Click OK.
8. On the Smart View ribbon, click Panel. The Smart View panel opens.
9. On the Smart View panel, click Shared Connections.

10. Sign in with your user name and password.
11. On the Smart View panel, select the drop-down list for the Select Server to proceed field.
12. Select Oracle@Essbase from the list of shared connections.
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13. Expand the list of cubes for Essbase_FA_Cluster.
14. Expand the USChartofAccounts cube.
15. Select db. Don't expand the selection.
16. On the Smart View panel, click Connect, and then click Ad Hoc Analysis.
17. On the Essbase ribbon, click POV. The Point of View window enables you to select data dimension values, so

you can pinpoint the information you want for the Excel analysis.
18. On the Point of View window, click the drop-down list for each dimension and select the ellipsis (...) to open the

member selector. On the Member Selection window, remove the default selection for each dimension using
the Remove icon. Select the dimension value and add it using the Add icon. Click OK. Complete the member
selection, as shown in this table.

Field Value

Company
 

[All Company Values].[101]
 

Line of Business
 

10
 

Account
 

11200-Cash
 

Cost Center
 

All Cost Center Values
 

Product
 

All Product Values
 

Intercompany
 

All Intercompany Values
 

Scenario
 

Actual
 

Balance Amount
 

Period Activity
 

Amount Type
 

Period-to-date
 

Currency
 

USD
 

Currency Type
 

Total
 

19. On the worksheet, click the Accounting Period dimension in row 3, column A.
20. Right-click and select Smart View, Member Selection.
21. On the Member Selection window, remove the default selection. Expand the Accounting Period dimension

and add the period 12-16.
22. Click OK.
23. Double-click Ledger in row 2, column B, to zoom in. You can also zoom in by selecting the dimension,

navigating to the Essbase ribbon, and clicking Zoom In
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24. Click All Ledgers in row 2, column B, and click Zoom Out on the Essbase ribbon.
25. Right-click Ledger in row 2, column B, and select Smart View, Member Selection.
26. On the Member Selection window, remove the default selection of Ledger.
27. Select US Ledger Set and click the Add icon.
28. Click OK.
29. On the Point of View window, click Refresh.
30. Double-click US Ledger Set in row 2, column B, to zoom in.
31. Click the [US Ledger Set].[US Primary Ledger] cell.
32. On the Essbase ribbon, click Keep Only to remove the other Ledger members and keep only the selected

member.
33. To create a separate report based on the Company dimension, on the Essbase ribbon, click Cascade and select

Same Workbook. The Member Selection window opens.
34. On the Member Selection window, select [All Company Values].[102] and click the Add icon.
35. Click OK. A worksheet opens for company 102.
36. Click the All Company Values.101 worksheet.
37. Click the amount cell in row 3, column B.
38. Navigate to the Home ribbon and set the Accounting Number Format option to the dollar sign.
39. Navigate to the Essbase ribbon and click Preserve Format.
40. On the Point of View window, click Refresh.

Define a Report in Smart View with the Query Designer  
This example shows how to define a report using the Query Designer in Smart View.

Defining a Report with the Query Designer
1. Open Excel and navigate to the Smart View ribbon. Click Panel.
2. Click Shared Connections.
3. Sign in with your user name and password.
4. Click the Select Server to proceed drop-down list.
5. Select Oracle Essbase.
6. Expand the Essbase_FA_Cluster  and expand USChartofAccounts.
7. Highlight db. Don't expand db.
8. Click Connect.
9. Click the analysis link.

10. Navigate to the Essbase ribbon and click Point of View.
11. In the spreadsheet, click cell A2.
12. On the Essbase ribbon, click Query and select Query Designer. A new sheet named, Sheet1-Query is created

and the Query Designer displays.
13. On the Point of View panel, move:

a. Account to the Rows section.
b. Accounting Period to the Columns section.
c. Ledger to the Point of View section.

50



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 4
Oracle Fusion General Ledger

d. Company to the Rows section, as the first dimension.

Note:  You can also select the dimensions cells on the worksheet and use the Pivot command on the Essbase
ribbon to perform these steps.

14. Open the Amount Type dimension by clicking the drop-down list and selecting the Member Selection link.
Remove the default placeholder using the Remove icon. Select the period-to-date value and add it to the panel
of selected values using the Add icon.

15. On the Member Selection window, click the drop-down list next to the Amount Type dimension to toggle to
each Point of View dimension. Complete the fields, as shown in this table.

Field Value

Ledger
 

US Ledger Set > [US Ledger Set].[Us Primary Ledger]
 

Line of Business
 

All Line of Business Values
 

Cost Center
 

All Cost Center Values
 

Product
 

All Product Values
 

Intercompany
 

All Intercompany Values
 

Scenario
 

Actual
 

Balance Amount
 

Period Activity
 

Currency
 

USD
 

Currency Type
 

Total
 

16. From the POV Sheet1-Query_1 panel, click AccountingPeriod to open the Member Selection window. You can
also open the Member Selection window from the worksheet by right-clicking the AccountingPeriod cell, and
selecting Smart View, Member Selection.

17. Remove the default selection. Expand 2016. Select all four quarters and add the quarters to the selected panel.
18. Click OK.

Note:  The four quarters become separate columns on the worksheet.

19. Click the Company dimension.
20. Expand All Company Values.
21. Select [All Company Values].[101] and [Company]@[941] and add them. Remove the default value.
22. Click OK.
23. On the POV Sheet1-Query_1 panel, click Account in the Rows section.
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24. Expand All Corporate Accounts-V1 > Account@[T] > 95001 - Net Income Current Year.
25. Expand 95011-Revenue and 95021-Expenses.
26. Remove the default value. Select the following values and add them to the selected panel:

◦ 95011-Revenue

◦ 40000-Revenues

◦ 95021-Expenses

◦ 50000-Material and Goods

◦ 60000-Operating Expenses

◦ 70000-Extra Charges and Tax

27. Click OK.
28. On the POV Sheet1-Query_1 panel, click Apply Query.
29. Save your report to the desktop as your initials Smart View Financial Report.
30. Insert 7 rows at the beginning of the spreadsheet.
31. Click in cell A3. Click the Insert tab and select Picture.
32. Select WINNT (D) > Labs > Fin_reporting > Vision Logo.
33. Click Refresh.

Note:  You must refresh periodically to maintain the connection to the database.

34. From the Insert tab, click Text Box.
35. Click cell C4 and type your initials Income Statement for Companies 101 and 941. Use excel formatting to

format the text however you want.
36. Click Refresh.
37. Click Save.
38. Highlight all the cells that contain amounts.
39. Navigate to the Home ribbon, and from the Number section, select dollar sign.
40. On the Home ribbon, in the Cells section, select Format > AutoFit Column Width.
41. Navigate to the Essbase ribbon and select Preserve Format.
42. Click Refresh.
43. Click Save.
44. Insert three rows between the data for company 101 and 941.
45. On the first new blank row in Column B, type Total Income.
46. Add the following formula for the first column with data Qtr1-14: =C10+C15 where C10 is 95001-Revenue and

C15 is 95021-Expenses.
47. Copy and paste that formula to the other columns.
48. Do the same formula for totals of Company 941.
49. Format all the total cells as Accounting. On the Essbase ribbon, select Preserve Format.
50. Click Save.
51. Insert 10 more rows between the data for Company 101 and 941.
52. Highlight all four rows of the expense data for all four quarters, including Material and Goods.
53. Navigate to the Insert ribbon and select the Line chart from the Chart section.
54. Select the first 2-D Line chart layout.
55. On the line chart, click the Legend that reads Series1, Series2, Series3, and Series4.
56. From the Chart Tools ribbon, select Select Data.
57. In the Legend Entries (Series) pane, select Series2 and click Remove. Series2 is a total of expenses and not

appropriate for this chart.
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58. In the Legend Entries (Series) pane, select each series individually and click Edit. Complete the series and
names fields, as shown in this table.

Series Name

Series1
 

Material and Goods
 

Series3
 

Operating Expenses
 

Series4
 

Extra Charges and Tax
 

59. In the Horizontal (Category) Axis Labels panel click the first one and click Edit.
60. Click the icon next to the Axis label range: field.
61. On the spreadsheet, highlight the four quarter headers and click the icon next to the Axis Labels field.
62. Click OK twice.
63. Move and resize the line chart to fit inside the blank lines.
64. Click Save.
65. Navigate to: Financial Reporting Center > Tasks panel tab > Open Workspace for Financial Reports.
66. Click Navigate > Applications > BI Catalog.
67. Expand Shared Folders > Custom > highlight Financial Reports.
68. From the Tasks panel, select Upload.
69. Click Browse and from your Desktop, select your Smart View Financial Report.
70. Click Open.
71. Click OK.
72. Close the EPM Workspace tab.
73. From the Financial Reporting Center, click the Search icon.
74. Enter Smart and click Search.

Note:  Your report may not be found immediately. Wait a few minutes and try again.

Approval Groups Report  
This topic includes details about the Approval Groups Report.

Overview
You can now use the Approvals Group Report to view the approval groups defined in Oracle Business Process
Management (BPM). You can view the report output in both spreadsheet and XML format.

Key Insights
You can obtain the details of the group name, the approvers, and the sequence in which the approvers appear in the
approval group.
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Report Parameters
There are no parameters that you need to select for this report.

Frequently Asked Questions

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Workflow Rules Administrator
 

When do I use this report?
 

Use this report to review approval groups defined in BPM.
 

What type of a report is this?
 

Spreadsheet, XML
 

Workflow Rules Report  
This topic includes details about the Workflow Rules Report.

Overview
You can now use the Workflow Rules Report to view and validate the workflow rules configured in Oracle Business
Process Management (BPM) for the following financial workflows.

• Automatic or Manual Credit Request Processing

• Bank Account Transfer Approval

• Bankruptcy Request Approval

• Cash Advance Approval

• Credit Request Approval

• Credit Request Approval Postprocessing Action

• Delegation of Corporate Card Transactions for Inactive Employees

• Expense Report Approval

• Hold Resolution

• Incomplete Invoice Hold

• Intercompany Transaction Approval

• Intercompany Transaction Distribution Entry

• Invoice Account Coding
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• Invoice Approval

• Journal Approval

• Manually Entered Credit Request Completion

• Payment Approval

• Spend Authorization Approval

You can view the report output in both spreadsheet and XML format.

Key Insights
You can use the report to validate the workflow rules configured in Oracle Business Process Management (BPM)
to meet recommended best practices. Wherever the rules deviate from best practices, you can use the suggested
recommendations to make the necessary corrections.

You can also use this report to obtain details of the stage, participant, rule status, rule conditions, and approval routing
for each rule.

Report Parameters

Parameter Description

Workflow
 

You can select the workflow for which you want to review the workflow rules.
 

Frequently Asked Questions

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Workflow Rules Administrator
 

When do I use this report?
 

Use this report to review existing workflow rules defined in BPM.
 

What type of a report is this?
 

Spreadsheet, XML
 

Create a Financial Report  

Define a Basic Financial Report Using the Reporting Web Studio  
This is the first of six topics on designing a financial report with Financial Reporting Web Studio.
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Watch video
 

You can use Financial Reporting Web Studio to design traditional financial report formats such as balance sheets, profit
and loss statements, and cash flow reports. You can also design nontraditional reports for financial or analytic data that
include text and graphics.

In this example, you're designing a basic financial report.

1. From the Financial Reporting Center work area, select the Tasks panel tab and click Open Workspace for
Financial Reports.

2. On the Tools menu, select Launch Financial Reporting Web Studio.
3. On the File menu, select New, Report.
4. On the toolbar, click the Grid icon. Grids are tables that contain data from external database connections.
5. In the design canvas, draw a box to create the grid. The Database Connection Properties dialog box opens.

Tip:  When creating a grid, best practice is to leave space in the design canvas for other objects, such as a
company logo and report title.

6. Select the Data Sources list and select the data source for the chart of accounts that the report is based on. A
unique cube exists for each combination of chart of accounts and accounting calendar.

Tip:  Best practice is to always turn on suppression in financial reports at the Database Connection Server
level. You can verify the setting by highlighting the grid, and then selecting Data Query Optimization
Settings on the Task menu. For most reports, best practice is to turn on suppression for the entire grid. Then
turn suppression off for columns and rows that must always display. For more information about suppression
settings, refer to the Defining Basic Conditional Suppression section in the Financial Reporting Web Studio
User's guide.

7. Click OK. The Dimension Layout dialog box opens.

Arrange the Dimensions
Use the Dimension Layout dialog box to arrange the dimensions on your report. For this report, the accounting periods
display on the columns and the revenue and expense account information displays on the rows. The company appears
on each page and can be selected at runtime.

1. Drag the Accounting Period dimension to the Columns axis.
2. Drag the Account dimension to the Rows axis.
3. Drag the Company dimension to the Page axis.
4. Click OK to close the Dimension Layout dialog box.

Define the Rows
Use the Select Members dialog box to define the revenue and expense account rows.

1. Select the revenue parent account.

a. Double-click the Account cell. The Select Members dialog box opens with a default member selected.
b. Remove the default Account selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
c. In the Search field, enter the value for the account that represents total revenue and click the Search

icon.
d. Select the account from the search results and click OK. The account moves to the Selected area.
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e. Click OK. The Select Members dialog box closes.
2. Now insert a text row to add space between the revenue and expense accounts.

a. Select the last row in the grid by clicking the row header.
b. On the Insert menu, select Row, then Text.

3. Insert a row for the expense accounts.

a. Right-click the last row header.
b. On the Insert Row menu, select Data. Notice the default value for the new row is the revenue parent

account.
4. Select the expense parent accounts.

a. Double-click the account value in the new expense account row. The Select Members dialog box opens
with the revenue parent account selected.

b. Remove the revenue parent account selection from the Selected area by clicking to select it and then
clicking the Remove from Selected icon.

c. In the Available area, expand the Account member, and continue expanding until you find the expense
parent accounts for the report.

d. Select the accounts and click the Add to Selected icon to move them to the Selected area.
e. Select the Place selections into separate rows option so each account appears in its own row on the

report.
f. Click OK. The Select Members dialog box closes.

Save and Preview the Report
Save the report and leave it open for the next topic, which is adding a formula to a financial report.

1. Click the Save icon.
2. Select the folder with your name and enter the report name and description.
3. Click Save.
4. Optionally preview the report in HTML or PDF format using the File menu or toolbar.

Add Formulas to a Financial Reporting Report  
This is the second of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you define a formula to summarize the expense account balances on your financial report.

Before you start, do the steps described in the Define a Basic Financial Report Using the Reporting Web Studio topic,
then follow these steps.

1. Right-click the last row header, select Insert Row and select Formula.
2. Click in the empty cell in the new row.
3. In the Heading Row Properties pane, select the Custom Heading option, enter Total Expenses and click the

Update icon. The new heading appears in the report.
4. Select the row header for the formula row. The SUM function appears in the design canvas.
5. In the Formula bar, click the Sum(0) button and enter the formula and cell references in the formula text box.
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Because the expense rows appear one after the other, you can use the first row number and the last row
number with a colon in between. For example, Sum([3:5]). If the rows weren't contiguous, you could put
brackets around each row number and separate them with commas. For example, Sum([3], [5], [6]).

6. Validate the formula syntax by clicking the check mark icon in the toolbar. Validation checks the validity of the
formula, not if the data is available.

7. Save the report and leave it open for the next topic, which is defining a range function. Optionally preview the
report.

Define Range Functions for a Financial Reporting Report  
This is the third of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you define a range function to report across multiple accounting periods. You configure the range to
present balances for the last 12 months from the period selected at runtime.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report

Now follow these steps.

1. Double-click the Accounting Period cell. The Select Members dialog box opens.
2. Remove the default accounting period from the Selected area by clicking it to select it and then clicking the

Remove from Selected icon.
3. Click the Functions tab.
4. Select Range from the list.
5. Click the Add to Selected icon. The Range dialog box opens.
6. Define the starting member for the range.

a. On the Start Member row, click the Lookup Selection icon in the Value column.
b. Click the Functions tab.
c. Select the Relative Member function to define the periods that display on the report relative to the

period specified at runtime.
d. Click OK. The Relative Member dialog box opens.
e. On the Member row, click the Lookup Selection icon in the Value column.
f. Select Current Point of View for Accounting Period so you can enter the starting period for the report.

g. Click OK.
h. On the Offset row, enter -11 in the Value field.

The offset determines the first period of the range. The starting period in the range function is always
the oldest period. Because this is a rolling 12 period report, enter -11 to include the 11 periods prior to the
period you enter at runtime. The member selection for the End Member parameter determines period 12.

i. Click OK.
7. Define the ending member for the range.

a. On the End Member row, click the Lookup Selection icon in the Value column.
b. Select Current Point of View for Accounting Period.
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c. Click OK.
d. Click OK to close the Range dialog box.
e. Click OK to close the Select Members dialog box.

8. Save the report and leave it open for the next topic, which is defining a grid point of view. Optionally preview
the report.

Set User and Grid Points of View for a Financial Reporting Report  
This is the fourth of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you set a user point of view and a grid point of view for a financial report.

All financial reporting reports have a user point of view and a grid point of view. Best practice is to use a combination of
both.

If you want users to select certain dimension members at runtime, then those dimensions should be set in the
user point of view. Selections for user point of view members are global for a user and data source. This means the
application saves and applies them to any other report that has the same dimensions set to the user point of view. By
default, all dimensions are set to the user point of view and must be selected at runtime. If you want your report to
always use certain dimension selections, then select the specific members in the grid point of view.

Note:  Members of a grid point of view only display in HTML.

In this example you set the Ledger, Scenario, Balance Amount and Currency dimensions to use the grid point of view.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report

Now follow these steps.

1. Select the cell in the grid that represents the intersection of the rows and columns. The Grid Properties pane
opens.

2. In the Grid Properties pane, click the Grid Point of View check box.
3. In the design canvas, click the Ledger: User Point of View for Ledger button. The Select Members dialog box

opens.
4. Expand the Ledger member and continue to expand until you find the ledger to include on the report. Select

the ledger.
5. Click Apply Selection.
6. Select Scenario from the Dimension list to select the type of balance to use on the report.
7. Expand the Scenario member and select Actual.
8. Click Apply Selection.
9. Select Balance Amount  from the Dimension list.

10. Expand the Balance Amount member and select Period Activity.
11. Click Apply Selection.
12. Select Currency from the Dimension list.
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13. Search for USD.
14. Click OK to accept the search result.
15. Click Apply Selection.
16. Click OK to close the Select Members dialog box.
17. Save the report and leave it open for the next topic, which is setting page and grid properties. Optionally,

preview the report.

Work with Grid Point of View Setup and Page Axis for a Financial
Reporting Report  
This is the fifth of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you change the grid point of view setup and set the page member selection to a prompt on your
financial report.

Before you start, do the tasks described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report
4. Set User and Grid Points of View for a Financial Reporting Report

Now follow these steps.

1. Click the first cell in the grid to select all of the rows and columns.
2. Right-click and select Grid Point of View Setup from the list. The Setup Grid Point of View dialog box opens.

a. To prevent the Balance Amount dimension from being changed at runtime, select the Lock Member
Selection option.

b. Click OK. The Setup Grid Point of View window closes.
3. In the Grid Properties pane:

a. Click the Drill Through option to allow drilling from the report to the General Ledger transaction data.
b. Click the Suppression section to view the suppression settings.
c. Enter 0 in the Zero Values field to set the text option for rows with zero values. If necessary, you could

also suppress the display of rows with zero values, rows with missing data, and rows with errors.
4. Set a runtime prompt for the Company dimension so you have the flexibility of selecting any company or

combination of companies at runtime. In this example, you want to restrict the valid list of companies that can
be selected at runtime.

a. On the grid, click the Pages label. The Company dimension appears in the design canvas.
b. Click the Company button. The Select Members dialog box opens.
c. Remove the default Company selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
d. Select Prompt for Company.
e. Click the Add to Selected icon to move the selection to the Selected area.
f. Click OK. The Define Prompts dialog box opens.

g. Click the Lookup icon in the Choices List field. The Select Members dialog box opens.
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h. Remove the default Company selection from the Selected area by clicking it to select it and then clicking
the Remove from Selected icon.

i. Expand the Company member, and continue expanding until you find and select the default companies
you want to display in the prompt.

j. Click the Add to Selected icon to move the companies to the Selected area.
k. Click OK. The Select Members window closes.
l. On the Define Prompts dialog box, click in the Member Name field and select Alias. The actual company

label displays in the prompt list of values instead of a numeric company value, making the prompt more
user-friendly.

m. Click OK. The Define Prompts window closes.
5. Click the Pages label on the grid. The Page Properties pane opens.

a. In the Page Properties pane, select the Alias: Default option so each page of the report shows the name
of the company instead of the number.

6. Select the four data rows in the grid so all of the rows have the same settings.

a. In the Heading Row Properties pane, select the Alias: Default option in the Heading Row Properties pane
to display the revenue and expense account names instead of the accounts.

b. In the Heading Row Properties pane, select the Allow Expansion option so you can expand the parent
account values to view the detail child values.

7. Save the report and leave it open for the next topic, which is formatting your financial report and adding a
graph. Optionally, preview the report.

Add Formats and Graphs to a Financial Reporting Report  
This is the sixth and final topic in a series of topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you add formats and graphs to a financial report.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report
4. Set User and Grid Points of View for a Financial Reporting Report
5. Work with Grid Point of View Setup and Page Axis for a Financial Reporting Report

Now follow these steps.

1. In the report object browser, select the name of the report, which is the first object.
2. Add a logo.

a. In the report layout, drag the header line to make space for the logo and title.
b. In the Header section, click the Add Report Object icon and select Image.
c. In the Image Properties pane, click Browse and select your company logo.

3. Add a title.

a. Select the name of the report in the report object browser.
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b. In the Header section, click the Add Report Object and select Text. As an alternative, you can click the
Text icon in the toolbar and draw the text box. The text box opens.

c. Enter the report title.
d. Select the title text and use the format toolbar to adjust the font size, center the text, and change the font

style to bold.
4. Change the page orientation.

a. Select the name of the report in the report object browser.
b. On the File, menu, select Page Setup.
c. In the Page Setup dialog box, select the Landscape option.
d. Click OK.

5. Add a chart.

a. In the Body section, click the Add Report Object icon and select Chart.
b. In the Chart Properties pane, select the Line chart type.
c. To show only the expense account rows, deselect row 1, and select rows 3, 4, and 5 in the Data Range

section.
d. Click the Format Chart button. The Format Chart dialog box opens.
e. In the Appearance tab, enter the title for the chart. For example, Expenses by Period.
f. Click the Legend tab and enter a title for the legend. For example, Type of Expenses.

g. Click the Axes tab and enter a title for the Metadata axis. For example, Period. Enter a title for the
Primary Axis. For example, Dollars.

h. Click the Refresh Chart button to preview the chart on the Format Chart dialog box.
i. Click OK. The Format Chart dialog box closes.

6. Save the report and optionally, preview it.
For more information about Financial Reporting Web Studio, select the Using EPM with Oracle Financials Cloud link
from the All Books for Oracle Financials Cloud page of the Oracle Help Center at https://docs.oracle.com.

Inquiries  

View an Account Group from the Financial Reporting Center  
This example shows how to view an account group from the Financial Reporting Center.

Viewing an Account Group
1. Navigate to the Financial Reporting Center.
2. Click the Sales Organization account group link.
3. Change the period to 03-17. The balances are automatically updated.
4. Click Show/Hide Segments.
5. On the Account segment, select Value and Description.
6. For the Product and Intercompany segments, clear Value.
7. Click Done.
8. Click View as Sunburst.
9. Click Show Description.
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10. Select any cost center segment and click Move Ring Toward Center.

Note:  You can also use the Segments section to move the rings.

11. Click Done.

Inquire on GL Balances  
Balances are preaggregated at every level of your account hierarchy and updated when a journal is posted.

To inquire and analyze on real-time balances:

• Access both active and prepublished reports and books using the Financial Reporting Center.

• Review summary and detail information at any point in your account hierarchy using different points of view.

• Drill down from the parent and detail levels into balances and transactions.

Note:  All segment values and column, row, or page levels must be at a detail level before the drill link is enabled.

Tip:  You can now inquire on journal lines by company, cost center, and natural account or any other segment.

Drill Down to Balances
Use the Account Inspector to expand and drill down into an account balances. The default Account Inspector view
includes the member values from the default account group selected in the Account Monitor.

1. Click the Navigator > Financial Reporting Center link.
2. Select one of the accounts in the Account Monitor.
3. Click the Inquire and Analyze Balances link.
4. Select:

◦ All Cost Center Values

◦ Your account

◦ Company: All Company Values

◦ All other segments fill with 0's or accept the default

5. Select an Accounting Period.
6. Click Refresh.
7. Click Expand on the Cost Center.
8. Review the balances.
9. Change the accounting period to see how the balances change.

How You Inquire on Detail Balances  
You can run account inquiries using the Inquire on Detail Balances page. To get to the page, select the Inquire on Detail
Balances task in the Period Close work area.
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You can also drill through to the page from Financial Reporting or Smart View.

Search Criteria
Here are some points to consider when entering search criteria.

• Your data access set assignments determine the ledgers and ledger sets you can search on.

• You can search only on accounting periods, not on years or quarters.

• You can search any account hierarchy level in the chart of account fields, as long as the account hierarchies
(tree versions) are published to the balances cube. If the search times out before returning results, set parent
values for the chart of account dimensions to lower levels.

• You can search for segment values by description.

Saved Search
If you search often using the same criteria, create a saved search.

1. Enter your search criteria.
2. Click Save.
3. Enter a name for the search.
4. Optionally, make the saved search the default search. When you land on the Inquire on Detail Balances page,

the default saved search criteria is populated automatically.
5. Click OK.

Search Results
Here are a few things that you can do with the search results.

• Drill to journal lines for actual balances and then drill to the journal entry or subledger transactions.

Note:  The drill to journal lines displays attributes such as entered and accounted amounts, accounting date,
and journal line description.

Note:  Drilling on budget data isn't supported.

• Export the balances to Excel.

• Hide, show, and manage the columns using the View > Columns and View > Columns > Manage Columns
menus. For example, descriptions for chart of accounts dimensions are hidden by default. You might decide to
display descriptions for the company, cost center, and account dimensions.

Note:  If you select Entered or Converted in the Currency Type search field, the search results appear in two rows.
The first row shows the entered currency. The second row shows the ledger currency.

Drill Through from Financial Reporting and Smart View
If you're getting to the Inquire on Detail Balances page by drilling through from Financial Reporting or Smart View,
consider these points.

• Your data access set assignments determine whether you can drill through to the page.
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• Best practice is to set the point of view settings for chart of account dimensions to the lowest possible parent or
detail value to avoid a timeout.

• If you're drilling into a year or quarter Accounting Period dimension, the accounting periods are converted to
the applicable range of accounting periods on the Inquire on Detail Balances page.

• Your selections for rows, columns, page, and point of view display in the page search fields. You can refine the
search criteria as needed and rerun the search.

• From the inquiry page, you can drill to journal lines (for actual balances) and then drill to the journal entry or
subledger transactions.

Note:  Drilling through on budget data isn't supported.

Related Topics
• Save and Reuse Search Criteria in Account Balance Inquiries Readiness Training

• Save Searches with Multiple Criteria

• Overview of Data Access Set Security

• Currencies and Currency Types for Balances Cubes
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5  Oracle Fusion Intercompany Reports

Oracle Fusion Intercompany Predefined Reports  
Oracle Fusion Intercompany provides predefined reports that are used in the close process and to verify setup of the
accounting configuration.

Scheduled Processes work area

You can schedule and run reports from the Scheduled Processes work area. Navigate by clicking Navigator > Tools.

Reports and Analytics work area.

In some cases, you can also perform these:

• Access from the Reports and Analytics work area found that you can navigate to by clicking Navigator > Tools
or from other work areas.

• Open using links that launch the business intelligence (BI) catalog.

These tables are the predefined reports:

Display Name Description

Intercompany Account Details Report
 

Generates information about accounting details of outbound and inbound intercompany transactions.
Outbound transaction accounts include provider distribution and provider receivables accounting.
Inbound transaction accounts include receiver distribution and payables accounting.
 

Intercompany Transaction Summary
Report
 

Lists the intercompany transactions based on the submission selection criteria. Information includes
provider organization, receiver organization, batch, and transaction details.
 

Intercompany Transaction Summary
Report
 

Provides information about intercompany transaction lines grouped by outbound and inbound
transactions. The report can be configured for one or more intercompany organizations.
 

Intercompany Reconciliation Period
Summary Report
 

Lists the processing results of the Prepare Intercompany Reconciliation Reporting Information
program. Includes information about the intercompany receivables and intercompany payables
accounts summarized by period. Intercompany Reconciliation process automatically runs this report.
 

Intercompany Reconciliation Summary By
Source Report
 

Lists the processing results of the Prepare Intercompany Reconciliation Reporting Information
program. Includes information about the intercompany receivables and intercompany payables
accounts summarized by journal source. Intercompany Reconciliation process automatically runs this
report.
 

Intercompany Reconciliation Journal Lines
Report
 

Lists the processing results of the Prepare Intercompany Reconciliation Reporting Information
program. Includes information about journal lines posted to the intercompany receivables or
intercompany payables account. Intercompany Reconciliation process automatically runs this report.
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To run predefine reports, navigate to the Scheduled Processes work area and follow these steps:

1. Click the Schedule New Process.
2. Search for your process Name.
3. Enter your parameters.
4. Enter your process options and schedule.
5. Click Submit.

Intercompany Account Details Report  
This topic describes the Intercompany Account Details Report.

Overview
The Intercompany Account Details Report lists both the inbound and outbound accounting details of intercompany
transactions.

Outbound transaction accounts include provider distributions and provider receivables accounting. And Inbound
transactions include receiver distributions and payables accounting.

This image is an example of the report.
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Report Parameters
This table lists the parameters of the Intercompany Account Details Report:

Name Description

Account Type
 

Select Liability or Asset to display intercompany receivables accounts and intercompany payables
accounts. Select Expense or Revenue to display distribution accounts.
 

Batch Type
 

Indicate if the report should be run for outbound, inbound, or both batch types.
 

From/To Batch Number
 

Enter the range of intercompany batch numbers for the report.
 

From/To Accounting Date
 

Enter the range of accounting dates for reporting.
 

Frequently Asked Questions
This table lists frequently asked questions about the Intercompany Account Details Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Intercompany Accountant
 

When do I use this report?
 

Use this report to review your intercompany transactions.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Oracle Fusion Intercompany Predefined Reports

• Intercompany Transaction Summary Report

• Intercompany Reconciliation Reports

Intercompany Transaction Summary Report  
This topic includes information about the Intercompany Transaction Summary Report.
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Overview
The Intercompany Transaction Summary Report includes all intercompany transaction columns, and lists information
about intercompany transaction lines, grouped by outbound and inbound transactions.

You can configure this report for one or more intercompany organizations. Specifically, use this report to determine
whether a period contains any open transactions by listing the transactions for a particular batch or transaction status.

The following figure is an example of the report:

Report Parameters
The following table describes selected parameters of the Intercompany Transaction Summary Report:

Name Description

Batch Type
 

Indicate if the report should be run for outbound, inbound, or both batch types.
 

From/To Batch Number
 

Enter the range of intercompany batch numbers for the report.
 

From/To Accounting Date
 

Enter the range of accounting dates for reporting.
 

Invoice Indicate if the report should be run only for intercompany transactions that generated an invoice.
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Name Description

  

Frequently Asked Questions
The following table lists frequently asked questions about the Intercompany Transaction Summary Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Intercompany Accountant
 

When do I use this report?
 

Use this report to review your intercompany transactions.
 

What type of report is this?
 

• Oracle Transactional Business Intelligence

• Oracle Business Intelligence Publisher

Related Topics
• Oracle Fusion Intercompany Predefined Reports

• Intercompany Account Details Report

• Intercompany Reconciliation Reports

Intercompany Reconciliation Reports  
This topic includes information about the intercompany reconciliation reports.

Overview
The intercompany reconciliation reports enable you to reconcile your intercompany receivables and intercompany
payables accounts, and identify any missing transactions. These reports are automatically generated when you run the
Prepare Intercompany Reconciliation Information process. Use the reconciliation infolet feature to run the reports. The
intercompany reconciliation infolets displays the default view of the reconciliation, allows drill down to the reconciliation
reports, and also lets you run the reconciliation extraction process.

To generate data that's displayed on these reconciliation reports, you must first run this scheduled process.

• Prepare Intercompany Reconciliation Reporting Information

Intercompany reconciliation reports include:

• Intercompany Reconciliation Period Summary Report: Includes information about the intercompany receivables
and intercompany payables accounts summarized by period.
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• Intercompany Reconciliation Summary by Source Report: Includes information about the intercompany
receivables and intercompany payables accounts summarized by journal source.

• Intercompany Reconciliation Journal Lines Report: Includes information about journal lines posted to the
intercompany receivables or intercompany payables account.

Note:  You can't run these reports individually. They're linked together and must be run as the Prepare Intercompany
Reconciliation Reporting Information process.

Key Insights
The intercompany reconciliation reports show the entered or transaction amount of the accounting entries booked
to the intercompany receivables and payables accounts for a pair of provider and receiver legal entities. Since the
accounted amounts may differ due to different conversion rates for the intercompany receivables and intercompany
payables, you can run the reports using an additional currency and conversion rate that converts all amounts into a
common currency for comparison.

The intercompany reconciliation process starts with running the Prepare Intercompany Reconciliation Reporting
Information process. Select from a variety of parameters to determine the data for your reports. For example, select the
provider legal entity and receiver legal entity for which you want to run reconciliation.

Once the Prepare Intercompany Reconciliation Reporting Information process completes successfully, navigate to the
Intercompany Reconciliation work area to view the Reconciliation Period Summary Report. This report displays the
intercompany receivables and intercompany payables balances in summary for a period, and any differences between
them. Drill down to view the balances by source and journal lines. You have full drill down capabilities to the general
ledger journal, subledger accounting entry, and source receivables or payables transaction.

The reports include these details:

• Intercompany receivables and intercompany payables lines generated by the intercompany balancing feature

• Intercompany receivables and intercompany payables lines generated for the provider and receiver of each
intercompany transaction

And the reports don't include these details:

• Ledger balancing lines generated when the primary balancing segment value is in balance but either the
second balancing segment or the third balancing segment is out of balance

• Clearing company balancing lines

Report Parameters
This table describes selected parameters of the intercompany reconciliation reports:

Name Description

Provider Ledger
 

Indicate the ledger of the provider organization for reporting.
 

Provider Legal Entity
 

Indicate the legal entity of the provider organization. Select the legal entity provider for the
reconciliation extract process.
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Name Description

Provider Accounting Period
 

Select the provider accounting period for which the reconciliation extract process is run for the
provider ledger.
 

Receiver Legal Entity
 

Indicate the legal entity of the receiver organization. Select the legal entity receiver for the
reconciliation extract process.
 

Receiver Ledger
 

Indicate the ledger of the receiver organization for reporting.
 

Receiver Accounting Period
 

Select the receiver accounting period for which the reconciliation extract process is run for the receiver
ledger.
 

Additional Currency
 

Indicate the display data in a different additional currency to the ledger currency for the reconciliation
extract process.
 

Conversion Rate Type
 

Indicate the conversion rate type used to convert the amounts, if the reconciliation extract process is
run for an additional currency.
 

Conversion Date
 

Indicate the conversion date used to convert the amounts, if the reconciliation extract process is run for
an additional currency.
 

Frequently Asked Questions
This table lists frequently asked questions about the intercompany reconciliation reports.

FAQ Answer

How do I find these reports?
 

Schedule and run these reports from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

Intercompany Accountant
 

When do I use these reports?
 

Use these reports to:
 

• Review your intercompany balances.

• Determine any differences between the intercompany receivables and intercompany payables
balances for a period

• Drill down to view the balances by source and journal lines

What type of reports are these?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Oracle Fusion Intercompany Predefined Reports

• Intercompany Account Details Report

• Intercompany Transaction Summary Report
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6  Oracle Fusion Budgetary Control Reports

Oracle Fusion Budgetary Control Predefined Reports  
Additionally, you can use these predefined reports for further inquiry and reporting.

Display Name Description

Budget Import Analysis Report
 

Control Budget Balance Layout: Lists the control budgets, budget accounts, budget periods, and
amounts that are impacted by each imported budget line item.
 
Budget Release for Consumption Layout: Lists the budget release histories and future budget release
schedules for control budgets that don't allow their budget amounts to be available for consumption
until they're released.
 

Budgetary Control Results Report by
Transaction
 

Lists the impacted control budget, account, and period for a specific transaction as a result of
budgetary control validation.
 
The transaction number for a Payables payment before it's complete is the payment process request
number. When payment is complete, the transaction number for electronic payments will be the
payment reference number. The transaction number for check payments will be payment reference
number - check number.
 

Budgetary Control Results Report for
Transaction Batch
 

Lists the impacted control budget, account, and period for a group of transactions as a result of
budgetary control validation in a batch process.
 

Budgetary Control Exception Analysis
Report
 

Lists the budgetary control failures by control budget period. The budget account, transaction type,
 number, amount, and action are listed.
 

Budgetary Control Analysis Report
 

Fund Available Trend Layout: Lists the fund budget and consumption balance for a specific control
budget in a range of periods. The budget, commitment, obligation, and expenditure balance by cost
center and account are also listed.
 
View Funds Available Layout: Lists the funds available by control budget account and period. The
budget consumption from transactions is listed along with the impacted commitment, obligation, and
expenditure and funds available balances.
 
Account Activities Layout: Lists the control budget accounts by period with consumption and without
consumption. The account balance and transaction details are also listed.
 

Budgetary Control - Balances Real Time
 

The Budgetary Control - Balances Real Time subject area provides the real-time details of budgetary
control balances, such as budget, consumption, reservation category and funds available amounts, and
control budget details.
 

Budgetary Control - Transactions Real
Time
 

The Budgetary Control - Transactions Real Time provides the real-time details of transactions and their
impact on budget balances for the ad hoc analysis of budget consumption and funds available.
 

To run predefined reports, you can use one of these methods:
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Scheduled Processes work area

1. Navigate to Tools > Scheduled Processes and follow these steps:
2. Click the Schedule New Process button.
3. Search for your process name.
4. Enter your parameters.
5. Enter your process options and schedule.
6. Click Submit.

Reports and Analytics work area

1. Navigate to Tools > Reports and Analytics and follow these steps:
2. Go to Shared folders > Financials > Budgetary Control
3. Click on the report name.
4. In the tab that opens, enter your parameter values.
5. Click Apply.

Budget Import Results Report  
The Budget Import Results Report is automatically submitted either by the Import Budget Amounts or Import Budgets
from Spreadsheet process. Access the Budget Import Results Report from the output file of the Budget Import Results
Report process.

Use
The Budget Import Results Report to review the overall import result. The report provides a summary of control budgets
into which the budget data is successfully imported. The report also provides details about import failures.

The report doesn't list the resulting budget balances after the budget import. You obtain this information from the
budgetary control analysis reports or the Budgetary Control Dashboard.

This image is an example of the report.
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Related Topics
• Oracle Fusion Budgetary Control Predefined Reports

• Budgetary Control Analysis Report

Budgetary Control Results Reports  
This topic includes details about the budgetary control results reports.

Overview
The budgetary control results reports list these for a transaction or a group of transactions as a result of budgetary
control validation.

• control budget

• account

• period impacted

Budgetary control results reports have two layouts:

• Budgetary Control Results Report

• Budgetary Control Results for Batch Report

Here's an example of the Budgetary Control Results Report.

And here's an example of the Budgetary Control Results for Batch Report.
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Key Insights
The Budgetary Control Results Report process is automatically submitted when budgetary control validation is
performed online but the transaction is too large to display online. Access the Budgetary Control Results Report from
the output file of the Budgetary Control Results Report process.

The Budgetary Control Results for Batch Report process is automatically submitted when budgetary control validation is
performed for a batch of transactions. Access the Budgetary Control Results for Batch Report from the output file of the
Budgetary Control Results for Batch Report process.

Report Parameters
When you run the Budgetary Control Results Report directly, provide the combination of transaction type, transaction,
and view.

This table describes the process parameters:

Name Description

Transaction Type
 

Specify the type of transaction to include for reporting. For example, purchase order or invoice.
 

Transaction
 

Enter the transaction number to include for reporting.
 

View
 

Indicate whether to display the budgetary control results from the transaction perspective, or for users
with the proper access privileges, from the budget impact perspective.
 

When you run the Budgetary Control Results for Batch Report directly, provide the budgetary control attempt identifier.

This table describes the process parameter:

Name Description

Budgetary Control Attempt Identifier
 

Enter the identification of a budgetary control validation process run for reporting by batch processing.
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Frequently Asked Questions
Here are some frequently asked questions about the budgetary control results reports.

FAQ Answer

How do I find these reports?
 

Schedule and run these reports from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

Budget Manager
 

When do I use these reports?
 

Use these reports to review the results of the budgetary control validation for a transaction or group of
transactions.
 

What type of reports are these?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Oracle Fusion Budgetary Control Predefined Reports

Budgetary Control Exception Analysis Report  
This topic includes details about the Budgetary Control Exception Analysis Report.

Overview
The Budgetary Control Exception Analysis Report lists budgetary control failures for fund reservations. This interactive
report enables you to filter the records by period and failure type, and display the transaction detail in the detailed table.

The following figure is an example of the report.
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Key Insights
Use the Budgetary Control Exception Analysis Report to review all the budgetary control reservation failures in your
organization. Leverage the categorization of validation failures to prioritize resolutions. You can create user-defined
layouts to support your specific reporting needs.

This report only captures transactions that failed the attempts to reserve funds, but not those that failed the attempts to
check for funds availability.

Report Parameters
The following table describes the process parameters:

Name Description

Control Budget
 

Specify the name of the budget for reporting.
 

From/To Budget Period
 

Indicate the beginning and ending period of the control budget.
 

Include Additional Attributes
 

Indicate whether to include a full list of attributes for filtering data in the report.
 

Budget Account Filter
 

Specify the budget accounts for reporting.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Budgetary Control Exception Analysis Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Budget Manager
 

When do I use this report?
 

Use this report to review budgetary control failures for a range of budget periods.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Oracle Fusion Budgetary Control Predefined Reports
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Budgetary Control Analysis Report  
This topic includes details about the Budgetary Control Analysis Report.

Overview
The Budgetary Control Analysis Report is a ready to use Oracle Business Intelligence Publisher report that can
be viewed online or scheduled. The report layouts are predefined, but you can modify the layouts to meet your
requirements and filter data interactively.

Budgetary Control Analysis Report includes the following layouts:

• Funds Available Trend: Lists fund budget and consumption balances for a specific control budget in a range of
periods. The budget, commitment, obligation, and expenditure balances by cost center and account are also
listed.

• View Funds Available: Lists funds available by control budget account and period. Budget consumption from
transactions is listed along with the impacted commitment, obligation, and expenditure and funds available
balances.

• Account Activities: Lists control budget accounts by period with consumption and without consumption.
Account balances and transaction details are also listed.

The following figure is an example of the Funds Available Trend layout.

The following figure is an example of the View Funds Available layout.
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The following figure is an example of the Accounts Activities layout.
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Key Insights
Use this report to periodically review the consumption trends by control budget. Each layout displays the data to
highlight different aspects of consumption.

• Funds Available Trend: How the budget is consumed

• View Funds Available: How much is left in the budget

• Accounts Activities: Which activities are consuming the budget

This report only captures transactions for which funds are reserved, but not those that have only checked for funds
availability.

Report Parameters
The following table describes selected process parameters:

Name Description

Control Budget
 

Specify the name of the budget for reporting.
 

From/To Budget Period
 

Specify which periods to include in the report.
 

Include Additional Attributes
 

Indicate whether to include and retrieve additional attributes. If you're not using these attributes in
your layout, don't retrieve them.
 

Budget Account Filter
 

Specify the budget accounts for reporting.
 

Frequently Asked Questions
The following table lists frequently asked questions about the budgetary control analysis reports.

FAQ Answer

How do I find these reports?
 

Schedule and run these reports from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

Budget Manager
 

When do I use these reports?
 

Use these reports to:
 

• Review graphs of your budget and consumption amounts for your fund or project by period

• Analyze your budget, consumption and funds available balances and percentages by:

◦ Period, fund, cost center and object

◦ Period and budget account

• Review budget consumption details with budget account, period and transaction details
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FAQ Answer

• Review budget accounts and periods with budgeted amounts but no consumption

What type of reports are these?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Oracle Fusion Budgetary Control Predefined Reports

Balances Real Time Subject Area for Budgetary Control  
This topic includes details about the Budgetary Control - Balances Real Time subject area.

Overview
The Budgetary Control - Balances Real Time subject area provides the real-time details of budgetary control balances,
such as budget, consumption, reservation category and funds available amounts, and control budget details.

The following figure is an example of the criteria in the subject area report builder.

The following figure is an example of the results in the subject area report builder.
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Key Insights
Use the Budgetary Control - Balances Real Time subject area to build for ad hoc queries on budgetary control balances
for analysis by budget account and period and across ledger, project, award. Obtain details of the balances by linking a
query from budgetary control transactions subject area.

Frequently Asked Questions
The following table lists frequently asked questions about the Budgetary Control - Balances Real Time subject area.

FAQ Answer

How do I find this subject area?
 

In Oracle Business Intelligence Enterprise Edition, select Analysis from Analysis and Interactive
Reporting. Select the Budgetary Control - Balances Real Time subject area and select the applicable
attributes for your ad hoc reporting needs.
 

Who uses this information?
 

Budget Manager
 

When do I use this subject area?
 

Use the subject area Budgetary Control - Balances in Oracle Business Intelligence Enterprise Edition to
perform your ad hoc queries on budgetary control transactions and their budget impacts.
 

What type of subject area is this?
 

Oracle Transaction Business Intelligence
 

Related Topics
• Oracle Fusion Budgetary Control Predefined Reports
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Transactions Real Time Subject Area for Budgetary
Control  
This topic includes details about the Budgetary Control - Transactions Real Time subject area.

Overview
The Budgetary Control - Transactions Real Time subject area provides the real-time details of transactions and their
budget balances impact for ad hoc analysis of budget consumption and funds available.

The following figure is an example of the criteria in the subject area report builder.

The following figure is an example of the results in the subject area report builder.
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Key Insights
Use the Budgetary Control - Transactions Real Time subject area for ad hoc queries on budgetary control transactions
and their budget impacts. Create cross control budget reports with transaction attributes.

Frequently Asked Questions
The following table lists frequently asked questions about the Budgetary Control - Transactions Real Time subject area.

FAQ Answer

How do I find this subject area?
 

In Oracle Business Intelligence Enterprise Edition, select Analysis from Analysis and Interactive
Reporting. Select the Budgetary Control - Transactions Real Time subject area and select the applicable
attributes for your ad hoc reporting needs.
 

Who uses this information?
 

Budget Manager
 

When do I use this subject area?
 

Use the subject area Budgetary Control - Transactions in Oracle Business Intelligence Enterprise
Edition to perform your ad hoc queries on budgetary control transactions and their budget impacts.
 

What type of report is this?
 

Oracle Transaction Business Intelligence
 

Related Topics
• Oracle Fusion Budgetary Control Predefined Reports
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7  Oracle Fusion Tax Reports

Oracle Fusion Tax Predefined Reports  
Oracle Fusion Tax provides operational, business, and reconciliation reports for tax activity associated with buying and
selling goods and services through Oracle Fusion Payables and Oracle Fusion Receivables. Manual and imported tax
transaction details also provide the source for the predefined tax reports.

Oracle Fusion Tax reporting also provides reporting data models on which you can prepare user-defined and specialized
tax reports.

Before running the reports, ensure that you:

• Set up the following entities:

◦ Data Security

◦ Geographies

◦ Enterprise Structure

◦ Tax Regime to Rate setup

◦ Tax Party Profiles

◦ Tax Rules

◦ Suppliers

◦ Procurement Business Function

◦ Common Options for Payables

• Set up a different tax account for each of your tax rates, based on your requirements. This task is optional.
Different tax rates may share the same tax account.

You can schedule and run reports from the Scheduled Processes work area found on the Navigator.

For some tax reports, when you submit the job to run, the report logic calls the Tax Reporting Ledger. The Tax Reporting
Ledger uses data extracted from the tax repository and other sources, where needed.

Tax Reports Based on the Tax Reporting Ledger
The following reports are based on the tax reporting ledger.

Display Name Description

Tax Register
 

Identifies total tax amounts by tax type, tax class, and company based on transactions created in
Oracle Fusion Receivables, and manual and imported tax transactions from Oracle Fusion Tax. Includes
deferred tax accounting information and all transactions for which tax accounting is defined. Groups
data by tax registers: tax register and nonrecoverable tax register. Orders data by transaction number,
 customer name, or customer account number, and prints in summary or detail format.
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Display Name Description

Financial Tax Register
 

Prints tax and accounting information created from transactions entered in Oracle Fusion Receivables,
Oracle Fusion Payables, and Oracle Fusion Tax (Tax Repository). Lists input tax data, output tax data, or
both. Groups data into registers: tax register and nonrecoverable tax register.
 

Tax Reconciliation Report
 

Lists taxable and tax amounts by tax account for all Oracle Fusion Receivables transactions, and
manual and imported output tax transactions from Oracle Fusion Tax for a given period. Generates
subtotals by document class and tax account. Includes a flexfield filter parameter based on the
account. Prints data in summary or detail format.
 

Tax Reconciliation by Taxable Account
Report
 

Lists taxable transaction information created in Oracle Fusion Payables, Oracle Fusion Receivables, and
Oracle Fusion Tax (Tax Repository). Generates subtotals by tax account and tax rate code. Includes a
flexfield filter parameter based on the account.
 

Tax Audit Trail Report
 

Identifies detail tax and invoice information created and posted in Oracle Fusion Payables, and manual
and imported input tax transactions from Oracle Fusion Tax. The total amounts for each tax rate code
are listed in entered currency and ledger currency. Two report layouts are available: Invoice and Tax
Code.
 

Interim Tax Register
 

Prints detail and summary information about interim (deferred) tax on transactions entered in Oracle
Fusion Receivables and Oracle Fusion Payables. For example, the report provides supplemental
information for the Output VAT Journal and Input VAT Journal for declaration preparation in Spain.
 

Tax Allocations Listing Report
 

Lists transactions within a tax period and the tax boxes to which they're allocated. Provides
transactions within a specific document number range, and lists tax-related information and tax boxes
assigned to recoverable and nonrecoverable amounts.
 
Before running this report, run the Tax Reporting Selection Process which is based on the Tax
Reporting Ledger and Tax Allocation Process.
 

Tax Allocation Exception Report
 

Lists the transactions that aren't allocated to any tax box in the most recent run of the Tax Allocation
Process. Provides tax-related information for each transaction line.
 
Before running this report, run the Tax Reporting Selection Process which is based on the Tax
Reporting Ledger and Tax Allocation Process.
 

Tax Box Return Preparation Report
 

Lists taxable transactions by tax boxes. Groups taxable amounts and tax amounts by tax box numbers,
 and provides a basis for the preparation of tax returns.
 
Before running this report, run the Tax Reporting Selection Process which is based on the Tax
Reporting Ledger.
 

Sales Tax Report
 

Identifies taxable, exempt, and tax amounts for invoices entered in Oracle Fusion Receivables, and
manual and imported tax transactions from Oracle Fusion Tax. Data is printed and grouped by tax
jurisdiction.
 

Running the Predefined Reports
To run predefined reports, use the following steps the Scheduled Processes work area in the Navigator menu:

1. Click the Schedule New Process button.
2. Search on the Process Name.
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3. Enter the appropriate parameters.
4. Enter the appropriate process options and schedule.
5. Click Submit.

Tax Register and Financial Tax Register  
This topic includes details about the Tax Register and Financial Tax Register.

Overview
Tax registers include:

• Tax Register: Identifies total tax amounts by tax type, tax class, and company from transactions created in
Oracle Fusion Receivables. The report includes deferred tax accounting information and all transactions for
which tax accounting is defined.

The following figure is an example of the report.

91



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 7
Oracle Fusion Tax Reports

• Financial Tax Register: Prints tax and accounting information created from transactions entered in Oracle
Fusion Receivables, Oracle Fusion Payables, and Oracle Fusion Tax repository. The report lists input, output tax
data, or both.

The following figure is an example of the report.

All amounts are printed in transaction entered currency.

Key Insights
The tax register types for the Tax Register and Financial Tax Register are:

Name Description

All
 

Use this register to include all tax transactions.
 

Nonrecoverable Tax Register
 

Use this register to show your partial and fully nonrecoverable input taxes. It also provides details on
nonrecoverable taxes on:
 

• Earned discounts

• Unearned discounts

• Finance charges

• Adjustments

Tax Register
 

Use this register to report tax liability. It includes details on:
 

• Standard and collected output tax

• Partial and fully recoverable input taxes
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Report Parameters
The following table describes selected process parameters:

Parameter Description

Reporting Level
 

Choose the level on which you want to run the report. You can choose from three different levels,
 Ledger, Legal Entity, and Tax Registration Number.
 

Reporting Context
 

Specify the context for the report. The list of values for this parameter depends on the reporting level
you selected.
 

• If you select the reporting level of Legal Entity, you select the legal entity on which to report, and
optionally select the tax registration number. By entering a tax registration number in the Tax
Registration Number parameter, you report only on a subset of transactions that are entered for
a specific legal reporting unit associated with the tax registration number.

Run the report for a tax registration number to report on the transactions entered for legal
entities that share the same tax registration number. This is also known as tax group registration.

• If you select Ledger as the reporting level, you can report on legal entities associated with ledgers
defined in the ledger set or data access set within your security profile. Run tax reports by ledger
when you want to review your tax activity as it aligns with your accounting.

Run tax reports by ledger when you need to view tax activity in a currency other than the
currency of the ledger or the currencies of the transactions.

Tax Registration Number
 

Enter a tax registration number that is assigned to the legal reporting unit, when the reporting level is
Legal Entity.
 

Tax Point Date
 

Include the transactions for the date range specified.
 
Tax point date is the date on which the taxpayer becomes liable for paying the tax to the tax authority.
 

Currency
 

Select the range of currencies to include in the report. If a transaction is in a currency that is not within
the specified range, it isn't included.
 

Accounting Status
 

Run the report for accounted transactions, unaccounted transactions, or both transactions.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Tax Register and Financial Tax Register.

FAQ Answer

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

• Tax manager

• Tax accountant

When do I use these reports? Use these reports to:
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FAQ Answer

  
• Report your tax liability to the tax authority

• Determine your nonrecoverable taxes

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• Interim Tax Register

• Transaction Tax Report Features

• Example of Reporting Output Taxes for Tax Setup Options on Receivables Activities in the Tax Register and
Nonrecoverable Tax Register

• Example of Reporting Input Taxes in the Nonrecoverable Tax Register and Recoverable Tax Register

• Example of Reporting Prepayments in the Tax Register

Interim Tax Register  
This topic includes details about the Interim Tax Register.

Overview
The Interim Tax Register identifies detailed and summary information of unpaid or partially paid payables and
receivables transactions that have a tax liability created on the payment date. The report prints customer details,
transaction tax-related details, and the tax totals by tax rate code.

All transactions with tax point basis as payment are reported in the Interim Tax Register until they are fully paid.

The following figure is an example of the report:
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Key Insights
Your security profile controls which ledgers and legal entities you can select. You can report on:

• Legal entities within your security profile

• Legal entities associated with ledgers defined in the ledger set or data access set within your security profile

Report Parameters
The following table lists selected report parameters:

Parameter Description

Reporting Level
 

Choose the level on which you want to run the report. You can choose from three different levels,
 Ledger, Legal Entity, and Tax Registration Number.
 

Reporting Context
 

Specify the context for the report. The list of values for this parameter depends on the reporting level
you selected.
 

• If you select the reporting level of Legal Entity, you select the legal entity on which to report, and
optionally select the tax registration number. By entering a tax registration number in the Tax
Registration Number parameter, you report only on a subset of transactions that are entered for
a specific legal reporting unit associated with the tax registration number.

Run the report for a tax registration number to report on the transactions entered for legal
entities that share the same tax registration number. This is also known as tax group registration.

• If you select Ledger as the reporting level, you can report on legal entities associated with ledgers
defined in the ledger set or data access set within your security profile. Run tax reports by ledger
when you want to review your tax activity as it aligns with your accounting.

Run tax reports by ledger when you need to view tax activity in a currency other than the
currency of the ledger or the currencies of the transactions.

Tax Registration Number
 

Enter a tax registration number that is assigned to the legal reporting unit, when the reporting level is
Legal Entity.
 

Print Sequence Number
 

Select:
 

• No, to not print reporting sequences

• Yes, to print reporting sequences

From Sequence Number
 

Enter the starting sequence number when the Print Sequence Number is set to yes.
 
If blank, the sequence number starts from 1.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Interim Tax Register.

95



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 7
Oracle Fusion Tax Reports

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax manager

• Tax accountant

When do I use this report?
 

Use this report to plan for what taxes are to be paid in the future.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Tax Reconciliation and Audit Reports  
This topic includes details about the Tax Reconciliation Report, Tax Reconciliation by Taxable Account Report, and Tax
Audit Trail Report.

Overview
Tax reconciliation and audit reports include:

• Tax Reconciliation Report: Lists the taxable and tax amounts, by tax account, for all Oracle Fusion Receivables
transactions for a given period. Includes a flexfield filter parameter based on the account.

The following figure is an example of the report:

• Tax Reconciliation by Taxable Account Report: Lists taxable transaction information created in Oracle Fusion
Payables, Oracle Fusion Receivables, and Oracle Fusion Tax Repository. Includes flexfield filter parameter based
on the account.
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The following figure is an example of the report:

• Tax Audit Trail Report: Identifies detailed tax and invoice information created and posted in Oracle Fusion
Payables, and the total amounts for each tax rate code in entered currency and ledger currency. Two report
layouts are available: Invoice and Tax Code.

The following figure is an example of the report:
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Reconciliation reports are delivered as templates that you can use immediately or modify to satisfy your reporting
needs.

Key Insights
Tax Reconciliation Report

Use the Tax Reconciliation Report to prepare the output tax portion of your periodic tax returns. This report lists the
taxable and tax amounts of all sales transactions and output tax for a given period to enable you to identify and review
your tax liability for various tax rate codes. All the transaction and output tax information is displayed at the detail or
summary level.

In the report, you can select to include:

• Only transactions that are posted to the General Ledger

• Only transactions that are not posted to the General Ledger

• Both types of transactions

The report groups information and provides totals by:

• Account

• Transaction class

• Company

Tax Reconciliation by Taxable Account Report

Use the Tax Reconciliation by Taxable Account Report to report on taxable transactions in Oracle Fusion Payables,
Oracle Fusion Receivables, and Oracle Fusion Tax Repository. This report lets you reconcile period-end taxable account
balances to tax amounts. Only accounted transactions are listed in this report.

The Tax Reconciliation by Taxable Account Report helps you:

• Prepare a tax return from a single source

• Reconcile period-end taxable account balances.

The summarization level options for the report are:

• Taxable account: Displays transactions by taxable account and tax rate code. The report prints totals for each
tax rate code within an account and for each account.

• Tax rate code: Displays transactions by tax rate code and taxable account. The report prints totals for each
account within a tax rate code and for each tax rate code.

Note:  The predefined template provides you with a report that orders transactions by tax rate code and taxable
account.

The accounting segment range provides you with the ability to report transactions with taxable lines posted on the
account within the segment range. Specify the currency to limit the report to only transactions in that currency.

Tax Audit Trail Report

Use the Tax Audit Trail Report to review tax information for posted or partially posted purchase transactions. All
transaction types are included by default, however you can select the type of transactions to report. For example, you
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can create a report that includes invoices but excludes prepayments and external tax transactions imported from the tax
repository.

The Tax Audit Trail Report provides the following details:

• Detail tax and invoice information, and the total amounts in the entered and ledger currencies.

• Distributions of all posted and partially posted invoices.

• Tax amounts and taxable amounts for each invoice.

You can order the information by invoice and tax rate code, and also group data by reporting period, tax code and tax
rate.

Report Parameters
The following table lists selected report parameters common to the tax reconciliation and audit reports:

Parameter Description

Reporting Level
 

Choose the level on which you want to run the report. You can choose from three different levels,
 Ledger, Legal Entity, and Tax Registration Number.
 

Reporting Context
 

Specify the context for the report. The list of values for this parameter depends on the reporting level
you selected.
 

• If you select the reporting level of Legal Entity, you select the legal entity on which to report, and
optionally select the tax registration number. By entering a tax registration number in the Tax
Registration Number parameter, you report only on a subset of transactions that are entered for
a specific legal reporting unit associated with the tax registration number.

Run the report for a tax registration number to report on the transactions entered for legal
entities that share the same tax registration number. This is also known as tax group registration.

• If you select Ledger as the reporting level, you can report on legal entities associated with ledgers
defined in the ledger set or data access set within your security profile. Run tax reports by ledger
when you want to review your tax activity as it aligns with your accounting.

Run tax reports by ledger when you need to view tax activity in a currency other than the
currency of the ledger or the currencies of the transactions.

Tax Registration Number
 

Enter a tax registration number that is assigned to the legal reporting unit, when the reporting level is
Legal Entity.
 

Tax Point Date
 

Include the transactions for the date range specified.
 
Tax point date is the date on which the taxpayer becomes liable for paying the tax to the tax authority.
 

Frequently Asked Questions
The following table lists frequently asked questions about the tax reconciliation reports and the audit report.

FAQ Answer

How do I find these reports? Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
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FAQ Answer

  

Who uses these reports?
 

• Tax manager

• Tax accountant

When do I use these reports?
 

Use the:
 

• Tax reconciliation reports for preparing your tax returns and reconciling with general ledger
postings.

• Tax audit report to review tax information for posted or partially posted purchase transactions.

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• Transaction Tax Report Features

Payables Tax Reconciliation with General Ledger Report  
This topic includes details about the Payables Tax Reconciliation with General Ledger Report.

Overview
Reconciliation between subledger taxable transactions and the accounting application is a common business and
legal requirement for companies with tax reporting obligations in countries such as Austria, Germany and Switzerland.
The Payables Tax Reconciliation with General Ledger Report reconciles tax transaction information for Oracle Fusion
Payables with account balances in Oracle Fusion General Ledger.

Key Insights
Before running the report, ensure that you validate, account, and post the Payables invoices to General Ledger.

Parameters
The following table lists the main parameters for the Payables Tax Reconciliation with General Ledger Reports:

Name Description

Reporting Level
 

Choose the level on which you want to run the report. You can choose from three different levels,
 Ledger, Legal Entity, and Tax Registration Number.
 

Reporting Context
 

Specify the context for the report. The list of values for this parameter depends on the reporting level
you selected.
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Name Description

• If you select the reporting level of Legal Entity, you select the legal entity on which to report, and
then select the tax registration number associated with the legal entity.

• If you select Ledger as the reporting level, you can report on legal entities associated with ledgers
defined in the data access set within your security profile. Run tax reports by ledger when you
want to review your tax activity as it aligns with your accounting. Run tax reports by ledger when
you need to view tax activity in reporting or secondary ledger currency.

• If you select tax registration number as the reporting level, you can report all the transactions
associated with different legal entities sharing the same tax registration number.

Tax Registration Number
 

Specify the tax registration number of the legal entity or legal reporting unit that is submitting the
declaration to the tax authority.
 

From and To Accounting Period
 

Select the accounting period range for which you want to reconcile transactions.
 

Account
 

Specify different conditions for account code combinations to filter transactions. For example, you can
view transactions only for tax account 01-1775-000-000, if the account codes are filtered so that they
are equal to the following values:
 

• Co=01

• Acct=1775

• Ctr=000

• Prod=000

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Tax Reconciliation with General Ledger Reports.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

• Tax Specialist

• Tax Administrator

When do I use this report?
 

Use this report to reconcile Payables tax transactions with the tax account balance in General Ledger,
 as required by the tax reporting legal requirements in your country.
 

What type of report is this?
 

Oracle Analytics Publisher
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Sales Tax Report  
This topic includes details about the Sales Tax Report.

Overview
The Sales Tax Report identifies taxable, exempt, and tax amounts for invoices entered in Oracle Fusion Receivables.
Data is printed and grouped by tax jurisdiction.

The following figure is an example of the report.

Key Insights
The Sales Tax Report is used only for the sales tax type and accrual basis reporting.

For adjustments to be reported correctly in the Sales Tax Report, tax jurisdictions must be associated with a
corresponding tax rate.

Report Parameters
The following table describes selected process parameters:

Parameter Description

Reporting Level
 

Choose the level on which you want to run the report. You can choose from three different levels,
 Ledger, Legal Entity, and Tax Registration Number.
 

Reporting Context
 

Specify the context for the report. The list of values for this parameter depends on the reporting level
you selected.
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Parameter Description

 
• If you select the reporting level of Legal Entity, you select the legal entity on which to report, and

optionally select the tax registration number. By entering a tax registration number in the Tax
Registration Number parameter, you report only on a subset of transactions that are entered for
a specific legal reporting unit associated with the tax registration number.

Run the report for a tax registration number to report on the transactions entered for legal
entities that share the same tax registration number. This is also known as tax group registration.

• If you select Ledger as the reporting level, you can report on legal entities associated with ledgers
defined in the ledger set or data access set within your security profile. Run tax reports by ledger
when you want to review your tax activity as it aligns with your accounting.

Run tax reports by ledger when you need to view tax activity in a currency other than the
currency of the ledger or the currencies of the transactions.

Tax Registration Number
 

Enter a tax registration number that is assigned to the legal reporting unit, when the reporting level is
Legal Entity.
 

Tax Point Date
 

Include the transactions for the date range specified.
 
Tax point date is the date on which the taxpayer becomes liable for paying the tax to the tax authority.
 

Transaction Date
 

Include the transactions for the date range specified. If you specify a transaction date range but
no accounting date range, your report will not balance to the General Ledger if the transaction and
accounting dates for a transaction fall in different periods.
 

State
 

Include the sales tax information for the state you specify.
 

Exemption Status
 

List transactions which refer to the exemptions with the given status. For example, you can find all
transactions using rejected exemptions by entering Rejected.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Sales Tax Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax manager

• Tax accountant

When do I use this report?
 

Use this report to review and report your state and local tax liabilities to the tax authorities.
 

What type of report is this?
 

Oracle Analytics Publisher
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Tax Box Allocation Reports  
This topic includes details about the tax box allocation reports.

Overview
The tax box allocation reports lists transaction that are allocated to tax boxes and those that are exceptions. You can use
these reports as a basis for preparing tax returns.

Tax box allocation reports include:

• Tax Allocations Listing Report: Lists transactions within a tax period and the tax boxes that the transactions are
allocated to. It enables you to list transactions within a specific document number range. The report lists tax-
related information and tax boxes assigned to recoverable and nonrecoverable amounts.

The following figure is an example of the report:

• Tax Allocation Exception Report: Lists the transactions that are not allocated to any tax box in the most recent
run of the Tax Allocation Process. It provides tax-related information for each transaction line.

The following figure is an example of the report:
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• Tax Box Return Preparation Report: Lists taxable and tax amounts grouped by tax declaration box numbers for
periodic or annual allocations. Use the report as a basis for preparation of tax returns.

The following figure is an example of the report:

Key Insights
Before running the tax box allocation reports, run the Tax Reporting Selection Process which is based on the Tax
Reporting Ledger.

Report Parameters
The following table lists some selected parameters used while generating these reports.

Parameter Description

Tax Calendar Period
 

Specify the tax period to be included for reporting tax.
 

Source
 

Indicate whether transactions with input tax, output tax, or both are reported.
 

Reallocate
 

Indicate whether to reallocate tax boxes for all matched transactions or for only not allocated or in error
tax transactions.
 

Report Periodicity
 

Indicate the type of tax box allocation rule used to determine whether the tax box rule is applied for
periodic tax returns or annual tax returns.
 

Tax Calendar Year
 

Select the reporting year for annual allocation amounts. You can also report transactions on an annual
basis.
 

Summarization Level
 

Use this option to view the report in one of the following formats: Detail, Summary, or Both.
 

The following table shows the combination of parameter values that are valid:
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Reporting Periodicity Tax Calendar Year Tax Calendar Period

Periodic
 

N/A
 

Period (example May 2017)
 

Annual
 

Year (example, 2017)
 

N/A
 

Frequently Asked Questions
The following table lists frequently asked questions about the tax allocation reports.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax manager

• Tax accountant

When do I use this report?
 

Use these reports to:
 

• Review that your transactions are being accurately allocated to tax boxes

• Report your tax liabilities to the tax authorities

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Tax Box Allocations

• Generate Tax Returns Based on Tax Box Allocation Rules

• Tax Reporting Ledger

Yearly Tax Report  
This topic includes details about the Yearly Tax Report.

Overview
Use the Yearly Tax Report to display detailed or summarized information about tax and taxable amounts within a year.
You can view information on both input and output tax for all finally reported tax periods within a year. All tax amounts
are reported in the ledger currency.

The Yearly Tax Report provides countries using the Tax Reporting Selection Process the capability to analyze the annual
subledgers and manual tax entry information.
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Only finalized transactions in closed periods are included in the report. Use the Tax Final Reporting Process to mark
transactions as final and close the tax calendar period.

You can print the report in the following levels:

• Detail: Prints detailed tax amounts and summarized tax amounts by month and year. Includes the following
sections:

◦ Detailed Tax Calendar Period

◦ Detailed Tax Calendar Year

◦ Summarized Tax Calendar Period

◦ Summarized Tax Calendar Year

• Summary: Prints summarized tax amounts by tax calendar period and tax calendar year.

The following figure is an example of the report.

Key Insights
The following table displays the tax categories used to group the report:

Tax Category Grouping Criteria

Declarable Output Tax
 

Transaction type name.
 

Declarable Input Tax
 

Document category name, recoverable taxable and tax amounts, and nonrecoverable taxable and tax
amounts.
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Tax Category Grouping Criteria

Manual Tax Entries
 

Manually entered transactions and transactions imported from external sources into the tax repository.
Includes the batch name, tax and taxable amounts. Debit tax amounts represent input tax, and credit
tax amounts represent output tax.
 

Within each tax category, you can also group according to other criteria, such as:

• Tax rate code

• Tax rate

• Tax type

Report Parameters
The following table lists selected parameters:

Parameter Description

Reporting Identifier
 

System generated reporting entity identifier assigned when the process Select Transactions for Tax
Reporting is run. The reporting entity identifier is built as a concatenation of the Reporting Level,
Legal Entity, Tax Regime, TRN and the Reporting Identifier ID (for example: LE:Vision Italy-1017:IT
VAT:IT12345670017:300100066356392).
 

Tax Calendar Year
 

Indicate the tax year for tax reporting and settlements.
 

Summarization Level
 

Specify the level of detail for reporting. You can print summary data or detailed data.
 

Report Heading
 

Specify the report header that must be printed on the report as a legal requirement.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Yearly Tax Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax manager

• Tax accountant

When do I use this report?
 

Use this report to analyze:
 

• Subledger tax information

• Manual tax entry information

What type of report is this? Oracle Analytics Publisher
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FAQ Answer

  

Related Topics
• How Tax Reporting is Processed
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8  Oracle Fusion Subledger Accounting
Reports

Oracle Fusion Subledger Accounting Predefined Reports 

Oracle Subledger Accounting provides accounting reports for fiscal and internal control purposes.

The reports are comprehensive from a financial standpoint and include the best source of information for each type of
journal entry. These reports can be used in lieu of the General Ledger-based journals and account analysis reports to
see detailed subledger journal entries as well as supporting transaction information.

Scheduled Processes work area

Reports can be scheduled and run from the Scheduled Processes work area found in Tools on the Navigator.

Reports and Analytics work area

In some cases, reports are also:

• These reports are available from the Reports and Analytics work area, found in Tools on the Navigator, or from
other work areas.

• Opened using links that deploy the business intelligence (BI) catalog.

The following table contains the primary predefined reports by type:

Account Analysis Reports

This table contains a listing of Subledger Accounting account analysis reports.

Display Name Description

Account Analysis Report
 

Provides drill down information about the movement on a particular account for a period or range of
periods. It only includes journal entries posted to general ledger.
 

Account Analysis by Legal Entity Report
 

Prints account balances by account combination and selected segments with subledger journal details,
including third-party information and sequences. Flexible grouping and sorting options are provided at
submission.
 

Journal Reports

This table contains a listing of Subledger Accounting journal reports.
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Display Name Description

Daily Journals Report
 

Lists subledger journal activity for a given period or date range, journal source, entered currency, and
journal batch. Report prints detailed subledger journal lines prior to general ledger summarization.
Third party and transaction details are also listed for the journal lines.
 

Journal Entries Report
 

Displays detailed information for subledger and general ledger journal entries. Groups report by ledger,
 journal source, journal category, and event class at submission.
 

Journal Ledger Report
 

Lists the accounting entries with subledger details like transaction number, transaction date, and line
description, using flexible sorting options that are provided at report submission. This report provides
a real audit trail between general ledger and subledgers to satisfy legal and business requirements.
 

Journals and Third Party Report
 

Prints all journals posted in Oracle Fusion General Ledger for the accounting period. The report
provides accounting and reporting sequence details, detailed subledger accounting entry lines
reporting level regardless of the ledger journals summarization. Assists in verifying that all journals
are accurately recorded in chronological order with no gaps. It uses legal sequencing rules for both
accounting entries and source documents.
 

Subledger Detail Journal Report
 

Displays information about the posted general ledger journal batches that originate from Oracle Fusion
Receivables and Oracle Fusion Payables subledgers. The report prints subledger details like transaction
number, transaction date, transaction amount in entered and ledger currency.
 

Other Subledger Accounting Reports

This table contains a listing of other Subledger Accounting reports.

Display Name Description

Accounting Event Diagnostic Report
 

Shows the transaction data used in accounting. The data is collected when the profile option SLA:
Enable Diagnostics is set and the Create Accounting process is run.
 

Subledger Accounting Method Setups
Report
 

Displays the accounting setups for a subledger application and accounting method.
 

Subledger Period Close Exceptions Report
 

Lists all accounting events and journal entries that fail period close validation. Groups report by ledger,
 period, journal source, journal category, and event class at submission.
 

To run predefined reports, navigate to the Scheduled Processes work area and follow these steps:

1. Click the Schedule New Process button
2. Search on the process name.
3. Enter your parameters.
4. Enter your process options and schedule.
5. Click Submit.
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SLA Account Analysis Report  
This topic includes details about how you can use the Account Analysis Report.

Overview
You can use the Account Analysis report to view information about the movement on a particular account for a period
or range of periods.

Here is a screenshot of an example of the Account Analysis Report.

Key Insights
In the Account Analysis report, you can view only the details of journal entries that are posted to the general ledger.

Report Parameters
Let's look at the parameters of the Account Analysis Report.

Name Description

Subledger Application
 

Specify the subledger application for which the report is run.
 

Ledger
 

Select a ledger that you have access to, either directly through a GL data access set, or through a
business unit, asset book, legal entity, or payroll security assignment.
 

From Accounting Period Indicate the beginning period for the report data.
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Name Description

  

To Accounting Period
 

Indicate the ending period for the report data.
 

Balance Type
 

Specify whether the balance type is actual or encumbrance amounts.
 

Encumbrance Type
 

If the balance type is Encumbrance, select the encumbrance type.
 

Include User Transaction Identifiers
 

Specify whether the user transaction identifiers are included in the report data.
 

Include Accounts With No Activity
 

Indicate whether the report should include accounts with no activity in the selected period.
 

Account Filter
 

Enter the filtering conditions on the account. You can select all segments for the selected ledger and
define conditions including account value ranges.
 

Frequently Asked Questions
This table contains frequently asked questions about the Account Analysis Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Accountant

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use this report to review detailed subledger journal entries as well as supporting transaction
information.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Account Analysis Reports

SLA Journal Entries Report  
This topic includes details about how you use the Journal Entries Report.
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Overview
You can use the Journal Entries Report to view header and line information for Subledger Accounting and General
Ledger journal entries.

Here is a screenshot of an example of the Journal Entries Report.

Key Insights
You can group the Journal Entries Report by ledger, journal source, journal category, and event class at submission.

Report Parameters
Let's look at the parameters of the Journal Entries Report.

Name Description

Journal Source
 

Select from a list of enabled journal sources mapped to an accounting generating subledger
application.
 

Ledger
 

Select a ledger that you have access to either directly through a GL data access set or through a
business unit, asset book, legal entity, or payroll security assignment.
 

Process Category
 

Specify the process category to report on a specific subledger process category, or leave blank to
include all of the process categories.
 

Journal Category
 

Specify the journal category to report on a specific subledger journal category, or leave blank to include
all of the journal categories.
 

From Accounting Period
 

Indicate the beginning period for the report data.
 

To Accounting Period
 

Indicate the ending period for the report data.
 

Balance Type
 

Indicate whether the balance type is actual or encumbrance amounts.
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Name Description

Encumbrance Type
 

If the balance type is Encumbrance, select the encumbrance type.
 

Journal Entry Status
 

Indicate whether the journal entries are in draft, final, or invalid status.
 

Transfer or Posting Status
 

Indicate whether the posting status is transferred but not posted, not transferred, or posted.
 

Include User Transaction Identifiers
 

Specify whether the user transaction identifiers are included in the report data.
 

Frequently Asked Questions
This table lists frequently asked questions about the Journal Entries Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Accountant

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use this report to review detailed information for Subledger Accounting and General Ledger journal
entries.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Journal Reports

Third-Party Control Account Balances Report  
This topic includes details about how you use the Third-Party Balances Report.

Overview
You can use the Third-Party Control Account Balances Report to review subledger accounting third-party control
account balances and activity for suppliers and customers.

Here is a screenshot of the Third-Party Control Account Balances Report.
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Key Insights
You can view these information in the Third-Party Control Account Balances Report:

• Third-party balances for subledger accounting third-party control accounts.

• Subledger journal entry lines that add up to the total period activity for each control account, third party, and
third-party site.

• Third party and third-party site information.

• User transaction identifiers for the associated entries.

Report Parameters
Let's look at the parameters of the Third-Party Control Account Balances Report.

Name Description

Journal Source
 

Select from a list of enabled journal sources mapped to an accounting generating subledger
application.
 

Ledger
 

Select a ledger.
 
You must have access to the ledger either directly through a GL Data Access Set or through a:
 

• Business unit

• Asset book

• Payroll security assignment

From Accounting Period Indicate the beginning period for the report data.
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Name Description

  

To Accounting Period
 

Indicate the ending period for the report data.
 

Third-Party Type
 

Select the type of third party defined for the subledger application for the journal source. Values are
Customer, Supplier, and All.
 

Third-Party Name
 

Select a customer or supplier based on the third party type.
 

Third-Party Site
 

Select a third-party site for the supplier or customer identified by third-party name.
 

From Third-Party Number
 

Indicate the beginning of the range of customer or supplier numbers based on the third party type.
 

To Third-Party Number
 

Indicate the ending of the range of customer or supplier numbers greater than or equal to the From
value.
 

Include User Transaction Identifier
 

Specify whether the user transaction identifiers are included in the report data.
 

Account Filter
 

Enter the filtering conditions on the account. You can select all segments for the selected ledger and
define conditions including account value ranges.
 

Frequently Asked Questions
These are some frequently asked questions about the Third-Party Control Account Balances Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Accountant

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use this report when you want to review subledger accounting third-party control account balances
and activity for suppliers and customers.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Third-Party Detail and Balances Reports

• Guidelines for Validating a Third-Party Control Account

• Accounting Attribute Assignments
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Accounting Event Diagnostic Report  
This topic includes details about how you can use the Accounting Event Diagnostic report.

Overview
In the Accounting Event Diagnostic report, you can view the transaction data used in accounting.

Here is a screenshot of a page in the Accounting Event Diagnostic Report.

Key Insights
The Accounting Event Diagnostic report includes data that's collected when the profile option SLA: Enable Diagnostics
is set and the Create Accounting process is run. This report shows transaction data that's used during a particular run of
the create accounting process.

Report Parameters
Let's look at the parameters of the Accounting Event Diagnostic report.

Name Description

Subledger Application
 

Specify the subledger application for which the report is run.
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Name Description

Ledger
 

Optional; limits the diagnostic data selected to those of a particular ledger.
 
Select a ledger that you have access to, either directly through a GL data access set or through a
business unit, asset book, legal entity, or payroll security assignment.
 

Event Class
 

Optional; limits the diagnostic data to the specified event class within the application.
 
List of values includes the event classes for the corresponding application.
 

Event Type
 

Optional; limits the diagnostic data to the specified event type within the event class.
 
List of values includes the event types of the current application, entity, and event class.
 
If no event class is selected, you can't enter a value. If the event type field is blank, all the event types
are selected.
 

Transaction Number
 

Optional; limits the diagnostic data retrieved to the specified transaction.
 

Event Number
 

Optional; limits the diagnostic data retrieved to the specified event.
 

From Distribution Line Number
 

Optional; displays the data for the transaction object lines that are equal to or higher than the number
specified.
 
To enable this field, you must enter a transaction number and an event number.
 
List of values includes all transaction object line numbers for the given event.
 

To Distribution Line Number
 

Optional; displays the data for the transaction object lines that are equal to or lower than the number
specified.
 
To enable this field, you must enter a transaction number and an event number.
 
List of values includes all transaction object line numbers for the given event.
 

Accounting Program Request ID
 

Optional; restricts the diagnostic data to the specified request ID.
 
List of values retrieves the request IDs stored in the diagnostic framework tables.
 

Errors Only
 

Required
 
If Yes is selected, displays the diagnostic framework data only for the events that meet the selection
criteria and whose status is Error. Default is No.
 

Display Source Name
 

Required
 
If Yes is selected, the source name is displayed. If No is selected, the source code is displayed. Default is
No.
 

Display Accounting Attributes
 

Required
 
If Yes is selected, the accounting attributes are displayed. Default is No.
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Frequently Asked Questions
Here are some frequently asked questions about the Accounting Event Diagnostic Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Accountant

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use this report to review the transaction data that's referenced during accounting through accounting
rules and ledger setup.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Diagnose Subledger Accounting Event Data

Subledger Accounting Method Setups Report  
This topic includes details about how you use the Subledger Accounting Methods Setup Report.

Overview
You can use the Subledger Accounting Methods Setup Report to view the accounting setups for a subledger application
and accounting method.

Here are some screenshots of the Subledger Accounting Methods Setups Report.
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Key Insights
You can filter the report to view accounting setups for a particular event class and event type within the accounting
method.

This report is useful to view the complete setup done for an accounting method as well as for audit purposes.

These are some details you can view in the Subledger Accounting Methods Setups Report:

• Accounting Method

• Journal Entry Rule Sets

• Header Description Rules

• Journal Line Rules

• Account Rules

• Line Description Rules
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Report Parameters
Let's look at the parameters of the Subledger Accounting Methods Setups Report.

Name Description

Accounting Method
 

Specifies the accounting method name.
 

Subledger Application
 

Specifies the subledger application for which the report is run.
 

Event Class
 

Specifies the event class assigned to the accounting method for journal entry rule set assignments.
 
Report shows all event class and event type assignments for the accounting method and subledger
application if this parameter is blank.
 

Event Type
 

Specifies the event type assigned to the accounting method for journal entry rule set assignments.
 
Report shows all event class and event type assignments for the accounting method and subledger
application if this parameter is blank.
 

Include Component Usage
 

Specifies whether the report includes the section to show where each component is used.
 

Frequently Asked Questions
These are some frequently asked questions about the Subledger Accounting Methods Setup Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Application Administrator or Implementor
 

When do I use this report?
 

Use this report to view the complete setup done for an accounting method as well as for audit
purposes.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Subledger Period Close Exception Report  
This topic includes details about how you use the Subledger Period Close Exception Report.
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Overview
You can use the Subledger Period Close Exception Report to view all accounting events and journal entries that fail
period close validation. When the Subledger Period Close Exception report is submitted for a primary ledger, it also
includes exceptions from associated subledger level secondary ledger.

Here is a screenshot of the report.

Key Insights
When you close an accounting period, the report is automatically submitted if there are unprocessed accounting events
or untransferred journal entries. You can also generate the Subledger Period Close Exceptions Report independently
through the Scheduled Processes work area.

Report Parameters
Let's look at the selected process parameters.

Name Description

Journal Source
 

Select from a list of enabled journal sources mapped to an accounting generating subledger
application.
 

Ledger or Ledger Set
 

Select a ledger that you have access to either directly through a GL data access set or through a
business unit, asset book, legal entity, or payroll security assignment.
 

Journal Category
 

Specify the process category if you want to report on a specific subledger process category, or leave it
blank if you want to include all the process categories.
 

Event Class
 

Specifies the data to the selected event class within the application. List of values includes the event
classes for the corresponding application.
 

From Accounting Period
 

Indicate the beginning period for the report data.
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Name Description

To Accounting Period
 

Indicate the ending period for the report data.
 

Frequently Asked Questions
These are some frequently asked questions about the Subledger Accounting Methods Setup Report.

FAQ Answer

How do I find this report?
 

This report is automatically submitted when closing an accounting period if there are unprocessed
accounting events or untransferred journal entries.
 
You can also schedule and run this report from the Scheduled Processes work area on the Navigator
menu.
 

Who uses this report?
 

• Financial Accountant

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use this report to review all accounting events and journal entries that fail period close validation.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Create Accounting Execution Report  
When you submit the Create Accounting process, the Create Accounting Execution Report is submitted automatically
if the Create Accounting process completes with a success or warning status. The Create Accounting process output
contains a message with the Create Accounting Execution Report request identifier.

Use this request identifier to retrieve the execution report output.

Create Accounting Execution Report
Besides the automatic generation, you can also generate the Create Accounting Execution Report using these criteria:

• Submit the Create Accounting process.

• Use the request identifier of the wanted Create Accounting process that was run previously by the same user.
However, no other Create Accounting process should have been run with the same criteria.
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Carry Forward Subledger Accounting Balances Process  
The Carry Forward Subledger Accounting Balances process will carry forward supporting reference balances and third-
party control account balances to the current period for a ledger. This process is automatically initiated when the
accounting period is newly opened.

Note:  The process can also be submitted manually if the initial process executed abnormally when the accounting
period was opened.

Parameters
Ledger

The list of ledgers is based on the business units, asset books or legal entities that a subledger user has access to. Only
the list of ledgers associated with those business units, asset books or legal entities is shown.

Accounting Period

All periods for the accounting calendar and period type associated with the selected ledger.

Related Topics
• Projected Balances

Diagnose Subledger Accounting Event Data  
You can use the diagnostic framework to know why the accounting was created in a particular way or why there are
errors.

The diagnostic framework stores data that is used in the creation of a journal entry so you can use the data to analyze
accounting issues. It provides the transaction data that is referenced during accounting through accounting rules
and ledger setup. Most errors occur because either the source system information or the accounting rules are not as
expected.

Here are some ways in which you can use the diagnostic framework.

• In the implementation phase, you can launch the Accounting Event Diagnostic report to review the source
values available in the transaction objects.

• On a daily basis, you can use the Accounting Event Diagnostic report to troubleshoot exceptions.

Diagnostic Framework Features
The diagnostic framework features are as follows:

• SLA: Diagnostic Enabled: This option controls whether diagnostic information is gathered by the Create
Accounting process. Use with caution. Selecting this option can cause slow performance.
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• Diagnostic Framework Execution: When the SLA: Diagnostic Enabled option is set to Yes, the diagnostic
framework is executed simultaneously with the Create Accounting process. The diagnostic framework data is
stored in the diagnostic tables.

• Accounting Event Diagnostic Report: To view the diagnostic framework report, users submit the Accounting
Event Diagnostic process with the appropriate report parameters.

• Purge Accounting Event Diagnostic Data: Purging is useful when accounting is successfully created so that the
volume of information in the report does not increase to a point where it becomes unusable.

Diagnostic framework data purged:

◦ When the data collected can be purged by running the process.

◦ When the administrator launches the Purge Accounting Event Diagnostic Data process.

Diagnostic Framework Business Process Flow
The following steps describe the diagnostic framework business process flow:

1. The administrator sets the SLA: Diagnostics Enabled option to Yes for the user or responsibility.
2. Users submit the Create Accounting process that automatically executes the diagnostic framework to populate

the diagnostic tables. The diagnostic framework gathers source values and other information from the
transaction objects.

3. Users submit the Accounting Event Diagnostic process to view the diagnostic report. Based on the information
in the diagnostic report, users may determine if additional or resubmission of information from source systems
is required. They may also determine if any updates to the accounting rules is required.

4. Users run the Create Accounting process again to generate subledger journal entries for events that had an
error.

5. The administrator submits the Purge Accounting Event Diagnostic Data process to purge the results of the
diagnostic framework.

Adjust Supporting Reference Initial Balances  
Supporting References provides you the flexibility to store and report on additional information about a subledger
journal at the journal line level.

You can choose to use supporting references with balances to record subledger balances for a source using a
combination of supporting references plus the chart of account combination.

The Import Supporting Reference Initial Balances spreadsheet lets you upload the initial balances for Supporting
References. The initial balance is the starting balance for a supporting reference in the context of an application, ledger,
and account combination.

Note:  When using the Manage Configuration Packages task to export or import setup data, initial balances that have
been imported into one environment aren't going to be migrated into another. You must import balances separately
into each environment you maintain.

Access the task from the Setup and Maintenance work area.

Initialize Supporting Reference Balances when no balances exist
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Let's say you already maintain a balance for certain dimensions in the legacy system which aren't available in Oracle
Fusion and want to bring in those balances when migrating to Oracle Fusion Cloud ERP. Let's assume supporting
reference balances are to be initialized against the supporting references - Account Number, Customer Category, Line
Type, Country Code, State Code as follows:

Ledger Subledger Period Account
Combination

Currency Balance
(Debit)

Balance
(Credit)

Account
Number

Customer
Category

Line Type Country
Code

State
Code

Vision
Operations
 

Payables
 

Jun-20
 

01-120-2210-0000-000
 

USD
 

12654
 

 76768
 

Gold
 

Goods
 

US
 

NY
 

Vision
Operations
 

Payables
 

Jun-20
 

01-120-2210-0000-000
 

USD
 

 2030
 

76576
 

Silver
 

Services
 

US
 

CA
 

You must navigate to the Adjust Supporting Reference Balances task and download the spreadsheet template. Use the
Adjust Supporting Reference Balances ADFdi spreadsheet to initialize supporting reference balances for the supporting
references - Account Number, Customer Category, Line Type, Country Code, State Code. The journal entry that gets
created in the background doesn't have supporting reference information for both sides that’s, the supporting reference
is NULL for the offsetting entry. In this example journal entries get created as follows:

Period Account
Combination

Entered
(Debit)

Entered
(Credit)

Currency Accounted
(Debit)

Accounted
(Credit)

ANALYTICAL_
BALANCE_
FLAG

SR1 SR2 SR3 SR4 SR5

6/20/2021
 

01-120-2210-0000-000
 

12654
 

 EUR
 

15050
 

 P
 

76768
 

Gold
 

Goods
 

US
 

NY
 

6/20/2021
 

01-120-2210-0000-000
 

 12654
 

EUR
 

 15050
 

      

6/20/2021
 

01-110-2240-0000-000
 

 2030
 

USD
 

 2030
 

P
 

76456
 

Silver
 

Services
 

US
 

CA
 

6/20/2021
 

01-110-2240-0000-000
 

2030
 

 USD
 

2030
 

       

The journal entries created for initializing the supporting reference balances are created in Final status but not
transferred to GL, if all validations are successful. If you don't want balances to be maintained in the entered currency
( XLA_ENABLE_ENTERED_CURR_BAL_SUPP_REF is disabled), the supporting reference balances table is updated as
follows on initialization:

LEDGER_
ID

APPL_ID PERIOD CCID PERIOD_
BALANCE_
DR

PERIOD_
BALANCE_
CR

SR1 SR2 SR3 SR4 SR5

1
 

200
 

6/20/2021
 

01-120-2210-0000-000
 

15050
 

 76768
 

Gold
 

Goods
 

US
 

NY
 

1
 

200
 

6/20/2021
 

01-110-2240-0000-000
 

 2030
 

76456
 

Silver
 

Services
 

US
 

CA
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If you maintain balances in the entered currency (XLA_ENABLE_ENTERED_CURR_BAL_SUPP_REF is enabled), the
supporting reference balances table is updated as follows on initialization:

LEDGER_
ID

APPL_
ID

PERIOD CCID PERIOD_
BALANCE_
DR

PERIOD_
BALANCE_
CR

PERIOD_
ENTERED_
BALANCE_
DR

PERIOD_
ENTERED_
BALANCE_
CR

ENTERED_
CURRENCY_
CODE

SR1 SR2 SR3 SR4 SR5

1
 

200
 

6/20/2021
 

01-120-2210-0000-000
 

15050
 

 12654
 

 EUR
 

12654
 

Gold
 

Goods
 

US
 

NY
 

1
 

200
 

6/20/2021
 

01-110-2240-0000-000
 

 2030
 

 2030
 

USD
 

76456
 

Silver
 

Services
 

US
 

CA
 

Adjust Supporting Reference Balances when balances exist

Let's say supporting reference balances already exist and you just want to adjust the balances. Assuming
supporting reference balances are existing for the following account and supporting reference combination in the
XLA_AC_BALANCES table and you want to do an upward adjustment of 200.00 USD.

LEDGER_
ID

APPL_ID PERIOD CCID PERIOD_
BALANCE_
DR

PERIOD_
BALANCE_
CR

SR1 SR2 SR3 SR4 SR5

1
 

200
 

6/20/2021
 

01-120-1210-0000-000
 

12354
 

 76768
 

Bronze
 

Goods
 

US
 

NY
 

Navigate to the Adjust Supporting Reference Balances task and downloads the spreadsheet template. Use the Adjust
Supporting Reference Balances ADFdi spreadsheet to update supporting reference balances.

Manual journal entry is created in the background having supporting reference information for one of the lines which
is used to adjust balances, supporting reference is NULL for the offsetting entry. In this example journal entries get
created as follows:

Period Account
Combination

Entered
(Debit)

Entered
(Credit)

Currency Accounted
(Debit)

Accounted
(Credit)

ANALYTICAL_
BALANCE_
FLAG

SR1 SR2 SR3 SR4 SR5

6/20/2021
 

01-120-1210-0000-000
 

200
 

 USD
 

200
 

 P
 

76768
 

Bronze
 

Goods
 

US
 

NY
 

6/20/2021
 

01-120-1210-0000-000
 

 200
 

USD
 

 200
 

      

The journal entries created for adjusting the supporting reference balances are created in Final status but not
transferred to GL, if all validations are successful. If you don't want balances to be maintained in the entered currency
(XLA_ENABLE_ENTERED_CURR_BAL_SUPP_REF is disabled), the supporting reference balances table is updated as
follows on initialization:
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LEDGER_
ID

APPL_ID PERIOD CCID PERIOD_
BALANCE_
DR

PERIOD_
BALANCE_
CR

SR1 SR2 SR3 SR4 SR5

1
 

200
 

6/20/2021
 

01-120-1210-0000-000
 

12554
 

 76768
 

Bronze
 

Goods
 

US
 

NY
 

Correct Supporting Reference Balances

Let's say the supporting reference balances have been entered for an incorrect supporting reference combination. You
would want to correct the balance so that it is represented against the correct supporting reference combination.

Assuming supporting reference balances exist for the following account and supporting reference combination in the
XLA_AC_BALANCES table:

LEDGER_ID APPL_ID PERIOD CCID PERIOD_BALANCE_DR PERIOD_BALANCE_CR SR1 SR3 SR4 SR5

1 200 Jun-21 01-120-1240-0000-00016200 76768 Goods US NY

It was observed that the supporting reference combination used above is incorrect since the value for the supporting
reference SR2 was not entered while entering or initializing the balances.

Navigate to the Adjust Supporting Reference Balances task and download the spreadsheet template. Use the Adjust
Supporting Reference Balances ADFdi spreadsheet to update supporting reference balances as follows:

LEDGER_ID APPL_ID PERIOD CCID ENTERED_BALANCE_DR ENTERED_BALANCE_CR SR1 SR2 SR3 SR4 SR5

1 200 Jun-21 01-120-1240-0000-000 16200 76768 Goods US NY

1 200 Jun-21 01-120-1240-0000-00016200 76768 Silver Goods US NY

In this case, two manual journal entries are created in the background with supporting reference information for one of
the lines, which is used to update the balances. The supporting reference is NULL for the offset entry.

Period Account
Combination

Entered
(Debit)

Entered
(Credit)

Currency Accounted
(Debit)

Accounted
(Credit)

ANALYTICAL_BALANCE_
FLAG

SR1 SR2 SR3 SR4 SR5

Jun-21 01-120-1240-0000-000 16200 USD 16200 P 76768 Goods US NY

Jun-21 01-120-1240-0000-00016200 USD 16200

Jun-21 01-120-1240-0000-00016200 USD 16200 P 76768 Silver Goods US NY

Jun-21 01-120-1240-0000-000 16200 USD 16200

The journal entries created for adjusting the supporting reference balances are created in Final status but
not transferred to GL if all validations succeed. If you don't want balances maintained in the entered currency
(XLA_ENABLE_ENTERED_CURR_BAL_SUPP_REF is disabled), the supporting reference balances table is updated as
follows on initialization:

LEDGER_ID APPL_ID PERIOD CCID PERIOD_BALANCE_DR PERIOD_BALANCE_CR SR1 SR2 SR3 SR4 SR5

1 200 Jun-21 01-120-1240-0000-00016200 16200 76768 Goods US NY
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1 200 Jun-21 01-120-1240-0000-00016200 76768 SilverGoods US NY

Related Topics
• Update Subledger Accounting Balances Process

Update Subledger Accounting Balances Process  
Use the Update Subledger Accounting Balances process (XLABABUP) to update subledger supporting reference
balances and third-party control account balances.

This process is run automatically following the Create Accounting process. It should be run manually if the auto run fails
for any reason.

Run the report from the Scheduled Processes page and optionally schedule the process to run periodically.

Note:  Draft entries do not update balances. To include accurate balances, transactions must be accounted in Final.

Parameters
Subledger Application

List of all user accessible accounting generating subledgers.

Ledger

The list of ledgers is based on the user accessible business units, asset books or legal entities. Only the list of ledgers
associated with those business units, asset books or legal entities is shown.

Related Topics
• Adjust Supporting Reference Initial Balances

Access the Create Multiperiod Accounting Execution
Report  
When you submit the Create Multiperiod Accounting process, the Create Multiperiod Accounting Execution Report is
automatically submitted. In this report, you can see entries created by the Create Multiperiod Accounting process.

Here is what you do to recreate a Create Multiperiod Accounting Execution Report.

• Submit the Create Multiperiod Accounting process.

• Use the same request identifier of the required Create Multiperiod Accounting process that was run previously
by the same user. Also, no other Create Multiperiod Accounting process should have been run with the same
criteria.
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To get the best performance, we recommend using the predefined version of the data model and report.

Here are the steps you need to take to remove any customizations already made to the Create Multiperiod Accounting
Execution Report::

1. Log in to BI Publisher Enterprise through the BI Publisher URL.
2. Locate /Shared Folders/Custom/Financials/Fusion Accounting Hub in the Folders pane.
3. Delete Create Multiperiod Accounting Execution Report from this folder.
4. Delete Create Multiperiod Accounting Data Model under/Shared Folders/Custom/Financials/Fusion

Accounting Hub/Data Models folder.

Related Topics
• Multiperiod Accounting

• Considerations for Multiperiod Accounting

• Example of Multiperiod Accounting

Use the Supporting References Report  
In this procedure, you create and view the supporting references report in OTBI (Oracle Transactional Business
Intelligence).

Create a Supporting References Report
Before you create a supporting reference report, you must ensure that supporting references are assigned to journal
lines in the journal entry rule set and then the accounting created .

1. From the Home page, click Navigator > Reports and Analytics.
2. Open the Create drop down.
3. Select Analysis.
4. Select Subject Area: Subledger Accounting - Supporting Reference Real Time.

a. In the Create Analysis region of the Select Columns page, expand the Subject Area.
b. Expand the folders and select the desired columns.

- Click the Add icon to move columns to the Selected Columns region.
- To rename columns, select the column row and click the Edit icon.
- Resequence columns by using the arrows.

This table contains column names used in the supporting references report.

Folder Column

Journal Source
 

Journal User Source Name
 

Ledger
 

Ledger Name
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Folder Column

Supporting Reference Balance
Details
 
 

Select the appropriate supporting references
 
Rename as wanted.
 

GL Account
 

Concatenated Segments
 

Ledger
 

Ledger Currency
 

Time
 
 

Accounting Period Name
 

Supporting Reference Balances
 

Period Balance Dr
 
Period Balance Cr
 

c. Click Next button.
5. On the Select Views page:

a. Enter the report Title.
b. Select Table option.
c. Click Next .
d. Click theNext button again to skip the Edit Table page.

6. On the Sort and Filter page:

a. Click Add Filter.
b. Select Ledger Name.
c. Select Operator 'is equal to'.
d. Enter wanted ledger name.
e. To add another filter. Click Add Filter.
f. Select Journal User Source Name.

g. Select Operator 'is equal to'.
h. Enter wanted journal user source name.
i. Click Submit.

7. On the Create Analysis page:

a. Enter Analysis Name.
b. In the Save In region, select My Folders.
c. Click Submit.
d. Click OK.
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View the Supporting References Report
View the supporting reference report from the navigation pane.

1. Expand the navigation pane.
2. Expand My Folders.
3. Click your report name.
4. Click View action.
5. The supporting reference balances report is displayed.

Note:  If you don't see any data, the balances may not yet be updated. In that case, you must run the Update
Subledger Accounting Balances process and then view again.

Related Topics
• Supporting References
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9  Oracle Fusion Payables Reports

Oracle Fusion Payables Predefined Reports  
Oracle Fusion Payables provides predefined reports that cover the following areas:

• Invoices

• Payments

• Payables to Ledger Reconciliation

• Period Close

• Prepayments

• Income Tax and Withholding

• Netting

You can schedule and run reports from the Scheduled Processes work area. Sometimes, you can access and open
reports in the Reports and Analytics work area.

The following tables list the predefined reports.

Invoices

Name Description

Import Payables Invoices Report
 

Report from the process that creates Payables invoices from invoice data in the open interface tables.
 

Payables Credit Memo Matching Report
 

Lists credit memos and debit memos for suppliers along with the invoices to which the credit memos
and debit memos are matched.
 

Payables Invoice Aging Report
 

Lists unpaid invoices according to the specified aging periods.
 

Supplier Balance Aging Report
 

List the unpaid supplier invoices according to the specified aging periods.
 

Payables Invoice Audit by Voucher Number
Listing
 

Lists invoices with assigned sequential voucher numbers.
 

Payables Invoice Audit Listing
 

Lists invoices for review and audit based on a specified amount for a given supplier and range of
invoice creation dates.
 

Payables Invoice Register
 

Provides detailed information about invoices.
 

Payables Key Indicators Report
 

Generates reports with transaction activity and the current number of suppliers, invoices, payments,
 and matching holds.
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Name Description

Payables Matched and Modified Receipts
Report
 

Identifies receipts that were modified after invoice matching.
 

Payables Matching Detail Report
 

Provides details of how an invoice, purchase order, or receipt was matched.
 

Payables Matching Hold Detail Report
 

Provides detailed payables and purchasing information for invoices with matching holds and matching
hold releases.
 

Payables Negative Supplier Balance Report
 

Lists suppliers with negative balances along with the invoices and credit or debit memo transactions
for the balance.
 

Payments

Name Description

Payables Cash Requirement Report
 

Forecasts immediate cash needs for invoice payments.
 

Payables Payment Requests Import Report
 

List the payment requests for invoices that are imported or rejected with rejection reasons for
payments.
 

Payables Discounts Taken and Lost Report
 

Identifies payments where a discount was taken and payments where a discount was available, but not
taken.
 

Payables Payment Register
 

Provides detailed information about payments.
 

Payables Selected Installments Report
 

Lists all invoice installments selected in a payment process request to help determine how well the
selection criteria is selecting the correct invoices to pay.
 

Payment Audit by Voucher Number Report
 

Lists payments with assigned sequential voucher numbers.
 

Update Matured Bills Payable Status
 

Report from the process that updates the status of matured bills payable from issued to negotiable.
 

Escheated Payments Listing Report Lists the escheated payments along with the suppliers' details.

Payables to Ledger Reconciliation

Name Description

Payables to Ledger Reconciliation Report
 

Lists the journals posted to the general ledger for open payables balances to facilitate the reconciliation
of accounting and transactional data recorded in Payables and Oracle Fusion Subledger Accounting.
 

138



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 9
Oracle Fusion Payables Reports

Period Close

Name Description

Payables Open Items Revaluation Report
 

Lists changes in the value of open items, such as unpaid invoices and credit memos, due to conversion
rate fluctuations.
 

Payables Period Close Exceptions Report
 

Lists exceptions that prevent the Payables accounting period from closing.
 

Payables Posted Invoice Register
 

Lists accounting lines for invoices that have been transferred to the general ledger.
 

Payables Posted Payment Register
 

Lists accounting lines for payments that have been transferred to the general ledger.
 

Payables Trial Balance Report
 

Lists and subtotals by supplier and liability account, all unpaid and partially paid invoices that Payables
transferred to the general ledger.
 

Payables Unaccounted Transactions and
Sweep Report
 

Lists invoices and payments that weren't accounted for a period or date range.
 

Prepayments

Name Description

Prepayment Remittance Notice
 

Lists prepayments that were applied to supplier invoices.
 

Income Tax and Withholding

Name Description

Payables Withholding Tax by Tax Authority
Report
 

Lists withholding for tax codes assigned to a tax authority.
 

Payables Withholding Tax Letter
 

Creates a withholding tax letter to mail to a supplier on a periodic basis. The letter contains a list of
withholding made for a supplier summarized either by tax type and tax rate, or by supplier site.
 

Payables Withholding Tax Report
 

Lists withholding for a supplier. The invoice view is used to review detailed withholding tax information
by invoice. The supplier view is used to review the withholding information for a range of suppliers.
 

Update and Report Income Tax Details
 

Report from the process that updates or reports income tax type or income tax region fields on invoice
distributions that are used for United States 1099 reporting.
 

US 1096 Report
 

Summarizes each United States1099 form type that's transmitted on paper, as required by the United
States Internal Revenue Service. Generates the summary on a preformatted Internal Revenue Service
form.
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Name Description

 

US 1099 Electronic Media Report
 

Generates summarized United States1099 information in electronic format, as required by the United
States Internal Revenue Service.
 

US 1099 Forms - Comma Delimited Format
 

Reports the total United States 1099 miscellaneous tax type payments for 1099 suppliers in a comma
delimited format.
 

US 1099 Invoice Exceptions Report
 

Lists paid invoice distributions with inaccurate or missing United States 1099 income tax information.
 

US 1099 Payments Report
 

Lists payments made to United States 1099 suppliers.
 

US 1099 Report
 

Reports the total United States 1099 miscellaneous payments for a particular 1099 supplier and
generates 1099 forms for each tax reporting entity in an organization.
 

US 1099 Supplier Exceptions Report
 

Lists suppliers with inaccurate or incomplete United States 1099 income tax information.
 

Netting

Name Description

Netting Settlement Letter
 

Prints a letter that detail Receivables and Payables transactions in a netting settlement.
 

Netting Reversal Letter
 

Prints a letter that detail Receivables and Payables transactions reversed in a netting settlement.
 

Netting Settlement Report
 

Lists the transactions netted for a specific netting settlement in the PDF format.
 

Netting Settlement Listing
 

Lists the transactions netted for a specific netting settlement in the spreadsheet format.
 

Related Topics
• Overview of Oracle Fusion Financials Reports and Analytics Work Area

Invoices  

Import Payables Invoices Report  
This topic includes details about the Import Payables Invoices Report.
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Overview
The Import Payables Invoices Report provides information from the Import Payables Invoices process, which creates
invoices from invoice data in the open interface tables.

The following figure is an example of the report.

Key Insights
The report provides the results of the import process with the list of invoices that imported successfully along with the
reasons that invoices may have failed to import.

Frequently Asked Questions
The following table lists frequently asked questions about the Import Payables Invoices Report.

FAQ Answer

How do I find this report?
 

The report is automatically generated by the Import Payables Invoices process, but you can also
schedule and run it from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Specialist
 

When do I use this report?
 

When you run the Import Payables Invoices process and want to review the results of the process.
 

What can I do with this report?
 

Review the report for invoices that couldn't be imported.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• How Payables Standard Invoice Import Data Is Processed
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Overview of Payables Credit Memo Matching Report  
This topic includes details about the Payables Credit Memo Matching Report.

The Payables Credit Memo Matching Report lists credit memos and debit memos for suppliers and the invoices to which
the credit memos and debit memos are matched.

The following figures provide an example of one page from the report.

Key Insights
The report lists credit memo and debit memo details at the invoice distribution level, and amounts in both the entered
and ledger currencies.
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Frequently Asked Questions
The following table lists frequently asked questions about the Payables Credit Memo Matching Report.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane navigate to Shared Folders > Financials > Payables > Invoices.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Periodically to check the credit memos and debit memos that were created for a supplier or group of
suppliers.
 

What can I do with this report?
 

Review credit memo and debit memo line information.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Payables Invoices - Transactions Real Time subject area.

Related Topics
• Payables Credit Memo Matching Report

Overview of Payables Invoice Aging Report  
This topic includes details about the Payables Invoice Aging Report.

The Payables Invoice Aging Report lists unpaid invoices according to specified aging periods.

The following figure is an example of the report.
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Key Insights
The report provides the break down of the accounts payable balance across aging buckets that you can configure.
Before running this report, create aging periods on the Create Aging Periods page and run the Apply Missing
Conversion Rates process to provide missing conversion rate information.

Note:  This report is populated with data only when run for the supplier with whom the customer has the primary
liability as a buyer. Any secondary relationship between the supplier and other parties isn't covered by this report. So,
the report has no data if run for any third-party names in the report parameters.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Invoice Aging Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Run the report to review the outstanding amounts due to a supplier, and for how long the invoice
installments have been due.
 

What can I do with this report?
 

You can run this report for a business unit, supplier, invoice type, and aging period. You also have
various sorting options and can specify whether to include invoice and supplier site details.
 

Note:
This report doesn't show any data if it's run for third-party payments.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Invoice Aging Report

Overview of Supplier Balance Aging Report  
This topic includes details about the Supplier Balance Aging Report.

The Supplier Balance Aging Report list the supplier invoices according to specified aging periods. The report provides
the breakdown of the accounts payable balance across aging buckets that you configure in the aging periods. If you use
multiple currencies, the report converts the invoice amounts to the ledger currency using the conversion rate provided
on the invoice.
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Note:  Before running this report, create the invoice aging periods on the Create Aging Periods page and run the
Create Accounting process with the option to transfer the balances to General Ledger.

The following image is an example of the report:

Key Insights
This report allows user to generate the Supplier Balance Aging Report for any specific date. The aging report considers
only those supplier invoices that are accounted and transferred to the General Ledger and as a result the balances in this
report match up with the trial balance report.

• This report has a column Unallocated Amount. Invoice amounts are displayed in this column based on specific
data scenarios listed in the following: The amount isn't within the range of the defined aging buckets for
payment due.

• The outstanding amount for the invoice and the installment don't match. This can happen when one of the
amounts is displayed as a positive amount and the other as a negative amount.

• The payment amount is greater than the invoice amount. This can happen when the invoice distributions have
different accounting dates and the invoice or installment has been paid in between the accounting dates.

Note:  You should review and take the necessary action to correct.

Frequently Asked Questions
The following table lists frequently asked questions about the Supplier Balance Aging Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Run the report to review the outstanding amounts due to a supplier, and for how long the invoice
installments have been due.
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FAQ Answer

 

What can I do with this report?
 

You can run this report for a business unit, supplier, invoice type, and aging period. You also have
various sorting options and can specify whether to include invoice and supplier site details.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Supplier Balance Aging Report

Overview of Payables Invoice Audit by Voucher Number Listing  
This topic includes details about the Payables Invoice Audit by Voucher Number Listing.

The Payables Invoice Audit by Voucher Number Listing lists invoices with assigned sequential voucher numbers.

The following figures provide an example of one page from the report.
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Key Insights
The report lists the invoices created for a document sequence and the missing voucher numbers for a particular
sequence.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Invoice Audit by Voucher Number Listing.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Invoices.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use the report to audit the invoices that were entered for a document sequence.
 

What can I do with this report?
 

You can run the report for a sequence with a specified range of voucher numbers.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Payables Invoices - Transactions Real Time subject area.

Related Topics
• Payables Invoice Audit by Voucher Number Listing
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Overview of Payables Invoice Audit Listing  
This topic includes details about the Payables Invoice Audit Listing.

The Payables Invoice Audit Listing lists invoices based on a specified amount, for a given supplier and range of invoice
creation dates.

The following figures provide an example of one page from the report.

Key Insights
The report helps identify invoices that may have been entered in the application more than once.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Invoice Audit Listing.
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FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Invoices.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Periodically to check that duplicate invoices weren't entered for the same supplier.
 

What can I do with this report?
 

• Review for duplicate invoices.

• Submit the report for invoices after a specific date, more than a specific amount, and for specific
invoice types.

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Payables Invoices - Transactions Real Time subject area.

Related Topics
• Payables Invoice Audit Listing

Overview of Payables Invoice Register  
This topic includes details about the Payables Invoice Register.

The Payables Invoice Register provides detailed information about invoices.

The following figures are an example of one page of the report from the Reports and Analytics pane.
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The following figure is an example of the report from the Scheduled Processes work area.

Key Insights
Use this report to cross-check invoices entered in the application with the physical invoices that were used to enter
those invoices.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Invoice Register.
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FAQ Answer

How do I find this report? Schedule and run this report from the Scheduled Processes work area on the Navigator menu, or from
the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Invoices.

Who uses this report? • Financial Manager

• Financial Specialist

When do I use this report? Daily to cross check invoice data entry in the application against the invoice on which the entry was
made.

What can I do with this report? Run the report for a specific invoice group, date range, accounting period. You can also specify an
invoice status, such as validated or canceled.

What type of report is this? Oracle Analytics Publisher and Oracle Transactional Business Intelligence

Related Subject Areas
This report uses the Payables Invoices - Transactions Real Time subject area.

Related Topics
• Payables Invoice Register

Overview of Payables Key Indicators Report  
This topic includes details about the Payables Key Indicators Report.

The Payables Key Indicators Report generates reports with transaction activity, and the current number of suppliers,
invoices, payments, and matching holds.

The following figure is an example of the report.

Key Insights
The report provides summary information for key indicators, such as the number of invoices and payments entered,
and the modifications made for those transactions during a period.
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Frequently Asked Questions
The following table list frequently asked questions about the Payables Key Indicators Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Periodically to get activity details for a period, such as the number of invoices created and percentage
of invoices modified. You can also review exceptions for invoices, payments, and reconciliation.
 

What can I do with this report?
 

• Run the report for a business unit and period.

• Specify whether to include invoice details.

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Key Indicators Report

Approval Groups Report  
This topic includes details about the Approval Groups Report.

Overview
You can now use the Approvals Group Report to view the approval groups defined in Oracle Business Process
Management (BPM). You can view the report output in both spreadsheet and XML format.

Key Insights
You can obtain the details of the group name, the approvers, and the sequence in which the approvers appear in the
approval group.

Report Parameters
There are no parameters that you need to select for this report.

Frequently Asked Questions

FAQ Answer

How do I find this report? Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
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FAQ Answer

  

Who uses this report?
 

Workflow Rules Administrator
 

When do I use this report?
 

Use this report to review approval groups defined in BPM.
 

What type of a report is this?
 

Spreadsheet, XML
 

Workflow Rules Report  
This topic includes details about the Workflow Rules Report.

Overview
You can now use the Workflow Rules Report to view and validate the workflow rules configured in Oracle Business
Process Management (BPM) for the following financial workflows.

• Automatic or Manual Credit Request Processing

• Bank Account Transfer Approval

• Bankruptcy Request Approval

• Cash Advance Approval

• Credit Request Approval

• Credit Request Approval Postprocessing Action

• Delegation of Corporate Card Transactions for Inactive Employees

• Expense Report Approval

• Hold Resolution

• Incomplete Invoice Hold

• Intercompany Transaction Approval

• Intercompany Transaction Distribution Entry

• Invoice Account Coding

• Invoice Approval

• Journal Approval

• Manually Entered Credit Request Completion

• Payment Approval

• Spend Authorization Approval

You can view the report output in both spreadsheet and XML format.
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Key Insights
You can use the report to validate the workflow rules configured in Oracle Business Process Management (BPM)
to meet recommended best practices. Wherever the rules deviate from best practices, you can use the suggested
recommendations to make the necessary corrections.

You can also use this report to obtain details of the stage, participant, rule status, rule conditions, and approval routing
for each rule.

Report Parameters

Parameter Description

Workflow
 

You can select the workflow for which you want to review the workflow rules.
 

Frequently Asked Questions

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Workflow Rules Administrator
 

When do I use this report?
 

Use this report to review existing workflow rules defined in BPM.
 

What type of a report is this?
 

Spreadsheet, XML
 

Overview of Payables Matched and Modified Receipts Report  
This topic includes details about the Payables Matched and Modified Receipts Report.

The Payables Matched and Modified Receipts Report identifies the receipts that were modified after invoice matching.

The following figure is an example of the report.
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Key Insights
The report lists the receipts that were modified after an invoice was created. Information in this report helps you take
further action, such as creating a debit memo if you returned some quantity of the receipt to the supplier.

Frequently Asked Questions
The following table list frequently asked questions about the Payables Matched and Modified Receipts Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Periodically for details of receipt numbers that were modified after an invoice was created.
 

What can I do with this report?
 

Run the report for a business unit and receipt date range. You can also run the report for a supplier and
supplier site.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Matched and Modified Receipts Report

Overview of Payables Matching Detail Report  
This topic includes details about the Payables Matching Detail Report.

The Payables Matching Detail Report provides details of how an invoice, purchase order, or receipt, was matched.

The following figure is an example of the report.
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Key Insights
The report provides details of transactions that were created against an invoice and its related documents, such as a
purchase order or receipt. For example, you can get the list of all the invoices that were matched against a purchase
order, or similarly the list of all the purchase orders against which an invoice was matched.

Frequently Asked Questions
The following table list frequently asked questions about the Payables Matching Detail Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

When you want to review details of how an invoice, or its related purchase orders or receipts, was
created.
 

What can I do with this report?
 

• Resolve matching errors and holds that may be placed on an invoice.

• Run this report for a specific transaction, and for all the transactions of a business unit.

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Matching Detail Report

Overview of Payables Matching Hold Detail Report  
This topic includes details about the Payables Matching Hold Detail Report.

The Payables Matching Hold Detail Report provides detailed payables and purchasing information for invoices with
matching holds and matching hold releases.

The following figure is an example of the report.
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Key Insights
The report lists the matching holds that were placed on an invoice, along with corresponding hold release details.
The report helps identify the list of suppliers who often send invoices outside the tolerance percentage, resulting in
matching holds. You can streamline your processes by contacting these suppliers and resolving the issues that cause
the matching holds.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Matching Hold Detail Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Run the report when you want to review the reasons that matched invoices went on hold.
 

What can I do with this report?
 

Use the report to identify suppliers that frequently have invoices on matching hold. You can run this
report for a supplier and for a data range.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Matching Hold Detail Report

Overview of Payables Negative Supplier Balance Report  
This topic includes details about the Payables Negative Supplier Balance Report.

The Payables Negative Supplier Balance Report lists suppliers with negative balances, and the invoices and credit or
debit memo transactions, for the balance.

The following figure is an example of the summary page from the report.
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The following figure is an example of the details page from the report.

Key Insights
The report helps identify the list of suppliers with negative balances.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Negative Supplier Balance Report.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Invoices.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Periodically to identify the list of suppliers with a negative closing balance.
 

What can I do with this report?
 

• Run this report for a business unit and liability account.

• This report provides information to help you take the appropriate action. For example, the
standard invoices for some suppliers might not have been entered, or advance payments were
made, but the supplier didn't send the invoice for the expenses incurred.

What type of report is this?
 

Oracle Transactional Business Intelligence
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Related Subject Areas
The summary section of the report uses the Payables Invoices - Trial Balance Real Time subject area. The detailed
section of the report uses the Payables Invoices - Transactions Real Time subject area.

Related Topics
• Payables Negative Supplier Balance Report

Payments  

Overview of Payables Cash Requirement Report  
This topic includes details about the Payables Cash Requirement Report.

The Payables Cash Requirement Report forecasts immediate cash needs for invoice payments.

The following figure is an example of the report.

Key Insights
The report identifies the cash required for making a payment in a payment batch.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Cash Requirement Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report? Before every payment process request to determine cash requirements for that request.

159

https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20032380


Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 9
Oracle Fusion Payables Reports

FAQ Answer

  

What can I do with this report?
 

• Use the information to configure multiple payment process request templates.

• Forecast cash requirements for a specific period, such as 30 days, by defining a payment process
request template with the applicable parameters.

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Cash Requirement Report

Overview of Payables Payment Requests Import Report  
This topic includes details about the Payables Payment Requests Import Report.

Overview
Use this report to view the payment requests imported or rejected with rejection reasons. This report is automatically
generated when you run the Import Payables Payment Request process. The report can be submitted in both summary
and detail versions.

The following image is an example of the report:

Key Insights
The report is divided into the following sections:
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Payables Payment Requests Audit Report

• List all imported payment request.

Payables Payment Request Rejections Report

• Party Rejections

• Address Rejections

• Bank Rejections

• Payment Requests Rejections

Frequently Asked Questions
The following table lists frequently asked questions about the Import Payables Payment Requests Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Run the report to review the request for payment.
 

What can I do with this report?
 

Review the payment request and rejections for payment.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Payment Requests Import Report

Overview of Payables Discounts Taken and Lost Report  
This topic includes details about the Payables Discounts Taken and Lost Report.

The Payables Discounts Taken and Lost Report identifies payments where a discount was taken and payments where a
discount was available, but not taken.

The following figures provide an example of one page of the report from the Reports and Analytics pane.
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The following figure is an example of the report from the Scheduled Processes work area.

Key Insights
View a summary of each payment line for a supplier site.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Invoice Register.

FAQ Answer

How do I find this report? Schedule and run this report from the Scheduled Processes work area on the Navigator menu, or from
the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Payments.
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FAQ Answer

Who uses this report? Financial Manager
 
Financial Specialist
 

When do I use this report? Periodically to check for available discounts and discounts that were lost.

What can I do with this report? Use the information to identify invoices with lost discounts and decide whether you can benefit from
taking these discounts.

What type of report is this? Oracle Analytics Publisher and Oracle Transactional Business Intelligence

Related Subject Areas
This report uses the following subject areas:

• Payables Invoices - Transactions Real Time

• Payables Payments - Disbursements Real Time

Related Topics
• Payables Discounts Taken and Lost Report

Overview of Payables Payment Register  
This topic includes details about the Payables Payment Register.

The Payables Payment Register provides detailed information about payments.

The following figure is an example of one page of the report from the Reports and Analytics pane.
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The following figure is an example of the report from the Scheduled Processes work area.

Key Insights
The report lists all of the payments made for a date range.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Payment Register.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu, or from
the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Payments.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Daily to cross reference the created payment checks with the report.
 

What can I do with this report?
 

Run the report for a specific supplier, date range, bank account, and payment currency.
 

What type of report is this?
 

Oracle Analytics Publisher and Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Payables Payments - Disbursements Real Time subject area.
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Related Topics
• Payables Payment Register

Overview of Payables Selected Installments Report  
This topic includes details about the Payables Selected Installments Report.

The Payables Selected Installments Report lists all the invoice installments that are selected in a payment process
request.

The following figure is an example of the report.

Key Insights
The report provides a total payment amount for each currency.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Selected Installments Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Whenever you submit a payment process request.
 

What can I do with this report?
 

Use the report to help determine how well the selection criteria is identifying the correct invoices to
pay.
 

What type of report is this?
 

Oracle Analytics Publisher
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Overview of Payment Audit by Voucher Number Report  
This topic contains details of the Payment Audit by Voucher Number Report.

The Payment Audit by Voucher Number Report lists payments by sequential voucher numbers.

The following figure is an example of the report.

Key Insights
The report helps identify the payments created for a document sequence and any missing voucher numbers for a
particular sequence.

Frequently Asked Questions
The following table lists frequently asked questions about the Payment Audit by Voucher Number Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

When you want to audit the payments that were entered for a document sequence.
 

What can I do with this report?
 

Run the report for a sequential range of voucher numbers.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payment Audit by Voucher Number Report

Overview of Update Matured Bills Payable Status Report  
This topic includes details about the Update Matured Bills Payable Status Report.
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The Update Matured Bills Payable Status Report provides information about the Update Matured Bills Payable process,
which updates the status of matured bills payables from issued to negotiable.

The following figure is an example of the report.

Key Insights
The report lists the payments that were issued along with the maturity date of each payment. The maturity date is
updated with every run. This lets you eliminate manual intervention for incrementing the date parameter before each
run.

Frequently Asked Questions
The following table lists frequently asked questions about the Update Matured Bills Payable Status Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

You can run this report periodically for information on payments that haven't matured yet.
 
Or, you can schedule this report to run regularly. The Auto Increment feature updates the maturity date
on a scheduled frequency.
 

What can I do with this report?
 

You can run this report for a bank account or supplier to identify the list of payments that were issued
and not negotiable.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• How Payment Statuses Change

Payables to Ledger Reconciliation  

Overview of Payables to Ledger Reconciliation Report  
This topic includes details about the Payables to Ledger Reconciliation Report.
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The Payables to Ledger Reconciliation Report lists the journals posted to the general ledger for open balances. The
report facilitates the reconciliation of accounting and transactional data recorded in Payables and Oracle Fusion
Subledger Accounting.

The following figure is an example of the report.

Key Insights
The interactive reporting capability of the Payables to Ledger Reconciliation Report provides both summarized and
detailed reconciling data for review. The Summary report lets you view payables and accounting beginning and ending
balances, summarized activity for the period, and how the activity was accounted.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables to Ledger Reconciliation Report.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Payables
to Ledger Reconciliation.
 

What are the pre-requisites for running
this report?
 

Run the Prepare Payables to General Ledger Reconciliation process from the Scheduled Processes work
area. This generates the data that's used for the Payables to Ledger Reconciliation report.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

During the Payables period close process.
 

What can I do with this report?
 

You can reconcile payables data to the general ledger.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Subledger Accounting - Payables Summary Reconciliation Real Time subject area.
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Related Topics
• Considerations for Setting Up for Payables to General Ledger Reconciliation

• Considerations For Payables to Ledger Reconciliation Report

• Prepare Payables to General Ledger Reconciliation

Considerations For Payables to Ledger Reconciliation Report  
Use the Payables to Ledger Reconciliation report to facilitate the reconciliation of payables data to the general ledger.
The interactive reporting capability of the Payables to Ledger Reconciliation report provides both summarized and
detailed reconciling data for review.

The summary shows payables and accounting beginning and ending balances, summarized activity for the period,
and how the activity was accounted. You can drill down on any amount in the summary Difference column to see the
Differences Detail report for that item. The Differences Detail report displays the real-time details that make up the
summary balance and indicates potential causes for differences between actual and reconciling amounts.

This report can only be run for the Primary ledger and for non-adjustment periods.

To view the report, you must select a ledger and request name, which is the name from the Prepare Payables to General
Ledger Reconciliation process.

Note:  For a more efficient reconciliation, don't allow general ledger sources other than Oracle Fusion Payables to post
to Payables accounts.

Consider these points when using the Payables to Ledger Reconciliation report.

• Differences Between Transactional and Accounted Amounts

• Differences Between Summary and Detail Amounts

• Differences Between the Reconciliation Report and Other Payables Reports

• Differences Due to Rounding

• Variances Due to Transactions not Validated

Differences Between Transactional and Accounted Amounts
Ideally the payables transactional amounts and the accounted amounts on the report summary should be the same.
The Payables Begin Balance accounting amount should agree with the Payables Trial Balance report for the last day of
the previous period. The Payables End Balance accounting amount should agree with the Payables Trial Balance report
for the last day of the period being reconciled.

Any differences that you find require further investigation and correction. Common reasons for differences between
transactional amounts and accounted amounts include:

• Transactions that aren't accounted.

• Transactions with subledger accounts that fall outside the account range of the report.

• Transaction amounts that don't agree with the subledger journal line amounts.

• Journals posted to the subledger or general ledger that didn't come from Payables.

• Subledger journals that aren't transferred or posted to general ledger.
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After finding and correcting discrepancies, you must rerun the Prepare Payables to General Ledger Reconciliation
process and review the reconciliation report summary.

Note:  The report summary may contain variance amounts if the Payables Begin Balance plus the period activity
differ from the Payables End Balance. This applies to both the Payables Amount and the Accounting Amount. If after
reviewing the data the variance can't be explained, contact the help desk.

Differences Between Summary and Detail Amounts
The Non-Payables Begin Balance on the report summary is that portion of the general ledger liability account beginning
balance that didn't originate from Payables transactions. You can drill down from the beginning balance amount to the
general ledger journal lines. The accounting date for the journal lines falls within the current fiscal year, but prior to the
period for the reconciliation report.

The source for these journal lines is typically not Payables. However, you may see manual subledger journal entries with
the Payables source entered directly in the subledger, but not necessarily linked to a Payables transaction. Most of these
entries represent adjustments.

Manual subledger journals created during the current reconciling period display on the report summary in the Other
Accounting amount. These journals become part of the Non-Payables Begin Balance amount in subsequent periods.
Manual general ledger journals that may affect payables accounts and are created directly in the general ledger display
in the Non-Payables Activity amount.

Summary amounts might not reflect totals on detail pages for one of the following reasons:

• Data was modified after the Prepare Payables to General Ledger Reconciliation process was run for a given
accounting period. For example, transactions or accounting was created between the time the process was run
and the moment you drill down from summary to detail.

Note:  Discrepancies might still exist if accounting activities occur in the subledger or general ledger after the Prepare
Payables to General Ledger Reconciliation process is run. Oracle recommends that you perform these accounting
activities prior to closing the Payables period and running the preparation process.

Tip:  To limit discrepancies between the summary and detail reports, set the Payables accounting period status to
Closed or Permanently Closed.

• Security rules in your setup may restrict you from viewing data from certain business units or segment values.
Oracle recommends that appropriate security be given to users for all business units and accounting flexfield
segment values that each user is responsible for reconciling.

• If you're downloading a large amount of data and plan to perform a number of data manipulations, use the CSV
format. If you're downloading data for reference purposes only, use the Excel format.

Differences Between the Reconciliation Report and Other Payables Reports
Data on the Payables to Ledger Reconciliation report might differ from the following Payables reports:

• Payables Aging Report, Payables Invoice Register, Payables Payment Register: You can't exclude intercompany
transactions from the aging report or the registers. If you run the reconciliation report and exclude
intercompany transactions, or show only intercompany transactions, then the reports display incompatible
data.
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• Payables Aging Report: The reconciliation report displays payables balances for the first and last date of a
period. You can run the aging report for the current date only.

Differences Due to Rounding
Fully paid invoices could have rounding differences. The sum of the entered amounts for the invoice distributions and
the sum of the entered amounts for the invoice payment might not match.

The total accounted amounts of the invoice and payment liabilities for a fully paid invoice always match. Rounding
differences between the original invoice liability amount and the sum of the payment liabilities are automatically written
off. The write-off occurs when the final payment, or prepayment application, is accounted.

However, because the payables amounts are taken from the invoice distributions and invoice payments, rounding
differences can appear on the report summary. These differences are included in the Payment Variance amount in the
Payables Amount column on the report summary.

Variances Due to Transactions not Validated
On the report summary, the Payables Begin Balance and Payables End Balance amounts include validated transactions
only. Unvalidated transactions are included in the Payables Variance amount. For the Invoice Approval and Invoice
Account Coding in-application notifications, use the 'Edit Distributions' option in the Actions menu to edit the
distributions.

Note:   Unvalidated transactions are transactions that are incomplete or that have validation issues, such as invalid
accounts or amount variances that must be corrected.

For example, if the current period has 200 USD of unvalidated invoice transactions, the report displays the following:

• Payables Begin Balance = 10,000 USD

• Invoices = 1,200 USD

• Payables Variance = 200 USD

• Payables End Balance = 11,000 USD

Note:  The Invoices Detail report includes unvalidated transactions, so you can review the report to identify the
unvalidated and unaccounted transactions.

Related Topics
• How can I report invoices for merged suppliers on the Payables to Ledger Reconciliation report?

• Considerations for Setting Up for Payables to General Ledger Reconciliation

• Why did the export download only some of the rows on the Payables to Ledger Reconciliation report drill-down
page?

• Prepare Payables to General Ledger Reconciliation
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Considerations for Setting Up for Payables to General Ledger
Reconciliation  
Periodically you reconcile the transactions in your accounts payable application, both before and after you post
to the general ledger. The Payables to General Ledger Reconciliation preparation process and report help simplify
reconciliation and reduce the amount of manual reconciling activity required.

The automated activities in the reconciliation process function according to your Oracle Fusion Financials setup. A
review of some of these setups can help improve the overall reconciliation process.

Consider these points when setting up the Oracle Fusion Payables to general ledger reconciliation.

• Reconciling by Business Unit or Ledger

• Assigning the Financial Category

• Setting the Reconciliation Data Purge Frequency Profile Option

• Configuring User Security

Reconciling by Business Unit or Ledger
If you implicitly map primary balancing segment values to business units, you can reconcile based on business unit.
Reconciling by business unit allows employees from different business units to balance their respective accounting
activity.

If you don't implicitly map primary balancing segment values to business units, you must reconcile based on ledger. In
this case, you must have access to all business units associated with the ledger to perform a thorough reconciliation.
You must also reconcile by ledger if you centralize payment processing using the service provider model.

Assigning the Financial Category
You must assign the financial category of Accounts Payable to all your liability natural account values. You perform
this task on the Manage Values page for the value set associated with the natural account segment of your chart of
accounts.

Note:  To include bills payable, intercompany, and tax authority liability accounts on the reconciliation report, you can
also assign them the Accounts Payable category.

After you assign the category, you can leave the Account parameter blank when you run the Prepare Payables to
General Ledger Reconciliation process. The process includes all accounts that have a financial category of Accounts
Payable in the ledger. Or you can enter specific natural account values to limit the report to reconciling only a subset of
the payables accounts in the ledger.

Note:  You must assign the category to a natural account in your chart of accounts to see information about the
Payables to Ledger Reconciliation report.

Note:  The Business Unit filter works with the Payables column and the Account filter works with the Accounting
column of the Payables dashboard.
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Setting the Reconciliation Data Purge Frequency Profile Option
Use the Reconciliation Data Purge Frequency profile option to specify the number of days to keep reconciliation data.
You might want to keep the data for comparison purposes.

When you run the Prepare Payables to General Ledger Reconciliation process, the process refers to the value of the
Reconciliation Data Purge Frequency profile option. Any reconciliation data requests older than the number of days
specified in the profile option are purged from the tables.

For example, you set the profile to 30 days and submit the preparation process on January 1. If you submit the process
again on January 29, the data isn't purged. However, the data is purged if you submit the process on February 1.

Configuring User Security
Typically General Ledger users are secured by data access sets. Data access sets use primary balancing segment values
to secure access to ledgers, ledger sets, and portions of ledgers. Payables users are secured by business units.

For the Payables to Ledger Reconciliation report:

• General Ledger users can see general ledger data for the balancing segment values in their data access set.
General Ledger users can also see the Payables or Oracle Fusion Subledger Accounting data for all business
units linked to the ledger.

• Payables users can see the Payables and Subledger Accounting data for business units in their security
definition. Payables users can also see general ledger data for all balancing segment values in the ledger.

The data roles for the General Ledger or Payables job roles can affect the reconciliation report. If data roles grant access
to specific business units for General Ledger users or specific data access sets for Payables users, the report only
includes:

• For General Ledger users, the Payables or Subledger Accounting data for those business units in the ledger to
which the user has access.

• For Payables users, general ledger data for those balancing segment values included in the data access set to
which the user has access.

If business units and balancing segment values are implicitly mapped, the report should work properly. Users can filter
the report for the balancing segment values that are mapped to the business units to which they've access.

If business units and balancing segment values aren't intentionally or implicitly mapped, the Payables to Ledger
Reconciliation report could display the following unintended results:

• For General Ledger users, the report includes general ledger data for all balancing segment values in the data
access set. Payables and Subledger Accounting data is limited to the business units to which a user is granted
access.

• For Payables users, one possible outcome is that the report doesn't include any general ledger data. Another
outcome is that the report includes general ledger data that isn't properly mapped to the Payables or Subledger
Accounting data for the business unit.

You can resolve this issue. Remove the access granted to specific business units for the General Ledger job roles, and
the specific data access sets for the Payables job roles.
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FAQs for Payables Reports  

How can I report invoices for merged suppliers on the Payables to Ledger
Reconciliation report?  
Set the Third-Party Merge Accounting option to Replace third party on the Manage Subledger Accounting Options
page. Otherwise, an accounting variance could appear on the Payables to Ledger Reconciliation report for journal lines
that are attributed to merged suppliers.

Why did the export download only some of the rows on the Payables to Ledger
Reconciliation report drill-down page?  
The export downloads only the rows that display on the page.

Consider an example where you can drill down Invoices page to 1,000 rows, but the page displays only 25 rows at a time.
In this scenario, the export to Excel downloads only 25 rows.

Oracle Transactional Business Intelligence has a setting that controls the number of rows that display on a page.
For more information on manually configuring settings for data in views, see the Oracle Fusion Middleware System
Administrator's Guide for Oracle Transactional Business Intelligence.

Period Close  

Overview of Payables Open Items Revaluation Report  
This topic includes details about the Payables Open Items Revaluation Report.

The Payables Open Items Revaluation Report lists changes in the value of open items, such as unpaid invoices and
credit memos, due to conversion rate fluctuations.

The following figure is an example of the report.

Key Insights
The report identifies the list of open invoices that may have to be adjusted for currency conversion rate differences.
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Frequently Asked Questions
The following table lists frequently asked questions about the Payables Open Items Revaluation Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Before the period close.
 

What can I do with this report?
 

Use the report to revalue open item balances.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Open Items Revaluation Report

Overview of Payables Period Close Exceptions Report  
This topic includes details about the Payables Period Close Exceptions Report.

The Payables Period Close Exceptions Report lists the exceptions that prevent the Payables accounting period from
closing.

The following figure is an example of the report.

Key Insights
The report provides details of the transactions that prevent the Payables period from closing.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Period Close Exceptions Report.

FAQ Answer

How do I find this report?
 

The Payables Period Close process automatically generates this report. You can also run the report
from the Scheduled Processes work area on the Navigator menu.
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FAQ Answer

 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

During the period close process.
 

What can I do with this report?
 

You can run this report to identify the transactions that prevent the period from closing. You also have
the option of sweeping the transactions to the next period.
 
Accounts Payable Manager and Supervisor can cancel unsubmitted and incomplete supplier portal
invoices when required.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Period Close Exceptions Report

• Considerations for Closing a Payables Period

Overview of Payables Posted Invoice Register  
This topic includes details about the Payables Posted Invoice Register.

The Payables Posted Invoice Register lists accounting lines for invoices that have been transferred to the general ledger.

The following figures are an example of one page from the report.
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Key Insights
The reports lists the invoices that were accounted for a period and is used as a part of period close activities.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Posted Invoice Register.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Period
Close.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

During the period close process.
 

What can I do with this report?
 

Use this report, along with the following reports, to reconcile balances between Oracle Fusion Payables
and your general ledger:
 

• Payables Posted Payment Register

• Payables Trial Balance Report

• Payables to Ledger Reconciliation Report

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the following subject areas:

• Payables Invoices - Transactions Real Time

• Payables Invoices - Prepayment Applications Real Time

Related Topics
• Payables Posted Invoice Register
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Overview of Payables Posted Payment Register  
This topic includes details about the Payables Posted Payment Register.

The Payables Posted Payments Register lists accounting lines for payments that have been transferred to the general
ledger.

The following figures provide an example of one page from the report.

Key Insights
The reports lists the payments that were accounted for a period and is used as a part of period close activities.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Posted Payment Register.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Period
Close.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

During the period close process.
 

What can I do with this report?
 

Use this report, along with the following reports, to reconcile balances between Oracle Fusion Payables
and your general ledger:
 

• Payables Posted Invoice Register
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FAQ Answer

• Payables Trial Balance Report

• Payables to Ledger Reconciliation Report

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Payables Payments - Disbursement Real Time subject area.

Related Topics
• Payables Posted Payment Register

Overview of Payables Trial Balance Report  
This topic includes details about the Payables Trial Balance Report.

The Payables Trial Balance Report lists and subtotals, by supplier and liability account, all unpaid and partially paid
invoices that Oracle Fusion Payables transferred to the general ledger.

The following figure is an example of the report.

Key Insights
The report identifies the accounts payable balance at period end and provides the invoice details that comprise that
balance.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Trial Balance Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
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FAQ Answer

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

During the period close process.
 

What can I do with this report?
 

Cross check the accounts payable liability balance with the accounts payable liability balance in the
general ledger.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Trial Balance Report

Overview of Payables Unaccounted Transactions and Sweep
Report  
This topic includes details about the Payables Unaccounted Transactions and Sweep Report.

The Payables Unaccounted Transactions and Sweep Report lists these transactions:

• Invoices and payments that weren't accounted for a period or date range.

• Incomplete supplier portal invoice not yet submitted by the supplier.

The following figure is an example of the report.

Key Insights
The report provides the option of sweeping the unaccounted transactions to the next period.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Unaccounted Transactions and Sweep Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report? Financial Manager
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FAQ Answer

  

When do I use this report?
 

During the period close process.
 

What can I do with this report?
 

• Identify and review all unaccounted invoice and payment transactions.

• Sweep unaccounted transactions to another period.

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Unaccounted Transactions and Sweep Report

Prepayments  

Overview of Prepayment Remittance Notice  
This topic includes details about the Prepayment Remittance Notice.

The Prepayment Remittance Notice lists prepayments that were applied to supplier invoices.

The following figure is an example of the report.

Key Insights
Identify the list of open prepayments per supplier and the amount remaining to be applied.

Frequently Asked Questions
The following table lists frequently asked questions about the Prepayment Remittance Notice.
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FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Periodically to get the list of prepayments that are already paid but for which there is no supplier
invoice, or the prepayment hasn't been applied to any standard invoice yet.
 

What can I do with this report?
 

Send it to the supplier as a reminder to send you any outstanding invoices that may be due against the
advance payments.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Prepayment Remittance Notice

Income Tax and Withholding  

Overview of Payables Withholding Tax by Tax Authority Report  
This topic includes details about the Payables Withholding Tax by Tax Authority Report.

The Payables Withholding Tax by Tax Authority Report lists withholding taxes for tax codes assigned to a tax authority.

The following figure is an example of the report.
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Key Insights
The report lists withholding tax information for withholding tax codes that have amounts withheld.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Withholding Tax by Tax Authority Report.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Income
Tax and Withholding.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Periodically, to identify withholding amounts for each withholding authority.
 

What can I do with this report?
 

• Review detailed withholding tax information for withholding tax codes assigned to a supplier with
a type of Tax Authority.

• Use the information to satisfy management, supplier, and tax authority reporting requirements.

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Payables Invoices - Transactions Real Time subject area.

Related Topics
• Payables Withholding Tax by Tax Authority Report

Overview of Payables Withholding Tax Letter  
This topic includes details about the Payables Withholding Tax Letter.

The Payables Withholding Tax Letter is a letter that you can mail to a supplier periodically. The letter contains a list of
withholding taxes made for the supplier summarized either by tax type and tax rate, or by supplier site

The following figure is an example of the report.
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Key Insights
The letter provides details of the withholding amounts for various withholding codes that were deducted for a period.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Withholding Tax Letter.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Periodically to send suppliers details of withheld taxes that were deducted for a period.
 

What can I do with this report?
 

You can run this report for an individual supplier, all suppliers, or for a supplier type. You can also
specify a date range for the withholding information.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Payables Withholding Tax Letter

Overview of Payables Withholding Tax Report  
This topic includes details about the Payables Withholding Tax Report.

The Payables Withholding Tax Report lists the taxes withheld for a supplier. The report has an invoice view and a
supplier view. The invoice view is used to review detailed withholding tax information by invoice. The supplier view is
used to review withholding information for a range of suppliers.

The following figures provide an example of one page from the report.
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Key Insights
The report lists the invoices that have withholding deductions.

Frequently Asked Questions
The following table lists frequently asked questions about the Payables Withholding Tax Report.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Payables > Income
Tax and Withholding.
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FAQ Answer

 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Periodically to get details of the withheld taxes that were deducted an invoice.
 

What can I do with this report?
 

• The default grouping for the report is by invoice, but you can also group the report by supplier.

• You can run the report for a supplier or supplier type, and a date range.

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Payables Invoices - Transactions Real Time subject area.

Related Topics
• Payables Withholding Tax Report

Update and Report Income Tax Details  
This topic includes details about the Update and Report Income Tax Details report.

Overview
The report updates or reports on income tax type or income tax region fields on invoice distributions for United States
(US) 1099 reporting.

The following figure is an example of the report.

Key Insights
The report updates existing invoice distributions with income tax type and income tax region information from the
supplier setup.

Frequently Asked Questions
The following table lists frequently asked questions about the Update and Report Income Tax Details report.
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FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Periodically to update the income tax details on invoice distributions that are used for US 1099
reporting.
 

What can I do with this report?
 

You can run this report to update income tax details using the supplier setup for US 1099 reporting.
Income tax details might not be available when an invoice is created so you can use this report to
update the data.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• How Income Tax Detail Updates Are Processed

Overview of US 1096 Report  
This topic includes details about the United States (US) 1096 Report.

The US 1096 Report summarizes each US 1099 form type that's transmitted on paper, as required by the US Internal
Revenue Service, and generates the summary on a preformatted Internal Revenue Service form.

The following figure is an example of the report.

Key Insights
Before running this report, you must run the US 1099 Report.
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Frequently Asked Questions
The following table lists frequently asked questions about the US 1096 Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Annually for US 1099 reporting.
 

What can I do with this report?
 

Send the report to the Internal Revenue Service.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• US 1096 Report

Overview of US 1099 Electronic Media Report  
This topic includes details about the United States (US) 1099 Electronic Media Report.

The US 1099 Electronic Media Report generates summarized US 1099 information in electronic format, as required by
the United States Internal Revenue Service.

The following figure is an example of the report.

Key Insights
Before running the report, account for the invoices.

Frequently Asked Questions
The following table lists frequently asked questions about the US 1099 Electronic Media Report.
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FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Annually for US 1099 reporting.
 

What can I do with this report?
 

Send the output to the Internal Revenue Service.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• US 1099 Electronic Media Report

Overview of US 1099 Forms (Comma Delimited Format)  
This topic includes details about the United States (US) 1099 Forms (Comma Delimited Format).

The US 1099 Forms (Comma Delimited Format) lists the total US 1099 miscellaneous tax type payments for US 1099
suppliers in a comma delimited format.

The following figure is an example of the report.

Key Insights
Before running the report, account for the invoices.

Frequently Asked Questions
The following table lists frequently asked questions about the US 1099 Forms (Comma Delimited Format).

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Annually for US 1099 reporting.
 

189

https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20032202


Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 9
Oracle Fusion Payables Reports

FAQ Answer

What can I do with this report?
 

Report on the total US 1099 miscellaneous payments for US 1099 suppliers.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• US 1099 Report

Overview of US 1099 Invoice Exceptions Report  
This topic includes details about the United States (US) 1099 Invoice Exceptions Report.

The US 1099 Invoice Exceptions Report lists paid invoice distributions with inaccurate or missing US 1099 income tax
information.

The following figure is an example of the report.

Key Insights
Before running this report, account for the invoices.

Frequently Asked Questions
The following table lists frequently asked questions about the US 1099 Invoice Exceptions Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report? Before submitting the US 1099 Report.
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FAQ Answer

  

What can I do with this report?
 

Identify invoice distributions that are exceptions to the US 1099 reports.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• US 1099 Invoice Exceptions Report

Overview of US 1099 Payments Report  
This topic includes details about the United States (US) 1099 Payments Report.

The US 1099 Payments Report lists payments made to US 1099 reportable suppliers.

The following figure is an example of the report.

Key Insights
Before running the report, account for the invoices.

Frequently Asked Questions
The following table lists frequently asked questions about the US 1099 Payments Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Annually for US 1099 reporting.
 

What can I do with this report?
 

Reconcile the report to the US 1099 forms or prepare additional reporting.
 

What type of report is this?
 

Oracle Analytics Publisher
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Related Topics
• US 1099 Payments Report

Overview of US 1099 Report  
This topic includes details about the United States (US) 1099 Report.

The US 1099 Report provides the total US 1099 miscellaneous payments (MISC) and nonemployee compensation
(NEC) for a US 1099 supplier and generates US 1099-MISC and US 1099-NEC forms for each tax reporting entity in an
organization.

The following figure is an example of the report.

Key Insights
The report includes payments for invoice distributions that have one of the following values in the Income Tax Type
field in the 1099 form:

1099-MISC 1099-NEC

MISC types 1 through 18 (except for MISC9) MISC7

Frequently Asked Questions
The following table lists frequently asked questions about the US 1099 Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report?
 

Annually for US 1099 reporting.
 

Note:
Your 1099 report only considers the payments for which the invoices are available in Payables.
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FAQ Answer

What can I do with this report?
 

• Report on the total US 1099 miscellaneous payments and nonemployee compensation for US
1099 suppliers.

• Generate US 1099-MISC and 1099-NEC forms on preformatted forms from the Internal Revenue
Service for each tax reporting entity in the organization.

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• US 1099 Report

Overview of US 1099 Supplier Exceptions Report  
This topic includes details about the United States (US) 1099 Supplier Exceptions Report.

The US 1099 Supplier Exceptions Report lists suppliers with inaccurate or incomplete US 1099 income tax information.

The following figure is an example of the report.

Key Insights
Before running this report, account for the invoices.

Frequently Asked Questions
The following table lists frequently asked questions about the US 1099 Supplier Exceptions Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial Manager
 

When do I use this report? Before submitting the US 1099 Report.
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FAQ Answer

  

What can I do with this report?
 

Review suppliers with inaccurate or incomplete US 1099 income tax information and correct them
before generating the US 1099 forms.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• US 1099 Supplier Exceptions Report

Netting Reports  

Netting Settlement Letter  
This topic contains summary information about the Netting Settlement Letter.

Overview
Select the Generate Netting Letter option for an agreement to receive a netting settlement letter for yourself and
your third party every time a settlement takes place. The netting letter generation process automatically runs when
the netting manager submits a settlement, or creates a settlement without review. You can access the report from the
Financial Reporting Center.

The netting settlement letter lists the following invoices and transactions:

• The Payables invoices that were netted, which includes the following parameters:

◦ Invoice Number

◦ Invoice Type

◦ Invoice Date

◦ Invoice Amount

◦ Netted Amount

◦ Invoice Currency

◦ Invoice Total

◦ Netted Total
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• The Receivables transactions that were netted, which includes the following parameters:

◦ Transaction Number

◦ Transaction Type

◦ Transaction Date

◦ Transaction Amount

◦ Netted Amount

◦ Transaction Currency

◦ Transaction Total

◦ Netted Total

The following figure of a netting settlement letter sample lists only the Payables transactions that were netted:

The following figure of a netting settlement letter sample lists only the Receivables transactions that were netted:
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Key Insights
The settlement process runs the report automatically, and sends the letter to your third party. You can view the letter
from the Financial Reporting Center.

Frequently Asked Questions
The following table lists frequently asked questions about the netting settlement letter.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu. You can
also select the Generate Netting Letter for your Netting Agreement, and download the letter from
the Financial Reporting Center when a settlement is settled.
 

Who uses this report?
 

Netting Manager.
 

When do I use this report?
 

Use this report when a netting settlement is settled.
 

What can I do with this report?
 

Run the report for a settlement for your legal entity. The report can be emailed to your trading partner
automatically. If the Send Letters by Email option is selected on the Agreement, an email of the
settlement letter is sent to the third party.
 

What type of reports are these?
 

Oracle Analytics Publisher.
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Netting Reversal Letter  
This topic contains summary information about the Netting Reversal Letter.

Overview
The Netting Reversal Letter runs automatically when the netting manager reverses a netting settlement after selecting
the Generate Netting Letter option for the agreement. You can access the report from the Financial Reporting Center.
The netting reversal letter is similar to the netting settlement letter but it indicates that the payments have been voided,
and the receipts have been reversed.

The following figure describes a sample netting reversal letter for Payables:
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Key Insights
The reversal process runs the report automatically, and sends the letter to your third party. You can view the letter from
the Financial Reporting Center.

Frequently Asked Questions
The following table lists frequently asked questions about the netting reversal letter.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu. You can
also select the Generate Netting Letter option for your Netting Agreement, and download the letter
from the Financial Reporting Center when a settlement is reversed.
 

Who uses this report?
 

Netting Manager.
 

When do I use this report?
 

Use this report when a netting settlement is reversed.
 

What can I do with this report?
 

Run the report for a settlement for your legal entity. The report can be automatically mailed to your
trading partner. If the Send Letters by Email option is selected for the Agreement, an email of the
settlement letter is sent to the third party.
 

What type of reports are these?
 

Oracle Analytics Publisher.
 

Netting Settlement Report  
This topic describes about the Netting Settlement report.

Overview
The Netting Settlement report is an internal report for the netting manager to review. The report automatically runs
when the netting manager submits a settlement, or creates a settlement without review. You can access this report from
the Financial Reporting Center.

The netting settlement report lists these netting information:

• Netting Agreement and Netting Settlement options that were valid at the point of settlement.

• Payables invoices that were netted.

• Receivables transactions that were netted.

This figure lists the parameters of a netting settlement report:
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Here's a sample netting settlement report for Payables transactions.
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Here's a sample netting settlement report for Receivables transactions.
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Key Insights
The settlement process runs the report automatically. You can view the report from the Financial Reporting Center.

Frequently Asked Questions
Here are few frequently asked questions about the Netting Settlement Report.

FAQ Answer

How do I find this report?
 

The Netting Settlement report runs automatically when a settlement is settled. You can also schedule
and run this report from the Scheduled Processes work area.
 

Who uses this report?
 

Netting Manager.
 

When do I use this report?
 

Use this report when a netting settlement is settled.
 

What can I do with this report?
 

Run the report for a settlement for your legal entity. You can then review the invoices and transactions
that were netted in the settlement.
 

What type of report is this?
 

Oracle Analytics Publisher.
 

Netting Settlement Listing  
This topic contains summary information about the Netting Settlement Listing.

Overview
The netting settlement listing is an internal report in the spreadsheet format, that netting managers can review. The
listing automatically runs when the netting manager submits a settlement or creates a settlement without review. You
can access the report from the Financial Reporting Center.
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The netting settlement listing consists of the following four sections:

• Title tab: Provides the title of the listing. The following image displays the title tab of a Netting Settlement
Listing:
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• Header tab: Lists Netting Agreement and Netting Settlement options that were valid at the point of settlement,
as displayed in the following image:
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• Payables Transactions tab: Lists the following parameters:

◦ Supplier Name

◦ Supplier Number

◦ Taxpayer ID

◦ Tax Registration Number

◦ Supplier Site

◦ Invoice Number

◦ Invoice Date

◦ Invoice Type

◦ Terms Date

◦ Amount

◦ Invoice Currency

◦ Open Amount: Indicates the open invoice amount before netting.

◦ Final Netting Amount: Indicates the amount of the invoice that was netted.

◦ Open Amount after Netting: Indicates the final open invoice amount after netting.

Note:  You can identify a partially netted as the invoice with a positive Open Amount after Netting
that is less than the Open Amount.

◦ Settlement Currency

The following figure illustrates a sample netting settlement listing for Payables:
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• Receivables Transactions Tab: Lists the following parameters:

◦ Customer Name

◦ Customer Number

◦ Taxpayer ID

◦ Tax Registration Number

◦ Customer Site

◦ Transaction Number

◦ Transaction Date

◦ Transaction Type

◦ Terms Date

◦ Amount

◦ Transaction Currency

◦ Open Amount: Indicates the open invoice before netting.

◦ Final Netting Amount: Indicates the amount of the invoice that was netted.

◦ Open Amount after Netting

◦ Settlement Currency

The following figure illustrates a sample netting settlement listing for Receivables:

Key Insights
The settlement process runs the report automatically, and you can download the listing from the Financial Reporting
Center.
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Frequently Asked Questions
The following table lists frequently asked questions about the netting settlement listing.

FAQ Answer

How do I find this report?
 

The Netting Settlement Listing runs automatically when a settlement is settled. You can also schedule
and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Netting Manager.
 

When do I use this report?
 

Use this report when a netting settlement is settled.
 

What can I do with this report?
 

Run the report for a settlement for your legal entity. You can review the invoices and transactions that
were netted in the settlement, and then perform analysis on the date in the spreadsheet.
 

What type of report is this?
 

Oracle Analytics Publisher.
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10  Oracle Fusion Payments Reports

Oracle Payments Predefined Reports  
Oracle Fusion Payments provides the following disbursement predefined reports:

• Disbursement Accompanying Letter Formats

• Disbursement Payment File Formats

• Disbursement Payment File Register Formats

• Disbursement Payment Process Request Status Report Formats

• Disbursement Positive Pay File Formats

• Disbursement Separate Remittance Advice Formats

Payments provides the following funds capture predefined reports:

• Funds Capture Accompanying Letter Formats

• Funds Capture Authorization and Settlement Formats

• Funds Capture Payer Notification Formats

All of the preceding reports are:

• Processes that result in a formatted file.

• Formatted using a specific template.

• Manually generated, if opted, using the Scheduled Processes page.

• Automatically generated, if opted, using setup pages.

Running Disbursement and Funds Capture Reports Manually
To manually run Payments reports, perform the following steps from the Scheduled Processes page using the Navigator
menu.

1. Click the Schedule New Process button.
2. Search on the Process Name.
3. Enter the applicable parameters.
4. Enter the applicable process options and schedule.
5. Click the Submit button.

Running Disbursement Reports Automatically
The following table lists disbursement reports with their corresponding processes that automatically run after you select
specific options on the applicable page. The applicable process is called internally. Any required parameter values are
known by Payments without your intervention.
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Name of Report and Process Report Description Options You Select for the
Automatic Process

Output

Report: Disbursement Payment File
Formats
 
Process: Create Printed Payment
Files
 
or
 
Process: Create Electronic Payment
Files
 

Groups payments into payment
files, and then validates, formats,
and prints the payment documents
(printed payment files) or transmits
(electronic payment files) the
payment to the payment system.
 

Location: Submit Payment Process
Request page.
 
Options to select:
 

• Create payment files
immediately check box.

• Provide a default payment
document and a payment
process profile.

Printed payment documents, such
as checks or promissory notes.
 
or
 
Electronic payment files.
 

Report: Disbursement
Accompanying Letter Formats
 
Process: Payment File
Accompanying Letter
 

Creates an accompanying letter for
a payment file that your company
either prints and mails to the bank,
 along with the payment file on a
disk or manually transmits to the
bank, along with the payment file.
 

Location: Create Payment Process
Profile page, Payment File tab.
 
Option to select: Payment File
Accompanying Letter format.
 

Document.
 

Report: Disbursement Positive Pay
File Formats
 
Process: Create Positive Pay File
 

Creates a document that your
company transmits to its payment
system or bank to inform it of
payments made by check.
 

Location: Create Payment Process
Profile page, Reporting tab,
 Positive Pay section.
 
Option to select: Automatically
transmit file check box.
 

Document.
 

Report: Disbursement Separate
Remittance Advice Formats
 
Process: Send Separate Remittance
Advice
 

Creates notices that can be faxed,
E-Mailed, or printed and mailed
to external payees that list the
invoices your company has
electronically paid to the external
payee's bank account.
 

Location: Create Payment Process
Profile page, Separate Remittance
Advice section.
 
Option to select: Automatically
submit when payments are
confirmed check box.
 

Document.
 

Report: Disbursement Payment File
Register Formats
 
Process: Payment File Register
 

Creates a report displaying the
contents of a payment file, which
your company keeps for its records.
 

Location: Create Payment Process
Profile page, Reporting tab,
 Payment File Register section.
 
Option to select: Automatically
submit when payments are
complete check box.
 

Document.
 

Report: Disbursement Payment
Process Request Status Report
Formats
 
Process: Payment Process Request
Status Report
 

Creates a report that displays the
contents and status of a payment
process request, which your
company reviews online or prints.
 

Location: Manage Disbursement
System Options page.
 
Option to select: Automatically
submit at payment process
request completion check box.
 

Document.
 

Running Funds Capture Reports Automatically
The following table lists funds capture reports with their corresponding processes that automatically run after you select
specific options on the applicable page. The applicable process is called internally. Any required parameter values are
known by Payments without your intervention.
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Name of Report and Process Report Description Options You Select for the
Automatic Process

Output

Report: Funds Capture
Authorization and Settlement
Formats
 
Process: Create Settlement Batches
 

Formats authorizations,
 settlements, and settlement
batches, groups settlements into
batches, and submits them to
payment systems.
 

Automatically runs.
 

Settlement batches.
 

Report: Funds Capture Payer
Notification Formats
 
Process: Send Receipt of Payment
Notifications
 

Creates payment notifications that
can be faxed, E-Mailed, or printed
and mailed to external payers after
the settlement or settlement batch
is transmitted to inform them of
a funds capture transaction that
will charge their credit card or bank
account.
 

Location: Create Funds Capture
Process Profile page, Formats tab,
 Payer Notification section.
 
Option to select: Automatically
submit at settlement check box.
 

Document.
 

Report: Funds Capture
Accompanying Letter Formats
 
Process: Settlement Batch
Accompanying Letter
 

Creates an accompanying letter for
a direct debit settlement batch file
that your company either prints
and mails to the bank, or manually
transmits to the bank, along with
the settlement batch file.
 

Location: Create Funds Capture
Process Profile page, Formats tab,
 Settlement section.
 
Option to select: Accompanying
Letter Format check box.
 

Document.
 

Payment Process Request Status Reports  
This topic includes details about the Payment Process Request Status report.

Overview
The Payment Process Request Status report is a predefined disbursement report that displays the details of all the
payments generated in a specific payment process request. You can use the report to verify the payments created in a
payment process request.

The following figure is an example of a 3-page Payment Process Request Status report.
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Key Insights
The following table lists the difference between the formal Payment Process Request Status report name and the
process name that you must use to generate the report on the Scheduled Processes page.

Report Name Process Name Output

Disbursement Payment Process Request Status
Report Formats.
 

Payment Process Request Status Report
 

PDF file.
 

Automatic Generation of the Payment Process Request Status Report
To automatically generate the Payment Process Request Status report, perform the following steps:

1. Navigate: Navigator > My Enterprise > Setup and Maintenance > Search: Tasks pane: Manage
Disbursement System Options > Go to Task > Manage Disbursement System Options page.

2. On the Manage Disbursement System Options page, Payment Process Request Status Report section, perform
these steps:

a. From the Format choice list, select Payment Process Request Status Report Format.
b. Select the Automatically submit at payment process request completion check box.

Manual Generation of the Payment Process Request Status Report
To manually generate the Payment Process Request Status report from within Oracle Fusion Payments, perform the
following steps:

1. Navigate: Navigator > Payables > Payments link.
2. In the Payments Tasks pane, click the Submit Payment Process Request link to open the Submit Payment

Process Request page.
3. Select the Payment and Processing Options tab.
4. In the Processing Options section, select the Create payment files immediately check box.
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5. Navigate: Navigator > Tools > Scheduled Processes link. The Scheduled Processes page appears.
6. Click the Schedule New Process button. The Schedule New Process dialog box appears.
7. From the Name choice list, select Payment Process Request Status Report. If you don't see Payment Process

Request Status Report in the choice list, click the Search link to display the Search and Select: Name dialog
box.

8. If you don't see Payment Process Request Status Report in the choice list, enter the following in the Name
field using headline capitals as shown here: Payment Process Request Status Report, and click Search.

9. Select the resulting row and click OK.
10. In the Schedule New Process dialog box, click OK. The Process Details dialog box appears.
11. Select the applicable parameters and click Submit. A confirmation message displays with a process ID.

Tip:  Write down or remember the process ID.

12. In the Process ID field on the Scheduled Processes page, enter the process ID and click Search.
13. Click the Refresh icon until the result displays in the Search Results section.
14. Select the resulting row in the Search Results section to display additional details on the Scheduled Processes

page.
15. In the Log and Output section, click the 1 more link to display the Attachments dialog box. You can now see the

<process ID> .PDF output file.

Report Parameters
The following table describes the process parameters.

Name Description

Payment Process Request
 

The payment process request for which the Payment Process Request Status report is generated.
 

Format
 

Name of the applicable format, which is Payment Process Request Status Report Format.
 

Frequently Asked Questions
The following table lists frequently asked questions and provides answers about the Payment Process Request Status
report.

FAQ Answer

How do I find this report?
 

You can find the Payment Process Request Status report by selecting the 1 more link in the Log and
Output section in the Search Results section on the Scheduled Processes page.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

The Payment Process Request Status report is used when you want to verify the payments created in a
payment process request.
 

What can I do with this report?
 

You can:
 

• Generate the Payment Process Request Status report.
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FAQ Answer

• Download the .PDF file and retain it for your records.

What type of report is this?
 

Oracle Analytics Publisher
 

Payment File Register Reports  
This topic includes details about the Payment File Register report.

Overview
The Payment File Register report is a predefined disbursement report that displays details of payments that are
included in a payment file. You can retain this report for your records.

The following figure illustrates an example of the Payment File Register report.

213



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 10
Oracle Fusion Payments Reports

Key Insights
The following table lists the difference between the formal Payment File Register report name and the process name
that you must use to manually generate the report on the Scheduled Processes page.

Report Name Process Name Output

Disbursement Payment File Register Formats
 

Payment File Register
 

.PDF file
 

Generation of the Payment File Register Report
To generate the Payment File Register report, perform the following steps:

1. Navigate: Navigator > My Enterprise > Setup and Maintenance > Search: Tasks pane: Manage Payment
Process Profiles > Go to Task > Manage Payment Process Profiles page > Create button.

2. On the Create Payment Process Profile page, Reporting tab, select the Automatically submit when payments
are confirmed check box.
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3. Navigate: Navigator > Tools > Scheduled Processes link. The Scheduled Processes page appears.
4. Click the Schedule New Process button. The Schedule New Process dialog box appears.
5. From the Name choice list, select Payment File Register. If you don't see Payment File Register in the choice

list, click the Search link to display the Search and Select: Name dialog box.
6. If you don't see Payment File Register in the choice list, enter the following in the Name field in headline

capitals as shown here: Payment File Register, and click Search.
7. Select the resulting row and click OK.
8. In the Schedule New Process dialog box, click OK. The Process Details dialog box appears.
9. From the Payment File choice list, select the applicable payment file.

10. From the Format choice list, select Payment File Register Format and click Submit. A confirmation message
displays with a process ID.

Tip:   Write down or remember the process ID.

11. In the Process ID field on the Scheduled Processes page, enter the process ID and click Search. The result
displays in the Search Results section

12. Select the resulting row in the Search Results section to display additional details on the page.
13. In the Log and Output section, click the 1 more link to display the Attachments dialog box. You can now see the

<process ID> .PDF output file.

Report Parameters
The following table describes the process parameters of the Payment File Register report.

Name Description

Payment File
 

Payment file for which you are generating the Payment File Register report.
 

Format
 

Name of the applicable payment format, which is Payment File Register Format.
 

Frequently Asked Questions
The following table lists frequently asked questions and provides answers about the Payment File Register report.

FAQ Answer

How do I find this report?
 

You can find the Payment File Register report by selecting the 1 more link in the Log and Output
section in the Search Results section on the Scheduled Processes page.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

The Payment File Register report is used when you want to retain a record of the payments in a
payment file.
 

What can I do with this report?
 

You can:
 

• Generate and schedule the Payment File Register report
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FAQ Answer

• Retain the Payment File Register report for your records

What type of report is this?
 

Oracle Analytics Publisher
 

Separate Remittance Advice Reports  
This topic includes details about the Separate Remittance Advice report.

Overview
The Separate Remittance Advice report is a predefined disbursement report that's faxed, emailed as a PDF attachment,
or printed and mailed to a supplier, which lists the invoices you paid.

This image illustrates an example of the Separate Remittance Advice report.

Key Insights
This table lists the distinction between the formal Separate Remittance Advice report name and the process name.

Report Name Process Name Output

Disbursement Separate Remittance Advice
Formats

Send Separate Remittance Advice Emailed as a PDF attachment or as HTML in the
body of the email
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Automatic Generation of the Separate Remittance Advice Report
To automatically generate the Separate Remittance Advice report, complete these steps:

1. In the Setup and Maintenance work area, select:

◦ Offering: Financials

◦ Functional Area: Payments

◦ Task: Manage Payment Process Profiles

2. On the Manage Payment Process Profiles page, click the Create icon.
3. On the Create Payment Process Profile page, Reporting tab, Separate Remittance Advice section, from the

Format choice list, select Separate Remittance Advice Format.
4. Select the Automatically submit when payments are confirmed check box.
5. Optionally, select a condition for which the Separate Remittance Advice report is generated.
6. Select how you want the Separate Remittance Advice report delivered to the supplier, whether by email, as a

PDF attachment to an email, faxed, or printed and sent by the postal service.

Specification of Delivery Method on Supplier Site
To specify the delivery method of the Separate Remittance Advice report on a supplier site, complete these steps:

1. Navigate to: Navigator > Procurement > Suppliers link > Manage Suppliers link > Search for applicable
supplier > Supplier link > Sites tab > Site link > Edit Site page.

2. Select the Payments tab.
3. Select the Payment Attributes tab.
4. Select the Separate Remittance Advice Delivery tab.

a. From the Remittance Advice Delivery Method choice list, optionally select Printed, Fax, Email, or Email
with PDF as attachment. The latter option lets you attach the Separate Remittance Advice report to an
email as a PDF attachment.

b. In the Remittance Advice Delivery Email ID field, you can enter single or multiple emails. If you enter
multiple emails, separate them by a comma.

Generation of the Separate Remittance Advice Report
To manually generate the Separate Remittance Advice report, complete these steps:

1. In the Setup and Maintenance work area, select:

◦ Offering: Financials

◦ Functional Area: Payments

◦ Task: Manage Payment Process Profiles

2. On the Manage Payment Process Profiles page, click the Create icon.
3. On the Create Payment Process Profile page, Reporting tab, Separate Remittance Advice section, from the

Format choice list, select Separate Remittance Advice Format.
4. Optionally, select the Allow multiple copies for payment file check box to generate multiple copies of the

Separate Remittance Advice report.
5. Optionally, select a condition for which the Separate Remittance Advice report is generated.
6. Select how you want the Separate Remittance Advice report delivered to the supplier, whether by email, as a

PDF attachment to an email, faxed, or printed and sent by the postal service. A separate PDF output is available
only when the delivery method is Printed.

7. Navigate to: Navigator > Payables > Payments.
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8. In the Tasks pane, click the Send Separate Remittance Advice link. The parameters page for the Separate
Remittance Advice report appears.

9. Select applicable parameters from the choice lists and click Submit. A confirmation message displays with a
process ID.

Note:  Write down or remember the process ID.

10. Navigate to: Navigator > Tools > Scheduled Processes.
11. In the Process ID field on the Scheduled Processes page, enter the process ID and click Search. The result

displays in the Search Results section.
12. Select the resulting row in the Search Results section to display other details on the page.
13. In the Log and Output section, click the 1 more link to display the Attachments dialog box.

Note:  If you selected Printed as the delivery method, you'll see the <process ID> PDF as a separate output
file. No PDF output appears if you selected Fax, Email, or Email with PDF as attachment as the delivery
method.

Report Parameters
The following table describes the process parameters.

Name Description

Payment File Payment file for which you're generating the Separate Remittance Advice report.

Format Choice list that provides all formats defined as Separate Remittance Advice Format or as Separate
Remittance Advice Report that you can use to generate the report.

Payment Reference From Payment reference number generated by Payments, which identifies the starting payment within the
payment file.

Payment Reference To Payment reference number generated by Payments, which identifies the ending payment within the
payment file.

Frequently Asked Questions
The following table lists frequently asked questions and provides answers about the Separate Remittance Advice report.

FAQ Answer

How do I find this report? You can find the Separate Remittance Advice report by selecting the 1 more link in the Log and Output
section in the Search Results section on the Scheduled Processes page. Output availability depends on
the delivery method selected.

Who uses this report? • Financial Manager

• Financial Specialist

When do I use this report? The Separate Remittance Advice report is used when you make payments to a supplier, whether by
check or electronically.

What can I do with this report? You can:
 

• Generate the Separate Remittance Advice report.
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FAQ Answer

• Send the Separate Remittance Advice report to suppliers by email, postal service, or fax.

What type of report is this? Oracle Analytics Publisher

Related Topics
• How a Separate Remittance Advice Report Is Processed

• Payment Process Profiles

Positive Pay Reports  
This topic includes details about the Positive Pay report.

Overview
The Positive Pay report is a predefined disbursement report that lists checks issued by your organization with their
corresponding payee names, amounts, and currency. Since the report is included in the electronic transmission to your
payment system or bank, it prevents the payment of fraudulent checks, since unauthorized payments aren't listed on
the Positive Pay report.

The following figure is an example of a Positive Pay report.

Key Insights
The following table lists the difference between the formal Positive Pay report name and the process name.

Report Name Process Name Output

Disbursement Positive Pay File Formats
 

Create Positive Pay File
 

Document
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Prerequisites for Positive Pay Report Generation
Before you can generate a Positive Pay report, you must complete these prerequisite steps:

1. Create a payment process profile.

a. In the Setup and Maintenance work area, select:

i. Offering: Financials
ii. Functional Area: Payments

iii. Task: Manage Payment Process Profiles
b. On the Manage Payment Process Profiles page, click the Create icon.

i. On the Create Payment Process Profile page, enter values on the Usage Rules tab.
ii. On the Payment System tab, configure a payment system account by entering values in these

fields:

a. Payment System Account
b. Configuration Profile
c. Payment File Transmission Configuration
d. From Date and To Date
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2. Create a transmission configuration.

a. In the Setup and Maintenance work area, select:

i. Offering: Financials
ii. Functional Area: Payments

iii. Task: Manage Transmission Configurations
b. On the Manage Transmission Configurations page from the Select Protocol choice list, select a protocol

and click Create.
c. On the Create Transmission Configurations page, enter any of these dynamic naming attributes in the

Value field for the Sent File Name parameter:

i. &REQUESTID

Request ID refers to the process ID of the Create Positive Pay File process
ii. &DATE

Date is displayed in YYYYMMDD format.
iii. &TIME

Time is displayed in HHMMSS format.

For example, if you specify dynamic naming for the transmitted file as &REQUESTID_&DATE_&TIME,
then for a process ID of 123456 run on October 20, 2019 at 09:10:45, the file name of the transmitted file
is 123456_20191020_091045.

Note:  The dynamic naming attributes in the Value field for the Sent File Name parameter on the
transmission configuration is honored only when you don't specify a file prefix or a file extension, or
both on the payment process profile. If naming attributes are specified at both the payment process
profile and the transmission configuration, the setup at the payment process profile always takes
precedence.

d. On the Create Transmission Configuration page, you can use a static naming convention to name the
transmitted positive pay files. Enter any of the following combinations in the Sent File Name parameter:

i. A static naming attribute
ii. One or more dynamic naming attributes

iii. A combination of a static naming attribute and one or more dynamic naming attributes

Note:  If no naming convention is specified, then the default file extension is REQUESTID.file extension.
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Automatically Generate a Positive Pay Report
To automatically generate a positive pay report, complete this step:

1. On the Create Payment Process Profile page, Reporting tab, select the Automatically transmit file check box
to automatically run the positive pay report as part of the payment process request submission process.

Note:  Performing this step results in automatic generation of the Positive Pay report when you use this
payment process profile in a payment process request. However, when you use the payment process
profile to create a single payment, the Positive Pay report isn't generated automatically and you will need to
manually generate it.

Manually Generate a Positive Pay Report
To manually generate a positive pay report, complete these steps:

1. Navigate: Navigator > Payables > Payments.

a. In the Tasks pane, click the Create Positive Pay File link. The parameters page for the Positive Pay report
appears.

b. Select the applicable parameters from the choice lists and click Submit. A confirmation message displays
with a process ID.

Tip:  Write down or remember the process ID.

2. Navigate: Navigator > Tools > Scheduled Processes link.

a. In the Process ID field on the Overview page, enter the process ID that you wrote down in Step 1b and
click Search. The result displays in the Search Results section.

b. Select the resulting row in the Search Results section to display additional details on the page.
c. In the Log and Output section, click the 1 more link to display the Attachments dialog box. You can now

see the <process ID> .PDF output file.

Report Parameters
The following table describes the process parameters.

Name Description

Payment Process Profile
 

Payment process profile used to process the payments.
 

From Payment Date
 

Starting date within a date range of payments.
 

To Payment Date
 

Ending date within a date range of payments.
 

Allow Sending Replacement Copy
 

The inclusion of payments in the Positive Pay report that were included in a previous report if, for
example, the eText file was misplaced and your payment system or bank requests a duplicate copy of
the Positive Pay report.
 

Select Status Inclusion of one of the following in the Positive Pay report file:
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Name Description

  
• Only negotiable payments

•
Only payments that have been voided

• All payments

Transmit File
 

When set to Yes, transmits positive pay files that are generated using the Create Positive Pay File
process. Ensure that the following setup is completed:
 

• Specify a valid payment system account in the Payment System tab of the payment process
profile.

• Select a value from the Payment File Transmission Configuration choice list in the Payment
System tab of the payment process profile.

Frequently Asked Questions
The following table lists frequently asked questions and provides answers about the Positive Pay report.

FAQ Answer

How do I find this report?
 

You can find the Positive Pay report by selecting the 1 more link in the Log and Output section in the
Search Results section on the Scheduled Processes page.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

The positive pay report is used when you print checks and you want to send a report of check
numbers, dates, and amounts of all issued checks to your bank or payment system as a means to
detect and prevent fraud. Checks that have their payment amounts altered or that are derived from
stolen check stock are identified by the bank.
 

What can I do with this report?
 

You can:
 

• Generate the Positive Pay report

• Automatically generate and transmit the Positive Pay report to your payment system or bank
during payment processing.

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• How a Positive Pay File Is Generated
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Disbursement Accompanying Letters  
This topic includes details about the Disbursement Accompanying Letter.

Overview
The Disbursement Accompanying Letter is a predefined disbursement report that is sent to your payment system or
bank. The report accompanies a payment file and summarizes its contents.

The following figure is an example of the Disbursement Accompanying Letter report.
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Key Insights
The following table shows you the difference between the formal Disbursement Accompanying Letter report name and
the process name.

Report Name Process Name Output

Disbursement Accompanying Letter Formats
 

Create Payment File Accompanying Letter
 

.PDF file
 

Generation of the Disbursement Accompanying Letter Report
To generate the Disbursement Accompanying Letter report from within Oracle Fusion Payments, perform the following
steps:

1. Navigate: Navigator > Payables > Payments link.
2. In the Payments Tasks pane, click the Payment File Accompanying Letter link. The parameters page for the

Create Payment File Accompanying Letter appears.
3. From the Payment File choice list, select a payment file and click Submit. A confirmation message displays

with a process ID.

Tip:  Write down or remember the process ID

4. Navigate: Navigator > Tools > Scheduled Processes link.
5. In the Process ID field on the Scheduled Processes page, enter the process ID and click Search
6. Click the Refresh icon until the result displays in the Search Results section.
7. Select the resulting row in the Search Results section to display additional details on the Scheduled Processes

page.
8. In the Log and Output section, click the 1 more link to display the Attachments dialog box. You can now see the

<process ID> .PDF output file.

Report Parameters
The following table describes the process parameter:

Name Description

Payment File
 

Payment file for which you are creating the Disbursement Accompanying Letter
 

Frequently Asked Questions
The following table lists frequently asked questions about the Disbursement Accompanying Letter.

FAQ Answer

How do I find this report?
 

You can find this report by selecting the 1 more link in the Log and Output section in the Search
Results section on the Scheduled Processes page.
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FAQ Answer

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

The Disbursement Accompanying Letter is used when you want to:
 

• Summarize the contents of the payment file.

• Manually send the summary and the payment file to the payment system or bank.

What can I do with this report?
 

You can:
 

• Generate and schedule the Disbursement Accompanying Letter

• Print and mail the Disbursement Accompanying Letter to the payment system or bank, along with
the payment file on a disk.

What type of report is this?
 

Oracle Analytics Publisher
 

Funds Capture Payer Notification Reports  
This topic includes details about the Funds Capture Payer Notification report.

Overview
The Funds Capture Payer Notification report is a predefined funds capture report that can be faxed, emailed as a PDF
attachment, printed, or mailed to customers after a settlement or settlement batch is transmitted to your payment
system or bank. The report informs customers of a funds capture transaction that will charge their credit card or bank
account.

This image illustrates an example of the Funds Capture Payer Notification report.
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Key Insights
This table lists the the formal Funds Capture Payer Notification report name and the process name that's used to
manually generate the report.

Report Name Process Name Output

Funds Capture Payer Notification Formats
 

Send Receipt of Payment Notifications
 

PDF file if the delivery option is Printed,
 emailed as a PDF attachment if the delivery
option is Email with .pdf as attachment, faxed
if the delivery option is Fax, or as HTML in the
body of the email if the delivery option is Email.
 

Email Delivery of the Funds Capture Payer Notification Report
To enable customers to receive the Funds Capture Payer Notification report by email, complete these steps:

1. In the Setup and Maintenance work area, select:

◦ Offering: Financials

◦ Functional Area: Customer Payments

◦ Task: Manage Funds Capture Process Profiles

2. On the Manage Funds Capture Process Profiles, from the Select Processing Type choice list, select a processing
type.

3. Click Create.
4. On the Funds Capture Process Profile page, Formats tab, Notification to Payer section, from the Format choice

list, select the Receipt of Payment Notification format.
5. From the Delivery Method choice list, select Email.
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6. Sign in as an Oracle Receivables user.
7. Click the Billing icon.
8. On the Billing Tasks pane, click the Create Customer link and create a customer, a customer address, and a

customer site.
9. On the Account Site page, select the Payment Details tab.

10. In the Receipt of Payment Notification Preferences section, from the Debit Advice Delivery Method choice
list, optionally select Email with .pdf as attachment. This option lets you attach the Funds Capture Payer
Notification report to an email as a PDF attachment. If you select the Email option, the Funds Capture Payer
Notification report is sent as HTML in the body of the email.

11. In the Debit Advice Email ID field, enter a valid email.
12. In the Setup and Maintenance work area, select:

◦ Offering: Financials

◦ Functional Area: Customer Payments

◦ Task: Manage Internal Payees

13. On the Manage Internal Payees page, click the Create icon.
14. On the Create Internal Payee page, Notification to Payer section, enter a valid email in the From Email field and

the subject that you want to see in the notification email in the Subject field.

Generation of the Funds Capture Payer Notification Report
To generate the Funds Capture Payer Notification report from within Oracle Payments, complete these steps:

1. From the Accounts Receivable work area, click the Funds Capture icon.
2. Click the Tasks icon.
3. Click the Send Receipt of Payment Notifications link. The parameters page for the Send Receipt of Payment

Notifications appears.
4. Select applicable parameters and click Submit. A confirmation message displays with a process ID.

Tip:  Write down or remember the process ID.

5. Navigate: Navigator > Tools > Scheduled Processes link.
6. In the Process ID field on the Scheduled Processes page, enter the process ID and click Search. The result

displays in the Search Results section.
7. Select the resulting row in the Search Results section to display additional details on the page.
8. In the Log and Output section, click the 1 more link to display the Attachments dialog box. You can now see the

<process ID> PDF output file.

Report Parameters
This table describes the process parameters.

Name Description

Settlement Batch Reference
 

Payments-assigned reference number of the settlement batch.
 

From Settlement Date
 

Starting date within a date range of settlement transactions.
 

To Settlement Date
 

Ending date within a date range of settlement transactions.
 

228



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 10
Oracle Fusion Payments Reports

Name Description

From Payment System Order Number
 

Order number generated by Payments, which identifies the first settlement transaction to the payment
system.
 

To Payment System Order Number
 

Order number generated by Payments, which identifies the last settlement transaction to the payment
system.
 

Allow Sending Replacement Copy
 

The inclusion of settlements in the Funds Capture Payer Notification report that were included in a
previous report if, for example, the customer requests a duplicate copy of the Funds Capture Payer
Notification report.
 

Frequently Asked Questions
The following table lists frequently asked questions and provides answers about the Funds Capture Payer Notification
report.

FAQ Answer

How do I find this report?
 

You can find the Funds Capture Payer Notification report in the Output section. Click the 1 more link to
display the Attachments dialog box. You can now see the PDF output file.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

The Funds Capture Payer Notification report is used when you want to inform the customer of a
funds capture transaction that will charge the customer's credit card or bank account. By informing
customers of expected debits to their bank accounts, they can maintain sufficient balances so that
payments aren't rejected.
 
It is considered a best practice to inform your customers that funds capture transactions will charge
their credit card or bank account.
 

What can I do with this report?
 

You can:
 

1. Generate and schedule the Funds Capture Payer Notification report.
2. Send the Funds Capture Payer Notification report to customers by email, US mail, or fax.

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Funds Capture Accompanying Letters  
This topic includes details about the Funds Capture Accompanying Letter.
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Overview
The Funds Capture Accompanying Letter is a predefined funds capture report that's manually delivered to your
payment system or bank. The report accompanies a settlement batch file and summarizes its contents.

This figure illustrates an example of the Funds Capture Accompanying Letter.

Key Insights
Here are the differences between the formal Funds Capture Accompanying Letter report name and the process name.
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Report Name Process Name Output

Funds Capture Accompanying Letter Formats
 

Create Settlement Batch Accompanying Letter
 

.PDF file
 

Generation of the Funds Capture Accompanying Letter
To generate the Funds Capture Accompanying Letter from within Oracle Fusion Payments, complete these steps:

1. In the Setup and Maintenance work area, go to the Manage Funds Capture Process Profiles task:

◦ Offering: Financials

◦ Functional Area: Customer Payments

◦ Task: Manage Funds Capture Process Profiles

You can also use this navigation: Navigator > My Enterprise > Setup and Maintenance > Tasks panel tab >
Search > Manage Funds Capture Process Profiles

2. On the Manage Funds Capture Process Profiles page, select a processing type from the Select Processing
Type choice list and click Create.

3. On the Create Funds Capture Process Profile page, go to Formats tab.
4. In the Settlement section, select the options for the Outbound Format, Inbound Response Format, and the

Accompanying Letter Format.
5. Sign in as a manager.
6. From the Accounts Receivables work area, click the Funds Capture icon.
7. Click the Tasks icon.
8. Click the Settlement Batch Accompanying Letter link.
9. The parameters page for the Funds Capture Accompanying Letter appears.

10. From the Settlement Batch Reference choice list, select the applicable settlement batch reference number and
click Submit. A confirmation message displays with a process ID.

Tip:  Write down or remember the process ID.

11. Navigate:Navigator > Tools > Scheduled Processes.
12. In the Process ID field on the Scheduled Processes page, enter the process ID and click Search. The result

displays in the Search Results section.
13. Select the resulting row in the Search Results section to display additional details on the page.
14. In the Log and Output section, click the 1 more link to display the Attachments dialog box. You can now see the

<process ID> .PDF output file.

Report Parameters
This table describes the process parameter.

Name Description

Settlement Batch Reference
 

Application-assigned reference number for the settlement batch.
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Frequently Asked Questions
Here are the answers to some frequently asked questions that you may have about the Funds Capture Accompanying
Letter.

FAQ Answer

How do I find this report?
 

You can find the Funds Capture Accompanying Letter in the Log and Output section. Click the 1 more
link to display the Attachments dialog box. You can now see the .PDF output file.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use the Funds Capture Accompanying Letter to summarize the contents of a settlement batch. You can
then manually send the summary and the settlement batch to the payment system or bank.
 

What can I do with this report?
 

You can manually deliver the Funds Capture Accompanying Letter to your payment system or bank,
 along with the settlement batch.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
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11  Oracle Fusion Cash Management Reports

Oracle Fusion Cash Management Predefined Reports  
Oracle Fusion Cash Management provides predefined reports that are used in the following areas:

• Bank Statements

• Cash Transit

• Reconciling to the General Ledger

Scheduled Processes Work Area

You can schedule and run reports from the Scheduled Processes work area in the Tools section of the Navigator.

Reports and Analytics Work Area

In some cases, reports are also:

• Accessed from the Reports and Analytics work area in the Tools section of the Navigator or from other work
areas.

• Opened using links that launch the Oracle Business Intelligence Catalog.

The following tables list the predefined reports by type:

Bank Statement Reports:

Report Name Description Parameters (*Required)

Bank Statement Report
 

Displays the bank statements that are used to
analyze balances and transaction details.
 

• *Bank Account

• *From Statement End Date

• *To Statement End Date

Bank Statement Analysis Report
 

Displays bank statements used to analyze
balances and transaction details.
 

NA
 

Cash Transit Report

Report Name Description Parameters (*Required)

Cash in Transit Report
 

Lists all transactions for a specific bank
account, that have been remitted to the bank
but haven't been cleared. The report excludes
all voided transactions and all reversed
transactions with a reversal date on or prior to
the As of Date.
 

• *Bank Account

• Transaction Source

• As-of Date
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Cash to General Ledger Report

Report Name Description Parameters (*Required)

Cash to General Ledger Reconciliation Report
 

Displays bank statement transactions and
general ledger accounting entries that haven't
been reconciled and can cause discrepancies.
The report is used to reconcile bank balances to
general ledger cash balances.
 

• *Bank Account

• *Accounting Period

To run predefined reports, navigate to the Scheduled Processes work area and follow these steps:

1. Click the Schedule New Process button.
2. Search the Process Name.
3. Enter the parameters.
4. Enter the applicable process options and schedule.
5. Click Submit.

Related Topics
• How Data Is Structured for Analytics

• How You Create and Edit Reports

• Reporting and Analytics: Overview of Analyses, Dashboards, Reports, and Infolets

• Overview of Oracle Fusion Financials Reports and Analytics Work Area

Cash Management Bank Statement Report  
This topic includes details about the Cash Management Bank Statement Report.

Overview
The Cash Management Bank Statement Report displays bank account balances and transaction information for specific
bank statements. The following figure is an example of the report:

234

https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20046164
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20043938
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20035626
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20033101


Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 11
Oracle Fusion Cash Management Reports

Key Insights
The Cash Management Bank Statement Report is used for reviewing activity of a specific bank account.

Report Parameters
The following table describes required process parameters:

Name Description

Bank Account
 

The specific bank account used to receive payments and disburse funds.
 

From Statement End Date
 

Starting date range of the activities for the account.
 

To Statement End Date
 

Ending date range of the activities for the account.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Cash Management Bank Statement Report.

FAQ Answers

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Cash Manager

• Financial Manager

• Financial Specialist
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FAQ Answers

When do I use this report?
 

Use this report to review the bank statement of a specific bank account over a selected period.
 

What can I do with this report?
 

You can use this report to review bank statements and their reconciliation status.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Cash to General Ledger Reconciliation Report

• Cash in Transit Report

Cash in Transit Report  
This topic includes details about the Cash in Transit Report.

Overview
The Cash in Transit Report lists, for a specific bank account, all transactions that have been remitted to the bank but
haven't been cleared. The Cash in Transit report excludes the following:

• All voided transactions

• All reversed transactions with a reversal date on or prior to the As of Date

The following figure is an example of the cash in transit report:
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Key Insights
The Cash in Transit Report lists the transactions that are created but haven't been cleared as of a specific date.

Report Parameters
The following table describes required process parameters:

Name Description

Bank Account
 

The specific bank account used to receive payments and disburse funds.
 

Transaction Source
 

The origin of the transaction, such as payables or receivables.
 

As of Date
 

The date when the transaction status is checked.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Cash in Transit Report.
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FAQ Answers

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Cash Manager

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use this report to review the transactions of a specific bank account that have been remitted but
haven't been cleared.
 

What can I do with this report?
 

Identify transactions that haven't been cleared as of a specific date.
 

What type of report is this?
 

Oracle Business Intelligence
 

Related Topics
• Cash Management Bank Statement Report

• Cash to General Ledger Reconciliation Report

Cash to General Ledger Reconciliation Report  
This topic provides information about the Cash to General Ledger Reconciliation Report.

Overview
The Cash to General Ledger Reconciliation Report compares the GL cash account balance against the bank account
balance. It displays the unreconciled GL cash account journal entries and unreconciled bank statement lines that help
identify the discrepancies between the balances. This is done based on the specified range of periods.

238



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 11
Oracle Fusion Cash Management Reports

Key Insights
The Cash to General Ledger Reconciliation Report lists the subledger transactions that are accounted in GL but they are
not reconciled in Cash Management.

Consider assigning a unique GL cash account for each bank account and using it to record all cash transactions to
facilitate this book to bank reconciliation.

Report Parameters
The following table describes required process parameters:

Name Description

Bank Account
 

The specific bank account used to receive payments and disburse funds.
 

From Accounting Period
 

The first fiscal period a company uses to report financial results, such as a calendar month or fiscal
period. A portion of time in which the accounting calendar may be divided. Accounting periods make
up an accounting calendar.
 

To Accounting Period
 
 

The ending fiscal period a company uses to report financial results, such as a calendar month or fiscal
period. A portion of time in which the accounting calendar may be divided. Accounting periods make
up an accounting calendar.
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Frequently Asked Questions
The following table lists frequently asked questions about the Cash to General Ledger Reconciliation Report.

FAQ Answers

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

• Cash Manager

• Financial Manager

• Financial Specialist

When do I use these reports?
 

Use this report to:
 

• Review and identify the discrepancies in the bank account balances in Cash Management and the
GL cash account balance.

What can I do with this report?
 

Reconcile bank balances to the general ledger cash account balances.
 

What type of reports are these?
 

Oracle Analytics Publisher
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12  Oracle Fusion Receivables Reports

Oracle Receivables Predefined Reports  
Receivables provides predefined reports to help you analyze and manage your accounts receivable information.

The Receivables predefined reports cover the following areas:

• Bill Presentment Templates

• Accounting Reports

• Billing Reports

• Receivables Balances Reports

• Bills Receivable Reports

• Netting Settlement Reports

• Reconciliation Process and Report

You schedule and run all Receivables reports from the Scheduled Processes work area. You can also access and open
all reports in the Reports and Analytics work area.

To run a report from Scheduled Processes:

1. Click the Schedule New Process button.
2. Search for the process name that you want.
3. Enter values for the parameters that you need.
4. Enter the desired process options and schedule.
5. Click Submit.

The following tables group the Receivables reports by type and provide a description of each report.

Bill Presentment Templates
The predefined print templates are used to print Receivables transactions. You can also create your own versions of
these print templates.

Display Name Description

Print Invoices Template
 

Layout for printing invoices. Includes information about the customer, due date, line amount, tax
amount, and outstanding balance.
 

Print Credit Memos Template
 

Layout for printing credit memos. Includes information about the customer, application date, line
amount, and total amount applied.
 

Print Debit Memos Template
 

Layout for printing debit memos. Includes information about the customer, due date, line amount, and
outstanding balance.
 

Print Chargebacks Template
 

Layout for printing chargebacks. Includes information about the customer, due date, line amount, and
outstanding balance.
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Display Name Description

Print Summary Balance Forward Bills
Template
 

Layout for printing balance forward bills in summary mode. Includes information on the beginning
balance, summary information of current customer billing activity, and ending balance for the billing
cycle.
 

Print Detailed Balance Forward Bills
Template
 

Layout for printing balance forward bills in detail mode. Includes information on the beginning balance,
 details of current customer billing activity, and ending balance for the billing cycle.
 

Print Bills Receivable Template
 

Layout for printing bills receivable. Includes information about the customer drawee, drawee contact,
 creation date, transactions assigned to the bill, and total bill amount.
 

Accounting Reports
Use these reports to review and analyze Receivables accounting information.

Display Name Description

Bad Debt Provision Report
 

Provides information for reviewing bad debt exposure and provisioning based on percent collectible
assigned to the customer. Includes transaction number, balance due amount, and bad debt provision
amount in the ledger currency.
 

Invoices Posted to Suspense Report
 

Provides a list of all transactions that have revenue amounts posted to suspense accounts as a result
of running the Import AutoInvoice process. Includes information on transaction class, customer,
 transaction date, and transaction amount by business unit.
 

Potential Reconciling Items Report
 

Provides a list of journal items that may potentially post to incorrect general ledger accounts. Includes
customer account number, payment number, transaction number, and credit and debit amounts by
reporting level, reporting context, accounting date, and balancing segment.
 

Billing Reports
Use these reports to review and analyze Receivables billing and related transaction information.

Display Name Description

Billing History Report
 

Provides a summarized history of transactions and activities against them by customer site for a
specified date range. Includes information on original transaction amount, current balance due, sum of
all payments applied to the transaction, total credit memo amounts against the transaction, and total
adjustment amounts to the transaction.
 

Import AutoInvoice Execution Report
 

Report for the process that imports transactions from other source systems into Receivables. Includes
information about both successful and rejected transactions by transaction type, customer, transaction
number, and transaction date.
 

Print Adjustments Report
 

Prints information about adjustments associated with specified transactions and customers by
business unit, adjustment number, and transaction number.
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Display Name Description

Transaction Details Report
 

Lists invoices, credit memos, debit memos, and chargebacks for review. Includes information about
transaction header, transaction lines, sales credits, revenue accounts, account sets, and transaction
flexfields by business unit, transaction number, and transaction type.
 

Receivables Balances Reports
Use these reports to review and analyze payment information and customer balances.

Display Name Description

Automatic Receipt Creation and
Remittance Execution Report
 

Report for the process that creates automatic receipts and receipt remittances in a batch. Includes
information about automatically generated receipts, remitted receipts, and data validation errors by
batch.
 

Bank Risk Report
 

Provides information about receipts that are currently at risk with the remittance bank. Includes
information about the remittance batch, receipt, and receipt amount by business unit, remittance bank
branch, and remittance bank account.
 

Clear Receipts Automatically Execution
Report
 

Report for the process that clears receipts automatically. Includes information about the clearing of
customer receipts by remittance bank account, receipt number, and customer.
 

Create Automatic Receipt Write-offs
Execution Report
 

Report for the process that writes off unapplied amounts on selected receipts. Includes information
about the receipt write-offs by currency, customer, receipt number, amount, and date.
 

Create Customer Statements Execution
Report
 

Report for the process that generates customer statements. Prints customer billing information in
a format presentable to the customer. Includes information on invoices, debit memos, chargebacks,
payments, on-account credits, credit memos, adjustments, and past due information.
 

Customer Account Status Report
 

Provides a list of customer open items and the total balance due based on customer account status for
the specified ledger currency.
 

Customer Balances Revaluation Report
 

Displays information related to the difference between the original customer balance and the
revaluated balance for manually adjusting the general ledger. Includes the customer balance and the
open items that make up that balance by business unit, revaluation period, and customer.
 

Document Number Audit Report
 

Provides a list of document numbers assigned to transactions, adjustments, and receipts to help
identify missing document numbers for a business unit, document sequence name, and document
number range. Includes information about the status, customer, currency, and amount of the
transactions, adjustments, and receipts.
 

Format Automatic Receipts Report
 

Prints automatic receipts in a specified receipt batch so that they can be sent to customers for
confirmation. Includes receipt number, receipt date, currency, and the transactions applied to each
receipt.
 

Generate Late Charges Report
 

Prints information on late charges for transactions that are overdue or have late payments by batch
name. Includes transaction number, due date, and overdue amount of transactions.
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Display Name Description

Process Receipts Through Lockbox
Execution Report
 

Report for the process that creates receipts for payments made through lockbox. Includes information
on lockbox receipts and data validation errors for each transmission from the bank.
 

Receipts Days Late Analysis Report
 

Provides the cost of late customer payments by calculating weighted average days late for each
customer. Includes information about the transaction number, transaction type, due date, receipt
number, receipt days late, and receipt weighted days late by business unit, customer, transaction
number, and collector.
 

Receipts Awaiting Bank Clearance Report
 

Provides a list of receipts waiting to be cleared by the remittance bank. Includes information about
the remittance bank account name, remittance batch date, maturity date, receipt number and receipt
amount by business unit, maturity date, and currency.
 

Receipts Awaiting Remittance Report
 

Provides a list of receipts waiting to be remitted to the bank. Includes information about the remittance
bank account name, maturity date, receipt number, and receipt amount by business unit, remittance
bank account, maturity date, and currency.
 

Receivables Aging by General Ledger
Account Report
 

Provides information about outstanding receivables balances by general ledger account as of a specific
date. Includes information about customer, transaction number, due date, and outstanding amount by
balancing segment, transaction as-of date, aging buckets, currency, and customer.
 
The related Receivables Aging by General Ledger Account and Multifund Accounting report generates
aging details for ledgers and business units enabled for Multifund Accounting.
 

Receivables Open Items Revaluation
Report
 

Displays the amount needed to manually adjust general ledger account balances to reflect the
difference between the original and revalued customer open items. Includes information about
transaction number, due date, currency, open original amount, conversion rate, open ledger currency
amount, revaluation rate, and revaluation open amount by business unit, revaluation period,
 conversion rate type and balancing segment.
 

Receivables Projected Gains and Losses
Report
 

Compares the revalued amount of foreign currency transactions with the entered amount and prints
the projected unrealized gain or loss. Includes information about the currency, entered amount, ledger
currency amount, revaluation rate, and the revaluation gain and loss by business unit, ledger currency,
 customer, and transaction number.
 

Recognize Revenue Execution Report
 

Report for the process that recognizes revenue and creates revenue distributions for transactions
that use invoicing and revenue scheduling rules. Includes information about revenue accounting
distributions and unprocessed or partially processed transactions for customer billing.
 

Reversal Status Report
 

Provides information about the status of automatic receipt reversals processed for a settlement batch.
Includes the receipt date, receipt number, receipt amount, reversal reason code, and a description of
automatic receipt reversals that were unsuccessful.
 

Bills Receivable Reports
Use these reports to review and analyze bills receivable activity.

Display Name Description

Automatic Bills Receivable Remittance
Execution Report

Report for the process that creates a bills receivable remittance from bills receivable. Provides the
details of bills receivable remitted to the bank to initiate collection from customers.
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Display Name Description

  

Automatic Bills Receivable Transactions
Batch Report
 

Report for the process that creates bills receivable from transactions. Lists the transactions assigned to
each bill receivable.
 

Close Matured Bills Receivable Execution
Report
 

Report for the process that creates and applies receipts for standard remitted bills receivable, and
applies receipts and eliminates risk on bills receivable factored with recourse. Lists the changes to each
bill receivable and shows all receipts that were cleared by the process run.
 

Print Bills Receivable Report
 

Prints bills receivable either individually, belonging to a bills receivable batch, or belonging to a bills
receivable remittance batch.
 

Netting Settlement Reports
Use these reports to review and analyze Payables and Receivables netting settlements.

Display Name Description

Netting Settlement Letter
 

Prints a letter that provides details of Payables and Receivables transactions in a netting settlement.
 

Netting Reversal Letter
 

Prints a letter that provides details of Payables and Receivables reversed transactions in a netting
settlement.
 

Netting Settlement Report
 

Lists the Payables and Receivables transactions belonging to a specific netting settlement in PDF
format.
 

Netting Settlement Listing
 

Lists the Payables and Receivables transactions belonging to a specific netting settlement in
spreadsheet format.
 

Reconciliation Process and Report
Use this process and report to help you reconcile receivables data to the general ledger.

Display Name Description

Prepare Receivables to General Ledger
Reconciliation
 

Extracts and prepares transaction and accounting information for reconciling Receivables to the
General Ledger. You must run this process before you can use the Receivables to General Ledger
Reconciliation Report.
 

Receivables to General Ledger
Reconciliation Report
 

Provides both summary and detailed reconciliation of receivables data to the general ledger. The
summary report displays receivables and accounting beginning and ending balances, as well as
summarized activity for the period and how this activity was accounted. The detail reports display the
real-time details that make up balances from the summary report, and indicate potential causes for
differences between actual and reconciling amounts.
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Related Topics
• Overview of Oracle Fusion Financials Reports and Analytics Work Area

Accounting Reports  

Overview of the Bad Debt Provision Report  
This topic contains summary information about the Bad Debt Provision Report.

Overview
The Bad Debt Provision Report provides information about your bad debt exposure.

Key Insights
The report uses the percent collectible value that you specify in the Collectible field of the Credit and Collections
section of the customer account profile to calculate the bad debt provision.

Frequently Asked Questions
The following table lists frequently asked questions about the Bad Debt Provision Report.

FAQ Answer

How do I find this report? Reports and Analytics pane - Shared Folders - Financials - Receivables - Accounting
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FAQ Answer

  

Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

When you need customer overdue transaction collectibility information to create the provision for bad
debt accounting journals.
 

What can I do with this report?
 

Schedule periodically.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Invoices Posted to Suspense Report  
This topic contains summary information about the Invoices Posted to Suspense Report.

Overview
The Invoices Posted to Suspense Report provides a listing of all transactions that have revenue amounts posted to
suspense accounts.

Key Insights
The report groups and prints revenue amounts by the company or balancing segment of the accounting flexfield,
postable status, and currency.

Frequently Asked Questions
The following table lists frequently asked questions about the Invoices Posted to Suspense Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Accounting
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FAQ Answer

Who uses this report?
 

Financial Manager after a run of the Import AutoInvoice process, whenever you use a suspense general
ledger account.
 

When do I use this report?
 

To review a list of transactions, where revenue amounts are posted to suspense accounts when the
imported transaction line amounts don't agree with the Price * Quantity calculated amount.
 

What can I do with this report?
 

Schedule to run following a run of the Import AutoInvoice process.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Potential Reconciling Items Report  
During internal reconciliation, you use the Receivables to General Ledger Reconciliation Report to confirm that
transactional and accounting data match. However, even if the data matches, journals can still post to incorrect general
ledger accounts, due to issues with your Receivables setup.

Use the Potential Reconciling Items Report to help you identify and correct these setup issues.

You typically run the Potential Reconciling Items Report:

• For new software installations, prior to running final accounting, in order to confirm the correct derivation of
accounting.

• Whenever the accounting setup has been modified--such as the creation of new transaction types, receipt
methods or receivables activities--prior to running final accounting.

The report suggests journal items that potentially posted to general ledger accounts with unexpected account types,
thus creating reconciliation issues in general ledger. An unexpected account type refers to general ledger account types
that aren't normally associated with an item general ledger category. General ledger account types used by Receivables
include assets, liabilities, income, and expense.

For example, a receivable item might be expected to post to an asset account. If the item posts to a non-asset account,
then it will appear on the Potential Reconciling Items Report.

Typical items that the Potential Reconciling Items Report includes are:

• Adjustment journals with offset accounts that are asset accounts, rather than income or expense.

• Revenue journals for invoices and credit memos that post to account types other than income.

• Unearned revenue journals that post to an account type other than liability.

• Unbilled journals created for deferred billing that post to an account type other than asset.

• Late charge journals that post to an account type other than income.

• Cash, confirmation, or remittance journals that post to account types other than asset.

• Short term debt journals created by factoring receipts that post to account types other than liability.

• Nonrecoverable tax that posts to an account type other than expense.

Possible causes for discrepancy include:

• Incorrect accounting setup.
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• Incorrect manual updating of general ledger account distributions.

• Setup created for activities inconsistent with the intended use of Receivables.

When a potential reconciling item is an error, correct both the individual transaction and the incorrect setup to prevent
future occurrences of the same error.

Related Topics
• Guidelines for Using the Receivables to General Ledger Reconciliation Report

• Guidelines for Receivables to General Ledger Reconciliation

Billing Reports  

AutoInvoice Execution Report  
Use the AutoInvoice Execution Report to review a run of the Import AutoInvoice process.

The AutoInvoice Execution Report lists the total number of transactions imported for each AutoInvoice run, with
detailed information for all transaction lines that failed import. The report includes summary information for the
invoices, debit memos, and credit memos that were processed in each currency. The report also shows the total amount
for each transaction class for all transactions processed.

You can also review and correct AutoInvoice errors by downloading the Manage AutoInvoice Lines spreadsheet from the
Billing work area.

Related Topics
• How AutoInvoice Processes Data During Import

• How You Correct AutoInvoice Errors

Overview of the Transaction Details Report  
This topic contains summary information about the Transaction Details Report.

Overview
The Transaction Details Report lists all of the information that was entered for each of your transactions.
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Key Insights
The report provides, for each transaction, complete header and line information, tax information, freight information,
sales credits, revenue accounting, account sets, and transaction flexfield.

Frequently Asked Questions
The following table lists frequently asked questions about the Transaction Details Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Billing
 

Who uses this report?
 

Financial Specialist during transaction reviews.
 

When do I use this report?
 

When you need to see all the details related to specific transactions.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
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Overview of the AutoAdjustment Preview Report  
This topic contains summary information about the AutoAdjustment Preview Report.

Overview
The AutoAdjustment Preview Report provides information about potential automatic transaction adjustments,
generated after a run of the Create Automatic Billing Adjustments program.

Key Insights
The report includes information about the customer, transaction, adjustment amount, and adjustment status, and
displays the total amount and count for both approved and pending adjustments.

Frequently Asked Questions
The following table lists frequently asked questions about the AutoAdjustment Preview Report.

How do I find this report? Scheduled Processes - Create Automatic Billing Adjustments
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Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

To preview potential transaction adjustments when writing off transaction balances using the Create
Automatic Billing Adjustments program.
 

What can I do with this report?
 

Set the AutoAdjustments Option parameter of the Create Automatic Billing Adjustments program to
Generate Report Only.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Adjustment Register  
This topic contains summary information about the Adjustment Register.

Overview
The Adjustment Register provides information about approved adjustments that affect transaction balances.

Key Insights
Review both manual and automatic adjustments by customer, adjustment status, adjustment type, or adjustment
reason.

Frequently Asked Questions
The following table lists frequently asked questions about the Adjustment Register.
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FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Period Close
 

Who uses this report?
 

• Financial Specialist to review activity for the period.

• Financial Manager during period close processing.

When do I use this report?
 

When you need a listing of adjustments against customer transactions or to assist the receivables
reconciliation process.
 

What can I do with this report?
 

Schedule to run as needed.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Receivables - Adjustments Real Time subject area.

Overview of the Transaction Register  
This topic contains summary information about the Transaction Register.

Overview
The Transaction Register lets you review customer transactions by business unit and accounting period.
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Key Insights
The report includes all transactions that increase or decrease the customer outstanding balance for the specified period.

Frequently Asked Questions
The following table lists frequently asked questions about the Transaction Register.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Period Close
 

Who uses this report?
 

• Financial Specialist reviewing activity for the period.

• Financial Manager during period close processing.

When do I use this report?
 

• When you need a listing of customer transactions.

• During the receivables reconciliation process.

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
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Related Subject Areas
This report uses the Receivables - Transactions Real Time subject area.

Receivables Balances Reports  

Overview of the Customer Account Status Report  
This topic contains summary information about the Customer Account Status Report.

Overview
The Customer Account Status Report displays detailed information about each of your customer accounts.

Key Insights
The report displays for each customer all open debit items, credit items, and total balance due in the ledger currency.

Frequently Asked Questions
The following table lists frequently asked questions about the Customer Account Status Report.
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FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Specialist or Financial Manager when analyzing customer accounts.
 

When do I use this report?
 

When you want to analyze the detail that makes up the customer account balances by specific account
statuses or collectors.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Customer Balance Revaluation Report  
This topic contains summary information about the Customer Balance Revaluation Report.

Overview
The Customer Balance Revaluation Report identifies customers with credit (negative) balances.

Key Insights
The report provides the balance of a customer and the open items that make up the balance, and lists customers by
positive and negative balance.

Frequently Asked Questions
The following table lists frequently asked questions about the Customer Balance Revaluation Report.
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FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

When you need to create accounting journals for revaluated customer accounts and identify customers
with negative balances.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Projected Gains and Losses Report  
This topic contains summary information about the Projected Gains and Losses Report.

Overview
The Projected Gains and Losses Report lets you review open foreign (non-ledger) currency invoices, debit memos, and
chargebacks revalued according to the revaluation rate that you specify.
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Key Insights
The report compares the revalued amount of each debit item with the entered amount and prints the unrealized gain or
loss.

Frequently Asked Questions
The following table lists frequently asked questions about the Projected Gains and Losses Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

To review projected gain or loss for open foreign currency transactions revalued according to the
revaluation rate that you specify.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
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Overview of the Applied Receipts Register  
This topic contains summary information about the Applied Receipts Register.

Overview
The Applied Receipts Register provides information about all receipt applications that affect your customer balances.

Key Insights
Review receipt applications by customer and receipt batch. The report displays all receipt applications within the
specified date range regardless of check date.

Frequently Asked Questions
The following table lists frequently asked questions about the Applied Receipts Register.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Period Close
 

Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

When you need a listing of your customer applied receipts or to assist the receivables reconciliation
process.
 

What can I do with this report?
 

Schedule to run as needed.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Receivables - Standard Receipt Application Details Real Time subject area.
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Overview of the Unapplied Receipts Register  
This topic contains summary information about the Unapplied Receipts Register.

Overview
The Unapplied Receipts Register lets you review detailed information about customer unidentified, on-account and
unapplied payments. This information more accurately indicates how much a customer actually owes you.

Key Insights
The report groups receipts by receipt batch and customer, and provides separate totals by business unit for on-account,
unapplied, and unidentified receipts in the ledger currency, and a grand total for the report.

Frequently Asked Questions
The following table lists frequently asked questions about the Unapplied Receipts Register.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Period Close
 

Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

• When you need a listing of your customer unapplied receipts.

• To assist the receivables reconciliation process.

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Receivables - Standard Receipt Application Details Real Time subject area.
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Overview of the Receipts Days Late Analysis Report  
This topic contains summary information about the Receipts Days Late Analysis Report.

Overview
The Receipts Days Late Analysis Report helps you review the timeliness of your customer payments.

Key Insights
The report provides details of receipt applications against customer transactions for the period you specify.

Frequently Asked Questions
The following table lists frequently asked questions about the Receipts Days Late Analysis Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Manager when analyzing late payments.
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FAQ Answer

When do I use this report?
 

To review the timeliness of your customer payments, including weighted days late calculation, which
indicates the cost to you of overdue payments.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Receipts Awaiting Bank Clearance Report  
This topic contains summary information about the Receipts Awaiting Bank Clearance Report.

Overview
The Receipts Awaiting Bank Clearance Report lets you review receipts waiting to be cleared by your remittance bank.

Key Insights
The report provides a separate section for each currency included in the output, and sorts information within each
currency section by remittance bank account and remittance batch date.

Frequently Asked Questions
The following table lists frequently asked questions about the Receipts Awaiting Bank Clearance Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report? Financial Manager to analyze risk.
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FAQ Answer

  

When do I use this report?
 

To review all receipts waiting to be cleared by your remittance bank.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Receipts Awaiting Remittance Report  
This topic contains summary information about the Receipts Awaiting Remittance Report.

Overview
The Receipts Awaiting Remittance Report lets you review receipts awaiting remittance to your bank.

Key Insights
The report runs on both automatic and manual receipts. Once a receipt is approved for remittance it will no longer
appear on the report.
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Frequently Asked Questions
The following table lists frequently asked questions about the Receipts Awaiting Remittance Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Manager to analyze the overall remittance status.
 

When do I use this report?
 

To review all receipts requiring remittance to your bank.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Reversal Status Report  
This topic contains summary information about the Reversal Status Report.

Overview
The Reversal Status Report lets you view the status of automatic receipt reversals processed for a settlement batch by a
run of the Automatic Receipts Reversal process.
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Key Insights
This report is generated automatically after a run of the Automatic Receipts Reversal process. You can also run the
report manually. The report groups receipts by settlement batch and includes receipt date, receipt number, receipt
amount, reversal reason code, and a description of automatic receipt reversals that were unsuccessful.

Report Parameters
The following table lists selected report parameters:

Parameter Description

Settlement Batch Reference
 

Specify the identifier of the settlement batch for which you want to run the report.
 

From Settlement Batch Creation Date and
To Settlement Batch Creation Date
 

Indicate the settlement batch creation date range for reporting data.
 

Receipt Status
 

Indicate the receipt status for reporting data.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Reversal Status Report.

FAQ Answer

How do I find this report?
 

Scheduled Processes - Reversal Status Report
 

Who uses this report?
 

Financial Manager or Financial Specialist when analyzing automatic receipt activity.
 

When do I use this report?
 

To analyze the automatic receipt reversals and failed receipt reversals in a settlement batch.
 

What can I do with this report?
 

Schedule as needed.
 

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• How Automatic Receipts Are Reversed

Overview of the Reversed Receipts Report  
This topic contains summary information about the Reversed Receipts Report.
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Overview
The Reversed Receipts Report lets you review receipt reversals by reversal date and remittance bank.

Key Insights
The report displays results and total receipts by bank, customer or reversal reason. You can optionally review specific
receipts according to the parameters that you specify.

Frequently Asked Questions
The following table lists frequently asked questions about the Reversed Receipts Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Manager when analyzing causes of reversals.
 

When do I use this report?
 

To review receipt reversals by reversal date and remittance bank, and categorize by stop payments,
 insufficient funds, and receipts entered in error.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
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Related Subject Areas
This report uses these subject areas:

• Receivables - Standard Receipt Application Details Real Time

• Receivables - Miscellaneous Receipts Real Time

Overview of the Receivables Open Items Revaluation Report  
This topic contains summary information about the Receivables Open Items Revaluation Report.

Overview
The Receivables Open Items Revaluation Report is used to revalue your open items, including invoices, credit memos,
and debit memos.

Key Insights
Revalue open items based on the revaluation rate that you specify, which is either an end-of-period rate or a daily rate.
The report is divided into sections for each unique combination of balancing segment and receivables account.
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Frequently Asked Questions
The following table lists frequently asked questions about the Receivables Open Items Revaluation Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

When you need to revalue your customer open transactions for determining the amount needed to
manually adjust your general ledger balance to reflect the difference between the original and revalued
balance.
 

What can I do with this report?
 

Schedule as needed.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Receivables Aging by General Ledger Account
Report  
This topic contains summary information about the Receivables Aging by General Ledger Account Report.

Overview
The Receivables Aging by General Ledger Account Report helps you review information about outstanding receivables
balances.
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If you have enabled a ledger and its business units for Multifund Accounting, use the Receivables Aging by General
Ledger Account and Multifund Accounting Report to generate and review aging details for your accounts with detailed
receivables distributions.

Key Insights
You can use this report either during reconciliation or to age or summarize open receivables.

Frequently Asked Questions
The following table lists frequently asked questions about the Receivables Aging by General Ledger Account Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

Review information about your customer outstanding receivables balances by general ledger account
as of a specific accounting date.
 

What can I do with this report?
 

Schedule periodically.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Bills Receivable Reports  

Overview of the Bills Receivable Remittance Batch Management
Report  
This topic contains summary information about the Bills Receivable Remittance Batch Management Report.

Overview
The Bills Receivable Remittance Batch Management Report provides detailed information about a bills receivable
remittance batch.
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Key Insights
Review both remittance batch information and information about each bill receivable in the batch.

Frequently Asked Questions
The following table lists frequently asked questions about the Bills Receivable Remittance Batch Management Report.

FAQ Answer

How do I find this report?
 

Scheduled Processes - Create Bills Receivable Remittance Batch
 

Who uses this report?
 

Financial Specialist responsible for bills receivable.
 

When do I use this report?
 

To review a run of the Create Bills Receivable Remittance Batch process.
 

What can I do with this report?
 

According to your bills receivable remittance schedule.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Overview of the Automatic Bills Receivable Transactions Batch
Report  
This topic contains summary information about the Automatic Bills Receivable Transactions Batch Report.

Overview
The Automatic Bills Receivable Transactions Batch Report lists the contents of a bills receivable batch.
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Key Insights
The report lists the bills receivable created in a batch, or the bills receivable that will be created in a batch submitted in
Draft.

Frequently Asked Questions
The following table lists frequently asked questions about the Automatic Bills Receivable Transactions Batch Report.

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables Balances
 

Who uses this report?
 

Financial Specialist responsible for bills receivable.
 

When do I use this report?
 

When you need to review a list of the bills receivable created in a batch, or the bills receivable that will
be created in a batch if the Create Bills Receivable Batch process is submitted in Draft.
 

What can I do with this report?
 

Set the Batch Mode parameter of the Create Bills Receivable Batch process to Draft.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

271



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 12
Oracle Fusion Receivables Reports

Reconciliation Reports  

Overview of the Receivables to General Ledger Reconciliation
Report  
This topic contains summary information about the Receivables to General Ledger Reconciliation Report.

Overview
The Receivables to General Ledger Reconciliation Report is the primary tool for the reconciliation of receivables data to
the general ledger.

Key Insights
The report provides both summarized and detailed reconciling data for review and analysis.

Frequently Asked Questions
The following table lists frequently asked questions about the Receivables to General Ledger Reconciliation Report.

272



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 12
Oracle Fusion Receivables Reports

FAQ Answer

How do I find this report?
 

Reports and Analytics pane - Shared Folders - Financials - Receivables - Receivables to Ledger
Reconciliation
 

Who uses this report?
 

Financial Manager during period close processing.
 

When do I use this report?
 

When you're reconciling your receivables to your general ledger balances.
 

What can I do with this report?
 

Review report after running the Prepare Receivables to General Ledger Reconciliation scheduled
process.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses these subject areas:

• Receivables - Adjustments Real Time

• Receivables - Bill Receivable Real Time

• Receivables - Credit Memo Applications Real Time

• Receivables - Receipt Details Real Time

• Receivables - Standard Receipt Application Details Real Time

• Receivables - Transactions Real Time

• Subledger Accounting - Journals Real Time

• Subledger Accounting - Receivables Summary Reconciliation Real Time

• General Ledger - Journals Real Time

• General Ledger - Transactional Balances Real Time

Related Topics
• Guidelines for Using the Receivables to General Ledger Reconciliation Report

Guidelines for Using the Receivables to General Ledger
Reconciliation Report  
Use the Receivables to General Ledger Reconciliation report to facilitate the reconciliation of receivables data to the
general ledger.

The interactive reporting capability of the Receivables to General Ledger Reconciliation report provides both
Summarized and Detailed reconciling data for review:

• The Summary report lets you see receivables and accounting beginning and ending balances, as well as
summarized activity for the period and how this activity was accounted.
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• Drill down on any amount in the Summary report Difference column to display the Differences Detail report for
that item. The Differences Detail reports display the details that make up balances from the Summary report,
and indicate potential causes for differences between actual and reconciling amounts.

If you have a ledger and business units enabled for Multifund Accounting, you can also use the Receivables to General
Ledger Reconciliation Report to review and reconcile detailed receivables distributions.

Note:  For a more efficient reconciliation, don't allow general ledger sources other than Receivables to post to
Receivables accounts.

If you restrict the number of general ledger accounts that you include in a run of the Prepare Receivables to General
Ledger Reconciliation program, this can affect the display of data in the detail reports and may be the cause of a
difference between the accounted amount of a transaction and the reconciling amount.

For example, if Receivables transactions are recorded against balancing segment values 1, 2, 3 or natural accounts
A, B, C, and the account range you used excluded some of these values, then these transactions would show up as
differences on the report.

If you're downloading a large amount of data from the report to a spreadsheet and you plan to perform a number of
data manipulations, use the CSV format. If you're downloading data for reference purposes only, use the Excel or PDF
format.

Review these additional guidelines for using the Receivables to General Ledger Reconciliation report:

• Differences between Transactional and Accounted Amounts

• Differences between Summary and Detail Amounts

• Differences between the Reconciliation Report and the Aging Report

• Recommendations for Reconciling by Business Unit and by Intercompany Activity

• Recommendations for Reconciling Unapplied and Unidentified Receipts and On-Account Items

• Recommendations for Reconciling Bills Receivable

Differences between Transactional and Accounted Amounts
Ideally the Summary report displays no differences between receivables transactional amounts and accounted
amounts. In addition, the beginning and ending receivables balances normally agree with the Receivables Aging by
General Ledger Account reports.

Note:  It can happen that the Summary report contains variance amounts. If the Summary report contains variance
amounts, contact your system administrator.

Any differences that you find require further investigation and possible correction. Common reasons for differences
between transactional amounts and accounted amounts include:

• Transactions that aren't accounted.

• Transactions with subledger accounts that fall outside the account range of the report.

• Transaction amounts don't agree with the subledger journal line amounts.

• Journals are posted to the subledger or general ledger that didn't come from Receivables.

• Subledger journals weren't transferred or posted to general ledger.
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Transactions assigned transaction types that have the Open Receivable option set to No appear in the Other
Accounting section of the report, even though these transactions were posted to Receivables accounts assigned the
financial category of Accounts Receivable.

After finding and correcting discrepancies, you must re-run the Prepare Receivables to General Ledger Reconciliation
program and review the Summary report.

Note:  Some differences may be valid. For example, if you included unapplied and unidentified receipts in your
extract, but you don't post these receipts to a receivables account or an account with the financial category of
Accounts Receivable assigned, then these receipts appear as a difference outside the account range of the report. In
this case, you can re-run the extract and exclude these items.

Differences between Summary and Detail Amounts
The Non-Receivables Begin Balance amount is any portion of a general ledger account beginning balance that didn't
originate from Receivables transactions. You can drill down on this amount to see a list of general ledger journal lines
that have an accounting date that falls within the current fiscal year but prior to the period of the reconciliation report;
and that have an account combination that falls within the account range of the report.

The drill-down page doesn't include non-Receivables journal lines dated in previous fiscal years, which means that
these journal lines won't match the Non-Receivables Begin Balance amount. The drill-down page is only intended to
provide current fiscal year journals that might have posted erroneously to the receivables account.

The journal source of these journals isn't typically Receivables. However, you may see manual subledger journal
entries that were entered for the Receivables source directly into the subledger but not necessarily linked to a specific
Receivables transaction. Most of these entries represent adjustment journal entries.

Manual subledger journals created during the current reconciling period display in the Summary report in the Other
Accounting section, and become part of the Non-Receivables Begin Balance amount in subsequent periods. Manual
general ledger journals that may affect receivables accounts are created directly in the general ledger and don't display
in the Other Accounting section on the Summary report, but display instead in the Non-Receivables Activity amount.

Summary amounts may not reflect totals on detail pages because:

• Data was modified after the data extract was run for a given accounting period. If transactions or accounting
were created or modified between the time the extract was executed and the moment you drill down from a
summary amount to its detail amounts, the summary amount won't reflect the detail page totals.

To limit discrepancies between the summary and detail reports, set the Receivables accounting period status to
Close Pending or Closed.

• Security rules in your setup may restrict you from seeing data from certain business units or segment values.

Ensure that appropriate security is given to users for all business units and accounting flexfield segment values
that each user is responsible for reconciling.

Differences between the Reconciliation Report and the Aging Report
You may find differences between the data displayed in the Receivables to General Ledger Reconciliation report and
the Receivables Aging by General Ledger Account report. This list provides the principle reasons why this occurs and
recommendations for working with these differences:

• Intercompany Transactions: You can't limit the display of intercompany transactions on the Receivables Aging
by General Ledger Account report. If the reconciliation extract either excludes intercompany transactions or
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displays intercompany transactions only, then the Receivables to General Ledger Reconciliation report and the
Receivables Aging by General Ledger Account report won't display compatible data.

• Unaccounted Amounts: The Receivables Aging by General Ledger Account report doesn't display unaccounted
activity. Unaccounted amounts display as differences in the Summary Reconciliation report. In this case,
compare the Accounting End Balance with the Receivables Aging by General Ledger Account report. You will
need to subtract out any amount in Other Accounting, as this isn't included in the Receivables Aging by General
Ledger Account report.

• Receipts at Risk: The Receivables Aging by General Ledger Account Report has the option to display or ignore
Receipts at Risk. The Receivables to General Ledger Reconciliation report doesn't use this option, and always
excludes receipts at risk. For reconciliation purposes, be sure to exclude receipts at risk when running the
Receivables Aging by General Ledger Account report.

• Open Credits: The Receivables Aging by General Ledger Account report has the option to Age, Summarize, or
Exclude open credits. For reconciliation purposes, the recommendation is to Age or Summarize open credits.

CAUTION:  Don't use Advanced Collections Aging reports for reconciliation because they don't include general ledger
account information. This applies to these three reports:

• Aging by Common Currency Report

• Collections Aging 4-Bucket Report

• Collections Aging by Collector 7-Bucket Report

Recommendations for Reconciling by Business Unit and by Intercompany Activity
To reconcile by business unit, you need to have an implicit mapping of the business unit to one or more primary
balancing segment values. When you run the Prepare Receivables to General Ledger Reconciliation program, you
must specify both the business unit to reconcile and the balancing segment value or range of values assigned to that
business unit. The Business Unit parameter selects the receivables activity and the balancing segment value selects the
accounting data.

You have three options for reconciling Intercompany activity:

• Include Intercompany activity with other Receivables activity.

• Exclude Intercompany activity from reconciliation.

• Include only Intercompany activity.

If you want to include Intercompany activity with other Receivables activity, set the Include Intercompany parameter
to Yes and include the Intercompany account in the range of account values to extract. By default, if no account range is
selected, all accounts with the financial category of Accounts Receivable are included in the extract.

If you want to exclude Intercompany activity from reconciliation, set the Include Intercompany parameter to No, and
also exclude the Intercompany range of accounts from the extract.

If you're reconciling only the Intercompany activity, set the Include Intercompany parameter to Intercompany Only, and
select the account range for your Intercompany Receivables accounts.

Recommendations for Reconciling Unapplied and Unidentified Receipts and On-
Account Items
If you want to exclude unapplied and unidentified receipts, and on-account items, from reconciliation, set the Include
Unapplied and Unidentified Receipts parameter and the Include On-Account Items parameter to No, and exclude the
respective ranges of accounts from the extract. To avoid reconciling differences, don't post unapplied and unidentified
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receipts, and on-account items, to the same general ledger accounts as that used for transactions. If these receipts and
items are posted to the same accounts, then the accounting for transactions is also excluded.

If you never include unapplied and unidentified receipts, or on-account items, in your reconciliation, then don't assign
the financial category of Accounts Receivable to these accounts in your chart of accounts setup.

Note:  Receivables to General Ledger reconciliation doesn't include miscellaneous receipts. Ensure that you don't
assign the financial category of Accounts Receivable to miscellaneous receipt accounts.

Recommendations for Reconciling Bills Receivable
Two rows on the Summary report display bills receivable activity for the accounting period:

• Bills Receivable: Bills receivable created (unsigned or drawee-issued), accepted (signed), and canceled during
the accounting period.

• Bills Receivable Applications: All customer transactions applied to bills receivable created, accepted, and
canceled during the accounting period.

The totals for Bills Receivable and Bills Receivable Application net to zero, because both sides of the creation of
bills receivable and the application of transactions, or unapplication in the case of canceled bills, are recorded here.
Creation and Acceptance require the assignment of transactions to the bill receivable, so each of these bills display
the associated transaction applications. Cancellation reverses the bill receivable and its applications, so canceled bills
display both sides of the activity, application and unapplication.

Status changes to Remitted, Unpaid, and Factored bills receivable have an accounting impact only because, as the bill
goes through its lifecycle, only the account it posts to changes. These events display in the Summary report in the Other
Accounting section. Like all other events related to reconciliation, the accounts used for these activities need to have the
financial category of Accounts Receivable assigned to the natural account segment in the chart of accounts.

Other activities against bills receivable are included in existing sections of the Summary report and the related drill-
down reports. On-account credit memos against a bill receivable display in the Invoices section, along with all other
transaction activity. Receipts applied to bills receivable display with other receipts in the Applied Receipts section.

Related Topics
• Guidelines for Receivables to General Ledger Reconciliation

• What's a variance amount?

• Journal Capture Options

• How Account Balances Are Calculated

Guidelines for Receivables to General Ledger Reconciliation  
Periodically you need to reconcile the transactions in your accounts receivable system, both before and after you post to
general ledger. The Receivables to General Ledger Reconciliation extract and report help to simplify this process and to
reduce manual reconciling activity.

The automated activities in the reconciliation process function according to the way you set up your Financials
environment. A review of some of these setups can help improve the overall reconciliation process.

277

https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20026797
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20027226


Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 12
Oracle Fusion Receivables Reports

Review these activities related to setting up your Financials environment for Receivables to General Ledger
reconciliation:

• Business Unit vs. Ledger Reconciliation

• Accounts Receivable Financial Category

• Profile Option Settings

• User Security

Business Unit vs. Ledger Reconciliation
If you implicitly map primary balancing segment values to your business unit, you can reconcile based on business unit.
This allows employees from different business units to balance their respective organization activity.

If you don't implicitly map primary balancing segment values to business unit, you must reconcile based on ledger. In
this case, you will need access to all business units associated with the ledger to perform a thorough reconciliation.

Note:  Implicit mapping means that no specific setup is used to assign the business unit to a primary balancing
segment. This is a business decision, and your setup in Receivables should be such that the default accounting
assigned to activities for that business unit should be the primary balancing segment value that was decided.

Accounts Receivable Financial Category
You must assign the financial category of Accounts Receivable to all of your natural account values with the Receivables
account class. This is a required setup step for Receivables to General Ledger reconciliation. You perform this task under
the Manage Chart of Accounts Value Sets activity.

Note:  You must only assign the financial category of Accounts Receivable to natural accounts with the Receivables
account class. No other account class should have this assignment.

If the financial category of Accounts Receivable isn't included in the chart of accounts setup, the Receivables to General
Ledger Reconciliation report won't select any data. When you run the extract program, if you try to select general ledger
natural account values that don't have this category assigned, the extract program displays an error indicating that the
financial category wasn't assigned.

Once you assign the Accounts Receivable financial category, you can leave the Account parameter blank when you
run the extract, in order to include all accounts that have the Accounts Receivable financial category in the ledger. You
can alternatively enter specific natural account values to limit the report to reconciling only a subset of the Receivables
accounts in the ledger, but these values must have the Accounts Receivable financial category assigned.

If you set up accounts for unidentified, unapplied, and on-account receipts, and on-account credit memos, you must
also assign the Accounts Receivable financial category to these accounts in order to include them in reconciliation. If
you want to exclude these accounts during reconciliation, then you must exclude them from the Account parameter,
and both the Include On-Account Items parameter and the Include Unapplied and Unidentified Receipts parameter.

CAUTION:  You must assign unique general ledger accounts to unidentified, unapplied, and on-account receipts, and
on-account credit memos, to exclude them from reconciliation. Don't assign them the same Receivables accounts
as that used for transactions, because the accounting for transactions would also be excluded, causing reconciling
differences.
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Profile Option Settings
Review the setting of these profile options:

• Reconciliation Data Purge Frequency

• Zero Amount Journal Lines Displayed

Use the Reconciliation Data Purge Frequency profile option to indicate the number of days to keep reconciliation
extract data in the tables. Enter a value for the number of days needed to not lose prior extracts that you may need for
comparison purposes.

Every time you run the extract program, it refers to the value of the Reconciliation Data Purge Frequency profile
option. If there are any reconciliation data extract requests in the table older than the number of days specified in the
profile option, these requests are purged.

For example, if a reconciliation data extract is run on January 1, and the value of this profile option is set to 30 days, then
the data from January 1 isn't purged if you run another extract on January 29. However, the data is purged if you run
another extract on February 1.

The Zero Amount Journal Lines Displayed profile option affects whether journal lines with zero amounts display in the
Not Transferred to GL Detail report. If this profile option is set to Yes, the Summary report may equal zero and the detail
report will list these zero amount journal lines. This doesn't prevent Period Close and doesn't cause reconciling issues as
the net effect on the report is zero.

User Security
This section includes considerations for segment security and data access set.

Segment security applies to Detail reports only. If you don't have segment security access, then summary and detail
report totals may not match.

Typically General Ledger users are secured by a data access set, and Receivables users by business unit security. This
means that for the Receivables to General Ledger Reconciliation report:

• General Ledger users can see general ledger data for the balancing segment values in their data access set, as
well as the Receivables and Subledger Accounting data for all business units linked to the ledger.

• Receivables users can see the Receivables and Subledger Accounting data for business units in their security
definition, as well as general ledger data for all balancing segment values in the ledger.

However, if security is configured such that the data role for the General Ledger or Receivables job roles also have FND
grants to specific business units for General Ledger users or specific data access sets for Receivables users, then the
reconciliation report will only include:

• For General Ledger users, the Receivables and Subledger Accounting data for those business units in the ledger
to which the user has access.

• For Receivables users, general ledger data for those balancing segment values included in the data access set
to which the user has access.

This doesn't present a problem for the Receivables to General Ledger Reconciliation report if there is an implicit
mapping between business units and balancing segment values. Users can simply filter the report for the balancing
segment values that are mapped to the business units to which they have access, and the report should work properly.
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However, if there isn't an intentional and implicit mapping between balancing segment values and business units, then
this can cause the Receivables to General Ledger Reconciliation report to display undesirable results:

• For General Ledger users, the report will include general ledger data for all balancing segment values in the
data access set, while Receivables and Subledger Accounting data are limited to the business units to which a
user is granted access.

• For Receivables users, the report either won't include any general ledger data, or it will include general ledger
data that isn't properly mapped to the Receivables and Subledger Accounting data for the business unit.

You can resolve this issue by removing the FND grants from specific business units for the General Ledger job roles, and
from specific data access sets for the Receivables job roles.

Related Topics
• Chart of Accounts Components

Extract Reconciliation Data from Receivables to General Ledger  
Run the Prepare Receivables to General Ledger Reconciliation process to select data for the Summary section of the
Receivables to General Ledger Reconciliation Report.

The extract must run successfully in order to see the most current Summary report, and before you can run the
Receivables to General Ledger Reconciliation Report.

Use the following parameters of the Prepare Receivables to General Ledger Reconciliation process to control the
Receivables transaction activity that you intend to include in the extract:

• Business Unit

• Include Intercompany Transactions

• Include On-Account Items

• Include Unapplied and Unidentified Receipts

Tip:  To avoid unintended reconciling differences, you must ensure that you include or exclude the related accounting
activity associated with the Receivables transaction activity included in a given extract. For example, if you intend to
reconcile by a specific business unit but don't select the associated primary balancing segment values in the Account
parameter, accounting data from other business units belonging to the same ledger will display as differences.

Prepare Receivables to General Ledger Reconciliation Parameters
Request Name

Enter a name that is descriptive of this extract. Consider using a name that indicates the accounting period, date, and
time, especially if you’re planning to create multiple extracts.

Note:  Enter a unique request name each time you run the extract. If you reuse a request name, then the extract may
contain no data.

Ledger
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The ledgers available for selection are based on your security assignment. The default is the first ledger in alphabetic
order.

Business Unit

Use this parameter if you need to reconcile by a specific organization.

Note:  The business unit must be mapped to a balancing segment. If not, you must reconcile by ledger. If you have
implicitly mapped your business unit to one or more primary balancing segment values, you will also need to select
these values when you run the extract.

Accounting Period

You can select either an Open or Closed accounting period. The default is the latest period in the Closed Pending status,
if it exists, for the selected ledger.

You can run the extract on an Open period to see point-in-time summary balances, in order to review possible
reconciling activities you may encounter during period close processing. If you select an Open period for reconciliation,
users can still enter activity against the period after the extract runs, creating potential discrepancies between the
summary and detail information on the report. Best practice is to close the accounting period to be reconciled before
you run the extract, and then select this Closed period in the Accounting Period parameter.

Include Intercompany Transactions

You can include or exclude Intercompany transactions, or you can reconcile by Intercompany activity only.

Include On-Account Items

You can include or exclude on-account items. On-account items include on-account receipts and on-account credit
memos.

Note:  You may want to exclude on-account items if they typically post to non-receivable accounts. If you plan to
exclude on-account items, you also need to exclude the related general ledger account in the Account parameter.
Therefore, don't post this activity to the same Receivables account as your invoices to avoid reconciling differences.

Include Unapplied and Unidentified Receipts

You can include or exclude unapplied receipts and unidentified receipts. Unapplied receipts are receipts that haven't
been applied to a transaction; unidentified receipts are receipts without customer information.

You may want to exclude unapplied and unidentified receipts if they typically post to non-receivable accounts. If you
plan to exclude unapplied and unidentified receipts, you also need to exclude the related general ledger account in the
Account parameter. Therefore, don't post this activity to the same Receivables account as your transactions to avoid
reconciling differences.

Note:  Receivables to General Ledger reconciliation doesn’t include miscellaneous receipts.

Account

You can select values from any of the segments of the accounting flexfield. The natural account segment values must
have the financial category of Accounts Receivable assigned in your general ledger setup in order for the extract and
report to work properly.
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If you’re excluding on-account items, or unapplied and unidentified receipts, from your reconciliation, you must
also exclude their associated general ledger accounts, if those accounts have the financial category of Accounts
Receivable assigned. If they don't have the financial category assigned, by default these accounts aren’t included in your
reconciliation.

If you’re reconciling by business unit, select the range of balancing segment values implicitly mapped to your business
unit.

If you’re reconciling Intercompany activity, select the range of Intercompany accounts. These accounts must have the
financial category of Accounts Receivable assigned.

If you’re reconciling everything, you don't need to select any values. The report automatically selects data for
Receivables accounts that have the financial category of Accounts Receivable assigned.

Related Topics
• Guidelines for Using the Receivables to General Ledger Reconciliation Report

• Guidelines for Receivables to General Ledger Reconciliation

Receivables Report FAQs  

What's a variance amount?  
A variance amount is a line in the Receivables to General Ledger Reconciliation Report that displays the total amount of
variance between transactional and accounted amounts.

Variance amounts are due to some type of data corruption. There are two types of variance amounts: receivables
variance and accounting variance. A receivables variance is the result of data corruption in the Receivables tables.
An accounting variance is the result of data corruption either in subledger accounting or the general ledger. Variance
amounts don't display in any other section of the summary or detail reports.

The Receivables to General Ledger Reconciliation Accounting variance report captures information related to these two
causes of data corruption:

• Accounting entries in general ledger sourced from subledger accounting that are present in the general ledger
tables, but not available in the subledger accounting tables.

• Accounting entries transferred from the subledger to general ledger that are present in the subledger
accounting tables, but not available in the general ledger tables.

How are accounts reconciled to general ledger?  
The Receivables to General Ledger Reconciliation report only reconciles accounts receivable for accrual basis
accounting, and only reconciles accounting in the primary ledgers.

The Receivables to General Ledger Reconciliation report reconciles the transaction types that impact the accounts
receivable in general ledger. These include:

• Invoice

• Debit memo

• Credit memo

• On-account credit memo

• Chargeback
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• Adjustment

• Applied receipt

• On-account receipt

• Unapplied receipt

• Unidentified receipt

• Bills receivable

• Bills receivable application

Note:  On-account credit memo refund amounts and on-account credit memo gain or loss amounts are included in
the Invoices section of the Reconciliation report, because they affect the open balance of the receivable amount of
the credit memo. In all cases the intent is to close the credit memo, so both the original credit memo and the activity
against it are displayed.

The report also reconciles manual journal entries created in the Receivables subledger.

If your business unit is implicitly mapped to the primary balancing segment value in the chart of accounts, you can
run the report to reconcile by either business unit or ledger. If there is no implicit mapping, then you must reconcile by
ledger.

Note:  This mapping isn't defined anywhere in Receivables or General Ledger.

Netting Reports  

Netting Settlement Letter  
This topic contains summary information about the Netting Settlement Letter.

Overview
Select the Generate Netting Letter option for an agreement to receive a netting settlement letter for yourself and
your third party every time a settlement takes place. The netting letter generation process automatically runs when
the netting manager submits a settlement, or creates a settlement without review. You can access the report from the
Financial Reporting Center.

The netting settlement letter lists the following invoices and transactions:

• The Payables invoices that were netted, which includes the following parameters:

◦ Invoice Number

◦ Invoice Type

◦ Invoice Date

◦ Invoice Amount

◦ Netted Amount
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◦ Invoice Currency

◦ Invoice Total

◦ Netted Total

• The Receivables transactions that were netted, which includes the following parameters:

◦ Transaction Number

◦ Transaction Type

◦ Transaction Date

◦ Transaction Amount

◦ Netted Amount

◦ Transaction Currency

◦ Transaction Total

◦ Netted Total
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The following figure of a netting settlement letter sample lists only the Payables transactions that were netted:

The following figure of a netting settlement letter sample lists only the Receivables transactions that were netted:
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Key Insights
The settlement process runs the report automatically, and sends the letter to your third party. You can view the letter
from the Financial Reporting Center.

Frequently Asked Questions
The following table lists frequently asked questions about the netting settlement letter.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu. You can
also select the Generate Netting Letter for your Netting Agreement, and download the letter from
the Financial Reporting Center when a settlement is settled.
 

Who uses this report?
 

Netting Manager.
 

When do I use this report?
 

Use this report when a netting settlement is settled.
 

What can I do with this report?
 

Run the report for a settlement for your legal entity. The report can be emailed to your trading partner
automatically. If the Send Letters by Email option is selected on the Agreement, an email of the
settlement letter is sent to the third party.
 

What type of reports are these?
 

Oracle Analytics Publisher.
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Netting Reversal Letter  
This topic contains summary information about the Netting Reversal Letter.

Overview
The Netting Reversal Letter runs automatically when the netting manager reverses a netting settlement after selecting
the Generate Netting Letter option for the agreement. You can access the report from the Financial Reporting Center.
The netting reversal letter is similar to the netting settlement letter but it indicates that the payments have been voided,
and the receipts have been reversed.

The following figure describes a sample netting reversal letter for Payables:
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Key Insights
The reversal process runs the report automatically, and sends the letter to your third party. You can view the letter from
the Financial Reporting Center.

Frequently Asked Questions
The following table lists frequently asked questions about the netting reversal letter.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu. You can
also select the Generate Netting Letter option for your Netting Agreement, and download the letter
from the Financial Reporting Center when a settlement is reversed.
 

Who uses this report?
 

Netting Manager.
 

When do I use this report?
 

Use this report when a netting settlement is reversed.
 

What can I do with this report?
 

Run the report for a settlement for your legal entity. The report can be automatically mailed to your
trading partner. If the Send Letters by Email option is selected for the Agreement, an email of the
settlement letter is sent to the third party.
 

What type of reports are these?
 

Oracle Analytics Publisher.
 

Netting Settlement Report  
This topic describes about the Netting Settlement report.

Overview
The Netting Settlement report is an internal report for the netting manager to review. The report automatically runs
when the netting manager submits a settlement, or creates a settlement without review. You can access this report from
the Financial Reporting Center.

The netting settlement report lists these netting information:

• Netting Agreement and Netting Settlement options that were valid at the point of settlement.

• Payables invoices that were netted.

• Receivables transactions that were netted.

This figure lists the parameters of a netting settlement report:
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Here's a sample netting settlement report for Payables transactions.
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Here's a sample netting settlement report for Receivables transactions.
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Key Insights
The settlement process runs the report automatically. You can view the report from the Financial Reporting Center.

Frequently Asked Questions
Here are few frequently asked questions about the Netting Settlement Report.

FAQ Answer

How do I find this report?
 

The Netting Settlement report runs automatically when a settlement is settled. You can also schedule
and run this report from the Scheduled Processes work area.
 

Who uses this report?
 

Netting Manager.
 

When do I use this report?
 

Use this report when a netting settlement is settled.
 

What can I do with this report?
 

Run the report for a settlement for your legal entity. You can then review the invoices and transactions
that were netted in the settlement.
 

What type of report is this?
 

Oracle Analytics Publisher.
 

Netting Settlement Listing  
This topic contains summary information about the Netting Settlement Listing.

Overview
The netting settlement listing is an internal report in the spreadsheet format, that netting managers can review. The
listing automatically runs when the netting manager submits a settlement or creates a settlement without review. You
can access the report from the Financial Reporting Center.
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The netting settlement listing consists of the following four sections:

• Title tab: Provides the title of the listing. The following image displays the title tab of a Netting Settlement
Listing:
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• Header tab: Lists Netting Agreement and Netting Settlement options that were valid at the point of settlement,
as displayed in the following image:
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• Payables Transactions tab: Lists the following parameters:

◦ Supplier Name

◦ Supplier Number

◦ Taxpayer ID

◦ Tax Registration Number

◦ Supplier Site

◦ Invoice Number

◦ Invoice Date

◦ Invoice Type

◦ Terms Date

◦ Amount

◦ Invoice Currency

◦ Open Amount: Indicates the open invoice amount before netting.

◦ Final Netting Amount: Indicates the amount of the invoice that was netted.

◦ Open Amount after Netting: Indicates the final open invoice amount after netting.

Note:  You can identify a partially netted as the invoice with a positive Open Amount after Netting
that is less than the Open Amount.

◦ Settlement Currency

The following figure illustrates a sample netting settlement listing for Payables:
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• Receivables Transactions Tab: Lists the following parameters:

◦ Customer Name

◦ Customer Number

◦ Taxpayer ID

◦ Tax Registration Number

◦ Customer Site

◦ Transaction Number

◦ Transaction Date

◦ Transaction Type

◦ Terms Date

◦ Amount

◦ Transaction Currency

◦ Open Amount: Indicates the open invoice before netting.

◦ Final Netting Amount: Indicates the amount of the invoice that was netted.

◦ Open Amount after Netting

◦ Settlement Currency

The following figure illustrates a sample netting settlement listing for Receivables:

Key Insights
The settlement process runs the report automatically, and you can download the listing from the Financial Reporting
Center.
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Frequently Asked Questions
The following table lists frequently asked questions about the netting settlement listing.

FAQ Answer

How do I find this report?
 

The Netting Settlement Listing runs automatically when a settlement is settled. You can also schedule
and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Netting Manager.
 

When do I use this report?
 

Use this report when a netting settlement is settled.
 

What can I do with this report?
 

Run the report for a settlement for your legal entity. You can review the invoices and transactions that
were netted in the settlement, and then perform analysis on the date in the spreadsheet.
 

What type of report is this?
 

Oracle Analytics Publisher.
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13  Oracle Fusion Advanced Collections
Reports

Oracle Fusion Advanced Collections Predefined Reports  
You can generate some predefined reports that can be used in various stages throughout the collections process.

How to schedule a report?

You can schedule a report from your Scheduled Process Work area and Reports and Analytics Work area.

• Schedule a report from Scheduled process work area:
On the Navigator, click on Tools and then click Scheduled Processes to Schedule a report.

• Schedule a report from Reports and Analytics Work Area:
On Navigator, click on Tools and then click on Reports and Analytics work area
or,
Click the Reports and Analytics link on Oracle Business Intelligence Catalog.

You can create various predefined reports based these areas:

• Aging

• Dunning

• Promises

Aging Reports

Here are the three types of predefined aging reports:

Report Name Description Parameters (*Required)

Aging By Common Currency
 

You can translate all your open transaction into
a common currency based on the seven bucket
aging method.
 

• *Currency Conversion Type

• *Targeted Currency

• Business Unit

• From Customer Name

• To Customer Name

• As-of Account Date

• *Aging Bucket Method

• Show Open Credits

Collections Aging 4 Bucket Report
 

You can view your customer's open transaction
information based on the four bucket aging
method.
 

• *Business Unit

• From Customer Account
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Report Name Description Parameters (*Required)

• To Customer Account

• From Customer Name

• To Customer Name

• *Order By

• *Report Summary

• *Aging Bucket Method

• *Report Format

• *Show Open Credits

• As-of General Ledger Date

• From Balance Due

• To Balance Due

• *Show Receipts At Risk

Collections Aging by Collector 7 Bucket Report
 

You can view your customer's open transaction
information by collector based on the seven
bucket aging method.
 

• *Business Unit

• From Customer Account

• To Customer Account

• From Customer Name

• To Customer Name

• *Order By

• *Report Summary

• *Aging Bucket Method

• *Report Format

• Show Open Credits

• As-of Accounting

• Date

• From Balance Due

• To Balance Due

• *Show Receipts At Risk

• From Collector Name

• To Collector Name

Dunning Report

Here is the predefined dunning report:

Report Name Description Parameters (*Required)

Validate Customer Dunning Setup Report
 

Displays customer dunning setup issues and
provides solution.
 

• *Business Unit

• *Business Level

• *Show Errors Only

298



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 13
Oracle Fusion Advanced Collections Reports

Report Name Description Parameters (*Required)

• From Customer Name

• To Customer Name

• From Customer Account

• To Customer Account

Promises Report

Here is the predefined promise report:

Report Name Description Parameters (*Required)

Promise Reconciliation Report
 

Displays promise information by collector and
is based on payments received and the promise
status.
 

• Business Unit

• *From Date

• *To Date

• *Currency

• State

• Status

• *Report Format

• Collector Name

How to run a predefined report?

Here are the steps to run a predefined reports:

1. Navigate to the Scheduled Processes work area.
2. Click the Schedule New Process button.
3. Search the Process Name.
4. Enter the required parameters of the process.
5. Enter the applicable process options and schedule.
6. Click Submit.

Related Topics
• Reporting and Analytics: Overview of Analyses, Dashboards, Reports, and Infolets

• Data Structure for Analytics

• How You Create and Edit Reports

Aging Reports  
Using collections aging reports you can list your customer's open transactions information which can help you in
creating collection strategies and tasks.You can view all your customer's open transactions based on the aging buckets
you have defined.
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Here are the types of aging report you can create:

Aging 4 Bucket Report
In this report, you can view your customer's open transaction information based on the four bucket aging method.

This image shows a sample of Collections Aging 4 Bucket Report.

Report Parameters

This table shows all the required parameters for creating Collections Aging 4 Bucket Report:

Parameter Name Description

Aging Bucket Method
 

Either Staged or Aged, based on your company setup.
 

Order By
 

Select by Customer or Transaction Type.
 

Report Summary
 

Yes to display in summary, No to display in detail.
 

Show Open Credits
 

Yes or No to display open credits.
 

Show Receipts At Risk
 

Yes or No to display receipts at risk.
 

Aging by Collector 7 Bucket Report
In this report, you can view your customer's open transaction information by collector using the seven bucket aging
method.

This image shows a sample of Collections Aging by Collector 7 Bucket Report.
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Report Parameters

This table shows all the required parameters for creating Collections Aging by Collector 7 Bucket Report:

Parameter Name Description

Aging Bucket Method
 

Either Staged or Aged, based on your company setup.
 

As-of Accounting Date
 

Period start date for the report.
 

Order By
 

Select by Customer or Transaction Type.
 

Report Format
 

Select the format such as HTML, PDF, or Excel.
 

Report Summary
 

Yes to display in summary, No to display in detail.
 

Aging by Common Currency Report
In this report, you can view all open transaction information converted to one common currency for all Business Units or
a specific Business Unit.

This image shows a sample of Aging by Common Currency Report
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Report Parameters

This table shows all the required parameters for creating Aging by Common Currency Report:

Name Description

Targeted Currency
 

The currency you want displayed in the report. The default is USD.
 

Aging Bucket Method
 

Either Staged or Aged based on setup.
 

Frequently Asked Questions
This table lists some frequently asked questions about the aging reports.

FAQ Answers

Where can I find these reports?
 

On the Navigator menu click on the Scheduled Processes work area to schedule and run these reports.
 

Who uses these reports?
 

• Financial Manager

• Financial Specialist

When do I use these reports?
 

You can use these reports to:
 

• Review aging typically on a daily or weekly basis.

• Understand the aging and risk exposure of outstanding receivables.

What can I do with these reports?
 

Use these reports to formulate strategies with task or tasks to collect on outstanding delinquent
customers.
 

What type of reports are these?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Promise Reconciliation Report

• Collections Task

• Aging Methods

• Collections Strategies

• Processing Strategies

Promise Reconciliation Report  
In Collections Promise Reconciliation Report you can view all the promise details of each collector based on business
unit and date range. You can use this report to reconcile promises to pay with broken promises.
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This image shows a sample of Collections Promise Reconciliation Report:

Report Parameters
This table shows all the required parameters for creating Collections Promise Reconciliation Report.

Name Description

Business Unit
 

Select the appropriate business unit.
 

Collector Name
 

Specify by collector if appropriate.
 

Currency
 

Select the appropriate currency.
 

Date From
 

Starting date range.
 

Date To
 

Ending date range
 

Report Format
 

Select format such as HTML, PDF, or Excel.
 

Frequently Asked Questions
This table lists some frequently asked questions about the Collections Promise Reconciliation Report.

FAQ Answers

Where can I find this report?
 

On the Navigator menu click on the Scheduled Processes work area to schedule and run these reports.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

You can use this report to review and keep track of customer promise to pay commitments.
 

What can I do with this report?
 

You can track the payment progress of customers who have made promises to pay on their accounts.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
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Related Topics
• Aging Reports

• Collections Confirmation Notices

Validate Customer Dunning Setup Report  
In the Validate Customer Dunning Setup Report you can view all the dunning setup issues of your customers. You can
use this report to verify and identify gaps of dunning configurations.

For example the report can display missing customer e-mail, fax, or contact name. This report only shows those
customers who have open transactions.

This image shows a sample of Validate Customer Dunning Setup Report

Report Parameters
This table shows all the required parameters for creating Validate Customer Dunning Setup Report.

Name Description

Business Unit
 

Select the appropriate business unit.
 

From Collector Name
 

Starting range of collectors.
 

To Collector Name
 

Ending range of collectors.
 

From Customer Account
 

Starting range of customer accounts.
 

To Customer Account
 

Ending range of customer accounts.
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Name Description

From Customer Name
 

Starting range of customer names.
 

To Customer Name
 

Ending range of customer names.
 

Frequently Asked Questions
This table lists some frequently asked questions about the Validate Customer Dunning Setup Report.

FAQ Answers

Where can I find this report?
 

On the Navigator menu click on the Scheduled Processes work area to schedule and run these reports.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

You can use this report when configuring your dunning setups for customers, accounts, or by collector.
 

What can I do with this report?
 

Use this report to validate and identify gaps in the dunning setup for customer, accounts, or by
collector.
 

What type of report is this?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Collections Confirmation Notices

• Why did my Dunning Process end in Error?

Collections Confirmation Notices  
This topic includes detailed information about the various activities for the collections confirmation notices.

Overview
The collections confirmation notices provide details on submitted activities: disputes, payments, and promises. You can
use these notices to inform customers of the action taken on their accounts.

Confirmation Notices include:

• Collections Dispute Confirmation Delivery: Provides the details of the dispute submitted. The notice contains
the dispute number, amount, and creation date prior to approval.
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• Collections Payment Confirmation Delivery: Provides the details of the payment submitted. The notice contains
the dispute number, amount, and creation date prior to approval.

• Collections Promise Confirmation Delivery: Provides the details of the promise submitted. The notice contains
the promise amount and date.

Key Insights
These confirmation notices are used to provide a printed form of the commitment to customers reaffirming the
agreement made during a conversation with the customer. These notices are generated only when they are configured
in Manage Collections Preferences, in the Correspondence section, and set to Yes to automatically generate the notice.

Report Parameters
These notices are automatically generated if configured to do so, when you submit a dispute, apply a payment, or enter
a promise. Therefore no parameters are required.

Frequently Asked Questions
The following table lists frequently asked questions about the collections confirmation notices.

FAQ Answers

How do I find these notices?
 

Schedule and run these notices from the Scheduled Processes work area on the Navigator menu.
 

Who uses these notices?
 

• Financial Manager

• Financial Specialist

When do I use these notices?
 

Use these notices to:
 

• Correspond with customers who have recent activity applied to their accounts.

• Document and record the activity applied to a customer account.

What can I do with these notices?
 

Inform customers through correspondence of activity performed on their account.
 

What type of notices are these?
 

Oracle Business Intelligence Publisher
 

Related Topics
• Validate Customer Dunning Setup Report
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14  Oracle Fusion Revenue Management
Reports

Oracle Fusion Revenue Management Predefined Reports
 
Oracle Fusion Revenue Management provides the following predefined report:

• Revenue Contract Account Activities Report

• Standalone Selling Price Report

• Open Performance Obligation Report

Scheduled Processes Work Area

You can schedule and run the Revenue Contract Account Activities Report from the Scheduled Processes work area in
the Tools section of the Navigator.

Reports and Analytics Work Area

You can run the Standalone Selling Price Report and the Open Performance Obligation Report from the Reports and
Analytics work area in the Tools section of the Navigator.

The following tables list the Revenue Management predefined reports:

Report Name Description Parameters (* Required)

Revenue Contract Account Activities Report
 

Provides data extracted from Oracle Fusion
Revenue Management and Oracle Fusion
Subledger Accounting. The data is used to
report revenue contract account activities,
 which are used for financial analysis.
 

• *Ledger

• *Period From

• *Period To

• Account Class

Standalone Selling Price Report
 

Provides a summary of standalone selling
prices or you can drill down to the Observed
SSP Details report, which provides details of the
individual sales used to systematically derive
the observed standalone selling price. Use
the report to analyze your standalone selling
prices for a selected effective period or range of
selected effective periods.
 

• *Effective Period Start

• *Effective Period End

Open Performance Obligation Report
 

Lists open performance obligations. Use the
report to analyze open performance obligations
and their expected settlement and revenue
recognition for the selected ledger.
 

• *Ledger
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To run predefined reports from the Scheduled Processes work area, navigate to the Scheduled Processes work area and
follow these steps:

1. Click the Schedule New Process button.
2. Search on the Process Name.
3. Enter the parameters.
4. Enter the applicable process options and schedule.
5. Click Submit.

To run predefined reports from the Reports and Analytics work area, go to Tools on the Navigator.

Related Topics
• Set Up the Reports and Analytics Panel Tab

Revenue Contract Account Activity Report  
Use the Revenue Contract Account Activity report to analyze account balances by accounting contract and performance
obligation.

Use the information in this report to:

• Support audit processes.

• Perform detailed analysis of various accounts.

• Analyze customer, item, and source document information.

Run the report using Oracle Business Intelligence Publisher (BI Publisher). The underlying extract for the Revenue
Contract Account Activity Report contains additional information related to the accounting contracts and performance
obligations. To add or delete columns in the BI Publisher report template, use Microsoft Word or Microsoft Excel to
modify the columns.

Export the report data into one of the following formats for further analysis:

• Excel: In Excel, use Excel Pivot Table functionality to group and summarize data by account class, account, and
period

• Flat file format.

• An analytical tool such as Essbase during the transition period, to support analysis of the data for restatement
or disclosure purposes.

Standalone Selling Price Report  
The Standalone Selling Price Report lists a summary of standalone selling prices.

Use the report to analyze your standalone selling prices for a selected effective period or range of selected effective
periods. The report aids you in analyzing how the standalone selling prices were calculated, by providing a drill down to
the standalone sales transaction data used to derive the standalone selling prices.

You can filter the report output by attributes such as item, item group, memo line, item classification, performance
obligation template, pricing dimension, SSP Profile, and SSP Representation.
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You can also copy the report and use it as a starting point to create a report that will meets your own unique reporting
needs.

For more detailed information drill down to the Observed SSP Details report, which provides details of the individual
sales used to systematically derive the observed standalone selling price.

Key Insights
You can use the summary information or for more detailed information, drill down to the Observed SSP Details report,
which provides details of the individual sales used to systematically derive the observed standalone selling price.

Frequently Asked Questions
The following table lists frequently asked questions about the Standalone Selling Price Report.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Revenue
Management > Standalone Selling Price.
 

Who uses this report?
 

Revenue Manager
 

When do I use this report?
 

When I want to understand how a standalone sales price was derived.
 

What can I do with this report?
 

Analyze the standalone selling prices for a selected effective period or a range of selected effective
periods.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Revenue Management - Standalone Selling Price Real Time subject area.

Open Performance Obligation Report  
This topic includes details about the Open Performance Obligation Report.

Overview
The Open Performance Obligation Report lists open performance obligations. Use the Oracle Transactional Business
Intelligence (OTBI) Open Performance Obligation Report to analyze the open performance obligations for a selected
ledger. You can filter the report output by attributes such as legal entity and customer name.

You can also copy the report and use it as a starting point to create a report that will meet your own unique reporting
needs.
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Key Insights
Use the report to analyze open performance obligations and their expected settlement and revenue recognition for the
selected ledger.

Frequently Asked Questions
This table lists frequently asked questions about the Open Performance Obligation Report.

FAQ Answer

How do I find this report?
 

From the Reports and Analytics pane, navigate to Shared Folders > Financials > Revenue
Management > Revenue Recognition.
 

Who uses this report?
 

Revenue Manager or Revenue Analyst
 

When do I use this report?
 

When I need information about the expected settlement and revenue recognition for existing open
obligations.
 

Can I print the entire report?
 

The default printing option for the report is Visible. You can’t change this value at this time. However,
 you may copy the printed report to a custom folder so that all locked options are available in the
seeded version. After copying the report to a custom folder, you can edit the printing option.
 
Choose one of these printing options:

• Visible to All to print all report results for the entire dashboard.

• Visible to print only what is displayed on the report.

 

Note:  The maximum rows that can be exported is limited by Excel (approximately 1 million rows).
You may adjust the filter criteria and print in batches to get the entire results if they exceed the
limits.

What can I do with this report?
 

Analyze open performance obligations and their expected settlement and revenue recognition by
ledger.
 

What type of report is this?
 

Oracle Transactional Business Intelligence
 

Related Subject Areas
This report uses the Revenue Management - Customer Contracts Real Time subject area.
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15  Oracle Fusion Assets Reports

Oracle Assets Predefined Reports  
Oracle Assets provides predefined reports that are used in the close process and to verify asset transactions.

The Assets reports run from the Scheduled Processes work area found on the Navigator.

The following tables list the predefined reports by type.

Transaction Reports

Display Name Description

Asset Additions Report
 

• Lists all the assets added or capitalized during the specified periods.

• Sorted by and groups totals for each balancing segment, asset type, asset account, cost center,
 and reserve account.

Additions by Source Report
 

• Lists all the assets added or capitalized during the specified periods.

• Shows the details of associated invoice lines.

• Sorts and totals by source, balancing segment, asset type, asset account, cost center and asset
number.

Asset Retirements Report
 

• Lists all the asset retirements performed during the specified periods.

• Sorted by and groups totals for each balancing segment, asset type, asset account, and cost
center.

Asset Transaction History Report
 

• Lists all transactions performed on selected assets.

• Sorted by asset number.

Asset Transfers Report
 

• Lists all asset transfers performed during the specified period.

• Sorted by asset number.

CIP Capitalization Report
 

• Lists all the CIP assets capitalized during the specified periods.

• Sorted by and groups totals for each balancing segment, CIP cost account, cost center, and asset
cost account.

Cost Adjustment Report
 

• Lists all the asset cost adjustments made during the specified periods.

• Sorted by and groups totals for each balancing segment, asset type, asset cost account, and cost
center.

Cost Adjustments by Source Report
 

• Lists all the asset cost adjustments made during the specified periods.

• Shows the details of associated invoice lines.

• Sorts and totals by source, balancing segment, asset type, asset account, cost center, and asset
number.
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Display Name Description

Asset Category Change Report
 

• Lists all the assets for which the asset category is changed during the specified period.

• Sorted by and groups totals for each balancing segment, asset account, and asset number.

Asset Impairment Report
 

• Lists the impact of impairment transactions.

• Displays cost, new net book value, net selling price, value in use, and impairment loss amount for
all the impaired assets in the given book and depreciation period.

• Sorted by asset number.

Asset Additions by Responsibility Report
 

• Lists assets added or capitalized during the specified periods.

• Displays the owner and location for each unit.

• Sorts and totals by balancing segment, asset type, asset account, cost center, and reserve
account.

Mass Additions Reports

Display Name Description

Create Mass Additions Report
 

• Lists all invoice and discount lines processed by the last run of the Create Mass Additions process.

• Sorted by and groups totals for each foreign currency, balancing segment, asset clearing account,
 and cost center.

• Generated every time the Create Mass Additions process is run.

Delete Mass Additions Report
 

Lists all the mass addition lines in the Delete queue that are ready to be processed by the Delete Mass
Additions process.
 

Post Mass Additions Report
 

• Lists all the asset additions and cost adjustments processed by the Post Mass Additions process.

• Sorted by transaction type.

• Generated every time the Post Mass Additions process is run.

Reconciliation Reports

Display Name Description

Cost Clearing Reconciliation Report
 

• Lists all asset additions and cost adjustments performed during the specified period for which
accounting entries are created for cost clearing accounts.

• Sorted by and groups totals for each transaction type, balancing segment, and clearing account.

Cost Detail Report
 

• Lists asset level asset cost account balances for the specified periods.

• Sorted by and groups totals for each balancing segment, asset cost account, and cost center.

Cost Summary Report
 

• Lists asset cost account summary balances for the specified periods.

• Sorted by and groups totals for each balancing segment and asset cost account.

Journal Entry Reserve Ledger
 

• Lists asset depreciation amounts for the specified period.
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Display Name Description

• Sorted by and groups totals for each balancing segment, expense account, reserve account, and
cost center.

CIP Detail Report
 

• Lists asset level CIP cost account balances for the specified periods.

• Sorted by and groups totals for each balancing segment, CIP cost account, and cost center.

CIP Summary Report
 

• Lists CIP cost account summary balances for the specified periods.

• Sorted by and groups totals for each balancing segment and CIP cost account.

Reserve Detail Report
 

• Lists asset level asset reserve account balances for the specified periods.

• Sorted by and groups totals for each balancing segment, reserve account, and cost center.

Reserve Summary Report
 

• Lists reserve account summary balances for the specified periods.

• Sorted by and groups totals for each balancing segment and reserve account.

Revaluation Reserve Detail Report
 

• Lists asset revaluation reserve account balances for a specified period for an asset level.

• Sorted by and groups totals for each balancing segment, asset cost account, and cost center.

Revaluation Reserve Summary Report
 

• Lists asset level revaluation reserve account balances for the specified periods.

• Sorted by and groups totals for each balancing segment, reserve account, and cost center.

Asset Balances Register Report
 

• Lists initial costs, current reserve, year-to-date amounts, depreciation rules, and retirements for a
range of assets for the specified corporate book and for each associated tax book.

• Sorts the data by asset number.

Asset Register Report • Lists the cost-related details, current activity, and retirements for every asset within the selected
asset category.

• Lists all transactions that impact asset cost during the chosen period.

Asset Leases Expense Report
 

• Lists asset lease interest and expense amounts for the specified period.

• Sorted by and groups totals for each balancing segment, expense account, and cost center.

Asset Leases Liability Report
 

• Lists asset lease liability for the specified period.

• Sorts by and groups totals for each balancing segment, liability account, and cost center.

Asset Cost and Reserve Report
 

• Lists the asset cost and depreciation reserve balances at the asset or cost center level.

• Sorts and totals by category, asset type, asset cost account, and cost center.

• You can run the report only for closed periods.

Group Reports

Display Name Description

Group Asset Detail Report
 

• Lists the group and its member asset balances for the specified fiscal year and is used to comply
with Indian income tax requirements.

• Sorted by and groups totals for each fiscal year and asset category.
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Display Name Description

Group Asset Listing
 

• Lists the group asset balances for the specified fiscal year and is used to comply with Canadian
capital cost allowance requirements.

• Sorted by and groups totals for each fiscal year and asset category.

Group Asset Summary Report
 

• Lists the group asset balances for the specified fiscal year and is used to comply with Indian
income tax requirements.

• Sorted by and prints totals for each fiscal year and asset category.

Reports for the United States

Display Name Description

Form 4562 - Depreciation and
Amortization Report
 

• Lists asset depreciation amounts for the specified fiscal year.

• Used for US tax reporting. Sorted by balancing segment, fiscal year added, depreciation method,
 asset category, and asset number.

• Lists totals for each category, method, fiscal year added, and balancing segment.

Form 4626 - AMT Summary Report
 

• Lists the difference in year-to-date depreciation between any tax book and an alternative
minimum tax book through the period you select in detail.

• Sorted by balancing segment, depreciation method, asset account, category, and asset number.

• Lists totals for each category, asset account, method, and balancing segment.

Form 4626 - AMT Detail Report
 

• Lists the difference in year-to-date depreciation between any tax book and an alternative
minimum tax (AMT) book through the period you select in detail.

• Sorted by balancing segment, depreciation method, asset account, category, and asset number.

• Lists totals for each category, asset account, method, and balancing segment.

Form 4797 - Gain From Disposition of 1245
Property Report
 

• Lists gain or loss amounts from sales of 1245 property held longer than the capital gain threshold.

• Used for US tax reporting.

• Shows only assets that were sold.

• Sorts by balancing segment into gains and losses by asset account and by asset number.

• Lists totals for gains or losses, and for each distinct asset account and balancing segment.

Form 4797 - Gain From Disposition of 1250
Property Report
 

• Lists gain or loss amounts from sales of 1250 property held longer than the capital gain threshold.

• Sorted by balancing segment into gains and losses, property class, asset account, and asset
number.

• Lists totals for gains or losses, and for each asset account, property class, and balancing segment.

Form 4797 - Sales or Exchanges of
Property Report
 

• Lists amounts held longer than the capital gain threshold.

• Sorted by balancing segment into gains and losses, property class, asset account, and asset
number.

• Lists totals for gains or losses, and for each asset account, property class, and balancing segment.

Reports for Japan

314



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 15
Oracle Fusion Assets Reports

Display Name Description

Japanese Addition or All Asset Detail by
Asset Type Report 132 Characters
 

Lists depreciable assets for Japan in detail by asset type in a 132 character-wide format.
 

Japanese Addition or All Asset Detail by
Asset Type Report 180 Characters
 

Lists depreciable assets for Japan in detail by asset type in a 180 character-wide format.
 

Japanese Corporate Tax Reports Schedule
16 (1) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (2) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (4) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (6) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (8) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Depreciable Assets Tax
Summary Report
 

Lists a summary of depreciable assets for Japan by location as of January 1 for the selected fiscal year.
 

Japanese Detail by Asset Type (Decrease
Assets) Report
 

Lists depreciable assets for Japan in detail by the asset type Decrease Assets, between January 2 of the
prior year and January 1 of the selected fiscal year.
 

Other Reports

Display Name Description

Property Tax Report
 

• Lists the assets at a particular location as of the specified cutoff date.

• Used for property tax forms.

• Sorted by and groups totals for each balancing segment, location, asset account, and year
acquired.

What-If Depreciation Analysis Report
 

• Lists depreciation projections for the selected assets based on the specified depreciation
parameters.

• Generated when you submit what-if depreciation analysis for existing assets.

Hypothetical Depreciation Analysis Report
 

• Lists depreciation projections for hypothetical assets based on the specified depreciation
parameters.

• Generated when you submit what-if depreciation analysis for hypothetical assets.

Assets by Cash Generating Unit Report
 

• Lists all assets by cash generating unit.
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Display Name Description

• Extracts the details of all the asset impairment transactions such as asset number, cash
generating unit, cost, net book value, accumulated impairment reserve, and year-to-date
impairments from Assets.

To run Assets reports, perform the following steps in the Scheduled Processes work area in the Navigator menu.

1. Click the Schedule New Process button.
2. Search on the Process Name.
3. Enter the appropriate parameters.
4. Enter the appropriate process options and schedule.
5. Click Submit.

Assets Transaction Reports  
This topic includes details about the Assets transaction reports.

Overview
The Assets transaction reports list transactions performed during the life of the asset, such as additions, adjustments,
transfers, and retirements.

Assets transaction reports include:

Report Name Description

Asset Additions Report
 

Lists all of the assets added or capitalized during the specified periods. The report is sorted by and
groups totals for each balancing segment, asset type, asset account, cost center, and reserve account.
 

Additions by Source Report
 

Lists all the assets added or capitalized during the specified periods. The report shows the details of
associated invoice lines. The report sorts and totals by source, balancing segment, asset type, asset
account, cost center, and asset number
 

Asset Retirements Report
 

Lists all of the asset retirements performed during the specified periods. The report is sorted by and
groups totals for each balancing segment, asset type, asset account, and cost center.
 

Asset Transaction History Report
 

Lists all transactions performed on selected assets. The report is sorted by asset number.
 

Asset Transfers Report
 

Lists all asset transfers performed during the specified period. The report is sorted by asset number.
 

CIP Capitalization Report
 

Lists all of the construction-in-process (CIP) assets capitalized during the specified periods. The report
is sorted by and groups totals for each balancing segment, CIP cost account, cost center, and asset cost
account.
 

Cost Adjustment Report
 

Lists all of the asset cost adjustments made during the specified periods. The report is sorted by and
groups totals for each balancing segment, asset type, asset cost account, and cost center.
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Report Name Description

Cost Adjustments by Source Report
 

Lists all the asset cost adjustments made during the specified periods. The report shows the details
of associated invoice lines. The report sorts and totals by source, balancing segment, asset type, asset
account, cost center, and asset number.
 

Asset Category Change Report
 

Lists all of the assets for which the asset category is changed during the specified period. The report is
sorted by and groups totals for each balancing segment, asset account, and asset number.
 

Asset Impairment Report
 

Lists the impact of impairment transactions. Displays the cost, new net book value, net selling
price, value in use, and impairment loss amount for all of the impaired assets in the given book and
depreciation period. The report is sorted by the asset number. The report shows totals for the current
net book value, net selling price, values in use, impairment loss, and new net book value.
 

Asset Additions by Responsibility Report
 

Lists assets that were added or capitalized during the specified periods. The report displays the owner
and location for each unit. The report sorts and totals by balancing segment, asset type, asset account,
 cost center, and reserve account.
 

The following table describes selected report parameters:

Name Description

Book
 

Use this parameter to specify the book to be included for reports.
 

Currency
 

Use this parameter to specify the currency to be included for reports.
 

From Period
 

Use this parameter to specify the starting period for a range of the reports.
 

To Period
 

Use this parameter to specify the ending period for a range of the reports.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Assets transaction reports:

FAQ Answer

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

When do I use these reports?
 

Use these reports to:
 

• Ensure that your asset transactions are being accurately posted.

• Keep track of your assets, and to reconcile Oracle Assets to your general ledger.

How do I change the default report
format?
 

To change from Oracle Business Intelligence Publisher (BI Publisher), edit the fixed asset catalog and
choose the output format from the layout table in the view list.
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Assets Mass Additions Reports  
This topic includes details about the Assets mass additions reports.

Overview
The Assets mass additions reports help to track mass additions transactions from the time you bring them into Oracle
Assets from a source system such as Oracle Payables or Oracle Projects to the time you post them to Assets.

Mass additions reports include:

Report Name Description

Create Mass Additions Report
 

Lists all invoice and discount lines processed by the Create Mass Additions process. The report is
sorted by and groups totals for each foreign currency, balancing segment, asset clearing account, and
cost center.
 
This report is usually run from Payables.
 

Delete Mass Additions Report
 

Lists all the mass addition lines in the Delete queue that are ready to be processed by the Delete Mass
Additions process.
 

Post Mass Additions Report
 

Lists all the asset additions and cost adjustments processed by the Post Mass Additions process. The
report is sorted by transaction type.
 

The following table describes selected report parameters:

Name Description

Request Number
 

The request number of the Create Mass Additions process.
 

Book
 

Use this parameter to specify the book to be used for reporting.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Assets mass additions reports:

FAQ Answer

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

When do I use these reports?
 

Use these reports to keep track of all invoice and discount lines interfaced from Payables to Assets.
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FAQ Answer

What happens after I run the Create Mass
Additions process?
 

The Payables invoice and discount addition lines appear with the asset category you specified for the
item.
 

How many times can you run the Create
Mass Additions process?
 

You can run the Create Mass Additions process as many times as you like. Each time it sends potential
asset invoice line distributions and any associated discount lines to Assets. Payables ensures that it
does not bring over the same line twice.
 

How do I change the default report
format?
 

To change from Oracle Business Intelligence Publisher (BI Publisher), edit the fixed asset catalog and
choose the output format from the layout table in the view list.
 

Related Topics
• Mass Additions

• How Fixed Asset Mass Additions Import Data Is Processed

• How Payables Source Lines Are Imported

• How Project Costing Source Lines Are Imported

Assets Reconciliation Reports  
This topic includes details about the Assets reconciliation reports.

Overview
The Assets Reconciliation reports are designed to reconcile journal entries to your general ledger accounts.

Assets reconciliation reports include:

Report Name Description

Cost Clearing Reconciliation Report
 

Lists all asset additions and cost adjustments performed during the specified period for which
accounting entries are created for cost clearing accounts. The report is sorted by and groups totals for
each transaction type, balancing segment, and clearing account.
 

Cost Detail Report
 

Lists asset-level asset cost account balances for the specified periods. The report is sorted by and
groups totals for each balancing segment, asset cost account, and cost center.
 

Cost Summary Report
 

Lists asset cost account summary balances for the specified periods. The report is sorted by and
groups totals for each balancing segment and asset cost account.
 

Journal Entry Reserve Ledger
 

Lists asset depreciation amounts for the specified period. The report is sorted by and groups totals for
each balancing segment, expense account, reserve account, and cost center.
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Report Name Description

CIP Detail Report
 

Lists asset-level construction-in-process (CIP) cost account balances for the specified periods. The
report is sorted by and groups totals for each balancing segment, CIP cost account, and cost center.
 

CIP Summary Report
 

Lists CIP cost account summary balances for the specified periods. The report is sorted by and groups
totals for each balancing segment and CIP cost account.
 

Reserve Detail Report
 

Lists asset level asset reserve account balances for the specified periods. The report is sorted by and
groups totals for each balancing segment, reserve account, and cost center.
 

Reserve Summary Report
 

Lists reserve account summary balances for the specified periods. The report is sorted by and groups
totals for each balancing segment and reserve account.
 

Revaluation Reserve Detail Report
 

Lists asset revaluation reserve account balances for a specified period for an asset level. The report is
sorted by and groups totals for each balancing segment, asset cost account, and cost center.
 

Revaluation Reserve Summary Report
 

Lists asset level revaluation reserve account balances for the specified periods. The report is sorted by
and groups totals for each balancing segment, reserve account, and cost center.
 

Asset Balances Register Report
 

Lists initial costs, current reserve, year-to-date amounts, depreciation rules, and retirements for a
range of assets for the specified corporate book and for each associated tax book. The report sorts the
data by asset number.
 

Asset Register Report Lists the cost-related details, current activity, and retirements for every asset within the selected asset
category. The report also lists all transactions that impact asset cost during the chosen period.

Asset Leases Expense Report
 

Lists asset lease interest and expense amounts for the specified period. The report sorts by and groups
totals for each balancing segment, expense account, and cost center.
 

Asset Leases Liability Report
 

Lists asset lease liability for the specified period. The report sorts by and groups totals for each
balancing segment, liability account, and cost center.
 

Asset Cost and Reserve Report
 

The Asset Cost and Reserve Report lists the asset cost and depreciation reserve balances at the asset
or cost center level. The report sorts and totals by category, asset type, asset cost account, and cost
center. You can run the report only for closed periods.
 

The following table describes selected report parameters:

Name Description

Book
 

Use this parameter to specify the book to be included for reports.
 

Currency
 

Use this parameter to specify the currency to be included for reports.
 

From Asset Number and To Asset Number
 

Use these parameters to enter the asset number range for which you want to run the report.
 

Period Use this parameter to specify the period to be included for reports.
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Name Description

  

Frequently Asked Questions
The following table lists frequently asked questions about the Asset reconciliation reports:

FAQ Answer

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

When do I use these reports?
 

Use these reports to:
 

• Review your asset transactions to make sure they're being accurately posted.

• Keep track of your assets, and to reconcile Oracle Assets to your general ledger.

How do I reconcile journal entries to Oracle
General Ledger accounts?
 

Use the Unposted Journals Report in Oracle General Ledger to match General Ledger batch totals with
the asset batch totals found in the Subledger Accounting Account Analysis report.
 

How do I change the default report
format?
 

To change from Oracle Business Intelligence Publisher (BI Publisher), edit the fixed asset catalog and
choose the output format from the layout table in the view list.
 

Assets Group Reports  
This topic includes details about the Assets group reports.

Overview
The Assets group reports are designed to assist with the regulatory reporting requirements when you use group
depreciation.

Assets group reports include:

Report Name Description

Group Asset Detail Report
 

Lists the group and its member asset balances for the specified fiscal year and is used to comply with
Indian income tax requirements. The report is sorted by and groups totals for each fiscal year and
asset category.
 

Group Asset Listing
 

Lists the group asset balances for the specified fiscal year and is used to comply with Canadian capital
cost allowance requirements. The report is sorted by and groups totals for each fiscal year and asset
category.
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Report Name Description

Group Asset Summary Report
 

Lists the group asset balances for the specified fiscal year and is used to comply with Indian income tax
requirements. The report is sorted by and prints totals for each fiscal year and asset category.
 

The following table describes selected report parameters:

Name Description

Book
 

Use this parameter to specify the asset book to be included for reports.
 

Currency
 

Use this parameter to specify the currency to be included for reports.
 

From Fiscal Year
 

Use this parameter to specify the starting fiscal year for the reports.
 

To Fiscal Year
 

Use this parameter to specify the ending fiscal year for the reports.
 

From Asset Number and To Asset Number
 

Use these parameters to specify the asset number range you want to use for the report.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Assets Group reports.

FAQ Answer

How do I find these reports?
 

Schedule and run these reports from the Scheduled Processes work area on the Navigator menu.
 

When do I use these reports?
 

Use these reports if you use group depreciation as per regulatory reporting requirements of Canada
and India.
 

What are the group reports I can print?
 

• Canadian 50% Rule

Use this report to comply with the Canadian capital cost allowance (CCA) Schedule 8 guidelines.

• Group Summary: Summary for Half Year Rule

Use this report to review group asset amounts. It is designed to meet reporting on the Indian
50% rule and the Indian Income Tax Authorities regulatory requirement of summary depreciation
reporting.

• Group Detail: Detail for Half Year Rule

Use this report to review group and member asset detail amounts. The report is based on the
Indian 50% rule and is intended for management use.

How do I change the default report
format?
 

To change from Oracle Business Intelligence Publisher (BI Publisher), edit the fixed asset catalog and
choose the output format from the layout table in the view list.
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Related Topics
• Group Asset Depreciation

• Group Assets

• Guidelines for Creating Group and Member Assets

• Change Group Assets Using an Integrated Workbook

Reports for the United States  
This topic includes details about the reports for the United States.

Overview
These reports are designed to review the depreciation taken for the specified fiscal year. The reports also show
calculated gain or loss amounts for sales of 1245 or 1250 property held longer than the capital gain threshold.

Reports for the United States include:

Report Name Description

Form 4562 - Depreciation and
Amortization Report
 

Lists asset depreciation amounts for the specified fiscal year. This report is sorted by balancing
segment, fiscal year added, depreciation method, asset category, and asset number. It shows totals for
each category, depreciation method, fiscal year added, and balancing segment.
 

Form 4626 - AMT Detail Report
 

Lists the difference in year-to-date depreciation between any tax book and an alternative minimum
tax (AMT) book through the period you select in detail. The report is sorted by balancing segment,
depreciation method, asset account, category, and asset number. The report totals for each category,
asset account, method, and balancing segment.
 

Form 4626 - AMT Summary Report
 

Lists the difference in year-to-date depreciation between any tax book and an alternative minimum tax
book through the period you select in detail. The report is sorted by balancing segment, depreciation
method, asset account, category, and asset number. The report lists totals for each category, asset
account, method, and balancing segment.
 

Form 4797 - Gain From Disposition of 1245
Property Report
 

Lists gain or loss amounts from sales of 1245 property held longer than the capital gain threshold you
entered for the book on the Create Book page. This report only shows assets that were sold, so assets
without proceeds of sale do not appear. The report is sorted by balancing segment into gains and
losses, by asset account, and by asset number. The report shows totals for gains or losses, and for each
asset account and balancing segment.
 

Form 4797 - Gain From Disposition of 1250
Property Report
 

Lists gain or loss amounts from sales of 1250 property held longer than the capital gain threshold.
The report is sorted by balancing segment into gains and losses, property class, asset account, and
asset number. The report lists totals for gains or losses, and for each asset account, property class, and
balancing segment.
 

Form 4797 - Sales or Exchanges of
Property Report
 

Lists amounts held longer than the capital gain threshold. The report is sorted by balancing segment
into gains and losses, property class, asset account, and asset number. The report lists totals for gains
or losses, and for each asset account, property class, and balancing segment.
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Report Name Description

 

The following table describes selected report parameters:

Name Description

Book
 

Use this parameter to specify the book to be included for the reports.
 

Currency
 

Use this parameter to specify the currency to be included for the reports.
 

Fiscal Year
 

Use this parameter to specify the fiscal year for the reports.
 

From Period
 

Use this parameter to specify the starting period for a range of the reports.
 

To Period
 

Use this parameter to specify the ending period for a range of the reports.
 

Frequently Asked Questions
The following table lists frequently asked questions about the reports for the United States:

FAQ Answer

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

When do I use these reports?
 

Use these reports as per the regulatory reporting requirements of the United States tax law.
 

What information does the Gain From
Disposition of 1245/1250 Property Reports
print?
 

These reports calculate gain or loss amounts for sales of 1245 or 1250 property held longer than the
capital gain threshold you entered for the book on the Create Book page. Personal property is section
1245 or 1250 business property under United States tax law.
 
To use the 1245 or 1250 report, complete Part III of the United States federal tax form 4797 - Sales of
Business Property and enter a capital gain threshold of one year. If you need different capital gains
thresholds for different dates placed in service, such as the six month threshold for assets placed in
service before January 1, 1988 in the United States, set up your asset category for the different date
placed in service ranges with different thresholds.
 
The reports only show assets that were sold, so assets without proceeds of sale do not appear. For
items that were lost or stolen, run the Form 4684 - Casualties and Thefts Report.
 

How do I change the default report
format?
 

To change from Oracle Business Intelligence Publisher (BI Publisher), edit the fixed asset catalog and
choose the output format from the layout table in the view list.
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Other Assets Reports  
This topic includes details about the what-if analysis reports, property tax reports, and cash generating unit reports.

Overview
The other Assets reports include:

Report Name Description

Property Tax Report
 

Lists the assets at a particular location as of the specified cutoff date. This information is used for
property tax forms. The report is sorted by and groups totals for each balancing segment, location,
 asset account, and year acquired.
 

What-If Depreciation Analysis Report
 

Lists depreciation projections for the selected assets based on the specified depreciation parameters.
 

Hypothetical Depreciation Analysis Report
 

Lists depreciation projections for hypothetical assets based on the specified depreciation parameters.
 

Assets by Cash Generating Unit Report
 

Lists all assets by cash generating unit. The report extracts the details of all of the asset impairment
transactions, such as asset number, cash generating unit, cost, net book value, accumulated
impairment reserve, and year-to-date impairments from Oracle Assets.
 

Japanese Addition or All Asset Detail by
Asset Type Report 132 Characters
 

Lists depreciable assets for Japan in detail by asset type in a 132 character-wide format.
 

Japanese Addition or All Asset Detail by
Asset Type Report 180 Characters
 

Lists depreciable assets for Japan in detail by asset type in a 180 character-wide format.
 

Japanese Corporate Tax Reports Schedule
16 (1) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (2) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (4) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (6) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (8) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Depreciable Assets Tax
Summary Report

Lists a summary of depreciable assets for Japan by location as of January 1 for the selected fiscal year.
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Report Name Description

 

The following table describes selected report parameters:

Name Description

Book
 

Use this parameter to specify the book to be included for reports.
 

Currency
 

Use this parameter to specify the currency to be included for reports.
 

From Asset Number and To Asset Number
 

Use these parameters to enter the asset number range for which you want to run the report.
 

Frequently Asked Questions
The following table lists frequently asked questions about the other reports.

FAQ Answer

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

When do I use these reports?
 

Use these reports to:
 

• Review and analyze depreciation projections.

• Review data based on depreciation parameters for hypothetical assets.

• Review information for property tax forms.

• Review and analyze depreciation projection for your current depreciation parameters.

• Review and analyze the details of your asset impairment transactions.

What are the parameters required for
the Hypothetical Depreciation Analysis
Report?
 

You must enter a category, date in service, and cost when you submit this report.
 

Can I optionally enter an accumulated
depreciation amount for the Hypothetical
Depreciation Analysis Report?
 

Yes.
 

How do I submit the Hypothetical
Depreciation Analysis Report?
 

You must submit this report using the What-If Analysis window.
 

How do I change the default report
format?
 

To change from Oracle Business Intelligence Publisher (BI Publisher), edit the fixed asset catalog and
choose the output format from the layout table in the view list.
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Related Topics
• How Previous Year Tax Report Import Data Is Processed

• What-if Depreciation Analysis

• Perform What-if Depreciation Analysis on Existing Assets

• Perform What-if Depreciation Analysis on Hypothetical Assets

Asset Register Report  
This topic includes details about the Asset Register Report.

Overview
Use the Asset Register Report to provide cost-related details, current activity, and retirements for every asset within the
selected asset category. The report lists all transactions that impact asset cost during the selected period.

The following figure is an example of the report.

Key Insights
The Asset Register Report generates two layouts:

• Asset Register: Displays detailed information about active assets within a particular period range. Active assets
are assets that aren't fully retired during previous fiscal years.
Asset Register includes:

◦ Account details and description of each asset.
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◦ Financial data, such as initial values, increases, decreases, and final values. It includes asset cost
information, revaluation, depreciation, depreciation reserve, and net book value.

◦ Transaction information about asset transactions during the relevant fiscal year, ordered by the
transaction number.

• Asset Register - Retirements: Displays the assets that are retired during a given period. It includes retirement
date, asset cost at the time of retirement, retired depreciation reserve amounts, and retired net book value. This
is an optional layout.

The report doesn't include expensed assets or construction in process (CIP) assets.

Report Parameters
The following table lists selected parameters of the report:

Parameter Description

Major Category
 

Enter the major category segment value on which you want to report. Leave this parameter blank to
include all major categories.
 

Minor Category
 

Enter a minor category only if you enter a major category. Leave this parameter blank to include all
minor categories.
 

Asset Cost Account
 

Enter the assigned asset account. Select this parameter to list all the asset categories that are
associated with a particular cost account segment.
 

Legal Entity
 

Specify the legal entity to print the statutory heading on the report.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Asset Register Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Assets Manager

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use the Asset Register Report to:
 

• Report fixed asset ledger status to your tax authorities.

• Reconcile your fixed asset books with your ledger accounts balances.

• Review asset details, such as depreciation method, prorate convention, tag number, and
statistical information.
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FAQ Answer

• Review asset transactions, like additions and retirements, during the relevant fiscal year as of the
reporting period.

What type of reports are these?
 

Oracle Analytics Publisher
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16  Oracle Fusion Financials for EMEA Reports

Oracle Fusion Cloud Financials for EMEA Predefined
Reports  
Using Oracle Financials for EMEA you can generate predefined reports to meet reporting requirements of specific
countries for reconciliation and audit of tax calculated on transactions.

You can also prepare specialized reports based on the reporting data models.

You can schedule and run reports from the Scheduled Processes work area found on the Navigator. Here's how you
can run the predefined reports:

1. Click the Schedule New Process button.
2. Search on the Process Name.
3. Enter the appropriate parameters.
4. Enter the appropriate process options and schedule.
5. Click Submit.

You can generate predefined reports for:

• European Union

• France

• Germany

• Israel

• Italy

• Spain

• Turkey

• United Kingdom

Reports for the European Union and United Kingdom
The tax reports for the European Union and United Kingdom are:

Display Name Description

Sales Listing Report for European Union
 

Declares the information related to products and services that are rendered within the European Union
to VAT registered customers in other European Union member states.
 

Reverse Charge Sales List Report for UK
 

Lists the UK sales transactions that are created in Oracle Fusion Receivables. It lists transactions for
high value electronic goods that are subjected to the Reverse Tax Charge and reported to HRMC (Her
Majesties Revenue and Customs). The reported data is grouped by the customers.
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Reports for France
The tax reports for France are:

Display Name Description

DAS2 Contractor Letters for France
 

Generates letters to all contractors in France whose income is reported in the DAS2 extract file for the
current year. This lists income tax amounts from Oracle Fusion Payables grouped by income tax type
for France.
 

DAS2 Extract File for France
 

Generates the DAS2 electronic file for France that's submitted to the tax authorities in a predefined
format.
 

DAS2 Type 210 Updates Report for France
 

Generates a list of all changes to data related to DAS2 reporting for France. This also lists all the
changes that are made since the last run of the verification report.
 

DAS2 Verification Report for France
 

Generates DAS2 information for contractors in France and related income tax information from data
entered in Oracle Fusion Payables. The report extracts information into the DAS2 temporary tables and
automatically submits the DAS2 Verification Extract Execution Report for France.
 

Deductible VAT Declaration Report for
France
 

Lists the deductible VAT amount and totals of invoices for France that are entered in Oracle Fusion
Payables. The VAT deductibility rule, tax rate, and account number are used to group the reported data.
 

Audit Report for France
 

Creates the electronic audit file that's required to be submitted to tax authorities in France. You can
create the electronic file in HTML format, and as an excel spreadsheet for data verification.
 

Reports for Germany
The subledger and accounting reports for Germany are:

Display Name Description

Z4 Report for Germany
 

Lists all incoming and outgoing payments made through a foreign bank for the selected ledger and
date range. The report prints only the payments that are more than the legally defined threshold
amount.
 

Z5A Report for Germany
 

Shows the sum of all outstanding receivables and liabilities of goods and services traded with foreign
suppliers or customers. You can select the summarize option to print either the Z5A Reconciliation
Report or the Z5A Sheet 2 Report.
 

Journal Details Report for Germany
 

Provides posted general ledger journal activity for a given period or date range. You can optionally
include other criteria like journal category, ledger currency, and journal batch. You can group and sort
the entries at report submission. Using this report you can print balances for actual, encumbrance, or
budget balance type.
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Reports for Israel
The tax reports for Israel are:

Display Name Description

Withholding Tax Report for Israel
 

Prints summary and details of withholding tax and income tax activities.
 

Withholding Tax Reconciliation Report for
Israel
 

Prints all payments and related withholding tax transactions for suppliers and supplier sites for the
selected reporting period.
 

Withholding Tax File for Tax Authority for
Israel
 

Creates a text file in a predefined format for submission to the tax authorities, using the form 856. The
file lists the withheld tax amounts for each supplier, supplier personal details, and the total amounts on
the transactions including payments, withholding tax amounts, and liabilities.
 

Supplier Withholding Annual Certificate for
Israel
 

Prints the annual summary of all supplier transactions with the entity issuing the certificate. It lists the
withholding tax amounts and payments made to the supplier.
 

Receipt Report for Israel
 

Prints receipt details, taxpayer details, and payer details in a specific format.
 

Withholding Tax Summary Detail Report
for Israel
 

Prints summary and details of withholding tax and income tax activities.
 

Reports for Italy
The tax reports for Italy are:

Display Name Description

Declarable Input VAT Register for Italy
 

Lists the tax declarable activities including payments of the invoices with deferred tax. The report lists
supplier details and recoverable and nonrecoverable taxable and tax amounts grouped by tax rate
code.
 

Declarable Output VAT Register for Italy
 

Lists the tax declarable activities including receipts of the invoices with deferred tax, adjustments, and
bills receivables. The report prints customer details and transaction tax-related details grouped by tax
rate code.
 

Payable Sales VAT Register for Self-
Invoices, Inter-EU Invoices, and VAT for
Italy
 

Identifies a sales VAT register for Italy for all invoices received from suppliers within the European
Union or all self-billing invoices that have accounting dates within the period range being reported.
The report displays recoverable and nonrecoverable elements of both tax and taxable amounts
grouped by tax code.
 

Purchase VAT Register for Italy
 

Identifies all purchase invoices for Italy with document sequence numbers assigned to the selected
VAT register name, and with accounting dates within the period range being reported. The report
prints and groups invoices by tax rate code.
 

Receivables Sales VAT Register for Italy
 

Identifies all sales invoices for Italy assigned to the document sequence name of the selected VAT
register name, and with accounting dates within the period range being reported. The report prints
and groups invoices by tax rate code.
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Display Name Description

 

VAT Liquidation Report for Italy
 

Identifies a summary of the VAT amounts by tax code for each VAT type and VAT register for the
selected period. It also includes the consumption per exemption limit group and the available limit at
the beginning and end of the month. The transactional tax data are grouped by Declarable Output VAT
Register and Declarable Input VAT Register.
 

European Purchase Listing of Services for
Italy
 

Lists all Intra-EU payables transactions for services. The report prints invoice details specific to Italy
such as service mode, service code, and protocol number.
 

European Sales Listing of Services for Italy
 

Lists all Intra-EU receivables transactions for services. The report prints invoice details specific to Italy
such as service mode, service code, and protocol number.
 

Yearly Tax Report
 

Prints tax and taxable amount information for input and output taxes for all final reported tax periods
within the year. The report can be printed in detail or summary format.
 

Yearly Withholding Tax Report for Italy
 

Shows annual taxes withheld by first-party legal entities, for the supplier for the year selected.
The report data can be printed or grouped by supplier name, supplier taxpayer ID, or supplier tax
registration number.
 

Withholding Tax Letters for Italy
 

Identifies letters sent to suppliers in Italy confirming tax amounts withheld on partially or fully paid
purchase invoices within a calendar year. Letters can be printed for a specific supplier or for all
suppliers that have tax withheld.
 

Exemption Letter Report for Italy
 

Produces an exemption letter for each exempt supplier in Italy instructing them not to include VAT on
invoices that they submit.
 

Subledger Letter of Intent Register for Italy
 

Lists all exemption letters issued to suppliers or received by customers in Italy within a given period
range.
 

Letter of Intent Receivables Invoice
Register
 

Lists details about Receivables transactions issued with a Letter of Intent for a given calendar year.
Provides letter of intent details like protocol number, allocation type, amount and effective dates.
 

Supplier Exemption Limit Consumption
Report for Italy
 

Lists the details of suppliers eligible for exemption in Italy and their monthly consumption of assigned
exemption limit. Lists consumption details of all the suppliers, or a specific supplier. Details include all
invoices exempted during a calendar period.
 

Letter of Intent Report for Italy
 

Produces a letter of intent for each exempt supplier in Italy instructing them not to include VAT on
invoices that they submit.
 

Reports for Spain
The tax reports for Spain are:

Display Name Description

Input VAT Journal for Spain
 

Identifies detail and summary information about tax on invoices and expense reports for Spain
entered in Oracle Fusion Payables. Data is reported by register type: recoverable tax register and
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Display Name Description

nonrecoverable tax register. The transactions can be selected based on tax reporting type and tax
reporting code.
 

Output VAT Journal for Spain
 

Identifies detail and summary information entered in Oracle Fusion Receivables about tax on
transactions created for Spain. Data is reported by register type: tax register and nonrecoverable tax
register. The transactions can be selected based on tax reporting type and tax reporting code.
 

VAT Inter-EU Invoice Journal for Spain
 

Identifies detail and summary information about invoices received in Spain from suppliers located in
any European Union member state. Invoices are entered and posted in Oracle Fusion Payables, and
have offset or self-assessed tax distributions. The transactions can be selected based on tax reporting
type and tax reporting code.
 

VAT Inter-EU Invoice Format for Spain
 

Lists details of the same invoices that appear on the Spanish VAT Inter-EU Invoices Journal report. The
transactions can be selected based on tax reporting type and tax reporting code.
 

Modelo Electronic File Generation for
Spain
 

Prepares electronic file for Modelo 340, 347, 349, or 415 declarations in a legally predefined format.
 

Modelo Verification Report for Spain
 

Lists all payables invoices and receivables transactions that are reported in the Modelo 340, 347, 349,
 or 415 declarations. The report prints data based on the selected legal entity, period range, source, and
Modelo name. For receivables cash receipts, only receipts that are of a greater value than the entered
minimum cash amount are reported.
 

Withholding Tax Report for Spain
 

Identifies summary or detail withholding tax information for Spain by invoice and withholding tax code.
The report prints information for a selected legal entity, and optionally for specific supplier.
 

Withholding Tax Magnetic Format for
Spain
 

Lists withholding tax transactions for the selected legal entity and tax year in a flat file format in the
predefined layout.
 

Withholding Tax Extract Report for Spain
 

Extracts withholding tax transactions for Spain and stores them in an interface table to be used to
report withholding tax transactions. The report selects information for a specific legal entity, and
optionally for a specific supplier.
 

Report for Turkey
The tax report for Turkey is:

Display Name Description

Process Exchange Rate Difference Report
for Turkey
 

Summarizes the conversion rate differences for invoice, credit memo and journal. It also provides the
complete details including tax components in the ledger currency. It prints the eligible gain/loss lines
that are processed by the Process conversion rate Differences job for each trading partner and site.
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General Ledger and Subledger Accounting Reports for
EMEA  
Oracle Fusion Financials for EMEA provides predefined reports that are used to meet reporting requirements for
specific countries and for reconciliation and audit of tax calculated on transactions.

Use the General Ledger and Subledger Accounting reports for reporting in countries in Europe and South America.
These reports provide reporting data models on which you can prepare specialized reports. You can also use them to
inform shareholders on the financial results in other countries as well. Configure these reports to report the clearing
account reconciliation information available in the report extract.

You can schedule and run reports from the Scheduled Processes work area found on the Navigator. To run predefined
reports:

1. Click the Schedule New Process button.
2. Search on the Process Name.
3. Enter the desired parameters.
4. Enter the desired process options and schedule.
5. Click Submit.

General Ledger Reports
The following table lists the General Ledger reports:

Display Name Description

General Ledger Trial Balance Report
 

Lists actual account balances and activity by ledger, balancing segment, and account segment. The
report prints the value, description, and debit or credit balance for the beginning and ending period,
 along with the debits and credits for the period. The report can print income statement, balance sheet,
or all balances for a selected range of accounting code combinations. You can run this report for a legal
entity.
 

General Ledger Journal Entry Report
 

Provides general ledger journal activity for a given period or date range, and optionally other criteria
including journal source, entered currency, and journal batch. Flexible grouping and sorting options are
provided at report submission.
 

General Ledger Journal and Balance
Report
 

Retrieves all information for the reports that require journal entries and account balances. The account
balances can be printed for selected levels of the hierarchy for actual, encumbrance, or budget balance
types.
 

Subledger Accounting Reports
The following table lists the Subledger Accounting reports:
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Display Name Description

Third-Party Detail and Balances Report
 

Provides third-party account balances and accounting activity details for a period. You can review the
accounting process details by third party and audit third-party accounts in detail.
 

Third-Party Account Balance Report
 

Prints account and original third-party transactions impacting the account during a particular period.
The report is run to ensure that subledger and general ledger balances reconcile, and to identify
possible reasons for any discrepancies.
 

Third-Party Balances Summary Report
 

Displays information for each account of the third party and third-party site, and account
identification. This report is a tool for auditing third-party accounts.
 

Journals and Third-Party Report
 

Prints all journals posted in Oracle Fusion General Ledger for the accounting period. The report
provides accounting and reporting sequence details, detailed subledger accounting entry lines
reporting level regardless of the ledger journals summarization. It helps in verifying that all journals
are accurately recorded in chronological order with no gaps using legal sequencing rules for both
accounting entries and source documents.
 

General Ledger and Subledger Accounting
by Journal Lines Report
 

Lists account balances or selected segment balances with subledger journal details including entered
amounts, third-party name, journal source, journal category, and reporting and accounting sequences.
Total number of debit and credit documents is also listed.
 

Account Analysis by Legal Entity Report
 

Prints account balances by accounting code combination and selected segments with subledger
journal details, including third-party information and sequences. Flexible grouping and sorting options
are provided at submission.
 

General Ledger and Subledger Account
Analysis Report
 

Prints account balances by account with subledger journal details. The report displays entered
amounts, third-party information, sequences, and total number of debit and credit documents.
 

Daily Journals Report
 

Lists subledger journal activity for a given period or date range, journal source, entered currency, and
journal batch. Report prints detailed subledger journal lines prior to general ledger summarization.
Third party and transaction details are also listed for the journal lines.
 

Subledger Detail Journal Report
 

Displays information about the posted general ledger journal batches that originate from Oracle Fusion
Receivables and Oracle Fusion Payables subledgers. The report prints subledger details like transaction
number, transaction date, transaction amount in entered and ledger currency.
 

Journal Ledger Report
 

Lists the accounting entries with subledger details like transaction number, transaction date, and line
description, using flexible sorting options that are provided at report submission. This report provides
a real audit trail between general ledger and subledgers to satisfy legal and business requirements.
 

Reports for the European Union  

Sales Listing Report for European Union  
This topic includes details about the Sales Listing Report for European Union.
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Overview
Use the Sales Listing Report for European Union to declare goods and services that are rendered within the European
Union (EU) to VAT-registered customers in the other EU member states.

Let's take a look at the sample report in a summary format.

Key Insights
This report only includes transactions with the tax reporting code as Intra-EU transactions for goods or services tax.

Invoices, credit memos, and adjustments are reported based on the invoice tax date, the date on which goods and
services are rendered.

Report Parameters
This table describes the selected report parameters:

Parameter Name Description

Trader VAT Number
 

Select the tax registration number of the first-party legal reporting unit.
 

Country of the Tax Registration Number
 

Select the site whose country code is displayed on the report when the tax registration number doesn't
contain the first two characters as the country code.
 

Include Prior Period Adjustments and
Credit Memos

Select Yes to display adjustments and credit memos that are related to transactions from a different
reporting period. Select No for adjustments and credit memos to be included in the regular totals.
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Parameter Name Description

  

Rounding Rule
 

Select the rounding method for the calculated taxes to the minimum accountable unit. The available
options are Up, Down, and Nearest.
 

Minimum Reportable Amount
 

Enter the smallest unit used for the ledger currency amounts.
 

Tax Reporting Type Code
 

Select the appropriate Intra-EU transaction tax reporting type code.
 

Tax Reporting Code for Intra-EU Goods
 

Specify the tax reporting code created for goods. If you don't want to include goods in the report,
 select the value as null.
 

Tax Reporting Code for Intra-EU Services
 

Select a tax reporting code associated with the tax reporting type that you have previously selected.
 

Additional Tax Reporting Code 1
 

Select a tax reporting code associated with the tax reporting type that you have previously selected. If
required, specify the tax reporting code created for triangulation of goods or goods and services.
 

Additional Tax Reporting Code 2
 

Select a tax reporting code associated with the tax reporting type that you have previously selected. If
required, specify the tax reporting code created for triangulation of goods or goods and services.
 

Frequently Asked Questions
This table lists frequently asked questions about the Sales Listing Report for European Union.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use this report to declare goods and services that are rendered within the European Union (EU) to VAT-
registered customers in the other EU member states.
 

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• European Sales Listing Topical Essay
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Reports for France  

DAS2 Reports for France  
This topic includes details about the DAS2 reports for France.

Overview
In France, companies that do business with independent contractors declare to tax authorities all payments to
contractors each year for each supplier. These third-party payments include fees, commissions, and rebates. The DAS2
report declares all payments made to the contractors.
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The DAS2 reporting includes:

• DAS2 Contractor Letters for France: Generates letters to all contractors in France whose income is reported in
the DAS2 extract file for the current year. Lists income tax amounts from Oracle Fusion Payables grouped by
income tax type for France.

The following figure is an example of the DAS2 Contractor Letters for France.

• DAS2 Extract File for France: Generates the DAS2 electronic file for France that is submitted to the tax
authorities in a predefined format.
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• DAS2 Type 210 Updates Report for France: Generates a list of all changes to data related to DAS2 reporting for
France that are made since the last run of the verification report.

The following figure is an example of the DAS2 Type 210 Updates Report for France.

• DAS2 Verification Report for France: Generates DAS2 information for contractors in France and related income
tax information from data entered in Payables. Extracts information into the DAS2 temporary tables and
automatically submits the DAS2 Verification Extract Execution Report for France.

The following figure is an example of the DAS2 Verification Report for France.

Key Insights
You can generate an XML file with information on payments made to contractors and send it to the tax authorities.

If your company has more than one location that makes payments to independent contractors, you can submit:

• Separate formatted XML files for each location that is a part of a different tax district
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• One XML file if all locations are from the same tax district

All invoices, advanced payments or prepayments, and credit memos that have DAS2 income tax codes associated with
transaction lines are reported.

Report Parameter
The following table describes selected DAS2 report parameters:

Parameter Description

Legal Entity
 

Specify the legal entity. You can control the report output through this parameter only if you have
associated balancing segment values to your legal entities.
 

Supplier
 

Specify the name of the contractor to whom payment is made.
 

Year
 

Specify the year in which the payment is made.
 

Tax for Salaries
 

Specify whether taxes on salaries and contractor fees are paid to the government.
 

Frequently Asked Questions
The following table lists frequently asked questions about the DAS2 reports for France.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use the DAS2 reports to:
 

• Review payments made to foreign and domestic contractors during the fiscal year

• Print DAS2 letters to send to contractors informing them about the:

◦ Payments

◦ Information reported to tax authorities

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• How You Generate DAS2 Reports for France
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Deductible VAT Declaration Report for France  
This topic includes details about the Deductible VAT Declaration Report for France.

Overview
In France, companies must report deductible VAT on purchase of goods and services, by applying the relevant rule to
determine if VAT is deductible during invoice creation and payment time. The Deductible VAT Declaration Report for
France lists the deductible VAT amounts and totals of invoices for France, grouped by deductible VAT rule, tax rate, and
account number.

The following figure is an example of the report.

Key Insights
The VAT processing is based on tax point basis, tax point date, and marked as reportable. Only tax lines with the
reportable option set to yes are reported.

The Deductible VAT Declaration Report for France prints deductible VAT amounts and groups transactions by deduction
tax rules such as:

• DEB-M tax rule: VAT deductible on received invoices for goods or services.

• CRE-M tax rule: VAT deductible on invoice payments.
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For transactions to which the CRE-M rule applies, the tax point basis is set to Payment and are reported when they are
either partially or fully paid.

The report displays two separate sections for DEB-M and CRE-M tax rules and lists details of transactions that are not
posted to general ledger. Invoices with deferred tax rates are reported as a part of CRE-M only after the invoice is paid.
Invoices that have tax rates with tax point basis set to invoice, accounting, or delivery are reported under the DEB-M
section.

Report Parameters
The following table lists selected parameters for the Deductible VAT Declaration Report for France:

Parameters Description

Reporting Level
 

Choose the level on which you want to run the report. You can choose from three different levels,
 Ledger, Legal Entity, and Tax Registration Number.
 

Reporting Context
 

Specify the context for the report. The list of values for this parameter depends on the reporting level
you selected.
 

• If you select the reporting level of Legal Entity, you select the legal entity on which to report, and
then select the tax registration number associated with the legal entity.

• If you select Ledger as the reporting level, you can report on legal entities associated with ledgers
defined in the data access set within your security profile. Run tax reports by ledger when you
want to review your tax activity as it aligns with your accounting. Run tax reports by ledger when
you need to view tax activity in reporting or secondary ledger currency.

• If you select tax registration number as the reporting level, you can report all the transactions
associated with different legal entities sharing the same tax registration number.

Tax Registration Number
 

Specify the registration number that is assigned to first party or first-party site by the tax authority
when it is registered. A party or party site is identified by this registered number.
 

From Tax Point Date and To Tax Point Date
 

Print all the transactions based on the selected tax point date range.
 

Note:
When CRE-M rule is applicable on transactions, the tax point date is the payment date.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Deductible VAT Declaration Report for France.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant
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FAQ Answer

When do I use this report?
 

Use the Deductible VAT Declaration Report for France to produce the VAT declaration at the end of
each reporting period, listing the deductible VAT amount for each purchase invoice and also the total
VAT amounts for the period.
 

What type of reports are these?
 

Oracle Analytics Publisher
 

Audit Report for France  
This topic includes details about the Audit Report for France.

Overview
Use the Audit Report for France process to create an electronic audit file. You can transfer the electronic audit file,
which is a data file, to the tax authorities. This electronic audit file along with journals must comply with the Generally
Accepted Accounting Principles (GAAP) in France.

This report also includes the clearing account reconciliation information. In Columns 14, EcritureLet, and 15, DateLet,
you can view the reconciliation group and reconciliation date respectively for each of the reconciled clearing account
journal lines. For unreconciled lines or a reconciliation feature that's not being used, these columns don't display this
information.

From January 1, 2014, all tax paying companies in France that are audited by the tax authorities must create audit
documentation in the prescribed format. Auditors use this documentation to verify the coherence between the audit file
and the reported accounting.

Key Insights
Before running the report, ensure that you have:

• Set up the following entities:

◦ Data security

◦ Enterprise structure

◦ Document sequences, if applicable

• Completed the implementation project for your organization

• Entered, processed, accounted, and transferred all subledger transactions to General Ledger

Note:  All manual journals must be processed for the reporting period. You don't have to enter any specific attributes
on the subledger transactions or journals to report them.

Report Parameters
This table describes selected report parameters:
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Name Description

Journal Entry Source
 

Select a source or leave blank to report on all sources.
 

Ledger
 

Enter the ledger name. The available values depend on the data access set assigned to the user.
 

Legal Entity
 

Choose from values that are based on the legal entities associated with the ledger. Leave the field
blank to report on the complete ledger, regardless of the legal entity.
 

Show adjustment periods
 

Indicate whether to create the report by adjustment period.
 

From and To Accounting Period
 

Select the reporting period for which you want to display the adjustment period.
 

Account filter
 

Optionally, restrict the accounts to include in the data file.
 

Document Sequence Name
 

Enter the sequence name to specify the transactions to be included in the electronic file.
 

Posting status
 

Select the posting status to view:
 

• Only posted journals

• Journals that are transferred, but not yet posted

Frequently Asked Questions
This table lists frequently asked questions about the Audit Report for France:

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

General Ledger users.
 

When do I use this report?
 

Use this report at the end of the reporting period to prepare the file to be submitted to the tax
authorities. You can create the file quarterly or even for multiple tax years.
 

What type of report is this?
 

Oracle Analytics Publisher.
 

What role is required to run this report?
 

ORA_JE_EMEA_FINANCIAL_REPORTING_DUTY

Note:  Ensure that JE_PREPARE_FINANCIAL_REPORTS_FOR_FRANCE_PRIV and JE_PREPARE_
FINANCIAL_REPORTS_FOR_FRANCE_PRIV_OBI privileges are added to the ORA_JE_EMEA_
FINANCIAL_REPORTING_DUTY role.

 

How can I save the output for the audit
reports for France?
 

Choose Save to save the output file for the audit reports for France in text, data, or CSV format.
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FAQ Answer

How can I review the audit reports for
France?
 

You can review the audit reports in an excel sheet.
 

Related Topics
• Audit Report for France Topical Essay

Reports for Germany  

VAT Reports for Germany  
This topic includes details about the reports for Germany.

Overview
The reports for Germany provide the details needed by companies to meet the statistical reporting requirements of the
Federal Bank. You can use these reports as a basis for submitting your official declarations to the Federal Bank. These
reports also simplify the auditing of general ledger journals, and streamline the reconciliation of outstanding receivables
and liabilities of foreign customers and suppliers with subledger records.

The reports for Germany include:

• Z4 Report for Germany: Lists all incoming and outgoing payments made through a foreign bank for the
selected ledger and date range. Only payments more than the legally defined threshold amount are printed.

• Z5A Report for Germany: Provides details of receivables and liabilities of foreign customers and suppliers,
both internal and external. Based on the Summarize option selected, the Z5A Reconciliation Report or Z5A
Sheet 2 Report is printed. The Z5A Reconciliation Report lists single transaction amounts that reconcile with the
aggregated amounts in the Z5A Sheet 2 Report. Detailed amounts are provided per customer or supplier for
each transaction or invoice number on a given date.

• Journal Details Report for Germany: Provides posted general ledger journal activity for a given period or date
range for auditing posting sequences. In Germany, general ledger journals must be sequenced by posted date.
The report is generated for a range of accounting or posting dates to show all details of the sequenced journals
and daily total amounts.

The following figure is an example of the Z4 Report for Germany.
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The following figure is an example of the Z5A Reconciliation Report for Germany.

The following figure is an example of the Z5A Sheet 2 Report for Germany.
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The following figure is an example of the Journal Details Report for Germany.

Key Insights
For accurate statistical reporting on the Z4 Report for Germany, enter the following information for transactions:

• For Payables:

◦ Record type

◦ Payment reason

• For Receivables:

◦ Record type

◦ Reason
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Only transactions that are accounted and posted to the general ledger are selected for reporting.

Before you submit the Journal Details Report for Germany, you must configure the general ledger accounting sequence
to generate the sequence while posting the journal.

Report Parameters
The following table lists selected process parameters of the Z4 Report for Germany:

Name Description

Ledger
 

Specify the ledger for reporting.
 

Legal Entity
 

Specify the legal entity for reporting. If you have set up ledgers with multiple legal entities, this
parameter will allow you to generate the Z4 reports for a specific legal entity.
 

Threshold
 

Specify the statutory limit used to determine whether an individual payment is reported. The default
value is the current statutory limit of 12,500 EUR, and only payments more than this limit are reported.
 

The following table lists selected process parameters of the Z5A Report for Germany:

Name Description

Ledger
 

Specify the ledger for reporting.
 

Legal Entity
 

Specify the legal entity for reporting. If you have set up ledgers with multiple legal entities, this
parameter will allow you to generate the Z5A reports for a specific legal entity.
 

Summarize
 

Select the Summarize option for the Z5A Reconciliation Report, or leave the option blank for the Z5A
Sheet 2 Report.
 

Party Name
 

Indicate a supplier or customer to reconcile specific payments.
 

Threshold Amount
 

Specify the statutory limit used to determine whether an outstanding receivables or payables amount
is reported.
 

The following table lists selected process parameters of the Journal Details Report for Germany.

Name Description

Ledger
 

Specify the ledger for reporting.
 

Filter Conditions Defined
 

To audit a specific account, specify the segments and values.
 

Document Sequence Number
 

Specify the reporting sequence name used to number the posted journal. You can audit journals that
have a specific reporting sequence name and number assigned.
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Name Description

 

From/To Document Number
 

Enter a specific range to verify that sequence numbers are assigned chronologically.
 

First Page Number
 

Specify the starting page number for the report.
 

Frequently Asked Questions
The following table lists frequently asked questions about the reports for Germany.

FAQ Answer

How do I find these reports?
 

Schedule and run these reports from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

• General Accounting Manager

• Payables Manager

• Receivables Manager

• Financial Analyst

When do I use these reports?
 

Use these reports to:
 

• Review the incoming and outgoing payments that exceed the statutory limit.

• Report all payments with payment reason, reason code, and record type.

• Report outstanding receivables and payables of foreign customers and suppliers that exceed a
prescribed threshold.

• Print daily totals for a given period, or accounting and posting dates.

• Print journals that have posting errors.

• Audit reporting sequence name and numbers assigned to the journals, and verify they are
assigned in ascending order based on the journal posting date.

• Audit posting document sequences for a range of accounting or posting dates.

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• Reporting Features for Germany

Reporting Features for Germany  
Oracle Fusion Applications provide standard financial and tax reports to meet the legal and business reporting
requirements of tax authorities.
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Companies in Germany must comply with the Federal Bank reporting requirements on incoming and outgoing
payments when the amount for an individual payment transaction exceeds the statutory limit. The Federal Bank also
requires that companies use a specific format when submitting the Z4 and Z5 reports.

The following table lists the reports that support these requirements:

Report Name Description

Z4 Report for Germany
 

Reports all incoming and outgoing payments above a threshold amount that are any of the following:
 

• Received from nonresidents

• Received from residents for the account of nonresidents

• Made to nonresidents from residents

Includes all payments made through a foreign bank account. This report is used to complete the official
declaration.
 

Z5A Report for Germany
 

Provides the following reporting options:
 

• Z5A Sheet 2 Report, which summarizes the receivables and payables of foreign customers and
suppliers, respectively, both internal and external.

• Z5A Reconciliation Report, which reconciles the aggregated amounts included in the Z5A Sheet 2
Report, by providing the transaction details per customer or supplier.

Select the Summarize option for the Z5A Reconciliation Report, or leave the option blank for the Z5A
Sheet 2 Report.
 

Journal Details Report for Germany
 

Provides posted general ledger journal activity for a given period or date range, and optionally other
criteria including journal source, entered currency, and journal batch. Provides flexible grouping and
sorting options at report submission.
 
Prerequisite: Before you submit the report, you must configure the general ledger accounting
sequence to generate the sequence while posting the journal.
 
Use the report to:
 

• Verify that the journals are sequenced by posted date.

• Confirm balance sheet and profit and loss statements for a specific accounting period.

• Verify accounting books during audits.

Reports for Israel  

Overview of Withholding Tax Reports for Israel  
This topic includes details about the withholding tax reports for Israel.

Overview
All legal entities in Israel must submit their withholding tax reports in compliance with the fiscal authority specifications.
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The following reports support withholding tax for Israel:

• Withholding Tax Report for Israel: Prints summary and details of withholding tax and income tax activities. It
lists all the withholding tax transactions for a given period.

• Withholding Tax Reconciliation Report for Israel: Prints all payments and related withholding tax transactions
for suppliers and supplier sites for the selected reporting period.

• Withholding Tax File to Tax Authority for Israel: Creates a text file in a predefined format, called form 856, for
submission to the tax authorities. The file lists the withheld tax amounts for each supplier, supplier personal
details, and the total amounts on the transactions including payments, withholding tax amounts, and liabilities.

• Withholding Tax Annual Certificate to Suppliers for Israel: Prints the annual summary of all supplier transactions
with the entity issuing the certificate. It lists the withholding tax amounts and payments made to the supplier.
The report contains the following details:

◦ For a receipt in the form of a check: the account, bank, branch and check number information is listed.

◦ For an account transfer: bank, branch information is listed.

◦ Else, the credit card information is listed.

• Receipt Report for Israel: Prints receipt details, taxpayer details, and payer details in the specific format for
Israel.

Key Insights
Before running the reports, ensure that you:

• Set up the following entities:
◦ Data Security

◦ Geographies

◦ Enterprise Structure

◦ Suppliers

◦ Bank accounts

◦ Procurement Business Function

◦ Common Options for Payables

• Complete the implementation project before entering transactions and using the transaction tax reports.

Report Parameters
The following table lists the main parameters for the withholding tax reports for Israel:

Name Description

From and To Document Number
 

Enter a specific range to verify that sequence numbers are assigned chronologically.
 

Ledger
 

Specify the ledger for reporting.
 

Legal Entity Specify the legal entity that is submitting the declaration to the tax authority.
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Name Description

  

Reporting Level
 

Enter the reporting level for which you want to select transactions, such as ledger, legal entity, or tax
registration number.
 

Frequently Asked Questions
The following table lists frequently asked questions about the withholding tax reports for Israel.

FAQ Answer

How do I find these reports?
 

Schedule and run these reports from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

• Tax Manager

• Tax Accountant

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• Withholding Tax Reporting for Israel Topical Essay

Reporting Features for Israel  
Use Oracle Fusion Applications to get standard financial and tax reports that meet the legal and business reporting
requirements of tax authorities. For countries such as Israel, you can get a set of country-specific reports. These reports
meet local reporting requirements for withholding tax.

This table lists the withholding reports for Israel.

Withholding Tax Reports

Report Name Description

Withholding Tax Report for Israel
 

Prints summary and details of withholding tax and income tax activities.
 

Withholding Tax Reconciliation Report for
Israel
 

Prints all payments and related withholding tax transactions for suppliers and supplier sites for the
selected reporting period.
 

Withholding Tax File to Tax Authority for
Israel
 

Creates a text file in a predefined format for submission to the tax authorities, that's, form 856. The file
lists the withheld tax amounts for each supplier, supplier personal details, and the total amounts on the
transactions including payments, withholding tax amounts, and liabilities.
 

Withholding Tax Annual Certificate to
Suppliers for Israel

Prints the annual summary of all supplier transactions with the entity issuing the certificate. It lists the
withholding tax amounts and payments made to the supplier.
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Report Name Description

  

Receipt Report for Israel
 

Prints receipt details, taxpayer details, and payer details in a specific format.
 

Reports for Italy  

VAT Reports for Italy  
This topic includes details about the VAT reports for Italy.

Overview
Oracle Fusion Applications provide a set of VAT reports to meet the legal and business reporting requirements of tax
authorities.

The VAT reports for Italy include:

• Declarable Input VAT Register for Italy: Lists the declarable input VAT activities with document sequences
assigned to the selected tax register, including payments of invoices with deferred tax for a specific period. The
report displays the recoverable and nonrecoverable tax amounts and corresponding taxable amounts. Provides
a summary section with totals by tax rate code and a grand total.

The following figure is an example of the report.
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• Declarable Output VAT Register for Italy: Lists the declarable output VAT activities with document sequences
assigned to the selected tax register, including cash receipt applications of invoices with deferred tax and
adjustments. Displays the tax and taxable amounts. Provides a summary section with totals by tax rate code
and a grand total for invoices, receipts and adjustments.

The following figure is an example of the report.

• Payable Sales VAT Register for Self Invoices, Inter-EU Invoices, and VAT for Italy: Provides the recoverable,
nonrecoverable and deferred tax amounts, and corresponding portions of taxable amounts for all invoices
received from suppliers within the European Union, or all self-billing invoices that have accounting dates within
the reporting period.

The following figure is an example of the report.
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• Purchase VAT Register for Italy: Lists all purchase invoices with document sequences that are assigned to the
selected tax register and have accounting dates within the selected tax period.

The following figure is an example of the report.

• Receivables Sales VAT Register for Italy: Lists all sales invoices with document sequences that are assigned to
the selected tax register and have accounting dates within the selected tax period.

The following figure is an example of the report.

• VAT Liquidation Report for Italy: Provides summary information for all tax events that can be reported with tax
point dates within the reporting period. Identifies the associated tax register for each transaction. Provides a
summary per tax rate code with the totals for each tax register. Includes a grand total section for all sales and
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purchases VAT that can be reported and credit balances from the previous report, which determines the net
VAT amount to be paid to the authorities.
The following figure is an example of the report.

Key Insights
Before you run the VAT reports for Italy, ensure that you:

• Set up tax reporting entities and tax registers

• Configure tax reporting type and tax reporting type codes

• Associate document sequence names with tax registers

The VAT reports for Italy either use accounting date or tax point date for reporting data. Reporting of data by:

• Accounting date lets you list all invoicing activity regardless of what is declarable from tax perspective.

• Tax point date lets you report all declarable tax activity within a specific period and helps you to prepare
declaration.

The following table lists the reports that use accounting date and tax point date for reporting transactions:

Report Name Accounting Date Tax Point Date

Declarable Input VAT Register for Italy
 

No
 

Yes
 

Declarable Output VAT Register for Italy
 

No
 

Yes
 

Payable Sales VAT Register for Self Invoices,
Inter-EU Invoices, and VAT for Italy
 

Yes
 

No
 

Purchase VAT Register for Italy Yes No
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Report Name Accounting Date Tax Point Date

   

Receivables Sales VAT Register for Italy
 

Yes
 

No
 

VAT Liquidation Report for Italy
 

No
 

Yes
 

Run the Select Transactions for Tax Reporting process before you run the VAT reports for Italy. The process marks the
transactions with a tax reporting identifier, and identifies the tax reporting periods and tax registers defined for Italy.

Run the Finalize Transactions for Tax Reporting process to mark transactions as finally reported for the following
reports:

• Declarable Input VAT Register for Italy

• Declarable Output VAT Register for Italy

• VAT Liquidation Report for Italy

Note:  Only the listed reports can be printed in final mode and can be reprinted if required.

Report Parameters
The following table lists the common parameters for the VAT Reports for Italy:

Parameters Description

Tax Calendar Period
 

Indicate the period name of the monthly calendar for reporting data.
 

Tax Register
 

Indicate the tax register such as, recoverable and nonrecoverable for reporting VAT reporting for Italy.
 

First Page Number
 

Indicate the starting page for the report.
 

The following table lists additional parameters for the VAT Liquidation Report for Italy:

Parameters Description

Variation on Sales
 

Indicate the debit amount to reduce the sales VAT for net payment purposes.
 

Variation on Purchase
 

Indicate the credit amount to reduce the sales VAT for net payment purposes.
 

Frequently Asked Questions
The following table lists frequently asked questions about the VAT reports for Italy.
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FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use VAT reports for Italy to review:
 

• Invoices that are assigned to a document sequence name of a specified VAT register on the
accounting dates within specified period.

• Tax declarable activities including payments of invoices with deferred tax for a specific period.

• Tax declarable activities including cash receipts of invoices with deferred tax, adjustments, and
bills receivables.

• Review summary of VAT amounts grouped by tax code for each VAT register for the selected
period.

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• VAT Reporting for Italy Topical Essay

Intra-EU Reports for Italy  
This topic includes details of the Intra-EU reports for Italy.

Overview
Companies in Italy must report the details of the sale or purchase of services to or from companies in European Union
(EU) member states.

The reported transactions, once declared to the tax authority, must be stamped with declaration number issued by the
tax authority.
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Use the following reports to report intra-EU transactions to the tax authorities:

• European Sales Listing of Services for Italy: Use this report to declare services rendered by Italian companies to
VAT-registered customers in European Union (EU) member states.

The report prints service mode, service code, reporting receipt method, and reporting receipt country details
associated with the transactions. The following figure is an example of the report.

• European Purchase Listing of Services for Italy: Use this report to declare services purchased by Italian
companies from VAT-registered suppliers in European Union (EU) member states.

The report prints service mode, service code, reporting payment method, and reporting payment country
details associated with the transactions. The following figure is an example of the report.

Key Insights
Both the European Sales Listing of Services for Italy and European Purchase Listing of Services for Italy reports:

• Display report level totals for invoice amount.

Note:  Create your own templates to specify page totals, carry forward totals, or brought forward totals.

• Round off all amounts to the nearest Euro.

• List invoices that are reported and later canceled in the adjustments section of the report.

Before running the European Sales Listing of Services for Italy report, ensure that you:

• In Oracle Fusion Functional Setup Manager, use the:

362



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 16
Oracle Fusion Financials for EMEA Reports

◦ JG_ESL_EPL_SERVICE_CODE lookup type to specify the service code.

◦ JG_ESL_EPL_SERVICE_MODE lookup type to specify the service mode.

◦ JG_ESL_EPL_RCPT_PYMT_MODE lookup type to specify the reporting payment method.

• Configure the tax reporting type and tax reporting code for intra-EU transactions.

Before running the European Purchase Listing of Services for Italy report, ensure that you:

• Update the service code, service mode, reporting payment method, and reporting payment country for the
services you purchase.

• Update the service codes for the services you purchase. Use the Service Code (JG_ESL_EPL_SERVICE_CODE) lookup
type in Oracle Fusion Functional Setup Manager to specify the service codes.

• Configure the tax reporting type and tax reporting code for intra-EU transactions.

Report Parameters
The following table describes selected parameters of the European Sales and Purchase Listing of Services for Italy
reports:

Parameter Description

Tax Registration Number
 

Specify the registration number assigned to a party or party site by the tax authority when it's
registered. A party or party site is identified by this registered number.
 

Tax Reporting Type
 

Select a tax reporting type code created in Oracle Fusion Tax. Select the appropriate Intra-EU
transaction tax reporting type.
 

Tax Reporting Code
 

Select a tax reporting code created as a part of the tax reporting type you previously selected. Specify
the tax reporting code relating to European Sales Listing of Services for Italy.
 

Frequently Asked Questions
The following table lists frequently asked questions about the European Sales and Purchase Listing of Services for Italy
reports:

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use the European Sales Listing of Services for Italy and European Purchase Listing of Services for Italy
reports to:
 

• Meet the reporting requirements of the Italian tax authorities.

• Verify the details before submitting information as a declaration to the tax authority.
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FAQ Answer

• Accompany the positive receipt of the declaration number from the tax authority for future
reference.

What type of reports are these?
 

Oracle Analytics Publisher.
 

Related Topics
• How European Purchase Listing Services for Italy is Reported

• How European Sales Listing Services for Italy is Reported

• Turnover Reporting

Exemption Reports for Italy  
This topic includes details about the exemptions reports for Italy.

Overview
In Italy, regular exporters can legally request suppliers to not charge VAT on purchase transactions. The Letter of Intent
is the official letter to send to suppliers and customs for vat exemption. This letter contains:

• Instructions to invoice without VAT.

• Revocation or suspension of a previous letter of intent, with instructions to invoice with VAT.

The exemption limit is the total VAT exemption amount that a regular exporter can claim against suppliers, and it is
monitored on a periodic basis.

364

https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20046010
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20046009
https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20046315


Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 16
Oracle Fusion Financials for EMEA Reports

The following reports support exemption handling for Italy:

• Exemption Letter Report for Italy: Produces a letter of intent for each exempt supplier in Italy instructing them
not to include VAT on invoices that they submit.

The following figure is an example of the report.
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• Letter of Intent Receivables Invoice Register: Lists details about receivables transactions issued with a Letter
of Intent for a given calendar year. Provides letter of intent details such as protocol number, allocation type,
amount, and effective dates.

The following figure is an example of the report.

• Subledger Letter of Intent Register for Italy: Lists all letters of intent issued to suppliers or received by
customers in Italy within a given period range.

The following figure is an example of the report.

• Supplier Exemption Limit Consumption Report: Lists the details of suppliers eligible for exemption in Italy and
their monthly consumption of assigned exemption limit. Lists consumption details of all the suppliers, or a
specific supplier. Details include all invoices exempted during a calendar period.

Key Insights
For each year, the initial exemption limit is the sum of all reported export invoices of the previous year. You can allocate
the exemption limit as an annual or monthly amount and allocate the exemption limit among different suppliers. To
each supplier, you send a Letter of Intent that indicates the exemption amounts, and request that they do not charge tax
when they send the invoices.
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Define the tax reporting type and tax reporting code with the usage as exempt for using letter of intent and reporting
exemption data.

Exemption limits can be adjusted during the year to reflect an increase or decrease in export activities and changes in
the VAT exemption amount as agreed with tax authorities. However, you will not be able to change the exemption limit
type.

Report Parameters
This table lists the common parameters for all the exemption reports:

Parameter Description

Tax Reporting Type Code
 

Specify the tax reporting type code as created in Oracle Fusion Tax. Select the appropriate tax
reporting type created for letter of intent.
 

Tax Reporting Code
 

Specify the tax reporting code created as a part of the tax reporting type that you previously selected.
Specify the tax reporting code relating to letter of intent.
 

From Period and To Period
 

Indicate the period range for the report data.
 

This table lists the parameters for the Letter of Intent Receivables Invoice Register:

Parameter Description

Calendar Year
 

Indicate the year for the report data.
 

From Customer and To Customer
 

Indicate the customer range for the report data.
 

This table lists the parameters for the Supplier Exemption Limit Consumption Report:

Parameter Description

Calendar Year
 

Indicate the year for the report data.
 

Month
 

Indicate the month for which the consumption of exemption amount must be reported.
 

From Supplier and To Supplier
 

Indicate the supplier range for the report data.
 

Invoices with Letter of Intent
 

Indicate whether all or only invoices with a letter of intent must be included in the report.
 

Frequently Asked Questions
The following table lists frequently asked questions about the exemption reports for Italy.
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FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

• Tax Specialist

• Accounts Receivables Manager

• Accounts Receivables Specialist

• Accounts Payables Manager

• Accounts Payables Specialist

When do I use this report?
 

Use the exemption reports for Italy to:
 

• Specify VAT exemption limit on transactions

• Review transactions issued with a letter of intent during a calendar year

• Review all letter of intent issued to suppliers or received from customer during a given period.

• Monitor monthly consumption of exemption amounts to make sure you do not exceed the agreed
limit.

• Review the monthly consumption of assigned exemption limit.

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• Supplier Exemptions for Italy

Withholding Tax Reports for Italy  
This topic includes details about the withholding tax reports for Italy.

The withholding tax reports for Italy provide specific withholding tax information on supplier invoices as required by the
tax authorities in Italy. You can use these reports to produce withholding tax letters you send to suppliers, reconcile the
withholding tax letters sent to suppliers with the yearly amounts withheld for tax and social security, and prepare the
yearly declarations for the tax authorities.

The following reports support withholding tax handling for Italy:

• Withholding Tax Letters for Italy: Creates letters sent to suppliers in Italy that confirm the tax and social security
amounts withheld on purchase invoices that are partially or fully paid within a calendar year. Prints for a specific
supplier or for all suppliers.

• Yearly Withholding Tax Report for Italy: Shows the annual taxes withheld by first-party legal entities for a
supplier during a specified year, ordered by supplier name, supplier taxpayer ID or supplier tax registration
number. Prints the yearly summary of tax and social security amounts withheld for the legal entity. For each
supplier and supplier site:

Key Insights
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Before running the reports, ensure that you:

• Set up the following entities:

◦ Data Security

◦ Geographies

◦ Enterprise Structure

◦ Suppliers

◦ Tax Authorities

◦ Bank accounts

◦ Procurement Business Function

◦ Common Options for Payables

• Complete the implementation project before entering transactions and using the transaction tax reports.

Create a new Withholding Tax Regime
Here’s how you can create a new withholding tax regime.

Follow these steps:

1. From the Setup and Maintenance area navigate to the Manage Tax Regimes task.
2. Open the Manage Tax Regimes UI and switch to the Withholding Tax option.
3. Under the Withholding Tax Regimes section, create a new withholding tax regime.
4. Enter the required details for the new tax regime and save.

Create new Withholding Taxes
The Withholding Tax reporting feature for Italy enables you to report on both withholding tax and social security
amounts. To achieve this you need to set up separate taxes for both the withholding and the social security.

Setting Up Withholding Tax

To establish a new withholding tax, follow these steps:

1. Navigate to the Manage Taxes task.
2. Select the Withholding Tax option and create a new tax.
3. Enter the details for the withholding tax.
4. Save and create the tax rule defaults.

Note:  Unless you specify different rules to use a different jurisdiction, status, or rate, the default values will
apply whenever the tax is applicable.

5. Select the Tax Jurisdiction row in the Indirect Defaults area and click the Create Default button to activate the
Tax Jurisdiction type.

6. In the Create Withholding Tax Jurisdiction UI, enter the tax jurisdiction details, save, and close.
7. Activate the Tax Status line and click on the Create Default button.

The Create Withholding Tax Status UI opens. Configure the tax status details, save, and close.
8. Activate the Tax Rate type and click on the Create Default button.

The Create Withholding Tax Rate UI opens. Configure the tax rate details. Assign the ledger and account
information, then save, and close. Now you have your tax defaults defined.
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9. Click on the Tax Reporting Codes tab. Assign the predefined ORA_IT SOCIAL SECURITY tax reporting type to
the withholding tax with the tax reporting code set to N(No).
This tax reporting type is used to identify which tax to use for the Italian withholding tax reporting.
Transactions that have this tax applied are reported on the Italian withholding tax reports.

10. Click on the Tax Authorities tab and assign the tax authority and site to the withholding tax. Save the tax and
enable it for transaction entry by selecting the Enable tax for transactions option. Save and close.

Establishing Social Security Tax

To establish a new withholding tax. follow these steps:

1. Navigate to the Manage Taxes UI and define the social security tax.
◦ Note that even when the social security tax is not used, you have to create it with a default 0% rate for the

Withholding Tax Letter for Italy to work as expected.
◦ Save and create the tax rule defaults.

◦ Note: Unless you specify different rules to apply a specific jurisdiction, status, or rate, the default values
will apply whenever the social security tax is applicable.

2. Activate the Tax Jurisdiction type record and click on the Create Default button. The Create Withholding Tax
Jurisdiction UI opens. Enter the details for the tax jurisdiction. Save and close.

3. Activate the Tax Status type and click on the Create Default button.
◦ The Create Withholding Tax Status UI opens. Enter details for the tax status. Save and close.

4. Activate the Tax Rate type and click on the Create Default button.
◦ The Create Withholding Tax Rate UI opens. Enter details for the tax rate.

5. Assign the ledger and account information for the rate. Save and close.
◦ Now you have your tax defaults defined.

6. Click on the Tax Reporting Codes tab and assign the ORA_IT SOCIAL SECURITY tax reporting type for IT SS tax
with tax reporting code Y(Yes).

◦ This reporting type code identifies the tax for Italian withholding tax reporting. Setting the tax reporting
code to yes means that withholding tax amounts created for this tax with be reported as social security
amounts on the Italian withholding tax reports.

7. Move to the Tax Authorities tab and enter the tax authority and site for the social security tax. Tax Authorities
are entered as suppliers with the supplier type set as Tax Authority. This information is used if Tax Invoice
Creation is enabled on the Controls and Defaults tab.

8. Save and enable the social security tax by selecting the Enable tax for transactions. Save again.

Create a New Tax Rule
The example below is only for demonstration purposes to show you one possible way how you can set up the tax rules
for withholding tax and social security. For customers, the tax rules and tax determinants have to be based on the
current legislation.

Create a new user-defined fiscal classification code

Follow these steps:

1. Go to the Manage Transaction-Based Fiscal Classifications task.
2. In the Manage Transaction-Based Fiscal Classifications UI change the value to User-Defined Fiscal

Classification Codes in the top left corner. Click on the Create icon.
3. On the Create User-Defined Fiscal Classification Code UI enter a new code that you can use as a tax

determinant for the withholding tax rules. Save and close the window.

Create tax applicability rules
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To create a new tax applicability rule, follow these steps:

1. On the Manage Tax Rules UI choose the Withholding Tax radio button and Tax Rule Type Tax Applicability Rules
in the top left corner. Click on the Create icon.

2. Enter details for the new tax rule.
3. Click on Create on the list of values for the Tax Determining Factor Set. This opens the Create Tax Determining

Factor Set UI. Define a new tax determining factor set based on a user-defined fiscal classification code.
4. Click on OK. This saves the new record and automatically selects it as the tax determining factor set for the tax

rule.
5. Click on the next button.
6. Select Create from the list of values for the Tax Condition Set field. This opens the Create Condition Set UI.

Enter a new condition set that uses the new user-defined fiscal classification value created in the previous
setup step.

7. Click on OK and the new condition set is automatically saved and selected as the tax condition set for the tax
rule.

8. Click on the Save and Next button.
9. Enable the new tax rule by selecting Enabled and clicking on the Submit button. This completes the creation of

the tax applicability rule for the withholding tax. The next step is to create a very similar tax rule for the social
security tax.

10. On the same UI enter details for a new tax applicability rule for the social security tax.
11. For the Tax Determining Factor Set field choose the Create option from the list of values. This opens the

Create Tax Determining Factor Set UI. Define a new tax determining factor set based on a user-defined fiscal
classification code.

12. Click on OK. This saves the new record and automatically selects it as the tax determining factor set for the tax
rule.

13. Click on the Next button.
14. Select the Create option for the Tax Condition Set field. This opens the Create Condition Set UI. Enter a new

condition set that uses the new user-defined fiscal classification value created earlier. The same is used in the
withholding tax rule so when this attribute is entered on the invoice both the withholding tax and social security
tax will be applicable for the invoice line.

15. Click on OK and the new condition set is automatically saved and selected as the tax condition set for the tax
rule.

16. Click on the Save and Next button.
17. Enable the new tax rule by selecting Enabled and clicking on the Submit button. This completes the creation of

the tax applicability rule for the social security tax.

Create Configuration Owner Tax Options

1. Go to the Manage Configuration Owner Tax Options UI and select the Withholding Tax option. Click on the
Create icon to enter a new record.

2. Select the first party legal entity as the configuration owner. Enter processing controls for standard invoice and
prepayment invoice event class. In Italy the withholding tax has to be created at the time the payment is sent to
the supplier so set the tax calculation point as Payment for both event classes. Save and close.

◦
Update the Business Unit Tax Profile

1. Open the Manage Party Tax Profiles UI and change the search option to Business Unit Tax Profile. Search for
the Business Unit by name.

2. Click on the edit icon to open the Edit Business Unit Tax Profile UI.
3. Enable the use of legal entity withholding tax subscription on the Controls and Defaults tab. Save and close.

This completes the necessary minimum setup for withholding tax for Italy.
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Supplier Setup
For withholding tax suppliers who are individuals you can add their date of birth and place of birth in the regional
information section of the Supplier UI. Choose Withholding Tax for Italy from the list of values in the Regional
Information field for these additional attributes to appear. The information entered is used on the Withholding Tax
Letters for Italy report.

Entering Transaction Details
Invoice creation

1. Go to Navigator, click on Payables, select Invoices, and choose Create Invoice.
2. Enter the invoice header and line information.
3. For the User-Defined Fiscal Classification field enter the value created in the setup. In our setup, this attribute is

used as the tax determinant for withholding tax.
4. Validate and account the invoice.

Payment creation

• Go to Navigator, click on Payables, select Payments, and choose Create Payment.

• Note that the payment amount is less than the full invoice amount. The difference is the withholding amount.
Account the payment.

Review the withholding tax lines

Re-query the invoice and review the withholding tax lines created.

Reporting
You can access all the reports from the Scheduled Processes Reporting and Scheduled Processes in the Tools section of
the Navigator menu.

Here are the reports:

Withholding Tax Letters for Italy

Run the Withholding Tax Letters for Italy report to create and print letters to your suppliers about all the withholding tax
transactions that were partially or fully paid during the reporting year.

The report has the following parameters:

1. Select the Legal Entity and the tax year for which you want to run the report.
2. You can also select just one specific supplier, or a range of suppliers for the report. Alternatively, you can leave

the last two parameters blank and report on all withholding transactions for the year.

Yearly Withholding Tax Report for Italy

The Yearly Withholding Tax Report for Italy is used to list all withholding transactions for a tax year.

The report has the following parameters:

1. Select the Legal Entity and the tax year for which you want to run the report.
2. The information can be ordered by the supplier name, supplier taxpayer ID, or tax registration number.

◦ The report output displays summary information for each tax rate by supplier and also for the entire
report.
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Report Parameters
The following table describes selected process parameters:

Name Description

Legal Entity
 

Specify the legal entity for reporting.
 

Year
 

Specify the calendar year to be included for reporting withholding tax.
 

Frequently Asked Questions
The following table lists frequently asked questions about the withholding tax reports for Italy.

FAQ Answer

How do I find these reports?
 

Schedule and run these reports from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

• Tax Manager

• Tax Accountant

• Payables Manager

• Payables Specialist

When do I use these reports?
 

Use these reports to:
 

• Create letters for your suppliers in Italy to confirm withheld tax amounts.

• Reconcile the withholding tax letters sent to your suppliers.

• Review withheld taxes for each invoice or supplier.

• Review withheld taxes by calendar year for your first-party legal entities.

What type of reports are these?
 

Oracle Analytics Publisher.
 

Related Topics
• Reporting Features for Italy

Report for Poland  

How You Print Commercial Documents Execution Report  
This topic contains summary information about the Print Commercial Documents Execution Report.
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Overview
The Print Commercial Documents Execution Report lists all the selected transactions to be printed based on the
parameters that you have provided. The printing program checks the following information:

• The validity of the association between Document Fiscal Classification or Document Subtype and the template,
which you use for the invoice print process.

• Document Fiscal Information such as Third-Party Name, Document Number, and Transaction Date.

Key Insights
Before running the reports, ensure that you:

• Set up the following entities:

◦ Data Security

◦ Geographies

◦ Address Style Format

◦ Enterprise Structures

◦ Tax Regimes to Rate Flow

◦ Tax Profiles for Parties

◦ Tax Rules

◦ Customers and Suppliers

◦ First Party Bank, Branch, and Account

• Complete the implementation project for your organization before you start the following feature-specific
setup.

This is what a typical Commercial Documents Execution Report looks like:
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Report Parameters
This table describes the process parameters:

Parameter Description

Legal Entity
 

Indicates the legal entity that issues the documents to be printed. The default value is the legal entity
that's associated to the reference data set of the user. This parameter is mandatory.
 

Tax Registration Number
 

Indicates the tax registration number that issued the documents to be printed. This parameter is
optional.
 

Business Unit
 

Indicates the business unit that issued the documents to be printed. The default value is the business
unit that's linked to the reference data set of the user. This parameter is mandatory.
 

Start Date
 

Indicates the start date of the period that the documents are registered in. This parameter is optional.
 

End Date
 

Indicates the end date of the period that the documents are registered in This parameter is optional.
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Parameter Description

Third Party Type
 

Indicates the type of third party the documents are sent to. For Poland, value of the third-party type is
Customer. This parameter is mandatory.
 

Third Party
 

Indicates the third party to whom the documents are issued. This parameter is optional.
 

Third Party Site
 

Indicates the third-party site to which the documents are issued. This parameter is optional.
 

Print Mode
 

Indicates the print mode. Select Draft or Final. The default value is Draft. Use the Draft mode to verify
data after your print. Select Final when you're ready to present the printed copy to a third party.
Selecting Final also links the copy of the report to the transaction that you can view from the View
Transactions page. This parameter is mandatory.
 

Document Type
 

Indicates the document type to be printed. The specific Document Fiscal Classification that you defined
determines the documents. This parameter is optional.
 

Start Document Number
 

Indicates the first number in the range of document numbers to be printed. This parameter is optional.
 

End Document Number
 

Indicates the last number in the range of document numbers to be printed. This parameter is optional.
 

Print Currency
 

Indicates the print currency in which the documents are to be printed. Select Entered or Ledger. This
parameter is mandatory.
 

Print Template
 

Indicates the template to be used to print the documents. This parameter is optional.
 

Order By
 

Indicates the order in which the documents are printed. This parameter is mandatory.
 

Frequently Asked Questions
This table lists frequently asked questions about the Print Commercial Documents Execution Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

This report is used by:
 

• Receivables Supervisor

• Receivables Manager

When do I use this report?
 

Use the Print Commercial Documents Execution report to check:
 

• The validity of the association between Document Fiscal Classification or Document Subtype and
the template, which is to be used for the invoice print process.

• Document fiscal information, such as Third-Party Name, Document Number and Transaction
Date.
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FAQ Answer

• The reason for transactions not getting printed.

What type of report is this?
 

Oracle Analytics Publisher.
 

Reports for Spain  

VAT Reports for Spain  
This topic includes details about the VAT reports for Spain.

Overview
Oracle Fusion Applications provide a set of VAT reports to meet the legal and business reporting requirements of tax
authorities.

The VAT reports for Spain include:

• Input VAT Journal for Spain: Provides summary and detail tax information on recoverable and nonrecoverable
tax for accounted transactions entered in Oracle Fusion Payables and tax repository. Reports by register type,
such as recoverable tax register or nonrecoverable tax register.
The following figure is an example of the report.
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• Output VAT Journal for Spain: Provides summary and detail tax information on recoverable and nonrecoverable
tax for accounted transactions entered in Oracle Fusion Receivables and tax repository. Reports by register
type, such as recoverable tax register or nonrecoverable tax register.

The following figure is an example of the report.

• VAT Inter-EU Invoice Journal for Spain: Provides summary and detail information on invoices received in Spain
from suppliers located in any European Union member state. Includes invoices that have offset or self-assessed
tax distributions.

The following figure is an example of the report.
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• VAT Inter-EU Invoice Format for Spain: Lists details of the same invoices that appear on the VAT Inter-EU
Invoices Journal for Spain. Selects transactions based on tax reporting type and tax reporting code.

The following figure is an example of the report.

Key Insights
You can report transactions based on a specific tax reporting type and tax reporting code or report transactions
associated with all the tax reporting types and codes. Ensure that you create relevant tax reporting types and tax
reporting codes and assign them to tax rates before running the reports. When the tax rate is applied to a transaction,
tax reporting type and tax reporting code is also applied.

If you want to use a calendar for tax reporting that is different from the accounting calendar, set up a new calendar
and associate it with the tax reporting entity. However, before you create a new calendar, you must set up a new tax
reporting entity.

Before you run the VAT reports for Spain, ensure you:

• Configure the document sequence to be used for reporting and printing transactions on the reports.

• Run the Select Transactions for Tax Reporting process to select and mark transactions for reporting.

When you finish reviewing the reports and want to close the tax period, run the Finalize Transactions for Tax Reporting
process. The process marks all the reported transactions as finally reported.

Report Parameters
This table lists selected parameters for the VAT reports for Spain:
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Parameter Description

From Tax Calendar Period and To Tax
Calendar Period
 

Specify the tax calendar period range for reporting data. The transactions are selected for reporting
based on the tax point date that is within the specified tax calendar period range.
 

Tax Reporting Type
 

(Optional) Select a tax reporting type created in Oracle Fusion Tax. Select the appropriate tax reporting
type for reporting VAT on transactions for Spain.
 

Tax Reporting Code
 

(Optional) Select a tax reporting code created as a part of the tax reporting type that you previously
selected. Specify the tax reporting code for reporting VAT on transactions for Spain.
 

Enable Reporting Sequence
 

Indicate whether you want to print reporting sequences for your transactions.
 

Register Type
 

Select the register type. You can select tax register, nonrecoverable tax register, or both. This
parameter is applicable only for:
 

• Input VAT Journal for Spain

• Output VAT Journal for Spain

Note:
When you want to list transactions with interim tax, run the Interim Tax Register.
 

Start Invoice Sequence
 

Indicate the starting invoice sequence number. When you want to continue the reporting sequence
numbers from the previous reporting period, specify the number you want to use as the starting
number for this period. The default value is 1.
 

Usability Improvements
You can define withholding keys and sub keys, and additional extracted data elements.

The Withholding Magnetic Format for Spain report includes the ability to define withholding keys and sub keys and
assign them to the withholding tax rates. The keys (sub keys) allowed in the Modelo 190 are A, B (01, 02, 03), C, D, E (01,
02, 03, 04), F (01, 02), G (01, 02, 03), H (01, 02, 03, 04), I (01, 02), J, K (01, 02, 03), L (01 to 30). If withholding keys and sub
keys are not defined and assigned to tax rates, expense reports are populated with the default value A00 and all other
transactions populated with the default value G01.

The Withholding Magnetic Format for Spain XML Data extract file contains additional data elements:

• Header elements

◦ ERP Cloud Program Version - EXTERNAL_VERSION

◦ Legal Entity primary contact name, phone and email - G_LEGAL_ENTITY - FULL_NAME,
EMAIL_ADDRESS and PHONE_NUM

• Detail records

◦ Supplier Type and Tax Organization Type - C_VENDOR_TYPE and C_ORGANIZATION_TYPE

Setup Steps
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To implement changes related to the keys and sub keys reported in the Withholding Magnetic Format for Spain output
file, follow these setup steps:

1. Create new Tax Reporting Type for withholding keys and sub keys:
a. Navigate to the Setup and Maintenance, Manage Tax Reporting Types.
b. Create new Tax Reporting Type JEES_WHT_KEY_SUBKEY with these values:

- Tax Reporting Type Code: JEES_WHT_KEY_SUBKEY
- Tax Reporting Type Name: WHT Keys and Subkeys for Spain
- Tax Reporting Type Purpose: Withholding tax reporting type
- Country: Spain
- Data Type: Text
- Minimum Length of Reporting Codes: 1
- Maximum Length of Reporting Codes: 3
- Reporting Type Uses: enable Tax Rate

c. Add new Tax Reporting Codes:
- Tax Reporting Code: G01
- Description: G: Income from economic activities: Professional activities to which the general

withholding rate is applicable: Sub key 01
d. Define all required Tax Reporting Codes for Spanish withholding keys and sub keys. Example: A01, G03,

H04.
e. Save and Close.

2. Associate Tax Reporting Code JEES_WHT_KEY_SUBKEY to the Withholding Tax Rates Codes:

a. Navigate to Setup and Maintenance, Manage Tax Rate and Tax Recovery Rates.
b. Search for Withholding Tax and define Search Withholding Tax Rates parameters or create new

Withholding Tax Rate.
c. Associate Withholding Tax Rate with Tax Reporting Codes with these values:

- Tax Reporting Type Code = JEES_WHT_KEY_SUBKEY
- Data Type = Text
- Tax Reporting Code = G01
- Description = G: Income from economic activities: Professional activities to which the general

withholding rate is applicable: Sub key 01
d. Save and Close.

3. (Optional) Here are some considerations:

◦ The keys and sub keys values are defined as Tax Reporting Code for the Tax Reporting Type Code
JEES_WHT_KEY_SUBKEY. The Tax Reporting Code for key and sub key is assigned to the Withholding Tax
Rate. In the Withholding Magnetic Format for Spain output file the Key is the first position from the Tax
Reporting Code and is reported in the position 78. The sub key is the second and third position from the
Tax Reporting Code JEES_WHT_KEY_SUBKEY and is reported in the position 79 and 80.

◦ If withholding keys and sub keys are not defined and assigned to tax rates, expense reports are
populated with the default value A00 and all other transactions populated with the default value G01.

◦ Define primary Legal Entity contact name, primary phone and email, Supplier Type and Tax Organization
Type for supplier to extract values in the Withholding Magnetic Format for Spain XML extract data file.

Frequently Asked Questions
This table lists frequently asked questions about the VAT reports for Spain.

381



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 16
Oracle Fusion Financials for EMEA Reports

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use the VAT reports for Spain to review tax information on:
 

• Invoices and transactions entered in Payables and Receivables.

• Transactions that are manually entered in the tax repository.

• Invoices received in Spain from suppliers located in any European Union member state.

You can also use these reports for tax reconciliation and for preparing tax declarations.
 

What type of reports are these?
 

Oracle Analytics Publisher.
 

Related Topics
• Reporting Features for Spain

Modelo Reports for Spain  
This topic details about the tax box allocation reports.

Overview
The Modelo Reports for Spain are legally required turnover reports. These reports are delivered electronically in a
predefined format to the tax authorities in Spain.

The Modelo reports for Spain include:

• Modelo Electronic File Generation for Spain: Prepares electronic file for Modelo 340, 347, 349 or 415
declarations in a legally predefined format.

• Modelo Verification Report for Spain: Lists all payable invoices and receivables transactions that are reported
in the Modelo 340, 347, 349, or 415 declarations. The report prints data based on the selected legal entity,
period range, source, and modelo name. For receivables cash receipts, only receipts with a value more than the
entered minimum cash amount are reported.

Key Insights
Modelo reporting is based on accounting date or transaction date, depending on the type of Modelo and source of data.

You can report a transaction in multiple reports, which can be submitted annually, quarterly, or monthly.

Run Modelo Electronic File Generation for Spain for one period at a time and verify your transactions or summary data.

You can't filter the foreign customers or suppliers in Modelo reports. It is controlled by the tax reporting type, which is
a mandatory parameter. Hence, you must have a separate tax rate code for invoices of foreign customers or suppliers
mapped to a different tax reporting type to prevent them from being reported in the Modelo reports.
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Report Parameters
Let's understand the selected report parameters:

Parameter Description

Modelo Name
 

Select the Modelo type. Available values for this parameter are: Modelo 340, 347, 349, or 415
 

Source
 

Select Payables or Receivables. Modelo reporting doesn't include manually entered tax transactions.
 

Minimum Transaction Value
 

Select the minimum transaction amount to be reported. This parameter is required for Modelo 347 and
415.
 

Receipt Method
 

Select the Receivables receipt method that's used to record customer payments in cash. Only receipts
with the specified receipt method are selected and compared with the cash amount limit. The cash
amount limit is specified using the Minimum Cash Receipt Amount parameter.
 

Minimum Cash Receipt Amount
 

Specify the minimum amount for payments in cash.
 

Selection Status
 

Select the status of the transactions to be reported. The available options are all, preliminary, and final
 

Driving Date
 

Select the transactions based on transaction date or accounting date.
 

Frequently Asked Questions
Here are some frequently asked questions about the Modelo Reports for Spain.

FAQ Answer

How do I find this report?
 

You can schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

You can use these reports to do the following things:
 

• Review your payables and receivables transactions before reporting to the tax authorities.

• Report to the tax authorities in Spain in a predefined format.

What type of reports are these?
 

These are Oracle Analytics Publisher reports.
 

Related Topics
• How Modelo Reports for Spain are Generated
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Withholding Tax Report for Spain  
This topic explains about the withholding tax reports for Spain.

Overview
The Withholding Tax Report for Spain is an annual report that's submitted to the tax authorities at the beginning of the
year. Using this report you can list the operations of the previous year.

The Withholding Tax Reports for Spain includes:

• Withholding Tax Extract Report for Spain: Extracts the withholding tax transactions for Spain, and stores them
in an interface table. You can select information based on a specific legal entity, and optionally based on a
specific supplier.

• Withholding Tax Report for Spain: Identifies summary or detail of withholding tax information for Spain by
invoice and withholding tax type. You can print information for a selected legal entity, and optionally for a
specific supplier.

• Withholding Magnetic Format for Spain: Lists withholding tax transactions for the selected legal entity and tax
year in a flat file format in the predefined layout.

Here's an example of the report.

Key Insights
When you submit the Withholding Tax Data Extract Report for Spain, the data extract overwrites the transactions stored
from any previous submission.

The Withholding Tax Report for Spain lists only invoices that are posted to the general ledger, and includes
prepayments. When you apply prepayment to an invoice on a date other than the invoice accounting date, the report
displays prepayment as a negative amount with the prepayment application date.
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Report Parameters
The following table lists selected report parameters:

Parameter Description

Withholding Tax Type
 

Select one of the following:
 

• Spanish Income Tax Withholding (Modelo 190)

• Spanish Nonresidents Withholding

• Spanish Investment Income Withholding

• Spanish Property Rental Withholding

Selection Criteria
 

Select one of the following:
 

• Invoice accounting date, for validated or approved transactions only

• Payment date, for paid withholding transactions only

Frequently Asked Questions
Here are few frequently asked questions about the Withholding Tax Reports for Spain.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use these reports to declare withholding and payments on account of income from employment,
 economic activities, prizes, certain capital gains and income allocations.
 

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• How Modelo Reports for Spain are Generated

• Reporting Features for Spain
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Reports for Turkey  

Exchange Rate Difference Report for Turkey  
This topic includes details about the Process Exchange Rates Difference report.

Overview
This report summarizes the exchange rate differences for invoice, credit memo, and journal. Use this report to:

• View ledger currency including tax components.

• Print the eligible gain/loss lines that are processed by the Process Exchange Rates Difference job for each
trading partner and site.

Key Insights
You must run the Process Exchange Rate Difference job before running this report. The report output is a predefined
PDF format that displays the following information:

• Eligible gains/losses in terms of the total exchange rate difference amount, recorded for a trading partner
enabled to generate the exchange rate difference invoice.

• Total tax amount segregated from the total exchange rate difference amount.

• Line level information for the invoice, credit memo, and journal.

Use the report grouping to view the details of eligible gain/loss incurred and how it is processed at various levels. The
trading partner and trading partner site at each level are the final grouping level. The following combinations are used:

• Exchange rate difference type, creation option, status, transaction currency, and receipt currency

• Exchange rate difference type, and creation option

• Exchange rate difference type

When you search for processed records, the report displays additional information about reference numbers of the
invoices, credit memos, and journals. This reference number can be used to query exchange rate difference invoices,
credit memos, and journals.

The following figure is an example of the report.
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Report Parameters
The following table describes selected process parameters:

Parameter Description

Source
 

Specify the subledger application for which the report must be run. The available options are Accounts
Receivables and Accounts Payables. The default value is Accounts Receivables.
 

Business Unit
 

Specify the business unit for which the report must be run. The default value is the business unit to
which a user has access. If a user has access to multiple business units, the default is the last used
business unit.
 

Period
 

Specify the period for which the report must be run. The list of values includes all the open subledger
periods.
 
The default value is the earliest unprocessed open period if the exchange rate difference is enabled.
Otherwise, it is the earliest open general ledger period.
 

Unprocessed Only
 

Specify if the report must be printed for unprocessed or processed records. If you select Yes, only the
lines that were processed in the preview mode of the exchange rate difference job are printed. If you
select No, all the invoices, credit memos, and journals are printed.
 

Report Mode
 

Specify the layout of the report. Valid values are Detail and Summary. If the report is submitted in the
detail mode, it displays both header and line level details for each record. If the report is submitted in
the summary mode, it displays only the header level details for each record.
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Frequently Asked Questions
The following table lists frequently asked questions about the Process Exchange Rate Differences Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

 
• Tax Manager

• Tax Specialist

• Tax Accountant

• Accounts Receivable Manager

• Accounts Receivable Specialist

• Accounts Payable Supervisor

• Accounts Payable Manager

• Accounts Payable Specialist

When do I use this report?
 

Use the Process Exchange Rate Differences report to analyze records. These records are of the
following types:
 

• Unprocessed records: These include the exchange rate difference gain/loss lines after they
have been processed. Use these records to envision the exchange rate difference invoices, credit
memos, and journals that are going to be created.

• Processed records: These include the exchange rate difference invoices, credit memos, and
journals that have been created.

What type of reports are these?
 

Oracle Analytics Publisher
 

Reports for United Kingdom  

Reverse Charge Sales Listing Report for UK  
This topic includes details about the Reverse Charge Sales Listing Report for UK.

Overview
The Reverse Charge Sales Listing Report for UK lists the sales transactions for UK that are created in Oracle Fusion
Receivables. It lists transactions for high value electronic goods that are subjected to the Reverse Tax Charge and
reported to HRMC (Her Majesties Revenue and Customs). Reported data is grouped by customers.

The following figure is an example of the report.

388



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 16
Oracle Fusion Financials for EMEA Reports

Key Insights
Before you run the report, configure self-assessed tax in Oracle Fusion Tax and ensure that transactions with self-
assessed tax are available for reporting.

The report output is available in two formats:

• XML: Provides a readable view of the report.

• CSV: Creates the electronic output to submit the report to HMRC.

HMRC requires a specific format for the CSV version, no specific format for the XML output.

Report Parameters
The following table describes selected report parameters of the report:

Parameter Description

Legal Entity
 

Specify the legal entity submitting the declaration to the tax authority.
 

Tax Registration Number
 

Specify the tax registration number of the legal entity or legal reporting unit submitting the declaration
to the tax authority.
 

Tax Reporting Type
 

Indicate the appropriate reporting type that you defined to be used for reporting of reverse charges.
Tax reporting type identifies a specific unit of information, such as a date or a text comment, to
associate with a specific tax usage.
 

Tax Reporting Code
 

Specify the appropriate tax reporting code.
 

From Tax Point Date and To Tax Point Date
 

Print all the transactions based on the selected tax point date range.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Reverse Charge Sales Listing Report for UK.
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FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use this report to provide details of high value sales transactions that are subject to reverse tax
charges.
 

What type of reports are these?
 

Oracle Analytics Publisher
 

Other EMEA Reports  

General Ledger Trial Balance Report  
This topic includes details about the General Ledger Trial Balance Report.

Overview
The General Ledger Trial Balance Report lists actual account balances and activity by ledger, balancing segment, and
account segment. The report prints the account number, description, and debit or credit balance for the beginning and
ending period. This also includes the debits and credits for the period. The report can print income statement, balance
sheet, or all balances for a selected range of accounting combinations.

The following figure shows an example of the General Ledger Trial Balance Report. The report has columns for the
account, account description, year beginning balances, net beginning balances, prior periods, period activity, ending
balances, and net ending balances.
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Key Insights
Before submitting the report, you must complete these tasks:

• Ensure that balances are available for printing in the selected period and account range.

• Define the account hierarchy.

You can use the report to print account balances and activity by legal entity. The report enables you to print reporting
and accounting sequences.

Report Parameters
The following table lists selected report parameters.

Parameter Description

Data Access Set
 

Enter the data access set that you can access based on the defined security structure. Data access set
is required for all general ledger reports.
 

Ledger
 

Specify the ledger for the selected data access set. Ledger is required for all general ledger reports.
 

From Period and To Period
 

Indicate the period range for the report data.
 

Filter Conditions
 

Enter the filtering conditions on the accounting flexfield. You can select all segments for the selected
ledger, and define conditions including account value ranges.
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Parameter Description

Currency Type
 

Specify the currency type, such as entered, statistical, or total. The default value is Total.
 

Account Level
 

Enter the number of hierarchy levels you want to use for reporting. The valid values are:
 

• Blank for printing only detail rows.

• 1 through 10 for printing relevant number of parent total rows. For example, consider you entered
3 and your account hierarchy for the natural account has 3 levels. You see balances at 2 parent
levels and for the natural account segment. For the same structure, if you enter 2 then you see
balances at only the 2 parent levels.

Top-Level Parent Account
 

Indicate the highest level, top-level parent account that you want to work with. This parameter works
with the account level parameter.
 

Account Class
 

Select a specific account class or accept the default value of All.
 

Account Delimiter
 

Specify the character that must be used as a separator between accounting flexfield segments.
 

Zero Beginning of Year Balance
 

Select:
 

• Yes for zero balances for debit and credit.

• No for the year beginning balance.

Trial Balance Type
 

Specify the type of account balance to determine the level of detail and results as of the beginning or
end of the year. You can select one of the following types: Begin Year, Detail, End Year, Results. The
default value is Detail. Use the default value to print all accounts in your selected range. The Begin
Year, End Year, and Results trial balance types are provided for compliance with specific country
requirements.
 

Page Number Format
 

Select the applicable page number format. The valid values are Page: n and Page: n of m. The default
value is Page: n of m.
 

Frequently Asked Questions
The following table lists frequently asked questions about the General Ledger Trial Balance Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Accountant

• Financial Manager

When do I use this report?
 

Use the General Ledger Trial Balance Report to review:
 

• Accounting combination or natural account values and description

• Prior period activity and year-to-date activity
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FAQ Answer

• Period beginning and period ending balances

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• General Ledger and Subledger Accounting Reports for EMEA

General Ledger Journal and Balances Reports  
This topic includes details about the General Ledger Journal and Balances reports.

Overview
General ledger journal and balance reports provide details on journal entries and account balances. The reports list
posted accounting activity for account balances for all periods in a selected period range. For each account, the reports
provide beginning balance, general ledger posted journal lines, and ending balance. Journal entry reports print all
details of general ledger journals.
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General Ledger Journal and Balance reports include the following reports:

• General Ledger Journal Entry Report: Provides general ledger journal activity for a given period or date range,
and optionally other criteria including journal source, entered currency, and journal batch. Flexible grouping
and sorting options are provided at report submission. To improve the performance of the report:

◦ If you have entries in multiple currencies, run the report for one currency at a time. Only the accounting
lines of the selected currency display, instead of all accounting lines of a multicurrency journal.

◦ Enter values for the company or balancing segment when running the report. With this method, you can't
see all the accounting lines of your intercompany journal.

The following figure shows an example of the General Ledger Journal Entry Report. The report has columns for
the line, account, account description, line description, posting status, and entered and accounted amounts.

• General Ledger Journal and Balance Report: Retrieves all information for the reports that require journal
entries and account balances. The account balances can be printed for selected levels of the hierarchy for
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actual, encumbrance, or budget balance types. To improve the performance of the report, filter by company or
balancing segment value.

The following figure shows an example of the General Ledger Journal and Balance Report. The report has
columns for the batch, journal, category, effective date, journal number and line, description, and amounts.

Key Insights
Before submitting the reports, you must transfer subledger journals to the general ledger.

Report Parameters
The following table lists the common parameters applicable to all the General Ledger Journal and Balance Reports.

Parameter Description

Data Access Set
 

Enter the data access set that you can access based on the defined security structure. Data access set
is required for all general ledger reports.
 

Ledger
 

Specify the ledgers for the selected data access set. Ledger is required for all general ledger reports.
 

From Period and To Period
 

Indicate the period range for the report data.
 

Filter Conditions
 

Enter the filtering conditions on the accounting flexfield. You can select all segments for the selected
ledger, and define conditions including account value ranges.
 

The following table lists selected parameters for the General Ledger Journal Entry.

Parameter Description

Posting Status
 

Select the applicable posting status. Valid values are Error Status, Posted Journals, and Unposted
Journals.
 

Journal Source Enter the source of journal entries such as, payables, receivables, or manual.
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Parameter Description

  

The following table lists selected parameters for the General Ledger Journal and Balance Report.

Parameter Description

Currency Type
 

Specify the currency type, such as entered, statistical or total. The default value is Total.
 

Balance Type
 

Specify whether the balance type is actual or encumbrance. The default is Actual (A).
 

Frequently Asked Questions
The following table lists frequently asked questions about the General Ledger Journal and Balance Reports.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Accountant

When do I use this report?
 

Use these reports to declare withholding and payments on account of income from employment,
 economic activities, prizes, certain capital gains and income allocations.
 

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• General Ledger and Subledger Accounting Reports for EMEA

Journal Reports  
This topic includes details about the journal reports.

Overview
Use Journal reports to verify that your journals, accounting entries, and source documents are in compliance with the
legal requirements.
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Journal reports include the following reports:

• Daily Journals Report: Lists subledger journal activity for a given period or date range, journal source,
entered currency, and journal batch. Report prints detailed subledger journal lines prior to general ledger
summarization. Third party and transaction details are also listed for the journal lines.

The following figure shows an example of the Daily Journals Report. The report has columns for
the journal line, account, account description, line description, transaction date or number, tax
code, third-party name and number, entered currency, and entered and accounted amounts.

• Subledger Detail Journal Report: Displays information about the posted general ledger journal batches that
originate from Oracle Fusion Receivables and Oracle Fusion Payables subledgers. The report prints subledger
details like transaction number, transaction date, and transaction amount in entered and ledger currency.

The following figure shows an example of the Subledger Detail Journal Report. The report
has columns for the journal line, subledger line, account, account description, tax code,

397



Oracle Fusion Cloud Financials
Using Analytics and Reports for Financials

Chapter 16
Oracle Fusion Financials for EMEA Reports

transaction number and date, currency, conversion rate, and entered and accounted amounts.

• Journal Ledger Report: Lists the accounting entries with subledger details like transaction number, transaction
date, and line description, using flexible sorting options provided at report submission. This report provides a
real audit trail between general ledger and subledgers to satisfy legal and business requirements.

The following figure shows an example of the Journal Ledger Report. The report has
columns for the journal line, account, account description, line description, internal reference,
third-party name and number, entered currency, and entered and accounted amounts.
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Key Insights
The Daily Journals Report provides:

• Subledger accounting entry lines regardless of the general ledger journals summarization.

• Audit trail information about the original business documents or transactions to support each accounting entry
line.

• Verification details that all journals are recorded in chronological order with no gaps. It uses legal sequencing
rules for both journal or accounting entries and source documents.

• Flexible sorting options to help you with reconciliation. Report data is sorted by period end document sequence
name and number, accounting sequence, accounting date, and journal name.

The Journal Ledger Report provides an audit trail between the general ledger and subledgers to satisfy legal and
business requirements. This report lists the accounting entries in general ledger with subledger details.

Use the Journal Ledger Report to:

• Maintain an audit trial.

• Perform periodic internal verification.

• Reconcile subledger accounting activity with general ledger journals.

• Sort data to audit and reconcile subledger data. You can sort data by period end document sequence name and
number, accounting sequence, accounting date, and journal name.

Report Parameters
The following table lists selected parameters for the Daily Journals Report.

Parameter Description

Posting Status
 

Select the applicable posting status. Valid values are Error Status, Posted Journals, and Unposted
Journals.
 

Journal Entry Status
 

Indicate whether the journal entries are in draft, final or invalid status.
 

Third-Party Name
 

Select the name of the third party for whom you want to generate the report.
 

Summarization Level
 

Select:
 

• Detail: Displays details of each transaction line.

• Summary: Summarizes the transaction lines by specific accounting flexfield segments.

Show Account Recapitulation
 

Select Yes to print the report summary at the accounting flexfield level.
 

The following table lists selected parameters for the Subledger Detail Journal Report.
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Parameter Description

Journal Entry Status
 

Indicate whether the journal entries are in draft, final or invalid status.
 

Accounting Sequence Name
 

Specify the accounting sequence name for which you want to run the journals.
 

The following table lists selected parameters for the Journal Ledger Report.

Parameter Description

Accounting Period Type
 

Indicate whether to submit the report for all, standard, or adjustment accounting period types.
 

Show Running Totals
 

Select Yes to print running totals in the report.
 

Summarize by Account
 

Select Yes to print summarized debit and credit lines per account for a single journal. The default value
is No.
 

Frequently Asked Questions
The following table lists frequently asked questions about the journal reports.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Accountant

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use the journal reports to verify whether your journals, accounting entries, and source documents
comply with the legal requirements.
 

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• General Ledger and Subledger Accounting Reports for EMEA

Third-Party Detail and Balances Reports  
This topic includes details about third-party detail and balances reports.
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Overview
The third-party detail and balances reports include:

• Third-Party Balances Summary Report: Displays information for each account of the third party and third-party
site, and account identification. This report is a tool for auditing third-party accounts.

The following figure is an example of the report.

• Third-Party Detail and Balances Report: Provides third-party account balances and accounting activity details
for a period. You can review the accounting process details by third party and audit third-party accounts in
detail.

The following figure is an example of the report.
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• Third-Party Account Balance Report: Prints account and original third-party transactions impacting the
account during a particular period. The report is run to ensure that subledger and general ledger balances
reconcile, and to identify possible reasons for any discrepancies.

The following figure is an example of the report.

• Journals and Third-Party Report: Prints all the journals posted to the general ledger for an accounting period.
It provides detailed subledger accounting entry lines regardless of the general ledger journals summarization.
Transaction line description, third-party name and number, and transaction amounts in entered and ledger
currency. The report uses legal sequencing rules for both accounting entries and source documents to verify
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if all journals are recorded in a chronological order without gaps. The report lets you create various views of
reported information based on seven flexible sorting rules that help with reconciliation and auditing.

The following figure is an example of the report.

Key Insights
Before submitting the reports, complete the following tasks:

• Ensure that the third-party control account balances are available for printing for the selected date and account
range.

• Manually run the Update Subledger Account Balances process for your ledger and application, if you accounted
your third-party transactions online.

Note:  You must set up a third-party control account. You can set it up as supplier control account, customer control
account, or both.

During the accounting process, run the reports to ensure that subledger and general ledger balances reconcile, and to
identify discrepancies such as:

• Transaction amounts are assigned to incorrect accounts. For example, an invoice distribution amount is
assigned to a liability account.

• Transactions aren't posted to the general ledger.

• Journal batches aren't posted in the general ledger.

For each account, the report displays beginning balance, period activity, and period end balance.

Report Parameters
The following table lists selected parameters for the Third-Party Balances Summary Report:
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Parameter Description

Report Heading
 

Print report headings, select one of the following options: Ledger, Legal Entity, and Statutory Header
for Italy.
 

Journal Entry Source
 

Enter the source of journal entries, such as payables, receivables, or manual.
 

Third-Party Type
 

Indicate the party type, such as supplier or customer.
 

Third-Party Name
 

Submit the report for a specific third party, or leave this field blank for all third parties.
 

The following table lists selected parameters for the Third-Party Detail and Balances Report:

Parameter Description

Journal Entry Source
 

Enter the source of journal entries, such as payables, receivables, or manual.
 

Third-Party Type
 

Indicate the party type, such as supplier or customer.
 

Third-Party Name
 

Submit the report for a specific third party, or leave this field blank for all third parties.
 

The following table lists selected parameters for the Third-Party Account Balance Report:

Parameter Description

Report Heading
 

Print report headings, select one of the following options: Ledger, Legal Entity, and Statutory Header
for Italy.
 

Journal Entry Source
 

Enter the source of journal entries, such as payables, receivables, or manual.
 

Third-Party Type
 

Indicate the party type, such as supplier or customer.
 

The following table lists selected parameters for the Journals and Third-Party Report:

Parameter Description

Journal Entry Source
 

Enter the source of journal entries, such as payables, receivables, or manual.
 

Event Class
 

Indicate the event class, such as credit memos and debit memos.
 

Group by Period
 

Indicate whether to group the journal entries by period.
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Frequently Asked Questions
The following table lists frequently asked questions about third-party detail and balances reports.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Accountant

• Financial Manager

• Financial Specialist

When do I use this report?
 

Use the third-party detail and balances reports to:
 

• Review the accounting process details by third party and third-party site.

• Audit third-party accounts in detail.

• Reconcile transactions accounted by an audited company with transactions accounted by the
third parties.

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• General Ledger and Subledger Accounting Reports for EMEA

Account Analysis Reports  
This topic includes details about how you use account analysis reports.

Overview
You can use account analysis reports to provide a complete set of reports that support fiscal verification processes
in countries in Europe and South America. You can also use these reports to inform shareholders about the financial
results in other countries, including the United States.
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Account analysis reports include the following reports:

• General Ledger and Subledger Account Analysis Report: You can view account balances by account with
subledger journal details. The report displays entered amounts, third-party information, sequences, and total
number of debit and credit documents.

Here is a screenshot of the General Ledger and Subledger Account Analysis Report.

• General Ledger and Subledger Accounting by Journal Lines Report: You can view account balances or selected
segment balances with subledger journal details including entered amounts, third-party name, journal source,
journal category, and reporting and accounting sequences. Total number of debit and credit documents is also
listed in this report.

Here is a screenshot of the General Ledger and Subledger Accounting Journal Lines Report.
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• Account Analysis by Legal Entity Report: Use this report to view account balances by account combination and
selected segments with subledger journal details, including third-party information and sequences. Flexible
grouping and sorting options are provided at submission.

This is a screenshot of the Account Analysis by Legal Entity Report.

Key Insights

The account analysis reports enable you to do these tasks:

• Provide a legal account ledger

• Reconcile subledger balances with the general ledger balances

• Maintain an audit trail

• Allow a periodic internal verification

You can view these information for each account:

• Account identification

• Account beginning balances for the reporting period

• Period transactions with subledger and general ledger information

• Resulting account ending balances

In addition, you can use the General Ledger and Subledger Accounting by Journal Lines Report to get these
information:

• Details of subledger accounting entry lines, regardless of the general ledger journals summarization.

• Audit trail information about the original business documents or transactions to support each accounting entry
line. This information varies across countries.
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Report Parameters
Let's look at the common parameters for the account analysis reports.

Parameter Description

Ledger
 

Specify the ledgers for the selected data access set. Ledger is required for all general ledger reports.
 

Legal Entity
 

Specify the legal entity. You can control the report output through this parameter only if you have
associated balancing segment values to your legal entities.
 

From Period and To Period
 

Indicate the period range for the report data.
 

Flexfield Filter Conditions
 

Enter the filtering conditions on the accounting flexfield. You can select all segments for the selected
ledger and define conditions including account value ranges.
 

Here are some selected General Ledger and Subledger Accounting account analysis report parameters.

Parameter Description

Include Legal Entity Information
 

Select Yes to print the legal entity on the report.
 

Balance Type
 

Specify whether the balance type is budget, encumbrance, or actual amounts.
 

Display Tax Rate Code
 

Select Yes to include the tax rate code details.
 

Document Sequence Name
 

Enter the name of the document sequence used to generate unique number for the journal.
 

Here area some selected parameters of the General Ledger and Subledger Accounting journal lines report.

Parameter Description

Accounting Sequence Name
 

Indicate the name of the sequence used to generate a unique number for the subledger journal.
 

Posting Status
 

Indicate whether the posting status is transferred but not posted, not transferred, or posted.
 

Journal Entry Status
 

Indicate whether the journal entries are in draft, final or invalid status.
 

Third-Party Type
 

Select the party type as customer or supplier.
 
Optional parameter.
 
May be blank.
 

Journal Source Enter the source of journal entries, such as payables, receivables, or manual.
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Parameter Description

  

Journal Category
 

Select journal category when you want to report on a specific subledger journal category. Leave it blank
when you want to include all the journal categories.
 

Let's look at some account analysis by legal entity report parameters.

Parameter Description

Balance Type
 

Specify whether the balance type is budget, encumbrance, or actual amounts.
 

Include Zero Amount Lines
 

Indicate whether the report should include accounts with no activity in the selected period or zero
amount lines.
 

Report Heading
 

Accept the default value or modify the report page heading by selecting one of the available values.
The default value is the legal entity name.
 

Frequently Asked Questions
Theses are some frequently asked questions about account analysis reports.

FAQ Answer

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses these reports?
 

• Financial Accountant

• Financial Manager

• Financial Specialist

When do I use these reports?
 

Use the account analysis reports to:
 

• Collect and report information about all posted journal transactions in the general ledger for a
selected period and range of accounts.

• Verify that transactions are recorded systematically, and ensure an audit trail from general ledger
to the subledger.

• Perform validation for each accounting period once it's closed.

• Verify the accounting entry lines before their approval.

What type of reports are these?
 

Oracle Analytics Publisher
 

Related Topics
• General Ledger and Subledger Accounting Reports for EMEA
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Yearly Tax Report  
This topic includes details about the Yearly Tax Report.

Overview
Use the Yearly Tax Report to display detailed or summarized information about tax and taxable amounts within a year.
You can view information on both input and output tax for all finally reported tax periods within a year. All tax amounts
are reported in the ledger currency.

The Yearly Tax Report provides countries using the Tax Reporting Selection Process the capability to analyze the annual
subledgers and manual tax entry information.

Only finalized transactions in closed periods are included in the report. Use the Tax Final Reporting Process to mark
transactions as final and close the tax calendar period.

You can print the report in the following levels:

• Detail: Prints detailed tax amounts and summarized tax amounts by month and year. Includes the following
sections:

◦ Detailed Tax Calendar Period

◦ Detailed Tax Calendar Year

◦ Summarized Tax Calendar Period

◦ Summarized Tax Calendar Year

• Summary: Prints summarized tax amounts by tax calendar period and tax calendar year.

The following figure is an example of the report.
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Key Insights
The following table displays the tax categories used to group the report:

Tax Category Grouping Criteria

Declarable Output Tax
 

Transaction type name.
 

Declarable Input Tax
 

Document category name, recoverable taxable and tax amounts, and nonrecoverable taxable and tax
amounts.
 

Manual Tax Entries
 

Manually entered transactions and transactions imported from external sources into the tax repository.
Includes the batch name, tax and taxable amounts. Debit tax amounts represent input tax, and credit
tax amounts represent output tax.
 

Within each tax category, you can also group according to other criteria, such as:

• Tax rate code

• Tax rate

• Tax type

Report Parameters
The following table lists selected parameters:
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Parameter Description

Reporting Identifier
 

System generated reporting entity identifier assigned when the process Select Transactions for Tax
Reporting is run. The reporting entity identifier is built as a concatenation of the Reporting Level,
Legal Entity, Tax Regime, TRN and the Reporting Identifier ID (for example: LE:Vision Italy-1017:IT
VAT:IT12345670017:300100066356392).
 

Tax Calendar Year
 

Indicate the tax year for tax reporting and settlements.
 

Summarization Level
 

Specify the level of detail for reporting. You can print summary data or detailed data.
 

Report Heading
 

Specify the report header that must be printed on the report as a legal requirement.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Yearly Tax Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax manager

• Tax accountant

When do I use this report?
 

Use this report to analyze:
 

• Subledger tax information

• Manual tax entry information

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• How Tax Reporting is Processed
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17  Oracle Fusion Financials for Latin America
Reports

Oracle Fusion Financials for America Predefined Reports 

Oracle Fusion Financials for America provides predefined reports that are used to meet reporting requirements for
specific countries and for reconciliation and audit of tax calculated on transactions.

You can schedule and run reports from the Scheduled Processes work area found on the Navigator. To run predefined
reports:

1. Click the Schedule New Process button.
2. Search on the Process Name.
3. Enter the appropriate parameters.
4. Enter the appropriate process options and schedule.
5. Click Submit.

Oracle Fusion Financials for America provides predefined reports for:

• Mexico

Reports for Mexico
The tax reports for Mexico are:

Display Name Description

Chart of Accounts for Mexico Report
 

Companies in Mexico must submit accounting information to the tax authorities. According to the new
government regulations, companies must upload accounting information to the Tax Administration
Services (SAT) internet portal through a registered email account.
 

Journals for Mexico Report
 

Companies in Mexico must submit accounting information to the tax authorities. According to the new
government regulations, companies must upload accounting information to the Tax Administration
Services (SAT) internet portal through a registered email account.
 

Auxiliary Report for Mexico
 

The Auxiliary Report for Mexico helps with an in-depth analysis of all accounting entries for a given
account in a given period. The report displays beginning and ending balance, as well as the daily
journals entries posted to that account during the period.
 

Trial Balance Report for Mexico
 

The trial balance report is an XML file that includes a summary of the initial balances, the sum of
total transactions for the period, and the final balances for each account that you report in the Chart
of Accounts XML file. The accounts related to assets, liabilities, equity, and results of operations
(revenues, costs and expenses) are all included.
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Reports for Mexico  

Auxiliary Report for Mexico  
This topic contains summary information about the Auxiliary Report for Mexico.

Overview
The Auxiliary Report for Mexico helps with an in-depth analysis of all accounting entries for a given account in a given
period. The report displays beginning and ending balance, as well as the daily journals entries posted to that account
during the period.

Key Insights
To run the report, you must first grant access to the user for the Journals for Mexico process so that you can run it from
the Scheduled Processes page. For more information, see Enable the Mexican Reporting Processes.

After generating the report in OTBI, convert the report to an XML format before uploading it to the Tax Administration
Services (SAT) website. You can create the report once and use it periodically.

To use this report with the Legal Entity filter, you must set the Sequencing By option in Specify Ledger Options to Legal
Entity and create the accounting sequences with Legal Entity information.

Frequently Asked Questions
The following table lists frequently asked questions about the Auxiliary Report for Mexico.

FAQs Answer

How do I find this report?
 

In Oracle Transactional Business Intelligence, select Analysis from Analysis and Interactive Reporting.
 

Who uses this report?
 

• Financial Accountants

• Financial Specialists

When do I use this report?
 

Use the Auxiliary Report for Mexico when you need to provide detailed records of your accounts to the
fiscal authorities.
 

What type of report is this?
 

Oracle Transaction Business Intelligence
 

Related Topics
• Generate the Auxiliary Report for Mexico

• Convert the Auxiliary Report for Mexico to an XML Format
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Generate the Auxiliary Report for Mexico  
The Auxiliary Report for Mexico provides a detailed analysis of all accounting entries for a given account during a given
period. The report displays beginning and ending balances, as well as the daily journal entries posted to an account
during a specific period.

Use the Auxiliary Report for Mexico to provide detailed records of your accounts to the fiscal authorities.

Prerequisites
Complete these steps before you generate the Auxiliary Report for Mexico:

1. Sign in to Oracle Transactional Business Intelligence.
2. Click Catalog.
3. Click New, Folder on the catalog tool bar.
4. Create a local folder in My Folders.
5. Enter the Name of the folder as Mexico and click OK.

The new folder appears in the folder pane in My Folders.
6. Select the Mexico folder and click the Expand icon.
7. Click the New icon that appears on the toolbar.
8. Click the Analysis option that appears in Analysis and Interactive Reporting.
9. Enter this SQL statement in the Create Analysis from Simple Logical SQL option:

SELECT NumCta saw_0, DesCta saw_2, SaldoIni saw_4, SaldoFin saw_5, Fecha saw_6, NumUnIdenPol saw_7,
 Concepto saw_8, Debe saw_9, Haber saw_10, Accounting_Period saw_11, Ledger saw_12, Legal_Entity saw_13
 FROM (SELECT
 "General Ledger - Transactional Balances Real Time"."Account"."General Ledger Code Combination
 Identifier" bal_ccid,
 "General Ledger - Transactional Balances Real Time"."Ledger"."Ledger Name" Ledger,
 "General Ledger - Transactional Balances Real Time"."Time"."Fiscal Period" Accounting_Period,
 "General Ledger - Transactional Balances Real Time"."Natural Account Segment"."Account Code" NumCta,
 "General Ledger - Transactional Balances Real Time"."Natural Account Segment"."Account Description"
 DesCta,
 "General Ledger - Transactional Balances Real Time"."- Balance"."Beginning Balance" SaldoIni,
 "General Ledger - Transactional Balances Real Time"."- Balance"."Ending Balance" SaldoFin,
 "General Ledger - Transactional Balances Real Time"."- Balance"."Period Net Activity" bal_periodbal
FROM "General Ledger - Transactional Balances Real Time" where "General Ledger - Transactional Balances
 Real Time"."Ledger"."Ledger Name" in ('@{p_ledger}') and "General Ledger - Transactional Balances Real
 Time"."Time"."Fiscal Period" in ('@{p_period}') ) balances full outer join (SELECT
 "General Ledger - Journals Real Time"."- Header Details"."Header Default Effective Date" Fecha,
 "General Ledger - Journals Real Time"."- Account"."General Ledger Code Combination Identifier"
 jrnl_ccid,
 CONCAT(REPLACE("General Ledger - Journals Real Time"."- Header Details"."Header Name",'
 ',''),CONCAT(REPLACE(CAST("General Ledger - Journals Real Time"."- Header Details"."Header Key" AS
 CHAR),' ',''),CONCAT(REPLACE("General Ledger - Journals Real Time"."- Batch Details"."Batch Name",'
 ',''),REPLACE("General Ledger - Journals Real Time"."- Header Details"."Header Description",' ',''))))
 jrnl_header_desc,
 CONCAT(SUBSTRING(REPLACE("General Ledger - Journals Real Time"."- Header Details"."Header Name",'
 ','') FROM 1 FOR (50 - CHAR_LENGTH(REPLACE(CAST("General Ledger - Journals Real Time"."- Header
 Details"."Header Key" AS CHAR),' ','')))),REPLACE(CAST("General Ledger - Journals Real Time"."- Header
 Details"."Header Key" AS CHAR),' ','')) NumUnIdenPol,
 "General Ledger - Journals Real Time"."- Ledger"."Ledger Name" jrnl_ledger,
 "General Ledger - Journals Real Time"."Time"."Fiscal Period" jrnl_period,
 "General Ledger - Journals Real Time"."- Line Details"."Line Description" Concepto,
 "General Ledger - Journals Real Time"."- Line Details"."Line Number" jrnl_line_number,
 "General Ledger - Journals Real Time"."- Lines"."Journal Line Accounted Amount Debit" Debe,
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 "General Ledger - Journals Real Time"."- Lines"."Journal Line Accounted Amount Credit" Haber,
 "General Ledger - Journals Real Time"."- Header Details"."Journal Legal Entity" Legal_Entity
FROM "General Ledger - Journals Real Time" 
where "General Ledger - Journals Real Time"."- Ledger"."Ledger Name" in ('@{p_ledger}') 
and "General Ledger - Journals Real Time"."Time"."Fiscal Period" in ('@{p_period}') 
and "General Ledger - Journals Real Time"."Posting Status"."Posting Status Code" = 'P'
and DESCRIPTOR_IDOF("General Ledger - Journals Real Time"."Balance Subtype"."Balance Subtype Name") =
 'A'
and "General Ledger - Journals Real Time"."- Header Details"."Journal Legal Entity" in
 ('@{p_legal_entity}')) journals on journals.jrnl_ledger = balances.Ledger 
and balances.bal_ccid = journals.jrnl_ccid 
and journals.jrnl_period = balances.Accounting_Period
ORDER BY saw_0,saw_4, saw_5, saw_6, saw_9, saw_10, saw_11

10. Click OK.
11. Click the Prompts tab.

Create two prompts for Ledger and Accounting Period.
12. Click the Add icon > Column Prompts > "Ledger"."Ledger".

The New Prompt: Ledger dialog box appears.
13. Click Options on the New Prompt: Ledger dialog box.
14. Enter SQL Results in the Choice List Values field.

A default query appears in the SQL statement box.
15. Replace the default query with the following query:

SELECT "General Ledger - Journals Real Time"."- Ledger"."Ledger Name" FROM "General Ledger - Journals
 Real Time" ORDER BY 1 ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY

16. Enter Presentation Variable in the Set a variable field.
17. Enter p_ledger as the presentation variable.
18. Click OK.
19. Click Add > Column Prompt > "Accounting_Period" . "Accounting_Period".

The New Prompt: Accounting_Period dialog box appears.
20. Click Options on the New Prompt: Accounting_Period dialog box.
21. Enter SQL Results in the Choice List Values field.

A default query appears in the SQL statement field.
22. Replace the default query with the following query:

SELECT "General Ledger - Journals Real Time"."Time"."Fiscal Period" s_1, SORTKEY("General Ledger -
 Journals Real Time"."Time"."Fiscal Period") s_2 FROM "General Ledger - Journals Real Time" ORDER BY 1,2
 ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY

23. Enter Presentation Variable in the Set a variable field.
24. Enter p_period as the presentation variable.
25. Click OK.
26. Click Add > Column Prompt > "Legal_Entity" . "Legal_Entity".

The New Prompt: Legal_Entity dialog box appears.
27. Click Options on the New Prompt: Legal_Entity dialog box.
28. Enter SQL Results in the Choice List Value box.

A default query appears in the SQL statement box.
29. Remove the default query and enter the following query:
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SELECT "General Ledger - Journals Real Time"."- Header Details"."Journal Legal Entity" FROM "General
 Ledger - Journals Real Time" ORDER BY 1 ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY

30. Enter Presentation Variable in the Set a Variable box.
31. Enter p_legal_entity as the presentation variable.
32. Click OK.

Generating the Auxiliary Report for Mexico
After completing the prerequisites, perform these steps to run the report. Select your ledger and accounting period
every time you run the report.

1. Sign in to Oracle Transactional Business Intelligence.
2. Click Catalog.
3. Navigate and select the Mexico folder in My Folders.
4. Click Open to open the Balance Journals Detail report.
5. Specify the ledger and accounting period in the Ledger and Accounting Period fields.
6. Click OK.

The report appears in a tabular format.
The report excludes encumbrance accounting journal entries.

Convert the Auxiliary Report for Mexico to an XML Format  
To upload the Auxiliary Report for Mexico to the Tax Administration Services (SAT) website, you must first convert the
report into an XML format.

To convert the report, perform these steps:

1. Run the Auxiliary Report Mexico report in Oracle Analytics Publisher.
Export the report to Microsoft Excel.

2. Click the Export option, select Data, and then select CSV Format.
3. On the Opening Balance Journals Details with Prompts dialog box, select the Open with option and click OK.

The report appears in Microsoft Excel.
4. Click the View tab.
5. Click Macros > Record Macros.

The Record Macros dialog box appears.
6. Click OK.
7. Click the View tab.
8. Click Macros > View Macros.
9. Click Edit on the Macros dialog box.

Microsoft Visual Basic editor appears.
10. Replace the existing code with the following code:

Sub MakeXML()
' create an XML file from an Excel table
Dim MyRow As Long, MyCol As Long, MyColStart As Long, MyColEnd As Long, MyCol2 As Long, Temp As String,
 YesNo As Variant, DefFolder As String
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Dim XMLFileName As String, XMLRecBuffer As String, XMLRec2Buffer As String, MyLF As String, RTC1 As Long
Dim RangeOne As String, RangeTwo As String, Tt As String, FldName(99) As String, CheckFlag As Long, Arr
Dim Version As String, RFC As String, Mes As String, Anio As String, TipoSolicitud As String, NumOrden
 As String
Dim NumTramite As String, Sello As String, noCertificado As String, Certificado As String, lastRow As
 Long
Dim XML As String, MidStr As String, Row As String, XML3 As String, XML4 As String, Pos As String, Pos2
 As String
Dim fsT As Object
'Create stream object
Set fsT = CreateObject("ADODB.Stream")
'save text/string data
fsT.Type = 2
'Specify charset for the source text data
fsT.CharSet = "utf-8"

MyLF = Chr(10) & Chr(13) ' a line feed command

YesNo = MsgBox("This procedure requires the following data:" & MyLF _
 & "1 A filename for the XML file" & MyLF _
 & "2 Version Value" & MyLF _
 & "3 RFC Value" & MyLF _
 & "4 Mes Value" & MyLF _
 & "5 Anio Value" & MyLF _
 & "6 TipoSolicitud Value" & MyLF _
 & "7 NumOrden Value" & MyLF _
 & "8 NumTramite Value" & MyLF _
 & "9 Sello Value" & MyLF _
 & "10 noCertificado Value" & MyLF _
 & "11 Certificado Value" & MyLF _
 & "Are you ready to proceed?", vbQuestion + vbYesNo, "MakeXML CiM")
 
If YesNo = vbNo Then
 Debug.Print "User aborted with 'No'"
 Exit Sub
End If

XMLFileName = FillSpaces(InputBox("1. Enter the name of the XML file:", "MakeXML CiM", "xl_xml_data"))
If Right(XMLFileName, 4) <> ".xml" Then
 XMLFileName = XMLFileName & ".xml"
End If

If Len(Dir("C:\Mexico", vbDirectory)) = 0 Then
 MkDir "C:\Mexico"
End If

If Len(Dir("C:\Mexico\Auxiliary", vbDirectory)) = 0 Then
 MkDir "C:\Mexico\Auxiliary"
End If

DefFolder = ActiveWorkbook.Path
'"c:\Mexico\Auxiliary"
'InputBox("2. Enter the location of the path for the output file", "MakeXML CiM", "Enter the Path")
RangeOne = "A1:K1"
If MyRng(RangeOne, 1) <> MyRng(RangeOne, 2) Then
 MsgBox "Error: names must be on a single row" & MyLF & "Procedure STOPPED", vbOKOnly + vbCritical,
 "MakeXML CiM"
 Exit Sub
End If
MyRow = MyRng(RangeOne, 1)
For MyCol = MyRng(RangeOne, 3) To MyRng(RangeOne, 4)
 If Len(Cells(MyRow, MyCol).Value) = 0 Then
 MsgBox "Error: names range contains blank cell" & MyLF & "Procedure STOPPED", vbOKOnly + vbCritical,
 "MakeXML CiM"
 Exit Sub
 End If
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 FldName(MyCol - MyRng(RangeOne, 3)) = FillSpaces(Cells(MyRow, MyCol).Value)
Next MyCol

'RangeTwo = InputBox("3. Enter the range of cells containing the data table:", "MakeXML CiM", "A2:I2")

lastRow = ActiveSheet.Cells(Rows.Count, "A").End(xlUp).Row

RangeTwo = "A2:K" & lastRow
If MyRng(RangeOne, 4) - MyRng(RangeOne, 3) <> MyRng(RangeTwo, 4) - MyRng(RangeTwo, 3) Then
 MsgBox "Error: number of field names <> data columns" & MyLF & "Procedure STOPPED", vbOKOnly +
 vbCritical, "MakeXML CiM"
 Exit Sub
End If
RTC1 = MyRng(RangeTwo, 3)

Version = InputBox("2. Enter the Version Value:", "MakeXML CiM", "1.3")
Version = "Version=" & Chr(34) & Version & Chr(34)

RFC = InputBox("3. Enter the RFC Value:", "MakeXML CiM", "RFC Value")
RFC = "RFC=" & Chr(34) & RFC & Chr(34)

Mes = InputBox("4. Enter the Mes Value:", "MakeXML CiM", "Mes Value")
Mes = "Mes=" & Chr(34) & Mes & Chr(34)

Anio = InputBox("5. Enter the Anio Value:", "MakeXML CiM", "Anio Value")
Anio = "Anio=" & Chr(34) & Anio & Chr(34)

TipoSolicitud = InputBox("6. Enter the TipoSolicitud Value:", "MakeXML CiM", "TipoSolicitud Value")
TipoSolicitud = "TipoSolicitud=" & Chr(34) & TipoSolicitud & Chr(34)

NumOrden = InputBox("7. Enter the NumOrden Value:", "MakeXML CiM", "NumOrden Value")
NumOrden = "NumOrden=" & Chr(34) & NumOrden & Chr(34)

NumTramite = InputBox("8. Enter the NumTramite Value:", "MakeXML CiM", "NumTramite Value")
NumTramite = "NumTramite=" & Chr(34) & NumTramite & Chr(34)

Sello = InputBox("9. Enter the Sello Value:", "MakeXML CiM", "Sello Value")
Sello = "Sello=" & Chr(34) & Sello & Chr(34)

noCertificado = InputBox("10. Enter the Certificado Number Value:", "MakeXML CiM", "noCertificado
 Value")
noCertificado = "noCertificado=" & Chr(34) & noCertificado & Chr(34)

Certificado = InputBox("11. Enter the Certificado Value:", "MakeXML CiM", "Certificado Value")
Certificado = "Certificado=" & Chr(34) & Certificado & Chr(34)

Arr = Array(Version, RFC, Mes, Anio, TipoSolicitud, NumOrden, NumTramite, Sello, noCertificado,
 Certificado)

If InStr(1, XMLFileName, ":\") = 0 Then
 XMLFileName = DefFolder & "\" & XMLFileName
End If

XMLRecBuffer = " <AuxiliarCtas:Cuenta "
CheckFlag = 0

'XML3 = "<AuxiliarCtas xmlns:xsi=" & Chr(34) & "http://www.w3.org/2001/XMLSchema-instance" & Chr(34) & "
 xsi:schemaLocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/AuxiliarCtas http://
www.sat.gob.mx/esquemas/ContabilidadE/1_1/AuxiliarCtas/AuxiliarCtas_1_1.xsd" & Chr(34) & " xmlns=" &
 Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/AuxiliarCtas" & Chr(34) & " Version=" &
 Chr(34) & Version & Chr(34) & " RFC=" & Chr(34) & RFC & Chr(34) & " Mes=" & Chr(34) & Mes & Chr(34)
 & " Anio=" & Chr(34) & Anio & Chr(34) & " TipoSolicitud=" & Chr(34) & TipoSolicitud & Chr(34) & "
 NumOrden=" & Chr(34) & NumOrden & Chr(34) & " NumTramite=" & Chr(34) & NumTramite & Chr(34) & " Sello="
 & Chr(34) & Sello & Chr(34) & " noCertificado=" & Chr(34) & noCertificado & Chr(34) & " Certificado=" &
 Chr(34) & Certificado & Chr(34) & ">"
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XML3 = "<AuxiliarCtas:AuxiliarCtas xmlns:AuxiliarCtas=" & Chr(34) & "http://www.sat.gob.mx/esquemas/
ContabilidadE/1_3/AuxiliarCtas" & Chr(34) & " xmlns:xsi=" & Chr(34) & "http://www.w3.org/2001/
XMLSchema-instance" & Chr(34) & " xsi:schemaLocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/
ContabilidadE/1_3/AuxiliarCtas http://www.sat.gob.mx/esquemas/ContabilidadE/1_3/AuxiliarCtas/
AuxiliarCtas_1_3.xsd" & Chr(34)
XML4 = XML3

 Row = ""

'Open XMLFileName For Output As #1
'Open the stream and write binary data to the object
fsT.Open
 
 For I = 0 To 9
 Pos = InStr(1, Arr(I), Chr(34))
 Pos2 = InStrRev(Arr(I), Chr(34), -1)
 Pos2 = Pos2 - Pos
 
 MidStr = Mid(Arr(I), (Pos + 1), (Pos2 - 1))
 'MsgBox MidStr
 If MidStr <> "" Then
 Row = Row & " " & Arr(I)
 End If
 
 Next I
 
 XML4 = XML4 & Row
 
 XML3 = XML4 & ">"

'Open XMLFileName For Output As #1
fsT.writetext "<?xml version=" & Chr(34) & "1.0" & Chr(34) & " encoding=" & Chr(34) & "UTF-8" & Chr(34)
 & "?>" & Chr(13) & Chr(10)
fsT.writetext XML3 & Chr(13) & Chr(10)
If FldName(1) = "SubCta" Then
 MyColStart = 7
 Else
 MyColStart = 5
End If
If FldName(1) = "SubCta" Then
 MyColEnd = 0
 Else
 MyColEnd = 2
End If
'MsgBox MyRng(RangeTwo, 4)
'MsgBox MyColStart
'MsgBox FldName(1)
For MyRow = MyRng(RangeTwo, 1) To MyRng(RangeTwo, 2)
 For MyCol = RTC1 To MyRng(RangeTwo, 4) - MyColEnd
 If MyCol = MyColStart And CheckFlag = 0 Then
 'MsgBox XMLRecBuffer
 fsT.writetext XMLRecBuffer & ">" & Chr(13) & Chr(10)
 CheckFlag = 1
 End If
 If MyCol = MyColStart Then
 XMLRec2Buffer = " <AuxiliarCtas:DetalleAux "
 For MyCol2 = MyCol To MyRng(RangeTwo, 4) - MyColEnd
 If RemoveAmpersands(FormChk(MyRow, MyCol2)) <> "" Then
 XMLRec2Buffer = XMLRec2Buffer & " " & FldName(MyCol2 - 1) & "=" & Chr(34) &
 RemoveAmpersands(FormChk(MyRow, MyCol2)) & Chr(34)
 ElseIf FldName(MyCol2 - 1) = "Debe" Or FldName(MyCol2 - 1) = "Haber" And
 RemoveAmpersands(FormChk(MyRow, MyCol2)) = "" Then
 XMLRec2Buffer = XMLRec2Buffer & " " & FldName(MyCol2 - 1) & "=" & Chr(34) & "0" & Chr(34)
 End If
 ' the next line uses the FormChk function to format dates and numbers
 ' the next line does not apply any formatting
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 ' fsT.writetext "<" & FldName(MyCol - RTC1) & ">" & RemoveAmpersands(Cells(MyRow, MyCol).Value) & "</"
 & FldName(MyCol - RTC1) & ">" & Chr(13) & Chr(10)
 Next MyCol2
 fsT.writetext XMLRec2Buffer & "/>" & Chr(13) & Chr(10)
 End If
 ' the next line uses the FormChk function to format dates and numbers
 ' the next line does not apply any formatting
 ' fsT.writetext "<" & FldName(MyCol - RTC1) & ">" & RemoveAmpersands(Cells(MyRow, MyCol).Value) & "</"
 & FldName(MyCol - RTC1) & ">" & Chr(13) & Chr(10)
 If CheckFlag = 0 Then
 If RemoveAmpersands(FormChk(MyRow, MyCol)) <> "" Then
 If FldName(MyCol - RTC1) = "Debe" Or FldName(MyCol - RTC1) = "Haber" Then
 XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) & "0" & Chr(34)
 ElseIf FldName(MyCol - RTC1) = "NumCta" And FldName(1) = "SubCta" Then
 If RemoveAmpersands(FormChk(MyRow, MyCol + 1)) <> "" Then
 XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) &
 RemoveAmpersands(FormChk(MyRow, MyCol)) & "-" & RemoveAmpersands(FormChk(MyRow, MyCol + 1)) & Chr(34)
 Else
 XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) &
 RemoveAmpersands(FormChk(MyRow, MyCol)) & Chr(34)
 End If
 ElseIf FldName(MyCol - RTC1) = "DesCta" And FldName(1) = "SubCta" Then
 If RemoveAmpersands(FormChk(MyRow, MyCol + 1)) <> "" Then
 XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) &
 RemoveAmpersands(FormChk(MyRow, MyCol)) & "-" & RemoveAmpersands(FormChk(MyRow, MyCol + 1)) & Chr(34)
 Else
 XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) &
 RemoveAmpersands(FormChk(MyRow, MyCol)) & Chr(34)
 End If
 ElseIf FldName(MyCol - RTC1) = "SubCta" Or FldName(MyCol - RTC1) = "SubDesCta" Then
 XML3 = "SubCta"
 Else
 XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) &
 RemoveAmpersands(FormChk(MyRow, MyCol)) & Chr(34)
 'MsgBox XMLRecBuffer
 End If
 End If
 End If
 Next MyCol
 If FormChk(MyRow, 1) <> FormChk(MyRow + 1, 1) Then
 fsT.writetext " </AuxiliarCtas:Cuenta>" & Chr(13) & Chr(10)
 XMLRecBuffer = " <AuxiliarCtas:Cuenta "
 CheckFlag = 0
 End If
Next MyRow

fsT.writetext "</AuxiliarCtas:AuxiliarCtas>" & Chr(13) & Chr(10)
'Close #1
'Save binary data To disk
fsT.SaveToFile XMLFileName, 2
MsgBox XMLFileName & " created." & MyLF & "Process finished", vbOKOnly + vbInformation, "MakeXML CiM"
Debug.Print XMLFileName & " saved"

End Sub
Function MyRng(MyRangeAsText As String, MyItem As Long) As Long
' analyse a range, where MyItem represents 1=TR, 2=BR, 3=LHC, 4=RHC

Dim UserRange As Range
Set UserRange = Range(MyRangeAsText)
Select Case MyItem
 Case 1
 MyRng = UserRange.Row
 Case 2
 MyRng = UserRange.Row + UserRange.Rows.Count - 1
 Case 3
 MyRng = UserRange.Column
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 Case 4
 MyRng = UserRange.Columns(UserRange.Columns.Count).Column
End Select
Exit Function

End Function
Function FillSpaces(AnyStr As String) As String
' remove any spaces and replace with underscore character
Dim MyPos As Long
MyPos = InStr(1, AnyStr, " ")
Do While MyPos > 0
 Mid(AnyStr, MyPos, 1) = "_"
 MyPos = InStr(1, AnyStr, " ")
Loop
FillSpaces = AnyStr
End Function

Function FormChk(RowNum As Long, ColNum As Long) As String
' formats numeric and date cell values to comma 000's and DD MMM YY
FormChk = Cells(RowNum, ColNum).Value
'If IsNumeric(Cells(RowNum, ColNum).Value) Then
' FormChk = Format(Cells(RowNum, ColNum).Value, "#,##0 ;(#,##0)")
'End If
If IsDate(Cells(RowNum, ColNum).Value) Then
 FormChk = Format(Cells(RowNum, ColNum).Value, "yyyy-mm-dd")
End If
End Function

Function RemoveAmpersands(AnyStr As String) As String
Dim MyPos As Long
' replace Ampersands (&) with plus symbols (+)

MyPos = InStr(1, AnyStr, "&")
Do While MyPos > 0
 Mid(AnyStr, MyPos, 1) = "+"
 MyPos = InStr(1, AnyStr, "&")
Loop
RemoveAmpersands = AnyStr
End Function

11. Run the macro.

The MakeXML CiM dialog box appears containing instructions to provide several details in a series of dialog
boxes.
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12. Click Yes and proceed with information entry on each dialog box as they appear one after the other. Enter the
following information:

◦ Name of the output file

◦ Location to save the file

◦ Version of the file

◦ RFC

◦ Mes

◦ Anio

◦ TipoSolicitud

◦ NumOrden

◦ NumTramite

◦ Seal

◦ Certificate number

◦ Certificate details

13. Verify the location where the output files will be saved and click OK.

Open the XML report that's saved at location you specified.

Chart of Accounts for Mexico Report  
This topic includes details about the Chart of Accounts for Mexico report.

Overview
Companies in Mexico must submit accounting information to the tax authorities. According to the new government
regulations, companies must upload accounting information to the Tax Administration Services (SAT) internet portal
through a registered email account.

Note:  You can use your taxpayer identification registry (RFC) to register your email on the SAT portal.

Fiscal authorities in Mexico publish the official chart of accounts that all companies must use to report accounting
information. This referential chart of accounts assigns a code to each account, and a level to identify parent/child
relationships for reporting purposes. You must set up these codes in Oracle Fusion Cloud Applications .

This image shows an example of the report: 
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Key Insights
You must map accounts from your company's chart of accounts to the SAT grouping codes in the Chart of Accounts
Mapping page. Only the accounts that are mapped to the SAT grouping codes are included in the report.

You can define the company's natural account segment as a single level or a hierarchy. If you implement an account
hierarchy, a child account can have a single parent account (recommended) or multiple parent accounts. When a child
account has multiple parent accounts, only the immediate parent appears on the report. You can map more than one
account to a given SAT grouping code.

Before you run the report, ensure the natural accounts appear at the correct level in the account hierarchy. Perform the
following steps to update the level of natural account according to the account hierarchy:

1. In the Setup and Maintenance work area, select these options:

◦ Offering: Financials

◦ Functional area: Financial Reporting Structure

◦ Show: All Tasks

◦ Task: Manage Account Hierarchies

2. Select the account.
3. From the Actions menu, select Flatten and click Row Flattening.
4. Click Force Flatten.
5. From the Actions menu, select Flatten and click Column Flattening.
6. Click Force Flatten.

Note:  To run the Chart of Accounts for Mexico process from the Scheduled Processes page, you must give access to
the user you use to manage the electronic accounting reports for Mexico. For more information, see the Enable the
Mexican Reporting Processes topic.

Report Parameters
This table describes the selected process parameters.

Parameter Description

Seal
 

Enter the digital electronic seal information provided by the fiscal partner.
 

Certificate Number
 

Enter the certificate number information provided by the fiscal partner.
 

Certificate
 

Enter certificate information provided by the fiscal partner.
 

Format Version
 

Enter the format version of the file defined by the Government of Mexico. It can change over time, such
as 1.1, 1.2, and 1.3. Currently it defaults to 1.3.
 

Chart of Accounts Mapping
 

Enter the chart of accounts mapping created for Mexico.
 

Legal Entity
 

Enter the legal entity, which determines the RFC number to be stamped on the report.
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Frequently Asked Questions
This table lists frequently asked questions about the Chart of Accounts for Mexico report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial accountant
 

When do I use this report?
 

Use this report to provide detailed chart of accounts information to the tax authorities in Mexico.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Enable the Mexican Reporting Processes  
To run the Journals for Mexico and Chart of Accounts for Mexico reports, you must enable the processes once to run
them from the Scheduled Processes page in Oracle Fusion Cloud Applications .

Enable the Process
To enable the processes, follow these steps:

1. Sign in as a IT_SECURITY_MANAGER user.
2. Select Tools > Security Console.
3. Click Create Role on the Roles page.
4. Enter the new role name with Role Code as Mexico_Reports_Custom.
5. Click Next to add the required privileges.
6. Add the required roles:

a. Click Add Function Security Policy.
b. Search for a required role.
c. From the search result, select and add the privilege roles and not the OBI roles.
d. Click Add Privileges to Role.

7. Similarly, add all the required privileges.
8. Verify that all the privileges were added successfully.
9. Click Next twice to go to the role hierarchy definition page.

10. Add the roles containing your Mexican Jobs:

◦ JL_GENERATE_CHART_OF_ACCOUNTS_FOR_MEXICO_ELECTRONIC_ACCOUNTING_PRIV_OBI

◦ JL_GENERATE_JOURNAL_ENTRIES_FOR_MEXICO_ELECTRONIC_ACCOUNTING_PRIV_OBI

11. Verify that all the roles have been added
12. Click Next to add the job role to the required users, such as the Mexican Manager.
13. Once all users are added, click Next and then click Save and Close to complete the job role definition.
14. Sign in as an Application_Implementation_Consultant user and navigate to the Setup and Maintenance page.
15. In the Setup and Maintenance work area, select these options:
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◦ Offering: Financials

◦ Functional area: Enterprise Profile

◦ Task: Manage Reference Data Set Data Access for Users

16. Select the Users with Data Access option and identify the user you need to add data access to.
17. Click Search to see all the existing data access privileges for this user.
18. Click the Create icon to add the new job role data access.
19. Add the required security contexts.

Note:  The usual set defined to cover all possible requirements is: Ledger, Data Access Set, Reference Data
Set, and Business Unit.

It is advisable to run a final process whenever there is a change in job roles. This is accessed from the Setup and
Maintenance page. Just select and click Submit. Follow its progress from the Tools > Scheduled Processes page.

Assign a Job Role to Users
After the job role is created and you can add it to a user.

Follow these steps:

1. Open the User Accounts page.
2. Select the job role and click Edit.
3. Keep clicking Next till you see the Add User page.
4. Add the user to the role.

Note:  Alternatively, you can select the user on the User Accounts page, click Edit, and add the role.

5. Click Save and Close to complete the setup.

You will also need to add the required data access for this user.

Configure the General Ledger Segments for Reporting in OTBI  
Before you generate the Auxiliary Report for Mexico, you need to configure and enable the general ledger segments for
reporting in OTBI.

Perform the following tasks to configure and enable general ledger segments for reporting:

1. Enable the chart of accounts segments for BI reporting.
2. Map the accounting segments with the corresponding BI Object Name.
3. Deploy flexfields.
4. Run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence process.

Note:  Ensure that you configured the chart of accounts. For details about how to configure the chart of accounts, see
How You Configure Chart of Accounts for Mexico Report topic.
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Enable the Chart of Accounts Segments
You must enable your accounting segments for OTBI reporting before using them. Perform the following steps to use
the accounting segments in OTBI:

1. Navigate to Setup and Maintenance work area.
2. Select an implementation project.
3. In the Task Lists and Tasks section, select Financials > Define Common Applications Configurations for

Financials > Define Common Reference Objects for Financials > Manage Key Flexfields .
The Manage Key Flexfields page appears.

4. Enter GL# in the Key Flexfield Code field and click Search.
5. Click Manage Structure Instances.

The Manage Key Flexfield Structure Instances page appears.
6. Use the search fields to search for your key flexfield structure instances.
7. Select your key flexfield structure instances from the Search Results.
8. Click the Actions menu and then click Edit.

The Edit Key Flexfield Structure Instance page appears.
9. Select the segment instance that you want to use in OTBI from the Segment Instances table.

10. Click the Actions menu and then click Edit.
The Edit Key Flexfield Segment Instance dialog box appears.

11. Select the BI enabled check box and click the OK\ button.
12. Click Save.
13. Repeat the steps for all the segment instances that you want to use in OTBI.

Map the Accounting Segments and BI Object Name
Populate the BI Object Name for each of the Segment Labels that want to use in OTBI for reporting and analysis. The BI
metadata has ten predefined BI Objects for the different GL segments. These BI Objects are used as dimensions in OTBI
for the selected GL segments.

Perform the following steps to map the different chart of account segments to the predefined BI objects:

1. Navigate to Setup and Maintenance work area.
2. Select an implementation project.
3. In the Task Lists and Tasks section, select Financials > Define Common Applications Configurations for

Financials > Define Common Reference Objects for Financials > Manage Key Flexfields .
The Manage Key Flexfields page appears.

4. Enter GL# in the Key Flexfield Code field and click Search.
5. Click the Actions menu and then click the Manage Segment Labels option.

The Manage Segment Labels page appears.
6. Update the BI Object Name for all the segment labels that are required. For the following three segment label

codes, specify the BI Object name as specified in the table. Do not modify the BI object name; use the BI object
name as mentioned in the following table.

Segment Label Code BI Object Name

FA_COST_CTR Dim - Cost Center
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Segment Label Code BI Object Name

  

GL_BALANCING
 

Dim - Balancing Segment
 

GL_ACCOUNT
 

Dim - Natural Account Segment
 

7. For the other non-qualified segment labels that you want to use in OTBI, use any BI object names from Dim -
GL Segment1 to Dim - GL Segment10.
For the Auxiliary report for Mexico, map the segment label MX_SUBACCOUNT to Dim - GL Segment9.

Deploy Flexfields
Perform the following steps to deploy the flexfields:

1. Navigate to Setup and Maintenance work area.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Financials

◦ Functional Area: Financial Reporting Structures

◦ Task: Manage Chart of Accounts Structure

3. On the Manage Chart of Accounts Structure page, enter GL# in the Key Flexfield Code field and click Search.
4. Click Deploy Flexfield.

The GL#: Processing dialog box appears indicating the deployment progress.
5. Click the OK button after the deployment completes.

Run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence
Process
Perform the following steps to run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence
process:

1. Navigate to the Scheduled Processes work area.
2. Click the Schedule New Process button.

The Schedule New Process dialog box appears.
3. Click Name.
4. Click Search.

The Search and Select dialog box appears.
5. Enter Import Oracle Fusion Data Extensions for Transactional Business Intelligence in the Name field.
6. Click Search.
7. Select the process name from the Search Results area and click the OK button.
8. Click the OK button on the Schedule New Process dialog box.

The Process Details dialog box appears.
9. Update the details and click the Submit button.

10. Note the Process ID and click OK to acknowledge that your process was submitted.
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11. Note the status of your process:

◦ If the status of the process is Succeeded, the process executed successfully. Proceed and generate the
Auxiliary Report for Mexico.

◦ If the status of the process is failed, check the log file, make corrections, and submit the process again.

Journals for Mexico Report  
This topic includes details about the Journals for Mexico report.

Overview
Companies in Mexico must submit accounting information to the tax authorities. Companies must upload accounting
information to the Tax Administration Services (SAT) internet portal through a registered e-mail account.

Note:  You can use your taxpayer identification registry (RFC) to register your e-mail address on the SAT portal.

The Journals for Mexico report collects information on all transactions that are accounted and posted in different
subledgers. The report also captures information related to electronic invoices generated for sales or received from
suppliers for purchases, as well as manually entered journals. However, you must update the global descriptive flexfields
when entering and posting transactions in Oracle Payables, Oracle Receivables, and Oracle General Ledger.

This image shows an example of the report.

Key Insights
To run the report, you must first enable the Journals for Mexico process so that you can run it from the Scheduled
Processes page. For more information, see Enable the Mexican Reporting Processes.

When you run the Journals for Mexico process, detailed transaction information is extracted from General Ledger for
the specified period.
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The report is generated in an XML format and includes these sections:

• Heading: Includes layout version, RFC number, and the date on which the report is generated.

• Details: Provide accounting information from the journal entries. Note that the UUID information depicted in
the GL journals is extracted directly from the AR and AP transactions. Any change in these transactions at the
subledger level don't need additional transfer actions to be included in the journals report.

Do note:

◦ Records in the journal entries are grouped based on your Payables and Receivables settings. The
information in the expense reports are tracked from the Payables transactions. GL entries are depicted as
they're entered in GL.

◦ Your role requires the data security privilege, Report Person National Identifier. The report shows the
employee national identification number for payment requests from Expenses.

Report Parameters
This table describes selected process parameters.

Parameter Description

Request Type
 

Select the audit request type indicated by the Government.
 

• AF - Audit Event

• FC - On-site Audit

• DE - Return

• CO - Compensation

Audit Request Number
 

Specify the audit request number, when the request type is audit event (AF) or on-site audit (FC).
 

Audit Process Number
 

Specify the audit process number, when the request type is return (DE) or compensation (CO).
 

Journal Version
 

Enter the format version of the file defined by the Government of Mexico. It can change over time, such
as 1.1, 1.2, and 1.3. Currently, the default value is 1.3.
 

Seal Number
 

Specify the digital electronic seal provided by the Government for the accounting file.
 

Certificate Number
 

Specify the digital certificate seal that protects the electronic accounting file.
 

Digital Seal Certificate
 

Specify digital seal certificate that protects the electronic accounting file.
 

Journal Source
 

Specify the name of the journal source. When you specify the source, the journal lines from that source
are extracted. When you specify ALL, journal lines from all the subledgers are extracted.
 

Show Adjustment Periods
 

Specify whether data during the adjustment period must be extracted and reported.
 

Ledger
 

Specify the ledger from which you want to extract data. When you specify a ledger, only posted journal
lines in that ledger are extracted.
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Parameter Description

From Period and To Period
 

Specify the range of subledger periods to be included for extracting data.
 

From Date and To Date Specify the date range to be included for extracting data. Date range must be between the From Period
and the To Period parameters.

Posting Status
 

Specify whether posted data must be included in the report.
 

Include Zero Amount Lines
 

Specify whether zero amount lines must be included in the report.
 

•

Frequently Asked Questions
This table lists frequently asked questions about the Journals for Mexico report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Financial accountant
 

When do I use this report?
 

Use this report to provide detailed accounting information to the tax authorities in Mexico.
 

What type of report is this?
 

Oracle Analytics Publisher
 

How You Capture Electronic Invoice Information for Mexico  
The Journals for Mexico report collects information on all transactions that are accounted and posted in different
subledgers. The report also captures information related to electronic invoices generated for sales, received from
suppliers for purchases, or from manually entered journals.

However you must update the global descriptive flexfields when entering and posting transactions in Oracle Payables,
Oracle Receivables, and Oracle General Ledger.

Global descriptive flexfields store the unique identifier and invoice number issued either by the Tax Administration
Services (SAT) or by an authorized service provider (PAC).

This table summarizes the flexfields you must update for electronic invoices when you create an invoice or transaction
in Payables, Receivables, Expense Reports or manual General Ledger entries.
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Global Descriptive Flexfields Used in Description

Digital Tax Receipt using Internet Unique
ID
 

• AP Invoices

• AP Payments

• AR Invoices

• AR Receipts

• Manual GL Entries

Enter the unique identifier of the Comprobante Fiscal Digital por
Internet. CFDI is an electronic billing schema that simplifies the process
of issuing and receiving invoices and involves engaging an authorized
certification provider.
 

Digital Tax Receipt Serial Number
 

• AP Invoices

• AR Invoices

Enter the serial number on the Digital Fiscal Document or Fiscal
Document with Bidirectional Bar Code (CFD/CBB). CFD/CBB is a paper-
based fiscal document that contains an authorized bidirectional bar
code. This type of fiscal document is issued to taxpayers whose annual
income is less than four million Mexican Pesos.
 

Digital Tax Receipt Invoice Number
 

• AP Invoices

• AR Invoices

Enter the invoice number on the CFD/CBB.
 

Foreign Invoice Number
 

• AP Invoices Enter the foreign invoice number, if it exists.
 

Payment Method
 

• AP Payments Select the payment type from the given list of values
 

Receipt Number
 

• Expense Reports Enter the unique identifier of CFDI. CFDI is an electronic billing schema
that simplifies the process of issuing and receiving invoices and
involves engaging an authorized certification provider.
 

Tax Payer ID
 

• Manual GL Entries Enter the tax payer ID of the transaction corresponding the manually
entered journal in GL.
 

To capture all the Mexican transactions correctly:

• In Payables, you can:

◦ Select Invoices for Mexico from the Regional Information list on the Additional Information tab on the
Show More page of the invoice header. Ignore the Routing Attributes 1-5 for now.

◦ Select invoice lines for Mexico from the Regional Information list on the Update Additional Information
dialog box, which appears after clicking the Details icon on the Payables invoice line.

Invoice Line amounts must be tax inclusive to display the Monto Total correctly.

• For Payables Payments, select Payments for Mexico from the Regional Information list on the Additional
Information tab of the payment header.

• In Receivables, select Transactions for Mexico from the Regional Information list on the Miscellaneous tab of
the transaction header.

• In Receivables Receipts, select Receipt for Mexico from the Regional Information list on the Additional
Information section of the AR Receipt header.

Note:  You must already define a payment method for the receipt method used in the Receivables Receipts.
You can define this method using Receipt Classes for Mexico from the Regional Information list on the
Receipt Classes and Methods page.
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• For Expense Reports, define the Receipt Number field to identify the UUID code on the Detail page of the
expense item definition. The page can be accessed directly by clicking the Create New Expense Item button or
from the detail section of an expense report by adding (and defining) a new expense item. Apart from the UUID
entered at the Receipt Number field, Merchant Name and Taxpayer ID fields are also mandatory for extracting
the information.

Note:  If you provide a valid UUID in the Receipt Number field, the transaction is considered as an expense
report with a UUID. Otherwise, it's treated as a foreign invoice reported under NumFactExt. The Valid UUID
format is: ad662d33-6934-459c-a188-bdf03930f444.

• For manual General Ledger transactions, select Journals for Mexico from the Regional Information list on the
Journal tab of the Show More page of the journals header.

If an invoice is paid in multiple installments, capture each payment separately. Update the GDFs with the details of your
payments.You can access the GDFs from the:

• Payment Installments dialog box in Payables

• Review Installments dialog box in Receivables

Trial Balance Report for Mexico  
This topic contains summary information about the Trial Balance Report for Mexico.

Overview
The trial balance report is an XML file that includes a summary of the initial balances, the sum of total transactions for
the period, and the final balances for each account that you report in the Chart of Accounts XML file. The accounts
related to assets, liabilities, equity, and results of operations (revenues, costs and expenses) are all included.

Key Insights
After generating the report from your folder in the General Accounting: Financial Reporting Center, convert the report to
an XML format so that it's ready to upload to the Tax Administration Services (SAT) website.

You can create the report once and use it periodically. The report can also be modified based on the requirements from
the Federal Government.

Frequently Asked Questions
The following table lists frequently asked questions about the Trial Balance Report for Mexico.

FAQs Answer

How do I find this report?
 

Run this report from your folder in the General Accounting: Financial Reporting Center.
 

Who uses this report?
 

• Financial Accountants

• Financial Specialists
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FAQs Answer

When do I use this report?
 

Use the Trial Balance Report for Mexico to know the summary of the initial balances, the sum of total
transactions for the period, and the final balances for each account that you report in the Chart of
Accounts XML file.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• Create a Trial Balance Report for Mexico

• Convert the Trial Balance Report for Mexico to XML Format

Create a Trial Balance Report for Mexico  
The trial balance report is an XML file that includes a summary of the initial balances, the sum of total transactions for
the period, and the final balances for each account in the Chart of Accounts XML file.

The report includes information on accounts related to assets, liabilities, equity, and the results of operations (revenues,
costs and expenses).

Use the Financial Reporting Web Studio to create the Trial Balance Report for Mexico. You can create the report once
and use it periodically. The report can also be modified based on the requirements from the Federal Government.

Note:  Ensure that you configured the chart of accounts . For details about how to configure the chart of accounts, see
How You Configure Chart of Accounts for Mexico Report topic.

Perform the following steps to create the report:

1. From the Financial Reporting Center work area, select the Tasks panel tab and click Open Workspace for
Financial Reports.

2. On the Tools menu, select Launch Financial Reporting Web Studio.
3. Click File > New > Report  or click the New Report icon.
4. Use the Report Pallet page as the container to build your report.
5. Click Insert > Grid... or click the New Grid icon.
6. Click and hold the left mouse button to select a large area of the grid to create the report.

The Select a Database Connection dialog box appears when you release the mouse after setting the size and
position of the grid.

7. Click the Database Connection list.
8. Select your database. A unique cube exists for each combination of chart of accounts and accounting calendar.

Note:  The user name and password are the login credentials you used to access the Financial Reporting Web
Studio.

9. Click OK.

The Dimension Layout dialog box appears. Set the point of view dimensions and accounts for the rows,
columns, and page levels.
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10. Use the Dimension Layout dialog box to arrange your dimensions. Move:

◦ Accounting Period and Balance Amount to Columns.

◦ Account to Rows.

Tip:  Click the icon in front of the name to select the dimension to move to the designed area.

The following figure illustrates how the dimensions appear on the Dimension Layout dialog box after you
made your selection.

11. Click OK.

You return to the grid which has the selected dimensions.
12. Add additional rows and columns to the grid according to your requirement.

◦ Columns: Copy column A and paste it four times to see columns A to E.

◦ Rows: Select row 1, right-click and select Insert Row > Text. Insert ten rows.

13. Enter the row text in each row cell. The following table lists the row text for each row.

Row Text

1
 

Version="1.3"
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Row Text

Note:
You can update the version number anytime.
 

2
 

RFC="SYS11103"

Note:
You can update the RFC anytime.
 

3
 

Mes="<<MemberName("Grid1", "AccountingPeriod")>>"

4
 

Anio="<<MemberName("Grid1", E, "AccountingPeriod")>>"

5
 

TipoEnvio="N" (User needs to fill value)

6
 

FechaModBal=" " (User needs to fill value)

7
 

Sello="Seal" (User needs to fill value)

8
 

noCertificado ="13"(User needs to fill value)

9
 

Certificado="cERT"(User needs to fill value)

10
 

Update the row cell and columns for row 10 with the following values:
 

◦ Row cell with NumCta

◦ Row 10, Column A with Saldo Ini

◦ Row 10, Column B with Debe

◦ Row 10, Column C with Haber
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Row Text

◦ Row 10, Column D with SaldoFin

The following figure illustrates how the grid should appear:

14. In the first column on the grid (Column A), double-click the AccountingPeriod cell.
The Select Members dialog box appears.

15. Remove the default selection from the Selected pane and assign a user-defined period selection.
16. Select the AccountingPeriod in the Selected pane and click Remove.
17. Select Current Point of View for Accounting Period from Available pane and click Move to place it in the

Selected pane.
18. Select the Place selection into separate columns option.
19. Click OK.
20. Repeat the steps for Columns B, C, and D.
21. In the last column on the grid (Column E), double-click the AccountingPeriod cell to open the Select Members

dialog box.
22. Select the AccountingPeriod in the Selected pane and click Remove.
23. Select Current Point of View for Accounting Period from Available pane and click Move to place it in the

Selected pane.
24. Click the Functions tab and select RelativeMember from the list.
25. Click Add.
26. Use the Edit RelativeMember Function dialog box to add the parameter values. The following table lists the

values you can enter.

Parameter Value

Member
 

Current Point of View for Accounting Period
 

Offset
 

0
 

Hierarchy AccountingPeriod
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Parameter Value

  

RelativeMemberList
 

Fiscal Year
 

27. Select the Place selection into separate columns option.
28. Click OK.
29. In the first column on the grid (Column A), double-click the BalanceAmount cell.

The Select Members dialog box appears.
30. Remove the default selection from the Selected pane and assign a user-defined selection.
31. Expand the Balance Amount node in the Available pane and select Beginning Balance.
32. Click Move.
33. Select the Place selection into separate columns option.
34. Click OK.
35. Repeat the steps and assign the user-defined properties as shown in the table for the BalanceAmount cell in

the other columns.

Column Parent Node Custom Selection

B
 

Period Activity
 

Period Activity Dr
 

C
 

Period Activity
 

Period Activity Cr
 

D
 

Ending Balance
 

Ending Balance
 

E
 

Ending Balance
 

Ending Balance
 

The following figure illustrates how your grid appears when you finish updating user-defined values for all the
dimensions.
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36. Select column E.
The Custom Properties dialog box appears.

37. Select the Hide Always check box.
38. Select the first two rows (row 1 and 2).
39. Select the Hide Always check box in the Custom Properties dialog box.
40. Select row 11, right-click and click Insert Row > Data. Row 12 is added.

Note:  For each account in the SAT chart of accounts mapping, add a row.

41. Double-click the Account cell in row 11 to open the Select Members dialog box.
42. Select Account in the Selected pane and click Remove.
43. Click the Members tab.
44. Expand the Account > All Account Values nodes that appear in the Available pane.
45. Select 1110 and click Move. The account appears in the Selected pane.
46. Select the Place selection into separate columns option.
47. Click OK.

You can follow the similar steps to add all your natural accounts.
48. Update the dimensions that appear in the grid with the values specified in the following table.

Note:  To update the dimensions, double-click the respective dimension buttons to open the Select Members
dialog box. Select the values as specified in the table in the Select Members dialog box and click OK.

Dimension Value

AccountingPeriod
 

Qtr1-00 for the year 2000
 

Note:
Run the report either for a year or for any quarter of a year.
 

Scenario
 

Actual
 

Ledger
 

Vision Operation
 

Note:
Run the report for any ledger.
 

Amount Type
 

Base
 

Currency
 

MXN
 

Currency Type
 

Entered
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49. Set the grid properties. Select the grid to open the Grid Properties dialog box. In the Suppression region, check
the following check boxes:

◦ Basic Options

◦ If Zero, Suppress

◦ If Missing, Suppress

◦ If Error, Suppress
50. Save the report.

Example of the final output of the report:

Convert the Trial Balance Report for Mexico to XML Format  
You can view the Trail Balance Report for Mexico from the Financial Reporting Center. After you have viewed the report,
you can convert it to an XML format to upload it to the Tax Administration Services (SAT) internet portal.

View the Trial Balance Report for Mexico
You can view the Trail Balance Report for Mexico from the Financial Reporting Center.

Follow these steps:

1. Sign in the Oracle Fusion Cloud Applications.
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2. On the home page of General Account Manager, select General Accounting: Financial Reporting Center, My
Folders, Trial Balance Report for Mexico.

3. View the report in HTML.
4. Click the HTML Preview list at the beginning of the page and select Export to Excel.

The report opens in Microsoft Excel.
5. Save the report in your local folder as an Excel Macro-Enabled Workbook.

Convert the Trial Balance Report for Mexico to XML Format
You can convert your report to an XML format that can be uploaded to the SAT portal.

Follow these steps:

1. Open the report in Microsoft Excel and click the View tab.
2. Click Macros, View Macros.
3. Enter GenerateXML in the Macro name field and click Create.

The Microsoft Visual Basic editor opens.
4. Copy and paste the following report conversion code in the Microsoft Visual Basic editor.

Sub GenerateXML()
 '
 ' GenerateXML Macro
 Dim Version As String
 Dim RFC As String
 Dim Mes As String
 Dim Anio As String
 Dim TipoEnvio As String
 Dim FechaModBal As String
 Dim Sello As String
 Dim noCertificado As String
 Dim BalanzaCertificado As String
 Dim XML As String
 Dim XML2 As String
 Dim Row As String
 Dim Row2 As String
 Dim ColumnName As String
 Dim ColumnValue As String
 Dim MesP1 As String
 Dim MesP2 As String
 Dim Pos As Integer
 Dim Pos2 As Integer
 Dim Pos3 As Integer
 Dim MidStr As String
 Dim MidStr2 As String
 Dim Arr

 Sheets(1).Select
 Version = Replace(ActiveSheet.Cells(1, 1).Value, " ", "")
 RFC = Replace(ActiveSheet.Cells(2, 1).Value, " ", "")
 Mes = Replace(ActiveSheet.Cells(3, 1).Value, " ", "")
 Anio = Replace(ActiveSheet.Cells(4, 1).Value, " ", "")
 TipoEnvio = Replace(ActiveSheet.Cells(5, 1).Value, " ", "")
 FechaModBal = Replace(ActiveSheet.Cells(6, 1).Value, " ", "")
 Sello = Replace(ActiveSheet.Cells(7, 1).Value, " ", "")
 noCertificado = Replace(ActiveSheet.Cells(8, 1).Value, " ", "")
 BalanzaCertificado = Replace(ActiveSheet.Cells(9, 1).Value, " ", "")
 
 Arr = Array("Version", "RFC", "Mes", "Anio", "TipoEnvio", "FechaModBal", "Sello", "noCertificado",
 "Certificado")
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 MesP1 = Mid(Mes, 6, 3)
 
 If MesP1 = "Jan" Then
 Mes = "Mes=" & Chr(34) & "01" & Chr(34)
 ElseIf MesP1 = "Feb" Then
 Mes = "Mes=" & Chr(34) & "02" & Chr(34)
 ElseIf MesP1 = "Mar" Then
 Mes = "Mes=" & Chr(34) & "03" & Chr(34)
 ElseIf MesP1 = "Apr" Then
 Mes = "Mes=" & Chr(34) & "04" & Chr(34)
 ElseIf MesP1 = "May" Then
 Mes = "Mes=" & Chr(34) & "05" & Chr(34)
 ElseIf MesP1 = "Jun" Then
 Mes = "Mes=" & Chr(34) & "06" & Chr(34)
 ElseIf MesP1 = "Jul" Then
 Mes = "Mes=" & Chr(34) & "07" & Chr(34)
 ElseIf MesP1 = "Aug" Then
 Mes = "Mes=" & Chr(34) & "08" & Chr(34)
 ElseIf MesP1 = "Sep" Then
 Mes = "Mes=" & Chr(34) & "09" & Chr(34)
 ElseIf MesP1 = "Oct" Then
 Mes = "Mes=" & Chr(34) & "10" & Chr(34)
 ElseIf MesP1 = "Nov" Then
 Mes = "Mes=" & Chr(34) & "11" & Chr(34)
 ElseIf MesP1 = "Dec" Then
 Mes = "Mes=" & Chr(34) & "12" & Chr(34)
 Else
 Mes = "Mes=" & Chr(34) & "13" & Chr(34)
 End If
 
 'XML = XML & "<BCE:Balanza xmlns:BCE=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/
BalanzaComprobacion" & Chr(34) & " xmlns:xsi=" & Chr(34) & "http://www.w3.org/2001/XMLSchema-instance"
 & Chr(34) & " xsi:schemaLocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/
BalanzaComprobacion http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/BalanzaComprobacion/
BalanzaComprobacion_1_1.xsd" & Chr(34) & " " & Version & " " & RFC & " " & Mes & " " & Anio & " " &
 TipoEnvio & " " & FechaModBal & " " & Sello & " " & noCertificado & " " & BalanzaCertificado & ">" &
 vbNewLine
 XML = XML & "<BCE:Balanza xmlns:BCE=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/
BalanzaComprobacion" & Chr(34) & " xmlns:xsi=" & Chr(34) & "http://www.w3.org/2001/XMLSchema-instance"
 & Chr(34) & " xsi:schemaLocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/
BalanzaComprobacion http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/BalanzaComprobacion/
BalanzaComprobacion_1_1.xsd" & Chr(34)
 XML2 = XML
 Row2 = ""
 
 For I = 1 To 9
 Pos = (InStr(1, Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), Chr(34))) + 1
 Pos2 = InStr(Pos, Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), Chr(34))
 Pos2 = Pos2 - Pos
 Pos3 = 3
 
 MidStr = Mid(Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), Pos, Pos2)
 MidStr2 = Mid(Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), 1, Pos3)
 
 If MidStr <> "" Then
 If MidStr2 = "Mes" Then
 Row2 = Row2 & " " & Mes
 Else
 Row2 = Row2 & " " & Replace(ActiveSheet.Cells(I, 1).Value, " ", "")
 End If
 End If
 
 Next I
 
 XML2 = XML2 & Row2
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 XML = XML2 & ">" & vbNewLine
 
 ActiveSheet.Range("A10").Select
 Selection.End(xlDown).Select
 SheetLastRow = ActiveCell.Row
 
 ActiveSheet.Range("A10").Select
 Selection.End(xlToRight).Select
 SheetLastColumn = ActiveCell.Column
 
 For I = 11 To SheetLastRow
 Row = vbTab & "<BCE:Ctas "
 For J = 1 To SheetLastColumn
 ColumnName = Replace(ActiveSheet.Cells(10, J).Value, " ", "")
 ColumnValue = ActiveSheet.Cells(I, J).Value
 Row = Row & ColumnName & "=" & Chr(34) & ColumnValue & Chr(34) & " "
 Next J
 Row = Row & "/>" & vbNewLine
 
 XML = XML & Row
 Next I
 
 XML = XML & "</BCE:Balanza>"
 
 fileSaveName = Application.GetSaveAsFilename(ActiveSheet.Name, fileFilter:="XML Files (*.xml), *.xml")
 
 Open fileSaveName For Output As #1
 Print #1, "<?xml version=" & Chr(34) & "1.0" & Chr(34) & " encoding=" & Chr(34) & "UTF-8" & Chr(34) &
 "?>"
 Print #1, XML
 Close #1
 '
End Sub
 

5. Click File > Save.

Save the file in your local folder and close Microsoft Visual Basic.
6. Select the GenerateXML macro and click Run that appears on the Macros dialog box in Microsoft Excel.
7. Save the XML file in your local folder.
8. Open the XML file and verify the output.

FAQs for Reports of Mexico  

How do parent accounts and subaccounts appear in the Mexico reports?  
If you have a combination of account and subaccount, the SubCtaDe field displays the immediate natural account
preceding a subaccount.

This happens because account hierarchy considers only the immediate natural account preceding the subaccount as
the parent. The original parent account may not always be the immediate parent for a subaccount.

Consider these parent and child natural accounts, and the associated subaccounts, for an example:

Natural Account - Parent Natural Account - Child Subaccount SubCtaDe displays

100  100
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Natural Account - Parent Natural Account - Child Subaccount SubCtaDe displays

  

100
 

10001
 

 100 10001
 

100
 

10002
 

 100 10002
 

 10002
 

001
 

10002 001
 

 10002
 

002
 

10002 002
 

Here, the parent account for the natural child accounts 10001 and 10002 is 100. However, the immediate parent account
for subaccount 001 is 10002 and not 100. Since it takes precedence before the natural parent account, the report
displays 10002 001, instead of 100 001.

Why doesn't my report display details of foreign fiscal documents?  
You can see details of foreign fiscal documents (CompExt) only on foreign invoices. These details aren't going to show
on your report.

Why doesn't my RFC appear on the Mexican reports?  
If your Taxpayer Identification Registry (RFC) doesn't appear on the Mexican report, try one of these methods:

• To make it appear at the header level:

◦ Specify it at your legal entity level while you create the legal entity.

• To make it appear at the national fiscal documents of type CFDI (CompNal) level and payment levels:

◦ Specify it at the supplier level.

Other Latin America Reports  

Purchase Withholding Certificate for Chile  
This section provides details about the Purchase Withholding Certificate Report for Chile.

Overview
The Purchase Withholding Certificate Report for Chile helps with an in-depth analysis of all the information for
transactions in the ledger currency that have transaction year within the certificate that is selected. The report displays
the calendar periods, taxable service fee, as well as the payments on which amounts were withheld.
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Key Insights
To generate the report, the role must be LAD Financial Reporting role, and it can be assigned to any job role. This do not
need any job role exclusively.

Lookup Codes
You must set up these lookup codes under the standard lookup ORA_JLCL_AP_DOCUMENT_TYPE:

• ORA_JL_CL_CREDIT_MEMO

• ORA_JL_CL_DEBIT_MEMO

• ORA_JL_CL_DOMESTIC_INVOICE

• ORA_JL_CL_FOREIGN_INVOICE

• ORA_JL_CL_INTERNAL

• ORA_JL_CL_SERVICE_FEE

• ORA_JL_CL_SERVICE_PARTICIPATE_FEE

Fiscal Classification Code
You must set up these fiscal classification codes under the country Chile (CL):

• ORA_JL_CL_CREDIT_MEMO

• ORA_JL_CL_DEBIT_MEMO

• ORA_JL_CL_DOMESTIC_INVOICE

• ORA_JL_CL_FOREIGN_INVOICE

• ORA_JL_CL_INTERNAL

• ORA_JL_CL_SERVICE_FEE

• ORA_JL_CL_SERVICE_PARTICIPATE_FEE

Frequently Asked Questions
This table lists frequently asked questions about the Purchase Withholding Certificate for Chile.

FAQs Answer

How do I find this report?
 

In Oracle Transactional Business Intelligence, select Analysis from Analysis and Interactive Reporting.
 

Who uses this report?
 

• Financial Accountants

• Financial Specialists

When do I use this report?
 

Use the Purchase Withholding Certificate for Chile when you need to provide detailed records of your
accounts to the fiscal authorities.
 

What type of report is this?
 

Oracle Transaction Business Intelligence
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Purchase Withholding Certificate for Argentina  
This topic contains summary information about the Purchase Withholding Certificate for Argentina.

Overview
The Purchase Withholding Certificate for Argentina provides all the report information for transactions in the ledger
currency that have the transaction date within the date range that is selected.

Key Insights
To generate the report, the role must be LAD Financial Reporting role, and it can be assigned to any job role. This do not
need any job role exclusively.

Frequently Asked Questions
The following table lists frequently asked questions about the Purchase Withholding Certificate for Argentina.

FAQs Answer

How do I find this report?
 

In Oracle Transactional Business Intelligence, select Analysis from Analysis and Interactive Reporting.
 

Who uses this report?
 

• Financial Accountants

• Financial Specialists

When do I use this report?
 

Use the Purchase Withholding Certificate for Argentina when you need to extract information which
electronically reports withholding VAT information.
 

What type of report is this?
 

Oracle Transaction Business Intelligence
 

Purchase Withholding Certificate for Colombia  
This topic contains summary information about the Purchase Withholding Certificate for Colombia.

Overview
The Purchase Withholding Certificate for Colombia helps with an in-depth analysis of all the report information for the
transactions in the ledger currency that have the transaction date within the date range that is selected.

Key Insights
To generate the report, the role must be LAD Financial Reporting role, and it can be assigned to any job role. This do not
need any job role exclusively.
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Frequently Asked Questions
The following table lists frequently asked questions about the Purchase Withholding Certificate for Colombia.

FAQs Answer

How do I find this report?
 

In Oracle Transactional Business Intelligence, select Analysis from Analysis and Interactive Reporting.
 

Who uses this report?
 

• Financial Accountants

• Financial Specialists

When do I use this report?
 

Use the Purchase Withholding Certificate for Colombia when you need to extracts information which
electronically reports withholding VAT information for Colombia.
 

What type of report is this?
 

Oracle Transaction Business Intelligence
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18  Oracle Fusion Financials for Asia/Pacific
Reports

Oracle Fusion Cloud Financials for Asia/Pacific
Predefined Reports  
Oracle Financials for Asia/Pacific provides predefined reports that are used to meet reporting and reconciliation
requirements for specific countries.

Scheduled Processes work area

Reports can be scheduled and run from the Scheduled Processes work area found from the Tools on the Navigator.

Reports and Analytics work area

In some cases, reports are also:

• Accessed from the Reports and Analytics work area found from the Tools on the Navigator or from other
work areas.

• Opened using links that launch the business intelligence (BI) catalog.

The following tables are the predefined reports.

Reports for Asia/Pacific

Display Name Description

Transactions Transfer Report for China
 

Lists the transfer results of Receivables transactions to the Golden Tax Adaptor.
 

Golden Tax Transaction Consolidation
Detail Report for China
 

Lists detailed consolidated information on parent Golden Tax transactions and related child Golden Tax
transactions.
 

Import VAT Invoices for China
 

Imports VAT invoices from the VAT invoicing software and maps the invoice data to the corresponding
Golden Tax transactions at both the header level and the line level.
 

VAT Invoices Mapping Report for China
 

Lists the mapping relationship between the original Receivables transactions and completed VAT
invoices from the VAT invoicing software .
 

Golden Tax Discrepancy Report for China
 

Lists all header and line level discrepancies between the original Receivables transactions, the Golden
Tax transactions created during the transfer process, and the completed VAT invoices imported from
the VAT invoicing software.
 

Payment Register with Bank Charges for
Japan
 

Lists payments with calculated bank charges. Used to review the amount of bank charges deducted
from a payment.
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Display Name Description

Input Tax Gain/Loss Report for Singapore
 

Produces the details on tax gain or loss on transactions for Singapore entered in foreign currencies in
Oracle Fusion Payables. The report lists data for a specific supplier or all suppliers. The report data is
grouped by tax rate code and supplier.
 

Output Tax Gain/Loss Report for
Singapore
 

Produces the details on tax gain/loss on transactions for Singapore entered in foreign currencies in
Oracle Fusion Receivables. The report lists data for a specific customer or all customers. The report
data is grouped by tax rate code and customer.
 

Withholding Tax Certificate for Thailand
 

Produces reports on the tax withheld by companies in Thailand while making payments to suppliers.
 

Subledger Reports

Display Name Description

General Ledger Journal to Subledger
Transaction Mapping Report
 

Lists the General Ledger journal details and the corresponding subledger transaction details in each
row for the selected data access set, ledger, and accounting period range. Details include account
combination, accounted and entered amounts, source, category, journal batch, journal names, supplier
or customer names, voucher, document, intercompany batch, payment, PO, and receipt numbers.
 

General Ledger Journal and Subledger
Transaction Mapping Report
 

List the mapping relationship between the General Ledger Journals and source subledger transactions
details.
 

To run predefined reports, navigate to the Scheduled Processes work area and follow these steps:

1. Click the Schedule New Process button.
2. Search for your process name.
3. Enter your parameters.
4. Enter your process options and schedule.
5. Click Submit.

Use General Ledger Journal and Subledger Transaction
Mapping Report  
This topic includes details about the General Ledger Journal and Subledger Transaction Mapping Report.

Overview
Use the General Ledger Journal and Subledger Transaction Mapping Report to display the mapping relationship details
between general ledger journals and the corresponding source subledger transactions for a specific data access set,
ledger, and accounting period.

The following figure shows an example of the General Ledger Journal and Subledger
Transaction Report. Some of the columns included on the report are period, account,
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currency, rate, entered amount, accounted amount, source, category, and journal batch name.

Key Insights
The following table lists the sources for which subledger information is reported, along with the information that is
displayed.

Source Subledger Information

Oracle Payables
 

• Supplier name

• Invoice number

• Document number

Oracle Receivables
 

• Customer name

• Transaction number

• Receipt number

Oracle Cost Management
 

• Supplier name

• Purchase order number

• Receipt number

Oracle Intercompany
 

Original intercompany batch number
 

Note:  For other sources, the report displays only general ledger information.

For secondary ledgers, when the data conversion level is subledger, only subledger information is displayed. You can
define the data conversion level during account setup. Otherwise, only general ledger information is reported.

When the subledger accounting options in the accounting setup, and the transfer to general ledger options in the
journal line type setup is summary, the subledger journal lines are summarized and transferred to general ledger.
In such cases, one general ledger journal line may be summarized from multiple subledger journal lines. The report
displays multiple lines for every subledger journal line and the amount displayed is from the corresponding subledger
journal line.
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Report Parameters
The following table lists selected parameters of the report.

Parameters Description

Data Access Set
 

Specify the data access set that is associated with your data role.
 

Ledger
 

Specify the ledger from which you want to export data. The ledger must be associated with the
selected data access set.
 

Legal Entity
 

When the selected ledger is a primary ledger, specify the legal entities assigned to it.
 
When the selected ledger is a secondary ledger, specify the legal entities that are assigned to the
corresponding primary ledger.
 

Source
 

Specify the name of the journal source as defined in the Manage Journal Source page.
 
When you specify the source, the general ledger journal lines from that source are extracted. All the
general ledger journal lines are exported if you don't specify any source.
 

Batch Name
 

Specify the general ledger batch name to be included for exporting data.
 

From Document Number and To
Document Number
 

Specify the range of general ledger sequence number to be included for exporting data.
 

From Period and To Period
 

Specify the range of general ledger periods to be included for reporting data. Only general ledger
journal lines during the specified period are exported.
 

Frequently Asked Questions
The following table lists frequently asked questions about the General Ledger Journal and Subledger Transaction
Mapping Report.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Accountant

When do I use this report?
 

Use the report to list the general ledger journal details and the corresponding subledger transaction
details in each row for the selected data access set, ledger, and accounting period range.
 
Details include account combination, accounted and entered amounts, source, category, journal batch,
 journal names, supplier or customer names, voucher, document, intercompany batch, payment,
 purchase order, and receipt numbers.
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FAQ Answer

What type of reports are these?
 

Oracle Analytics Publisher
 

Details of the Payment Register with Bank Charges for
Japan  
This topic includes details about the Payment Register with Bank Charges for Japan.

Overview
The Payment Register with Bank Charges for Japan lists payments with calculated bank charges.

The following figure is an example of the report.

Key Insights
The report lists payments and the bank charges that were deducted from a supplier payment.

Frequently Asked Questions
The following table lists frequently asked questions about the Payment Register with Bank Charges for Japan

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Financial Manager

• Financial Specialist

When do I use this report?
 

When you want to review the amount of bank charges deducted from a payment.
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FAQ Answer

What can I do with this report?
 

You can run this report for a specific business unit, payment date range, and currency.
 

What type of report is this?
 

Oracle Analytics Publisher
 

Related Topics
• How to Run the Payment Register with Bank Charges for Japan

Assets Reports for Japan  
This topic includes details about Assets reports for Japan.

Overview
Japanese Assets reports include:

Report Name Description

Japanese Addition or All Asset Detail by
Asset Type Report 132 Characters
 

Lists depreciable assets for Japan in detail by asset type in a 132 character-wide format.
 

Japanese Addition or All Asset Detail by
Asset Type Report 180 Characters
 

Lists depreciable assets for Japan in detail by asset type in a 180 character-wide format.
 

Japanese Corporate Tax Reports Schedule
16 (1) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (2) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (4) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (6) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Corporate Tax Reports Schedule
16 (8) Report
 

Lists the summary of depreciable assets for Japan in accordance with Corporate Tax Reports Schedule
16 for Japan.
 

Japanese Depreciable Assets Tax
Summary Report
 

Lists a summary of depreciable assets for Japan by location as of January 1 for the selected fiscal year.
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Report Name Description

Japanese Detail by Asset Type (Decrease
Assets) Report
 

Lists depreciable assets for Japan in detail by the asset type Decrease Assets, between January 2 of the
prior year and January 1 of the selected fiscal year.
 

The following table describes selected report parameters:

Name Description

Book
 

Use this parameter to specify the book to be included for reports.
 

Currency
 

Use this parameter to specify the currency to be included for reports.
 

From Asset Number and To Asset Number
 

Use these parameters to enter the asset number range for which you want to run the report.
 

Frequently Asked Questions
The following table lists frequently asked questions about Assets reports for Japan.

FAQ Answer

How do I find these reports?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

When do I use these reports?
 

Use these reports to:
 

• Review information for property tax forms.

• Review and analyze depreciation projection for your current depreciation parameters.

• Review and analyze the details of your asset impairment transactions.

How do I change the default report
format?
 

To change from Oracle Analytics Publisher, edit the fixed asset catalog and choose the output format
from the layout table in the view list.
 

About Input and Output Tax Gain/Loss Reports  
This topic includes details of the input and output tax gain/loss reports for Singapore.

Overview
The input and output tax gain/loss reports display the difference in both tax amounts and taxable amounts on foreign
invoices for different conversion rates.
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The input and output tax gain/loss reports include:

• Input Tax Gain/Loss Report for Singapore: Produces the details on tax gain or loss on transactions for
Singapore entered in foreign currencies in Oracle Fusion Payables. The report lists data for a specific supplier or
all suppliers. The report data is grouped by tax rate code and supplier.

The following figure is an example of the report.

• Output Tax Gain/Loss Report for Singapore: Produces the details on tax gain/loss on transactions for
Singapore entered in foreign currencies in Oracle Fusion Receivables. The report lists data for a specific
customer or all customers. The report data is grouped by tax rate code and customer.

The following figure is an example of the report.
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Note:  Manual tax transactions created in the tax repository are not reported.

Key Insights
Before running the reports:

• Set up legal entities and legal reporting units for each company site that is responsible for reporting taxes to the
tax authority.

• Set up tax regimes and taxes for your transactions.

• Set up supplier and customer conversion rates to calculate the tax amount and invoice taxable amount for
foreign currency invoices.

For the Input Tax Gain/Loss Report for Singapore, enter the supplier tax invoice conversion rate on the invoice and run
the Input Tax Gain and Loss Report for Singapore process.

For the Output Tax Gain/Loss Report for Singapore, enter the general ledger daily rate to represent the spot rate and
run the Output Tax Gain and Loss Report for Singapore process.

The gain/loss in the:

• Tax amount for foreign currency invoices is the difference between the:
◦ In-house tax amount using the in-house conversion rate, and

◦ Supplier or customer tax amount using the supplier or customer conversion rate (spot rate) you enter.

• Taxable amount is the difference between the:
◦ In-house taxable amount using the in-house conversion rate, and

◦ Supplier or customer taxable amount using the supplier or customer conversion rate.

A manual journal entry is posted to the general ledger to incorporate the gain/loss.

Note:  For transactions that are not in SGD currency and with incomplete conversion rate information, the following
occurs:

• For the Input Tax Gain/Loss Report for Singapore, the report indicates that the information is missing by
displaying:

◦ Unspecified for the supplier conversion rate

◦ Undetermined for the tax amounts in SGD currency

• For the Output Tax Gain/Loss Report for Singapore, the report indicates that the information is missing by
displaying:

◦ Unspecified for the spot conversion rate

◦ Undetermined for the tax amounts in SGD currency

Report Parameters
The following table describes selected report parameters:
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Parameter Name Description

Reporting Level
 

Gives you the option to run reports on three different levels, Ledger, Legal Entity, and Tax
Registration Number.
 

Reporting Context
 

Specify the context for the report. The list of values for this parameter depends on the reporting level
you selected.
 

• If you select the reporting level of Legal Entity, you select the legal entity on which to report, and
then select the tax registration number associated with the legal entity.

• If you select Ledger as the reporting level, you can report on legal entities associated with ledgers
defined in the ledger set or data access set within your security profile. Run tax reports by ledger
when you want to review your tax activity as it aligns with your accounting. Run tax reports by
ledger when you need to view tax activity in a currency other than the currency of the ledger or
the currencies of the transactions.

Tax Registration Number
 

Specify a tax registration number assigned to the tax registrations of the legal entity if the reporting
level is Legal Entity.
 

Note:
To prepare your tax returns, the recommended approach is to run tax reporting by legal entity and
tax registration number. Your legal entities and their associated tax registration numbers are aligned
with how your businesses are legally recognized by government authorities. Preparing reports by
tax registration number provides all reportable activity for a given legal entity regardless of how
your internal business units are organized.
 

From Tax Point Period and To Tax Point
Period
 

Print all transactions based on the selected tax point date range.
 

Tax
 

Lists invoice and tax information for a specified tax.
 

Supplier Name or Customer Name
 

Generates the report for a specified supplier or customer name.
 

Frequently Asked Questions
The following table lists frequently asked questions about the Input Tax Gain/Loss Report for Singapore and the Output
Tax Gain/Loss Report for Singapore.

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

• Tax Manager

• Tax Accountant

When do I use this report?
 

Use these reports to review the difference in both tax amounts and taxable amounts on foreign
invoices for different conversion rates.
 
The reports display different information, depending on whether the ledger currency is Singapore
Dollar (SGD) or another currency.
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FAQ Answer

 
When the ledger currency is:
 

• SGD, the tax gain or loss is displayed together with transaction information in SGD currency.

• Not SGD, the tax information is displayed in SGD currency for reporting to the tax authorities, and
in the accounted currency. The report includes:

◦ In-house conversion rate and the supplier conversion rate for the Input Tax Gain/Loss report.

◦ In-house conversion rate and the general ledger daily rate for the Output Tax Gain/Loss report.
The report only displays invoices that are approved and posted to the general ledger.

What type of reports are these?
 

Oracle Analytics Publisher
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Workflow Rules Report  
This topic includes details about the Workflow Rules Report.

Overview
You can now use the Workflow Rules Report to view and validate the workflow rules configured in Oracle Business
Process Management (BPM) for the following financial workflows.

• Automatic or Manual Credit Request Processing

• Bank Account Transfer Approval

• Bankruptcy Request Approval

• Cash Advance Approval

• Credit Request Approval

• Credit Request Approval Postprocessing Action

• Delegation of Corporate Card Transactions for Inactive Employees

• Expense Report Approval

• Hold Resolution

• Incomplete Invoice Hold

• Intercompany Transaction Approval

• Intercompany Transaction Distribution Entry

• Invoice Account Coding

• Invoice Approval

• Journal Approval

• Manually Entered Credit Request Completion

• Payment Approval

• Spend Authorization Approval

You can view the report output in both spreadsheet and XML format.

Key Insights
You can use the report to validate the workflow rules configured in Oracle Business Process Management (BPM)
to meet recommended best practices. Wherever the rules deviate from best practices, you can use the suggested
recommendations to make the necessary corrections.

You can also use this report to obtain details of the stage, participant, rule status, rule conditions, and approval routing
for each rule.
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Report Parameters

Parameter Description

Workflow
 

You can select the workflow for which you want to review the workflow rules.
 

Frequently Asked Questions

FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Workflow Rules Administrator
 

When do I use this report?
 

Use this report to review existing workflow rules defined in BPM.
 

What type of a report is this?
 

Spreadsheet, XML
 

Approval Groups Report  
This topic includes details about the Approval Groups Report.

Overview
You can now use the Approvals Group Report to view the approval groups defined in Oracle Business Process
Management (BPM). You can view the report output in both spreadsheet and XML format.

Key Insights
You can obtain the details of the group name, the approvers, and the sequence in which the approvers appear in the
approval group.

Report Parameters
There are no parameters that you need to select for this report.

Frequently Asked Questions
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FAQ Answer

How do I find this report?
 

Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
 

Who uses this report?
 

Workflow Rules Administrator
 

When do I use this report?
 

Use this report to review approval groups defined in BPM.
 

What type of a report is this?
 

Spreadsheet, XML
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